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CHAPTER 1

Introduccid al Mixxx

Mixxx enables you to perform live DJ mixes with your digital music collection. It helps you rock the party with DJ
controllers, vinyl turntables, or even just your keyboard. It is developed by an international team of volunteers who want
to bring the joy of DJing to everyone. The project is non-profit, open-source and community driven. Together, we aim
to build the best DJ software ever created. We hope you will join us!

1.1 How Mixxx Works

Mixxx is different from typical music player applications because it plays multiple audio files at the same time and has
many features to manipulate the playback of the audio files. This lets you creatively mix different tracks together on the
fly.

You can use Mixxx to preview the next track in headphones before the audience hears it, also known as headphone cueing.
This helps you choose a track that is appropriate for the present moment and that will mix well into the currently playing
track(s). To use headphone cueing, you need at least 2 separate audio outputs, typically provided by a USB audio interface
(also known as a “sound card”, although most of them are not shaped like cards anymore).

The shortcut for headphone cueing in Deck1 is T while for Deck 2 the shortcut is Y.
Mixxx can be used in two different ways for headphone cueing:
Internal Mixing

Mixxx plays multiple audio files on the computer at the same time, mixes them together, and sends the mixed
signal to one audio interface output. A separate signal is sent to another audio interface output for headphone
cueing. Often a DJ controller is used with internal mixing to provide easier control over Mixxx than a mouse
and keyboard.

External Mixing

In this kind of setup, Mixxx plays multiple audio files on the computer at the same time and sends each track
to a separate audio interface output. The audio interface’s outputs are plugged into an external hardware
mixer. The hardware mixer performs the actual mixing of the audio signals. On the hardware mixer, there
are separate outputs for the mixed signal to play to the audience and for the DJ to use headphone cueing.
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Figurel: Using Mixxx together with a DJ controller for internal mixing. The DJ controller has an integrated audio
interface that provides two separate stereo outputs.

External mixing is typically used with turntables and special vinyl records to manipulate digital music files as
if the music was on the vinyl records.

1.1. How Mixxx Works 2
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Figure2: Using Mixxx together with a USB audio interface, external mixer, and timecode vinyl for external mixing

1.1. How Mixxx Works 3



CHAPTER 2

Inici

2.1 Installing Mixxx

After downloading Mixxx from our Website, you need to install it on your computer.
Windows Double-click the Mixxx installation file and go through the installation wizard.
macOS Double-click the Mixxx .dmg file and drag the Mixxx icon to your Applications folder.

GNU/Linux No steps are necessary after you follow the instructions on the download page.

2.2 Upgrading Mixxx

You may safely install Mixxx on top of any previous version. You don’t need to uninstall the old version.

Your settings and library will not be removed or reset, but they may be upgraded when you launch the new version of
Mixxx. Note that we do not guarantee that new configurations will work on older versions of Mixxx, therefore you may
want to make a backup of your existing settings just in case.

Windows

Mixxx settings are in $LOCALAPPDATAS% \Mixxx, which is usually something like c: \
Users\<username>\AppData\Local\Mixxx. If you have trouble finding this
folder, see these instructions.

macOS Mixxx settings are in /Users/<username>/Library/Containers/org.
mixxx.mixxx/Data/Library/Application Support/Mixxx

GNU/Linux Mixxx settings are in /home/<username>/.mixxx
Copy this directory to a backup drive or somewhere else on your system to make a backup of your settings.
Vegeu també:

For detailed descriptions of the settings files, go to The Mixxx Settings Directory.



https://mixxx.org/download/
https://www.howtogeek.com/318177/what-is-the-appdata-folder-in-windows/

Mixxx User Manual, Versié 2.3.0

2.3 Obrint el Mixxx

P

Windows Feu doble clic a la icona del Mixxx de I'escriptori. Des del ment Inicia del Windows també podeu fer clic a
la icona del Mixxx o cercar el fixer Mixxx .exe.

Once you’ve installed Mixxx, start by opening Mixxx and importing your music to the Mixxx library.

macOS Double-click the Mixxx icon in the Applications folder. Alternatively, drag the Mixxx icon to the dock
and double-click it there or search for mixxx in Spotlight.

GNU/Linux Click the Mixxx icon in the applications menu or launcher of your desktop environment or perform a
search for mixxx. Alternatively type mixxx into the terminal, then hit Return. If your audio interface is
not accessible from Mixxx because it is used by other applications via PulseAudio, you may close and restart

Mixxx using pasuspender mixxx. See Launching Mixxx from the Command Line for an overview of Mixxx’s
command line options.

2.4 Importacio dels fitxers d’audio

PP~ MusicTools  Music - o X
Home Share View Play (2]

« « A s ThisPC > Music v o

# Quick access Name # Title Contributing artists  Album
[ Deskiop Demo Folder 1
3 Downloads Demo Folder2

Demo Folder 3
%] Documents

=] Pictures

D Music

Videos
@ OneDrive
[ This PC
& Network

*d Homegraup

<

3items 1 item selected =

>

Figurel: Mixxx running on Windows 10 - Choose music library directory dialog

El primer cop que executeu el Mixxx, si us demanara que seleccioneu la ruta de la vostra miusica. Per defecte se selecciona
la predeterminada pel sistema per emmagatzemar els fitxers d’audio, perd podeu triar qualsevol altra carpeta de I'ordinador.

Click Select Folder and Mixxx will scan your music library. Depending on the size of your library this could take some
time. All the supported music files Mixxx detects will be listed in the Tracks - View and edit your whole collection.

Si voleu actualitzar la biblioteca (p. ex. en afegir o moure fitxers), podeu fer-ho des de I'opcid Llibreria » Torna a

escanejar. Si voleu fer aquest procés cada vegada que s’inicii el Mixxx, seleccioneu Preferéncies » Llibreria » Torna a
escanejar en iniciar.

Avis: A Windows 7 i 8 la carpeta configurada en la finestra d’importaci6 és la Llibreria «Musica» de Windows, una

carpeta virtual especial. No podeu utilitzar aquest tipus de carpetes. Seleccioneu una carpeta especifica, com «La
meva Musica».

2.3. Obrint el Mixxx 5
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2.5 Analisi de la llibreria

% Mixxx automatically analyzes tracks the first time you load them in a deck. This allows you to run beargrid, key,

and ReplayGain detection on tracks in advance. It also prepares the waveform overviews, detects file corruption, and
calculates the BPM values.

Vegeu també:

For more information, go to Deteccio de ritme.

2.5.1 Why you should analyze your audio files

If the tracks have never been played with Mixxx before, the library columns BPM, Duration and Key will be empty or
unreliable (because the values are just read from the file’s tags if present and might be wrong). Pre-generating beatgrids
gives you the chance to double-check the beat markers to make sure they are correct. Errors in beatgrids can cause
difficulty when syncing tracks. Furthermore, track analysis takes considerable CPU power and might cause skips in the
audio — things you surely don’t need while performing.

2.5.2 How to analyze your audio files

Once you have imported your music library, press OK on the Preferences window.
* Go to the Analyze view on the left side panel of the library.

* To analyze a few specific tracks, hold down the Ct r1 button, and select the tracks that you want to analyze or you
can shift-select a range of tracks. Once they’ve been highlighted, click the Analyze button on the top right of
the library section.

 To analyze the newly added tracks, toggle the New label and then click Analyze.
» To analyze the entire library, toggle the All label and then click Analyze.

* The New and All toggle buttons are located at the top left of the analysis pane - just above the Preview and Cover
Art column titles of the library.

While analyzing, the progress in percentage and total queue length are shown.

2.6 Configuring sound input and output

Before you can start using Mixxx, you need to configure Mixxx to use your sound hardware in Preferences » Sound
Hardware. You do not need to configure all inputs and outputs.

The Maquinari DJ chapter explains different types of DJ hardware and how to set them up with the input and output
options. For Mixxx to perform the best it can on your system, configure the other Maquinari de so preferences in addition
to the inputs and outputs.

2.5. Analisi de la llibreria 6
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eC e # Preferences
L3
Sound Hardware -
» [ Controllers Sound API Core Audio H
i Library Sample Rate 44100 Hz a
o Interface . —
¥ Waveforms Audio Buffer 23.2ms H
W Auto DJ Multi-Soundeard Synchronization Default (long delay) E
I:Iinl E:::::Efs Keylock/Pitch-Bending Engine Rubberband (better) E
sl Crossiader Master Mix Enabled E
s gecfr::gm‘ Master Output Mode Stereo E
eat Detection e
; 1 Key Detection Microphone/Talkover Mix Master output u
'g) :‘:&Tg:;:';n Headphone Delay 0,00 ms -
X Live Broadcasting Master Delay 0,00 ms z
Query Devices
.n..-: o Input
Master Built-in Output a Channels 1 - 2 a
Headphones None a a
Restore Defaults Apply Cancel *

Figure2: Preferencies de maquinari de so del Mixxx

2.6.1 Output Options

Internal mixing:

Use these outputs if you are not using an external hardware mixer. If you are using a controller with a built-in audio
interface, use these outputs.

* Master: all decks, samplers, microphones, and auxiliary inputs mixed together. This output is sent to the speakers
for the audience.

* Headphones: all decks, samplers, microphones, and auxiliary inputs assigned to pre-fader listening
* Booth: same as Master output, but has a separate gain control

External mixing:
e Decks 1-4: the individual unmixed decks to send to an external mixer

* Bus Left/Center/Right: all decks, samplers, and auxiliary inputs assigned to each side of Mixxx’s crossfader

2.6.2 Input Options

Internal mixing:

Use these inputs if you are not using an external hardware mixer. If you are using a controller with a built-in audio
interface, use these inputs.

* Microphone 1-4: live microphone or musical instrument inputs
e Auxiliary 1-4: other sound sources
External mixing:

* Record/Broadcast: When this is configured, Mixxx will record and broadcast from this audio interface input instead
of the internal master mix. If you have a microphone plugged into the mixer, do not configure the Microphone 1-4
inputs.

Either internal or external mixing:

2.6. Configuring sound input and output 7
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* Vinyl Control 1-4: timecode input from turntables or CDJs for manipulating decks 1-4
Vegeu també:

microfons

2.6. Configuring sound input and output 8



CHAPTER 3

The Mixxx User Interface

Benvingut a la interficie del Mixxx. Aqui és on es fa magia. Segurament voldreu familiaritzar-vos molt amb aquesta
interficie perque és la principal manera d’utilitzar-lo. En aquest capitol, us presentem la interficie per defecte del Mixxx

i en descrivim els elements, rodetes i controls desllicants.

‘ - ‘WW%} R ,W+W+ ‘
e

s
> v a o
Don't Leave Me Lonely

Mark Ronson, Yebba

— W[
()

A
‘ NI Naive Andy Grammer She'd Say (with Ladysmith Bl...
ML Naive Andy Grammer Stay There
e ML Naive Andy Grammer Best Of You
UMK Naive Andy Grammer
» dd Tracks ME Naive Andy Grammer
Auto DJ UK Naive Andy Grammer Some Girl
Playlists UK Naive Andy Grammer Naive
Crates The Book of You &I Alec Benjamin The Book of You &
Computer The Book of You &I Alec Benjamin The Book of You &
Recordings The Book of You &I Alec Benjamin The Book of You &
History E Heartl The Weeknd Heartless

Analyse Heartless The Weeknd Heartless
iTunes Riri Aminé Riri

Rekordbox Changes Justin Bieber,Post Malone,Cl..  Forever

Serato Changes Justin Bieber ETA.
Changes Justin Bieber Confirmation
Changes Justin Bieber All Around Me
Changes Justin Bieber Available

# Chanaes lustin Rieher Chanaes

Figurel: The Mixxx interface - Latenight skin

Pop
Pop
Pop
Pop
Pop
Pop
Pop
Pop

Yol
2 P

‘op
R&B
R&B

Rap/Hip Hop

Pop
Pop
Pop
Pop
Pop

Pon

Decks 2
Deck Size: hide mixer to select
v Hotcues 4 8
v Intro & Outro Cues
[J Hotcue Shift Buttons
v Rate Controls

+ Rate Adjust Buttons
+ Key Controls
[ Vinyl Control
v Spinny
v Cover Art

Big Spinny/Cover Art

v Mixer
v Main / Headphone Mixer
v EQ Knobs
v EQ Kill Buttons
v Crossfader

v Effect Units 2
[ Super Knobs

[Jsamplers

Library
v Preview Deck
v Cover Art

This is the LateNight skin, PaleMoon color theme. It is the default skin supplied with Mixxx 2.3. There are a variety of
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other skins included with Mixxx. You should explore them all to figure out which one you prefer. This section will focus
on LateNight only, though all Mixxx skins provide most of the controls described here.

3.1 Skin Settings

On top, and on the right side of the user interface are the section expansion buttons and options.

Figure2: The GUI section quick toggles buttons in the top tool bar

If you click on either WAVEFORMS, 4 DECKS, MIXER, EFFECTS, SAMPLERS or MICS & AUX then you will enable
control sections for interacting with:

* Visualitzacié de grafics d ona

* Decks

* Mixer

* Effects

* Samplers

e Microphones & Auxiliary Inputs
Podeu també utilitzar les Application shortcuts.

Click the SETTINGS button or gear icon (depending on the skin) to open the skin settings menu. This provides common
basic controls as well as some skin-specific options.

3.2 Decks

The deck section comes in three sizes: Full, Compact and Mini. You can switch between any of the three sizes by clicking
on the Sertings button or the gear icon. Under the Decks section, click on «hide mixer to select». This will automatically
select the Compact deck (underlined and bolded). If you wish to change to a different deck size, you can choose FULL
or Mini.

The FULL deck (which is similar in all skins) will show the Mode de control de vinil i punts cue and Key
controls at the top of the deck section and then the Controls Hotcue, Intro/Outro Markers, Controls de bucle
at the bottom.

The Compact deck has a reduced set of controls for when you don’t need all of them on screen, for example
when they’re also accessible from your controller. Reverse is removed from the Playback/Cue Controls, and
the Controls Hotcue, Intro/Outro Markers, Controls de bucle and rate adjust buttons are not shown.

The mini deck is of a much smaller size and shows only the waveform and the Visualitzacio de la
informacié de la pista. You can also use minimal decks with the maximized library.

Suggerencia: Hiding the mixer will by default switch to the compact decks.

3.1. Skin Settings 10
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() (D)

Decks 2

Deck Size: hide mixer to select
v Hotcues 4 8

v Intro & Outro Cues

[] Hotcue Shift Buttons

v Rate Controls
v Rate Adjust Buttons
v Key Controls
[] Vinyl Control
v Spinny
v Cover Art
[] Big Spinny/Cover Art

v Mixer

v Main / Headphone Mixer
v EQ Knobs

v EQ Kill Buttons
v Crossfader

v Effect Units 2
(] Super Knobs

[]1Samplers

Library

v Preview Deck
v Cover Art

Figure3: The Skin Settings menu on the right

3.2. Decks 11
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Figure4: Un plat amb una pista carregada

La secci6 dels plats us permet controlar tot el que fa referéncia al tocadiscs virtual, que anomenem plaz. La dividirem en
diferents elements.

3.2.1 Visualitzacié de la informacio de la pista

Only Us

Kygo

Figure5: La seccié d’informacié de la pista del plat

Titol de la pista The title of the track that was loaded into a deck is displayed on top. This is the same as the title listed
under the Tifle column heading in the Mixxx library. This information is initially loaded from the track’s metadata.
If the metadata is missing, the title and artist are guessed from the filename.

Artista de la pista The artist of the track is listed below. It is the same as listed under the Arfist column heading in the
Mixxx library.

Time Elapsed/Remaining/Both By default it displays the total elapsed time in the track up to the millisecond. Clicking
on the display switches to the Time Remaining view, which indicates how much time is left before the track reaches
the end. Clicking the display again, both the elapsed and remaining time are shown simultaneously in the format
elapsed time / remaining time. You can change the default in Preferences » Decks » Deck options.

BPM (Tempo) El niimero a la part superior dreta és el BPM efectiu de la pista. Es tracta del BPM de la pista, ajustat a
la velocitat de reproduccié. Per exemple, si la pista normalment té 100 BPM i es reprodueix a +5%, aleshores el
BPM efectiu mostrara 105 BPM.

Suggereéncia: You can use a keyboard shortcut and tap with the beat to set the BPM to the speed you are tapping,
go to Amb un teclat d’ordinador for more information.

Key

J

Figure6: The Key options.

3.2. Decks 12
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The key displays the current musical key of the loaded track after pitch shifting. The key is displayed below the BPM
(Tempo). This is the same as the key that is shown under the Key column heading in the Mixxx library. Clicking the key
will expand it to reveal more options:

 Pitch Control: This changes the track pitch independent of the tempo. Left-clicking the - button decreases the
pitch by one semitone. Right-clicking it decreases the pitch by 10 cents. Left-clicking the + button increases the
pitch by one semitone. Right-clicking it increases the pitch by 10 cents.

¢ Sync and Reset Key: Left-clicking the MATCH button sets the key to a pitch that allows harmonic transition from
the other track. It requires a detected key on both involved decks. Right-clicking it resets the key to the original
track key.

Cover Art The cover art of the track loaded into the deck is displayed on the left side of the track. This is the same as
the cover art that is shown under the Cover Art column heading in the Mixxx library. In Deere skin you can choose
to enable or disable the cover art by clicking the gear icon in the upper right corner, then toggling the Decks » Cover
Art option. Clicking on the cover art will expand it into a full blown image. The cover art is also shown in the Vinyl
Widget next to the parallel waveforms.

3.2.2 Visualitzacié de grafics d’ona
La secci6 del grafic d’ona del plat permet visualitzar com canvia l'audio al llarg de la pista, de manera que podeu “veure”
la musica.

By default the waveform displays are aligned parallel to each other in order to make bearmatching easier, as it is possible
to beatmatch visually by aligning the beats that appear in each waveform.
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Figure7: Parallel waveforms in the default Mixxx skin (LateNight, PaleMoon theme)

Depending on the skin, Mixxx displays either parallel waveforms (default) or separate waveforms. LateNight and Tango
skins only have resizable parallel waveforms while Shade skin provides only separate waveforms. In Deere skin you can
select your preferred appearance by clicking the gear icon in the upper right corner, then toggling the Skin Settings »
Parallel Waveforms option.

Avis: If you have a slower computer and notice performance issues with Mixxx, try lowering the frame rate or
changing the waveform type in Preferences » Waveforms.

Grafic d’ona de reproduccio FEl grafic d’ona de reproduccié mostra I'envolvent de la pista al voltant de la posicié actual
de reproducci6 i es va actualitzant en temps real. Es pot utilitzar el ratoli per a pausar, fer scratch, moure enrere
o afegir-hi una pista nova. També permet fer ajustaments momentanis del pitch si es fa clic amb el boté dret i
S’arrastra cap als costats.

3.2. Decks 13



Mixxx User Manual, Versié 2.3.0

Suggeréncia: You can select from different types of displays for the waveform, which differ primarily in the level
of detail shown in the waveform, in Preferences » Waveforms » Waveform type.

Grafic d’ona de la pista The smaller, zoomed-out version of the waveform shows the various markers within the track

as well as the waveform envelope of the entire track. This is useful because they allow DJs to see breakdowns far
in advance. As visual aid, the part of the track that has already been played is darkened.

Clicking somewhere on the waveform allows you to jump to an arbitrary position in the track. Like with the
Waveform summary, you can select from different types of displays for the overview in Preferences » Waveforms »
Overview type.

Vinil giratori La linia que es mostra sobre el vinil giratori gira quan la pista es mou. Es similar a la marca de posici6 que

es troba en alguns discs de scratch. Feu anar el ratoli sobre el vinil giratori per pausar, fer scratch, moure endavant
i endarrere, o afegir-hi una pista nova - com si fos un disc de veritat. Quan es fan Bucles «roll» o al fer clic amb el
bot6 dret sobre el vinil mentre es reprodueix, una marca «fantasma» indica on continuara la reproduccié. El vinil
giratori esta amagat per defecte, i pot activar-se a Grup de botons d'opcions del plat.

If vinyl control is enabled, it can optionally display the time-coded vinyl signal quality. Activate the option in
Preferences » Vinyl Control » Show Signal Quality in Skin.

Zoom de grafic d’ona Using the mouse-wheel everywhere in the waveform summary will zoom the waveform in or out.

You can choose whether to synchronize the zoom level between the decks in Preferences » Waveforms.

Marques del grafic d’ona Mentre es mescla, poden apareixer diferents marques addicionals als grafics d’ona:

Position marker: The static vertical line in the center of the waveform summary indicates the playback point of
the deck. The waveform overview includes a vertical line to show the current position within the track.

Mareca de toc: Les linies blanques del grafic d’ona indiquen la posicié dels tocs de compas en I'audio, que tenen el
nom de graella de tocs

Marca de punt cue: Indica la posicié d’un punt cue.
Marca de hotcue: Indica la posici i niimero d’'un punt /ofcue, si n’hi ha.
Marca d’inici/fi de bucle: Indica el comengament i el final d’'un bucle.

superposicié de bucle: Es dibuixa entre els punts d’inici i final de bucle, i canvia el color depenent d’on esta ubicat
el bucle.

Notificacié de final de pista: Si el grafic d’ona parpalleja en vermell, vol dir que queden 30 segons o menys per a
que s’acabi la pista.

3.2.3 Grup de botons d’opcions del plat

Figure8: El grup de botons d’opcid del plat

The six buttons at the bottom right below the waveform allow you to configure the deck. Starting from the top row (left
to right) and the bottom row (left to right), the buttons are as follows:

Slip Mode Toggle When active, the playback continues muted in the background during a loop, reverse, scratch, etc.

Once disabled, the audible playback will resume where the track would have been.
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Commutador de mode quantitzat Si s’activa, tots els punts cue, hotcues, bucles i bucles de tocs s alinearan de manera
que comencin en un toc.

Boto d’ajustar la graella de ritme Clicking this button adjusts the track beat-grid so that the current position is marked
as a beat. This is useful if Mixxx was able to accurately detect the track’s BPM but failed to align the beat markers
on the beats. For more information, go to the chapter Deteccio de ritme.

Boto d’extreure la pista Si es fa clic en aquest botd, la pista s’expulsa del plat. També es pot utilitzar una drecera de
teclat, aneu al capitol Amb un teclat d’ordinador per a més informacio.

Commutador de repeticié Si s’activa el mode de repetici6, la pista tornara al principi quan acabi i continuara reproduint.

Commutador de bloqueig de clau musical Key lock locks the track’s pitch so that adjustments to its tempo via the rate
slider do not affect its pitch. This is useful if you would like to speed up or slow down a track and avoid the
“chipmunk” effect that speeding up vocals has.

3.2.4 Playback/Cue Controls

Figure9: The playback and cueing controls of the deck

Play/Pause Button En fer clic al boté de reproduccié/pausa s’inicia o es pausa la reproduccio.
Vegeu també:
El comportament del boté reprodueix/pausa depen del mode de punts cue.

Cue Button Si es prem el bot mentre sona la pista, la reproducci6 salta al punt cue de la pista, i es posa en pausa. Un
cop la pista esta pausada al punt cue, podeu pre-escoltar-la prement el bot6 cue. Si no heu mogut el punt cue, el
punt cue inicial és l'inici de la pista.

Vegeu també:
El comportament del boté cue depen del mode de punts cue.

Boto cap enrere Press and hold this button to temporarily play the track backwards during regular playback. Right-click
and hold for “Censor” mode. This reverses the track while the playback continues muted in the background. On
release playback is resumed where the track would have been if it had not been reversed.

Posant punts Cue

Tota pista té un punt cue, per defecte al comencament. A diferéncia dels hozcues, no es pot esborrar, tan sols moure el
punt.

El punt cue es mou segons el mode cue seleccionat, segons s’explica a continuacio.
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Auto Cue

Mixxx automatically seeks to the saved Cue point on track load. If none exists, seeks to the beginning of the track.

Uncheck Preferences * Interface » Auto Cue » Jump to main cue point on track load to always seek to the beginning of the
track.

Utilitzant els modes de cue

Mixxx supports various Cue modes that adapt to fit other devices in your setup or your personal preferences. The actual
behavior of the Play, Pause, and Cue buttons depends on the selected Cue mode. To change the Cue mode, go to
Preferences » Decks » Cue mode.

Mode Mixxx (per defecte)
* Mentre esta pausat en un punt cue (boté Cue ences):

— Hold down the Cue button to play the track from the Cue point, as long as the button is pressed. After releasing
the Cue button, the track jumps back to the Cue point and pauses again.

— Press Play/Pause before releasing the Cue button to continue playback normally.
e Mentre esta pausat en un punt diferent al punt Cue (boté Cue interminent):
— Tap the Cue button to store the current position as new Cue point.
¢ Mentre es reprodueix:
— Tap the Cue button to jump to the Cue point and pause playback.
Mixxx mode (no blinking)
¢ Same as the default Mixxx mode, but without blinking indicators.
Mode Pioneer
» Same as Mixxx mode, but the buttons are more flashy matching a Pioneer CDJ player.
— El bot6 Reprodueix/Pausa esta en intermitent un cop per segon quan la pista esta pausada.
— The Cue button flashes twice a second when the next push will move the Cue point.
Mode Denon
¢ While paused at Cue point (Cue button lit) - same as Mixxx mode:

— Hold down the Cue button to play the track from the Cue point, as long as the button is pressed. After releasing
the Cue button, the track jumps back to the Cue point and pauses again.

— Press Play/Pause before releasing the Cue button to continue playback normally.
¢ Mentre esta pausat en un punt diferent al punt Cue (boté Reprodueix intermitent):
— Tap the Cue button to move the track back to Cue point.
— Tap the Play/Pause button to move the Cue point to the current position and start playback.
* While playing - same as Mixxx mode:
— Tap the Cue button to jump to the Cue point and pause playback.
Mode Numark
e Same as Denon mode, but without a flashing Play/Pause button.

* Aquest mode és titil si voleu implementar una aparenc¢a amb plats de 3 botons, un bot6 Cue, un boté pausa separat,
i un bot6 Reprodueix/Salta.
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CUP (Cue + Play) mode

* Press the Cue button to jump to the Cue point and pause, continuing playback only when either the Cue button is
released or Play/Pause is pressed.

¢ If the Cue button is pressed while paused, the Cue point is first moved to the current position.

Suggeréncia: Podeu utilitzar els botons hotcue per a tenir més punts de referéncia en una pista.

Vegeu també:

Podeu també utilitzar dreceres de teclat per a fer Cue. Aneu a Amb un teclat d'ordinador per a més informacio.

3.2.5 Intro/Outro Markers

Figure10: The Intro/Outro End and Start Markers

You can use the Intro/Outro Markers with Auto DJ to mix in and out of points but unlike hotcues, they do not mark only
one point. The intro and outro are sections and each section is defined by two points. See DJ Automatic - Mescleu de
manera automatitzada.

Intro Start/End Markers The analyzer places the intro start point at the first sound of a track and you can decide where
to place the intro end point. Left-clicking on the marker when it is set jumps to the marker. When it is not set,
clicking sets the marker to the current play position. Right-clicking on the marker when it is set clears the marker.

Outro Start/End Markers The analyzer places the outro end point at the last sound of a track and you can decide where
to place the outro start point. Left-clicking on the marker when it is set jumps to the marker. When it is not set,
clicking sets the marker to the current play position. Right-clicking on the marker when it is set clears the marker.

Nota: If quantization is enabled, left-clicking on any of the markers snaps to the nearest beat.

3.2.6 Controls de reproduccié

Figurel1: Els controls de reproduccio6 del plat

Beatjump/ Loop Move Size You can type, use the arrow keys or scroll vertically in the input box to select the number
of beats to jump or move, with the Beatjump Forward/ Backward buttons.

Beatjump Backward button Clicking this while the loop is inactive will make the track jump backward by the set
number of beats (left click) or by one beat (right click). Clicking this while the loop is active will move the loop
backward by the set number of beats (left click) or by one beat (right click).
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Beatjump Forward button Clicking this while the loop is inactive will make the track jump forward by the set number
of beats (left click) or by one beat (right click). Clicking this while the loop is active will move the loop forward
by the set number of beats (left click) or by one beat (right click).

3.2.7 Mode de control de vinil i punts cue

Figure12: El mode de control de vinil i les opcions de control de punts cue d’un plat

The control above the waveforms relate to the vinyl control feature in Mixxx and is hidden in the default Mixxx user
interface. Click the gear icon in the upper right corner, then toggle Skin Settings » Vinyl Control Options, or use the specific
Application shortcuts to show or hide the section.

Vegeu també:
Per a més informaci6é de com utilitzar el control de vinil, aneu al capitol Control de vinil.
Vinyl button

This button enables vinyl control. When enabled in Mixxx, the track on the Mixxx deck is controlled by the external vinyl
control.

Pass button
This button enables passthrough. When enabled, audio from an external vinyl can be played on the Mixxx deck.
Botons Abs/Rel/Const

* Mode absolut: La posici6 de la pista correspon a la posici6 i velocitat de 'agulla.

¢ Mode relatiu: La velocitat de la pista correspon a la velocitat de I'agulla, perd sense importar la seva posicio.

* Mode constant: La velocitat de la pista correspon a I'iltima velocitat estable coneguda, independentment del que
es rebi ara mateix.

Cue/Hot button

Aquests botons determinen com es comporten els punts cue quan s’utilitza el mode relatiu del control de vinil:
» Off: Els punts cue s’ignoren.
¢ Cue: If the needle is dropped after the cue point, the track will seek to that cue point.

» Hot: The track will seek to the nearest previous /ofcue point.

3.2.8 Controls de sincronia i velocitat

Els controls de velocitat permeten canviar la velocitat a la que es reprodueixen les pistes. Aixo €s
molt ttil per a fer beatmatching de dues pistes en una mescla. Podeu fer canvis de la velocitat també
des del teclat de I'ordinador, veieu Amb un teclat d'ordinador per a més informacio.

Boté SYNC

¢ Clic amb el boté esquerra: Canvia la velocitat de la pista de manera que el BPM i la
fase de la pista concideix amb laltre plat.

* Clic amb el boto dret: Només canvia la velocitar de la pista per a que concideixi amb
laltre plat, perd no canvia la fase.

3.2. Decks
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Els plats i els reproductors de mostres trien al moment a quin altre plat sincronitzar-se. Tant
els plats com els reproductors de mostres només es poden sincronitzar amb altres plats. El
candidat per als reproductors de mostres és:

 El primer plat (en ordre numeric) que estigui reproduint una pista amb graella de ritme
detectada, i la velocitat de reproducci6 sigui diferent a la de per defecte.

¢ El primer plat (en ordre numeric) que tingui una pista carregada amb la graella de ritme
detectada, independentment de si esta reproduint o no.

Basicament, si sincronitzeu un reproductor de mostres i tant el plat 1 com el plat 2 estan
reproduint una pista amb graella de ritme, aleshores el plat 1 guanyara perqué numericament
va primer. El candidat de sincronitzacid per als plats es tria amb la nova sincronitzaci6 mestra,
podeu veure Sincronitzacio mestra per a més informacio.

Control lliscant de velocitat El control lliscant que us permet canviar la velocitat de la cangd, per
defecte fins a un 10% de la velocitat original. La velocitat s’incrementa en moure el control
cap amunt, a I'inrevés del que passa amb els tocadiscs de DJ i CDJ. Fent clic amb el boté dret
tornara el control a la seva velocitat original.

Indicador de la velocitat El percentatge amb que s’augmenta o disminueix la velocitat de la pista.
Si el control lliscant de velocitat esta al mig, I'indicador mostrara el text +0.0%, que vol dir
que no canvia.

Botons de velocitat momentani (Empeny) Pushing the diagonal arrow buttons is like nudging
the metal edge of a turntable, or the outer edge of a CD player. It will give the track a push or
pull forwards or backwards. If the buttons are released the previous tempo is restored. The
buttons can act as either a fixed pitch bend or a ramping pitch bend.

Botons de velocitat Clicking the - button will set the pitch/rate lower while the + button will set the
pitch/rate higher. This is like moving the pitch slider up or down by a fixed amount. Unlike
using the temporary pitch/rate buttons, the change is permanent so these button s don’t need
to be held down.

Vegeu també:

To customize the amount by which the buttons alter the pitch of the track, the slider range as well as the direction, go to
Preferences » Interface » Adjustment buttons » Permanent / Temporary.

Suggerencia: Si canvieu la velocitat d’'una pista, veureu que el to també canvia (per exemple, si s’accelera molt, la veu
sona com la dels barrufets). Podeu activar el blogueig de clau musical per a que es mantingui el to constant.

3.2.9 Controls de bucle

Figure14: Els controls de bucle i bucle de tocs del plat

In this section of the Mixxx interface you can control (beat-)loops and set the loop points of a track. You can also shift
loops using the beatjump /loop move controls shown at the right side of the looping controls.

Beatloop size The input box allows you to set the size of the loop in beats to set with the Beatloop button. Changing this
resizes the loop if the loop already matches the size. If a loop is set, a loop overlay will be drawn on the waveforms.
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Beatloop Left-clicking the Beatloop button starts a loop over the set number of beats. If quantize is enabled, it snaps to
the nearest beat. This works for manually placed loops as well as automatic loops set by the beatlooping buttons.
Depending on the current status of the loop, the loop overlay on the waveforms changes color. Right-clicking the
Beatloop button temporarily enables a rolling loop over the set number of beats. Playback will resume where the
track would have been if it had not entered the loop.

Double loop Clicking on the arrow pointing up will double the current loop’s length up to 64 bars. The length of the
loop overlay in the waveform will increase accordingly.

Halve loop Clicking on the arrow pointing down will halve the current loop’s length down to 1/32 bars. The length of
the loop overlay in the waveform will decrease accordingly.

Loop-In This button allows you to manually set the start point of a loop. A loop-in marker is placed on the waveform
indicating the position. If clicked when a loop was already set, it moves the start point of a loop to a new position.

Loop-Out This button allows you to manually set the end point of a loop. A loop-out marker is placed on the waveform
indicating the position. If clicked when a loop was already set, it moves the end point of a loop to a new position.

Reloop Left-clicking this button toggles the current loop on or off. If the loop is ahead of the current position, looping
will start when the loop is reached. This works only if the Loop-in and Loop-Out marker are set. Right-clicking
this button enables the loop, jumps to Loop-in marker and stops playback.

Suggerencia: If you are playing inside a loop and want to move the end point beyond its current position in the track,
click on the Beatloop button first and when the play position reaches the desired position, click on the Loop-Out button.

Vegeu també:

Si el mode quantitzat esta activat, els bucles s’ajustaran atumaticament al toc de compas més proper. Aquest esta desactivat
per defecte, i podeu activar-lo fent clic a Commutador de mode quantitzat.

3.2.10 Controls Hotcue

Figurel5: Els controls hotcue del plat

Per saltar a diferents parts de la pista, podeu utilitzar aquests botons numerats. Podeu també utilitzar dreceres de teclat,
aneu a Amb un teclat d ordinador per a més informaci6.

Definint hotcues

En fer clic en un dels botons numerats, es defineix un /ozcue a la posicié de reproduccid actual. Es posara una marca amb
el nimero corresponent al grafic d’ona i el bot6 s’iluminara per indicar que esta definit.
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Reproduir els hotcue

¢ Mentre esta reproduint: Feu clic al bot6 de hotcue per fer que la pista vagi immediatament a la posici6 del hotcue
i continui reproduint. Si esteu reproduint dins d’un bucle i feu clic a un hotcue que esta fora del bucle, aleshores la
reproducci6 anira al punt hotcue, i es desactivara el bucle.

* Mentre esta parat: Feu clic al bot6 hotcue per a que la pista vagi immediatament a la posici6 del hotcue i comenci
a reproduir mentre el bot6 es mantingui premut. Premeu la drecera de teclat de Reprodueix mentre el boté de
hotcue esta premut per a que continui la reproducci6 i es pugui deixar el boté hotcue.

Highlighting Hotcues
It’s possible to add labels or colors to your hotcues to make them easier to distinguish and make it possible to get their
«meaning» at first glance.

Labels and colors can be assigned from the Hotcue context menu, which can be opened by right-clicking either the hotcue
button or the hotcue marker in the waveform overview.

Suggeréncia: Mixxx allows customizing the color palette and bulk replacing hotcue colors.

Esborrar els hotcues

To delete a hotcue, right-click on the hotcue button or the waveform marker in the overview waveform to open the context
menu, then click the trash icon.

Nota: El Mixxx suporta fins a 36 hotcues per plat. Per defecte, només se’n mostren uns pocs a la interficie. Podeu
configurar les dreceres de teclat o les assignacions de la controladora per utilitzar-los tots.

Vegeu també:

Igual que amb els bucles (veure més amunt), si el mode qguantitzat esta activat, els punts hotcue s’ajustaran automaticament
al toc més proper. Aquest esta desactivat per defecte, i podeu activar-lo fent clic a Commutador de mode quantitzat.

3.3 Mixer

La secci6 del mesclador de la interficie dusuari del Mixxx permet controlar com els diferents plats i reproductors de
mostres es mesclen entre ells.

3.3.1 Monitors de nivell i controls lliscants del canal

Monitors de nivell The left meter shows the volume level for the left deck, while the right meter shows the volume level
for the right deck. The double meter at the center shows the current volume of the main output’s left and right
channel separately. These should stay at the top of the green region, with the loudest parts of the music (transients)
briefly going into the yellow region. They should never be in the red region. Refer to Setting your levels properly
(gain staging) for more details.

Control de volum del canal Els dos controls lliscants 1largs a cada costat dels monitors de nivell sén els faders de volum
dels plats, també coneguts com a faders de canal o de linia. Serveixen per ajustar el volum de cada plat.
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Figure16: La secci6 del mesclador

Suggereéncia: Alguns DJs prefereixen utilitzar els controls de volum en comptes del crossfader per a canviar de
volum entre les pistes. Proveu-ho, potser us agrada.

3.3.2 Equalitzadors i rodetes de guany

Rodeta de guany The gain knob (orange) above the volume fader allows you to adjust the gain applied to the deck. Use
this to compensate for the differences in recording levels between tracks. In general, you should adjust this knob so
that the track’s level meter stays around the top of the green region with the loudest parts of the track (the transients)
briefly going into the yellow region. Do NOT turn the Gain Knob up so much that the level meter is in the
red region. At this point the track is clipping, which sounds bad and could damage equipment.

Nota: By default, Mixxx automatically applies an additional ReplayGain so tracks have approximately equal
loudness at unity gain. Your tracks must be analyzed to take advantage of this feature. When an unanalyzed track
is loaded, Mixxx calculates its ReplayGain value, but will not apply a newly calculated ReplayGain value to a track
after it has already started playing (to avoid a sudden change in the gain of a playing track).

Vegeu també:

Teniu una explicacié de perque heu de posar els guanys d’aquesta manera a Ajust dels nivells de forma adequada
(Gain Staging en anglés).

Rodetes ’EQ

The low, mid, and high EQ knobs allow you to change the filters of the audio. This allows you to
selectively reduce or boost certain frequency ranges of the audio.
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Figurel7: Controls dEQ
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Avis: Tingueu en compte de no augmentar la equalitzacié fins a saturar la senyal, indicat pel monitor de
nivell en la zona vermella. Consulteu Ajust dels nivells de forma adequada (Gain Staging en anglés) per a més
informacié.

Botons d’eliminar Les capses petites al costat de cada rodeta d’EQ sén els kills. Manteniu premuts aquests botons per
eliminar completament el rang de freqiiencies corresponent. Si feu un clic rapid, es quedara activat, i es tornara
a desactivar si torneu a fer clic. Si els botons de kill no funcionen adequadament, comproveu les opcions de EQ
high/low shelf a les preferencies.

Quick Effect Super knob This knob lets you control the Meta knob of the deck’s Quick Effect. “Filter” is the default.
Right-click this knob to center it. This is equivalent to “no audible effect” for the built-in filter effects only (Filter,
Moog Ladder 4 Filter). The button next to the knob toggles the effect. It provides the same latching capabilities
like the EQ Kill switches.

Vegeu també:

Podeu personalitzar les opcions de EQ a Preferéncies » Equalitzadors.

3.3.3 Bot6 d’auriculars (PFL, o escolta previa)

OO

Figure18: Els botons d’auriculars dels dos plats del mesclador

El boté d’auriculars també es coneix amb el nom de PFL i permet pre-escoltar utilitzant els auriculars. Es a dir, permet
escoltar la pista que esteu preparant abans de que la senti el public. Aix0 us permet decidir on comencara la pista
1 manipular-la per a que s’ajusti millor amb la pista que sona (per exemple, sincronitzant els tocs, posant un bucle o
equalitzant-la). A l'activar la pre-escolta escoltareu la pista pels auriculars al volum maxim, independent de la posici6 del
fader del canal. Aixi doncs, per a que I'audieéncia no senti la pista que esteu pre-escoltant, premeu el boté de pre-escolta i
poseu el crossfader cap al plat contrari, o poseu el volum del canal a zero.

Nota: La pre-escolta per auriculars només esta disponible si heu configurat la sortida d’auriculars en les Preferéncies »
Magquinari de so.

Nota: Si utilitzeu un mesclador fisic extern, connecteu-hi els auriculars, en comptes de a la sortida de la targeta de so.
Aixi mateix, utilitzeu els botons d’auriculars del mesclador extern i no els del Mixxx.
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3.3.4 Crossfader

Figure19: The crossfader section of the mixer

El crossfader determina el volum de cada plat movent el control d’esquerra a dreta. Si els dos plats estan reproduint i el
crossfader esta al mig, escoltareu tots dos plats. Feu clic amb el bot6 dret per tornar el control a la posici6 per defecte.

To move the crossfader left or right, you can use the keyboard shortcut G and H. To apply small crossfade left and small
crossfade right, the shortcuts are Shift + G and Shift + H respectively.

Podeu invertir la configuracio del crossfader, fent que per escoltar el plat dret s’hagi de posar el control a I'extrem esquerra
iviceversa. Aix0 es coneix també amb el nom en anglés «Hamster style». Per canviar-ho aneu a Preferéncies » Crossfader.

The crossfader orientation determines to which side of the crossfader the deck is assigned. It can be set to the left or right
side, or to the center where it is unaffected by the crossfader knob.

Suggerencia: Si feu anar el DJ Automatic del Mixxx, podeu automatitzar el crossfading entre plats.

3.3.5 Headphone and Main Mix Controls

Figure20: The headphone and main mix knobs

Headphone Mix knob Allows you to control how much of the Main output you hear in the Headphones output. It works
like a crossfader between the stereo Main and stereo PFL signal. If the knob is set to the left, you only hear the
PFL signal, which is the usual position for prelistening tracks.

This can be used to practice DJing with only one stereo output and a set of either speakers or headphones.

Additionally, this can be used to mix in headphones when you cannot hear the speakers connected to the main
output and there are no booth monitor speakers. Some DJs prefer to use this knob to mix in headphones all the
time, but many find it to be a difficult way to play. If there is only one set of speakers and no booth monitors, you
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can avoid the need to mix in headphones by setting up the speakers behind you so both you and your audience can
hear them.

Nota: No oblideu activar el bot6 Auriculars al plat que voleu escoltar pels auriculars.

Head knob (Headphone gain)

This knob controls the gain applied to the headphone output signal that Mixxx sends to your sound card.
Generally, this knob should not be adjusted. To adjust the volume in your headphones, adjust your sound
card’s gain on the headphone output. Most external sound cards have a gain knob specifically for the
headphone jack. If you use an onboard sound card for your headphones, adjust the gain control in your
OS mixer program. If your sound card only has one gain knob that controls both the Main output and
the headphone output, then adjust the Head knob in Mixxx to control the volume of your headphones
without affecting your Main output.

Nota: Not all controls may be present in all skins anymore. However, these controls can be mapped to keyboards
and MIDI controllers. See Mixxx Controls for detailed information.

Headphone Split Cue button If activated, two mono signals are sent to the headphone output instead of one stereo
signal. The main signal plays in the right channel, while the cueing signal plays in the left channel. You can still
adjust the Head Mix knob to control the mix of the Main and cue signals in the left channel.

Rodeta de balan¢ This knob allows you to adjust the balance (left/right orientation) of the Main output.

Main Knob The Main Gain Knob controls the gain applied to the Main output signal that Mixxx sends to your sound
card, Internet broadcasting servers, and recorded mixes. Generally, this knob should not be adjusted. To change
the output volume, a gain control should be adjusted as close to the speakers as possible for the best signal-to-noise
ratio throughout your signal chain. Ideally, the volume would only be adjusted by adjusting the gain on the power
amplifier. On active speakers, including computer speakers, studio monitors, and PA systems that do not require a
separate amplifier, this means adjusting the gain on the speakers (which may be labeled «Volume»).

As a DJ, you may not have access to the power amplifier. In that case, adjust the volume by adjusting the gain on
the equipment closest to the power amplifier that you have access to. Typically, this is a DJ mixer. If you are not
going through a mixer, adjust the gain of your sound card. If your sound card does not have any controls on it (for
example, for sound cards built into computers), adjust the sound card settings with your OS mixer program. The
Main Gain Knob in Mixxx should be a last resort for adjusting volume.

Avis: Sota cap circumstancia haurieu de permetre que la senyal saturi en algun punt. Aixo passa quan
un monitor de nivell entra a la zona vermella, o quan s’ilumini un LED que tingui Petiqueta «clipping».

Vegeu també:

Teniu una explicacié de perque heu de posar els guanys d’aquesta manera a Ajust dels nivells de forma adequada
(Gain Staging en angles).
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3.4 Samplers

New Angel Small Talk Not In The Same Way

Figure21: Sample decks

New Angel Small Talk Not In The Same Way
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Figure22: Sample decks expanded

Els reproductors de mostres sén com plats en miniatura. Permeten reproduir mostres curtes i «jingles», o si voleu, també
més pistes. Tenen un petit grafic d’ona de la pista completa i un nombre limitat de controls. Tots els controls funcionen
com als plats, veieu Decks.

The Sampler section can be hidden in the Mixxx user interface. Click the SAMPLERS button at the top of the user
interface, or use the specific Application shortcuts to show or hide the section.

3.4.1 Grafic d’'ona de la pista
Grafic d’ona de la pista El grafic d’ona mostra les diferents marques de la pista, aixi com 'envolvent de tota la pista.
En fer clic en el grafic, es pot saltar a aquella posici6 de la pista.
Marques del grafic d’ona Mentre es mescla, poden aparéixer més marques als grafics d’ona:
¢ Marca de posici6: Una linia vertical indica la posicié de reproduccié de la mostra.

¢ Marca de hotcue: Indica la posicié i nimero d’un punt /sozcue, si n’hi ha.

3.4.2 Visualitzacié de la informacio de la pista

Artista/Titol de la pista Mostra el nom de I’artista i titol de la pista que s’ha carregat al reproductor de mostres.

BPM (Tempo) EI niimero a la part superior dreta és el BPM efectiu de la pista. Feu clic a sobre per canviar el valor al
ritme que marqueu.

3.4.3 Sample Deck Options Button Grid

The buttons grid next to the waveform overview allow you to configure the sampler deck. Starting from the top row (left
to right) and the bottom row (left to right), the buttons are as follows:

Commutador de repeticié Si s’activa el mode de repeticid, la pista tornara al principi quan acabi i continuara reproduint.
Bot d’extreure la pista En fer clic sobre aquest botd, es treu la pista del reproductor.

Commutador de bloqueig de clau musical El Bloqueix de clau fa que el to de la pista no canvii quan es canvia la
velocitat amb el control de velocitat.

Crossfader Orientation Toggle The crossfader orientation determines to which side of the crossfader the sampler is
assigned. It can be set to the left or right side, or to the center where it is unaffected by the crossfader knob.
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3.4.4 Controls del reproductor de mostres

Boto Reprodueix/Pausa En fer clic en aquest boté sempre comenca la pista des del punt Cue. Si esta reproduint, saltara
al punt cue. En fer clic amb el bot6 dret, la reproducci6 s’aturara i tornara a I'inici de la mostra.

Boté Sync Sincronitza el reproductor de mostres amb un plat, segons es descriu a Controls de sincronia i velocitat.

¢ Clic esquerra: Canvia la velocitat de la pista de manera que el BPM 1 la fase coincideixi amb la del plat amb el
que es sincronitza.

¢ Clic dret: Només canvia la velocitat de la pista per a que coincideixi amb la del plat amb el que es sincronitza, perd
no canvia la fase.

Controls Hotcue Per a saltar a diferents parts de la mostra, es poden utilitzar els botons numerats de hotcue.
Boto escolta previa Si esta actiu, permet escoltar préviament la pista pels auriculars.

Rodeta de guany Permet canviar el guany que s’aplica a una pista.

Monitor de nivell Indica el nivell de la senyal i pot ajustar-se amb la rodeta de Guany.

Control lliscant de velocitat El control lliscant permet canviar la velocitat de la mostra. Feu clic amb el bot6 dret al
control per a reiniciar-la al valor original.

3.5 Effects

Figure23: Collapsed effect unit

Figure24: Expanded effect unit

Mixxx comes with some built in sound effects that can be chained together in effect units. Effect units can be freely
assigned to different decks as well as other inputs. The buttons for routing decks to effect units are in the Decks.

Vegeu també:

The Efectes chapter has a more detailed explanation of the effects system.
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3.6 Microphones & Auxiliary Inputs

Figure25: La secci6 del microfon

The microphone section is hidden in the default Mixxx user interface. Click the MICS & AUX button at the top of your
user interface, or use the specific Application shortcuts to show or hide the section.

Vegeu també:

The Utilitzant microfons chapter has detailed instructions for setting up microphones with various hardware.

3.6.1 Controls de microfon

Boto per parlar Hold this button and talk to mix the microphone input into the Mixxx Main output. Short click on the
button for latching. This is handy for talking for an extended period, for example when streaming a radio show.
When in Latch mode, click again to mute the microphone input.

Commutador d’orientaci6 de la mescla Aquest control determina la destinacié de la mescla de I'entrada de microfon.
Ja sigui al canal esquerra del crossfader, al canal dret, o al centre (per defecte). Feu clic multiples vegades per
canviar entre les diferents possibilitats.

Monitor de volum de microfon Aqui es mostra el nivell de volum de 'entrada de microfon.

Rodeta de guany el microfon Utilitzeu aquesta rodeta per ajustar el guany de la sortida del microfon. Intenteu mantenir
el volum a un nivell raonable per evitar que la senyal es saturi.

3.7 Preview Deck

H.E.R. - Sometimes 76.00

S e -

Figure26: El reproductor de pre-escolta amb una pista carregada

The Preview Deck is a special deck that allows you to pre-listen to tracks in the headphones before using them in your
mix. Pre-listening to a track does not change its Played state as well as the play counter and is not logged in the History.
Press CTRL + 4 (Windows/Linux) or CMD + 4 (Mac) to display the Preview Deck.

Les caracteristiques en detall:

¢ Track Artist/Title: The artist and title of the track is displayed here. This is the same as that listed under the Track
and Title column heading in the Mixxx library. This information is initially loaded from the track’s metadata.

¢ Eject Track button: Clicking this button ejects the track from the deck.

¢ Play/Pause button: Clicking the button starts and pauses the playback. Right-clicking on the button will stop
playback and seek the play position to the beginning of the tracks.
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* Grafic d’ona de la pista: Mostra diferents marques (punts Cue, Hotcues) de la pista aixd com I'envolvent de la
pista sencera. Feu clic en qualsevol lloc per a anar a aquell punt de la pista.

* Gain slider: Move the slider to adjust the gain of the track.
¢ Volume Meter: Shows the current volume of the track. If it’s too loud and distorted, a peak indicator flashes red.
Vegeu també:

For more information, go to the chapter Pre-escolta de pistes.

3.7. Preview Deck 30



cHAPTER 4

La Biblioteca del Mixxx

4.1 Un cop d’ull a les caracteristiques de la Biblioteca

Gotye, Somebody That 1 Used 1 & preview  Played Duration

m]*__ = Klaypex Feel Alright (Daft Punk) 2012 Electronic

( Wolfgang Gartner Space Junk (OVERWERK Remix) 2010 0 Electro/House Good, bu

Search. (3) OVERWERK Contact 2011 3 Skip the
AZEALIA BANKS 212 2012
Utah Saints Something Cood 1992 6.87 Indie
Com Truise Polyhurt 2011 Elecronic
Gotye Somebody That | Used To Know (TheFatRat Remix) 2012 Electro House

Library
Auto DJ
Playlists
Requests

Setlist for Friday Monsta Where Did I Go (Dillon Francis & Kill Paris Remix)
Crates 9 ( Avicii Next Levels (TheFatRat Remix)

Crowd Pleasers ) 16 Bit Lolitas Diesel Beef (Original Mix)

Electro Hizatron & Bashley Discharge

Samples (0) Coyote Kisses s¥archaser 6 Hard Dance
Browse
Recordings
History
Analyze

Foster the People Don't Stop (TheFatRat Remix)
Kap Slap Paper Towels in Motion (Skrillex Edit) . Mashup

Figurel: La Biblioteca del Mixxx

The library manages all of your music files. This is where you can find the tracks you want to play and load them into a
deck or sampler; see Carrega de pistes. Mixxx imports your music library automatically when it is run for the first time,
see Canvi de les carpetes de miisica for more information.

La barra lateral esquerra conté diferents col-leccions de musica. La llista ubicada a la dreta mostra les pistes que hi ha en
dites col-leccions.

Barra lateral:
¢ Cerca: Cerqueu pistes a la vostra biblioteca del Mixxx.
* Tracks: View and edit your whole collection.
* DJ Automatic: Carregueu cangons automaticament per a mesclar-les de forma desatesa.
 Playlists: Arrange tracks in a set order.
 Crates: Organize tracks in (unordered) collections.

¢ Computer: Navigate, view, and load tracks from folders on your hard disk and connected devices.
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* Enregistraments: Enregistreu les vostres mescles i consulteu els enregistraments anteriors.

» History: Browse lists of tracks played in past mixing sessions.

* Analyze: Generate Mixxx-specific data for tracks before a gig.

 Biblioteques externes: Accediu a les biblioteques del iTunes, Traktor, Rhythmbox i Banshee.
Llista de pistes:

¢ Ordena: Mostra i ordena les col-leccions de pistes segons diferents criteris.

» Carrega: Arrossegueu le pistes a reproduir a sobre del grafic d’ona.

+ Editeu: Puntueu les pistes i editeu-ne les propietats.

4.2 Tracks - View and edit your whole collection

I‘l:ii" A sortable list of all the tracks in your music library.

Personalitzeu la vista Move columns by clicking a column header and dragging it to another position. Right-click on
a column header to show or hide individual columns. Adjust the column width to fit the contents of the rows by
double-clicking on the separator between two column headers.

Ordeneu les pistes Les pistes queden ordenades per la columna activa. Feu clic a la capcalera de la columna activa per
a invertir I'ordre. Feu clic en una altra columna per canviar la columna activa.

¢ Multi-Column sorting

You can sort multiple columns by clicking up fo three column headers you wish to sort your tracks by. This
makes searching for tracks in a large list more efficient. Clicking twice on a column header will reverse the
sort order.

Example:
1. Click on the BPM column header -> list is sorted by BPM

2. Click on the Year column header -> list is sorted by year. If year is equal, it is still sorted by the last
criteria, e.g. BPM.

3. Click on the Genre column header -> list is sorted by genre. If genre is equal, it is still sorted by year. If
genre and year is equal, then it is sorted by BPM.

* Random sorting
Click on the Preview column header to randomly sort tracks.
¢ Sort keys by circle of fifths

Click on the Key column header. The order starts with C at the top, then its relative minor (a), then adds 1
sharp (G), then G’s relative minor (e), and so adding sharps/removing flats around the circle of fifths. For
Lancelot notation, it starts with G#m at the top, which is /A in that notation, and proceeds alphanumerically
(minor keys appear before their relative major keys in this case).

Puntueu les pistes Assegureu-vos que la columna Puntuacio no esta amagada. Puntueu les pistes fent clic a les estrelles.

Editeu les pistes des de la llista Mixxx reads metadata from the tracks to fill the columns of the library. Double-click
on a field, edit the data, and hit Ent er when you are done. Go to the chapter edit metadata for detailed information.

Carregueu les pistes To load a track into a deck, you can either drag it to the waveform display, use the context menu
or use keyboard shortcuts. Go to the chapter Carrega de pistes for detailed information.
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Importeu més pistes Mixxx imports your music library automatically when it is run for the first time. Go to the chapter

Canvi de les carpetes de miisica for detailed information.

Preescolteu les pistes To pre-listen to tracks in your headphones without loading them to a regular deck, click the

icon in the Preview column. Go to the chapter Pre-escolta de pistes for detailed information.

Caratules Mixxx can display cover art it finds for a track in the library. It will search for available cover art in the

following places in order and will use the first one it finds:
1. The first image saved in the track’s ID3v2/Vorbis rags
An image file in the track folder (if there is only one image file there.)
Elfitxer $nom-base-fitxer%. jpgdelacarpetadela pistasiel nom és $nom-base-fitxer%.mp3
$Nom de 1l'album%.jpg
cover. jpg
front.jpg

album. jpg

S S e B

folder. jpg

El mixxx suporta els formats d’imatge segiients: jpg, jpeg, png, gif, bmp

Torneu a escanejar la biblioteca If you want to manually refresh your library without exiting (for example because you

added or moved files) you can do this with Library » Rescan Library in the menu at the top of the application
window. You can prompt an automatic rescan when Mixxx is started under Preferences *» Library » Rescan on
startup.

Rescanning the library will add new files to the library and mark tracks as missing if the corresponding file has been
deleted. It tries to detect and relocate missing tracks if files have been renamed or moved into another directory.

Automatically refreshing the metadata of tracks when files have been modified by an external application is not
supported, yet. In this case you need to select the affected tracks and (re-)import their metadata from file tags.

4.2.1 Menu contextual de la biblioteca

En fer clic amb el bot6 dret del ratoli sobre les pistes, al llistat de la biblioteca, fareu apareixer el menu contextual:

Add to Auto DJ

Adds the content of the selection to either the bottom or top of the Auto DJ playlist for automatic mixing. The
replace option deletes the Auto DJ queue first, and then fills it with the selected tracks.

Load to

Loads a selected file to one of the available Decks, Samplers or to the Preview Deck. Alternatively simply drag it
to the Visualitzacio de grafics d’'ona. The number of available decks and samplers might differ, depending on the
selected skin. Note that you can’t load multiple files at once.

Add to Playlist

Add selected tracks to an existing playlist, or drag the selection to a playlist crate in the sidebar. Choose Create
new playlist to put them into a new playlist.

Crates

The checkbox shows in which existing crates the selection is in. Changing the crates selection does not collapse the
menu, which allows much easier categorization of tracks without going through the menu from scratch. Choose
Create new Crate to put them into a new crate.

4.2
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¢ Select Color

Assign a color to all selected tracks to indicate mood, energy etc. Select the black button at the top left to remove
the color.

¢ Metadata

Import from File Tags: If the track’s metadata changes, (e.g. if you used iTunes to edit it,) this option lets
you save the new values for the selected tracks to the Mixxx library. See edit metadata.

Import from MusicBrainz: Look up metadata online by searching the MusicBrainz database and apply the
search results to your tracks. See edit metadata.

Export to File Tags: Saves metadata to files. Mixxx may wait to modify files until they are not loaded to
any decks or samplers. If you do not see changed metadata in other programs immediately, eject the track
from all decks and samplers or shutdown Mixxx.

Cover Art
» Choose New Cover: Select an image from the file browser as the cover.
» Clear Cover: Delete any cover information saved for this track.

+ Reload from track/folder: Reload the cover from the tracks” ID3v2 7ags or a picture in the track folder
if the tags do not supply any.

¢ Clear

BPM and Beatgrid: Removes the BPM and beatgrid data from the selected tracks in the Mixxx library.
After doing this, we recommend analyzing the tracks again.

Play Count: Marks selected tracks as not played in the current session and sets their play counter to zero.
The icon in the Played column changes.

Hotcues: Clears all saved hotcues and hotcue labels.
ReplayGain: Clears all saved ReplayGain values.

Waveform: Clears the saved waveform data from the selected tracks. This is useful if a file is overwritten by
another file of the same name, or was edited externally (e.g. in a waveform editor). To clear the waveform
cache for all tracks in the library, select Preferences » Waveforms » Clear cached Waveforms .

All: Clears all of the data above from the Mixxx library database at once.

¢ Change BPM

Allows to change the BPM to 50%, 66%, 75%, 133,33%, 150%, or 200% of the BPM set by Mixxx when
analyzing the tracks. If many of the detected BPM values are incorrect, you may try other settings in the
Analyzer Settings and re-run the analysis.

Bloqueja/Desbloqueja el BPM: Bloqueja o desbloqueja el BPM de les pistes seleccionades per evitar que
es pugui canviar des de les propietats de la pista. La icona -~ al costat del BPM de la pista, a la Biblioteca,
permet commutar aquesta opcio. En fer clic, canviara I'estat a «bloquejat», i la icona canviara a g

e Hide from Library

Temporarily hides selected tracks from the track list. Hidden tracks are listed in the Hidden Tracks menu item
which is explained below.

¢ Open in File Browser

Brings up the selected files in your file manager.

* Properties
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Similar to inline editing explained above, the properties dialog allows you to view and edit metadata such as title,
artist, album, and view the full file name and path. Note that you can not edit multiple files at once.

Nota: La majoria d’aquestes opcions també estan disponibles a les llistes de fitxers, i altres vistes com el DJ Automatic,
les llistes de reproducci6 o les caixes.

4.2.2 Pistes perdudes

The Missing Tracks view is accessible by expanding the Library tree item in the sidebar. Any tracks that were previously
loaded into your library but were later not found on your drive will appear here. Mixxx does not automatically delete
records of missing tracks so that extra metadata Mixxx might have (such as hot cues and beat grids) will not be lost in
case the file is replaced.

Les opcions disponibles:
* Botd Selecciona-ho tot: Selecciona totes les pistes de la llista.

* Boté elimina: Elimina les pistes de la Biblioteca del Mixxx, pero no les elimina de I'ordinador. Tan sols elimina
les metadades que el Mixxx té d’aquesta pista.

4.2.3 Pistes amagades

The Hidden Tracks view is accessible by expanding the Library tree item in the sidebar. Any tracks that were previously
loaded into your library but were later set to be hidden from the library will appear here. Use the Hide from Library
context menu item in the rracks view to temporarily hide selected tracks.

Les opcions disponibles:
* Boto Selecciona-ho tot: Selecciona totes les pistes de la llista.

* Boté Elimina: Elimina les pistes seleccionades de la Biblioteca del Mixxx, perd no les elimina de I'ordinador. Tan
sols elimina les metadades que el Mixxx té d’aquesta pista.

* Unhide Button: Removes the selected tracks from the Hidden Tracks view and makes them available in the regular
track lists again. The tracks will re-appear in every playlist or crate they were in before being hidden.

Vegeu també:

To learn how to permanently remove tracks from the Mixxx library using the Hidden Tracks view, see permanently remove
tracks.

4.3 Carrega de pistes

Les pistes es poden carregar a un plat de diferents maneres:

¢ Right-click the library track table: Right-clicking on a track in the table will present the options Load in Deck 1
and Load in Deck 2, among others. Making either selection will load a track into a deck.

e By Amb un teclat d’ordinador to load the selected track in the library track table. Use keyboard + and ¢ arrow
button to select a track, Shift + < to load into Deck 1 and Shift + - to load into Deck 2.

¢ Drag-and-drop from library track table: Dragging-and-dropping a track from the track table onto a waveform
display will load the track into that deck.
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* Drag-and-drop from deck to deck: Once you’ve loaded a track to deck, sampler, or preview deck, click on the
track title, track artist or cover art and drag it to another deck or sampler. Note that you can also drop tracks onto

Playlists and Crates in the sidebar, as well as into track tables of active Playlists or Crates.

¢ Drag-and-drop from external file browser: Dragging-and-dropping a track from an external file browser directly
onto a waveform display in Mixxx will load that track. This function also works with some other applications. For
example, on macOS, dragging-and-dropping a track from iTunes onto one of Mixxx’s waveform displays will load

it into that deck.

4.4 Per trobar les pistes (cerca)

The search function filters the currently displayed list (e.g. a playlist, a crate, or even the whole library) for tracks that

match your search query.

* Activate the search input field by clicking in it or pressing CTRL + F (Windows/Linux) or CMD + F (Mac).

» Type your search term(s). Mixxx filters the tracks as you type and shows only those matching the search term(s).

Search terms can include an artist’s name, a song title, BPM, etc.

* Per netejar el text de cerca, premeu ESC o feu clic al boté d’esborrar, just al costat del camp de cerca.

* Hit TAB to cycle between the search and the list of results in the library. Use the t+ and v keys to scroll in the list

of results.

Nota: Si teniu el focus al camp de cerca, les dreceres de teclat del Mixxx es desactivaran, consulteu Amb un teclat

d’ordinador.

4.4.1 Us d’operadors de cerca

Els operadors de cerca et permeten fer cerques complexes. Podr’s limitar el text a propietats concretes de les pistes.

El Mixxx suporta els segiients filtres:
¢ Text filtering: album_artist, album, artist, comment, composer, crate, genre, grouping, location, title

Examples

artist: “com truise”
album:Danger

genre: Trance

title: foo

composer: foo

comment: foo

genre:hip-hop -genre:gangsta

Nota: It doesn’t matter if you have space between the colon and the argument or not. Quotes must be used for

multi-word text arguments.

¢ Numeric filtering: bitrate, bpm, played, rating, track, year

Examples

4.4. Per trobar les pistes (cerca)
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bpm:140
bpm: >140
year: <2010
bpm: >=140

rating: <=4
bpm: 140-150
played: >10

Nota: You can put a space after the colon but currently there must be no space between the operator and the
number.

* Special filtering: key, duration, added, dateadded, datetime_added, date_added

— Supports fuzzy matching of key searches. The following example lists tracks with harmonically compatible
keys to C# minor.

’Nkey:c#m

You can combine operators but there’s no way to do an “OR” search right now. The following example lists
all tracks by “Danger” over 3 minutes long that are rated 4 or 5.

artist:Danger duration:>3m rating:>=4

— Filtres de negacié. Utilitzeu el prefix — com a operador de negaci6. FEl segiient exemple cerca per I'estil
«hip-hop» de qualsevol any exceptel el 1990.

’genre:hipfhop -year:1990

— Search for empty fields. The following example lists all tracks without a genre. It works for all text fields,
including crates.

’genre:""

Examples

duration:
duration:
duration:
duration:

2m10
<2:10
>1m35s
>62

Nota: You can put a space after the colon but currently there must be no space between the operator and the

number.
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4.5 Pre-escolta de pistes

To pre-listen to a track, activate the Preview column in a library view. Clicking the icon in the library’s Preview
column loads the selected track into a special Preview Deck that will only output sound in the headphones channel. Click
the ;- yy icon to stop the playback.

També podeu seleccionar una pista de la Biblioteca del Mixxx, arrossegar-la al grafic d’ona del reproductor de pre-escolta
i prémer el botd Reprodueix del costat del grafic d’ona.

To display the Preview Deck, press CTRL + 4 (Windows/Linux) or CMD + 4 (Mac).

Suggerencia: Click on the Preview column header to randomly sort tracks.

4.6 Modificacio de les metadades dels fitxers d’audio

El Mixxx llegeix les metadades rellevants de les pistes i els mostra a les columnes de la biblioteca. Podeu editar la majoria
de les metadades, i us permet fer-ho de diferents maneres. Algunes dades no es poden canviar, com la taxa de bits, la
mida, la durada, el tipus, el nom o la ubicacio.

Nota: El Mixxx no permet editar les metadades de multiples pistes alhora.

Avis: Mixxx won’t touch your audio files by default. Changes to a track’s metadata will be saved to the Mixxx library,
but not to the track itself.

If you wish to write modified track metadata from the library into file tags, check the box in Preferences » Library »
Track Metadata Synchronisation.

4.6.1 Edicié manual
Edicio en linia: To enable inline editing in the /ibrary go to Preferences » Library » Miscellaneous and check the box
«Edit metadata after clicking selected track».

Select any track in the /ibrary and click on the field you want to edit. If the field is editable, it will become an
editable text box. Enter a value and hit Enter when you are done.

chopper Q| v BPM Key CoverArt Played Album Artist Title Year Rating Genre Duration  Comment

» H Ubrary 122 Bbm m (7) Tetsuo & Youth Lupe Fiasco Chopper... 2015 %% - Hip-Hop 09:33 _

» Auto DJ
Figure2: Biblioteca del Mixxx - Edici6 en linia

Editor de propietats: To open the editor right-click on a single track in the library or any track label in decks or
samplers, then select Properties in the track menu. You can also double-click any track label in the decks or
samplers to open the editor directly.

Add or change values in the editable fields, and save your changes as explained below.
* Accepta: Accepta els canvis i tanca I'editor.

e Apply: Accept the changes and leave the editor open.
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[ ] @ Lupe Fiasco - Chopper feat. Billy Blue, Buk of Psychodrama, Trouble, Trae Tha Truth, Fam Lay & Glas...

m Comments BPM  Cuepoints

Title: Chopper feat. Billy Blue, Buk of Psychodrama, Trouble, Trae Tha Truth, Fam Lay &

Artist: Lupe Fiasco|

Album: Tetsuo & Youth

Album Artist:

Composer: Year: 2015

Genre: Hip-Hop Key:  Bbm

Grouping: Track #: |11

Duration: 09:33 BPM: 122.0 Bitrate: 320 kbps Filetype: mp3

Location: Lu[i':e Fiasco - Tetsuo & Youth/11. Chopper feat. Billy Blue, Buk of
Psychodrama, Trouble, Trae Tha Truth, Fam Lay & Glasses Malone.mp3

Get track metadata from MusicBrainz Reload track metadata from file Open in File Browser

Previous MNext Cancel _ OK

Figure3: Biblioteca del Mixxx - Editor de propietats

4.6. Modificacio de les metadades dels fitxers d’audio 39



Mixxx User Manual, Versié 2.3.0

* Cancel-la: Descarta els canvis i tanca I’editor.
¢ Anterior/Segiient: Carrega I'anterior o la segiient pista de la vista actual de la biblioteca.

¢ Import Metadata from File: Prompts Mixxx to re-read the metadata of the selected track (such as when
you have modified it externally with another application.)

* Import Metadata from MusicBrainz: Look up metadata on-line by searching the MusicBrainz database.
See below.

4.6.2 Us de la base de dades d’internet MusicBrainz
MusicBrainz is an open-source music encyclopedia that collects music mefadata and makes it available to the public.

® ® MusicBrainz

Select best possible match

Track Year Title Artist Alzum
Original tags

2008 Skeng Feat. Killa P - Flowdan The Bug London Zoo

Suggested tags
14 2011 Skeng The Bug Ministry of Sound: The Sound of Dubstep 2011

Previous Next Apply Close

Figure4: Biblioteca del Mixxx - Assistent de MusicBrainz

The MusicBrainz wizard in Mixxx allows searching the MusicBrainz database and applying the results to your tracks.

Seleccioneu una tnica pista a la Biblioteca, feu clic amb el boté dret i aneu a Recupera metadades amb el MusicBrainz.
Es cercaran les dades a la base de dades del MusicBrainz i es mostraran els resultats.

Select the best match from the search results by clicking on it in the list.
» Aplica: Aplica les metadades seleccionades a la pista.
* Tanca: Tanca l'assistent.

* Previous/Next: Load the previous or next track in the current library view and perform a MusicBrainz lookup on
it as well.

Fetching track metadata from MusicBrainz can fail:
« if Mixxx is unable to find the specified track in the MusicBrainz database,
* if Mixxx cannot reach the MusicBrainz servers (if they are down),

* or if you are not connected to the Internet.

Suggerencia: The MusicBrainz service has been designed for identifying full audio files. If a track is less than 2 minutes
long, identifying the file will likely fail. Identifying a layered mix-track or mash-up may produce false positives in the
result list.
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4.6.3 Using third-party software

If you have edited file metadata in third-party software you need to re-import the modified metadata into Mixxx manually
by selecting the affected tracks, open the context menu, and then choose Metadata » Import From File Tags.

Suggerencia: Rescanning the library with Library » Rescan Library in the menu on top of the application window will
only detect newly added or removed tracks but no modifications of existing tracks. This is a known limitation.

Algunes aplicacions populars d’edicié de metadades d’audio sén:
e Mp3tag (Windows)
e Kid3 (Mac, Windows, Linux)
¢ Picard (Mac, Windows, Linux)

4.7 DJ Automatic - Mescleu de manera automatitzada

|ﬁ| The Auto DJ queue is a special playlist that contains extra controls for automatic mixing. This is useful when taking

a break from live mixing or for using Mixxx as media player.
Les opcions del DJ Automatic:
 Shuffle button: Randomizes the order of tracks in the Auto DJ playlist.

¢ Add Random button: Adds a random track from track sources (crates) to the Auto DJ queue. If no track sources
are configured, the track is added from the library instead.

* Boté Ometre pista: Descarta la pista segiient, treient-la de la llista de DJ Automatic.
* Bot6 Esvaeix ara: Inicia la transicio cap a la segiient pista.

¢ Transition time spin-box: Determines the duration of the transition. A negative value will add a pause between
tracks.

¢ Selection Info label: Displays the duration and number of selected tracks. Press Ct r1 + A to get the total duration
of the AutoDJ queue.

* Boto Activa el DJ Automatic: Activa o desactiva el DJ Automatic.

The Skip track, Add Random and Fade now buttons are only accessible if the Auto DJ mode is enabled. The Search field
in the upper left corner is disabled in Auto DJ. By default, Auto DJ removes tracks after playing them but if you want
it to play the same tracks over and over again, you can activate the Aufo DJ Requeue option in Preferences » Auto DJ »
Re-queue tracks after playback.

Auto DJ Crates

It is possible to add random tracks to the bottom of the Auto DJ playlist. The tracks are chosen from a set of crates that
you have set as a source for Auto DJ, or from the standard library. Mixxx will normally try to select tracks that haven’t
yet been played. You can set a minimum number of tracks that are always available for selection no matter when they
were last played in Preferences » Auto DJ » Minimum available tracks in Track Source.

Vegeu també:

Per a més informacid, aneu al capitol Auto DJ.
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4.8

Playlists - Arranging tracks in a set order

DI Playlists are ordered lists of tracks that allow you to plan your DJ sets. Some DJs construct playlists before they

perform live; others prefer to build them on-the-fly.

Playlists are not directly loadable into decks as Mixxx is primarily intended for live, attended performance use. However,
you can right-click a playlist to queue it to Aufo DJ, so in a sense you can «play» it.

Create a playlist: Right-click on the Playlists sidebar item and select Create New Playlist. Name the playlist and
click OK. The total number of tracks and total duration are displayed next to the name.

Import playlists: Right-click on the Playlists sidebar item and select Import Playlist. Select one or more playlists
and click OK. Mixxx creates an import of these existing external playlists as new Mixxx playlists.

Add Tracks: Add tracks to a previously created playlist by dragging-and-dropping a selection of tracks from the
library or playlists onto the name of a playlist in the sidebar. Alternatively, use the right-click context menu in the
library’s track list.

Suggerencia: If you have a track selected in the library, all of the visible playlist and crates that it is in are shown
in bold.

Right-click on an existing playlist name to access the different features in the context menu:

Afegeix al DJ Automatic: Afegeix el contingut de la llista a la cua del DJ Automatic per a mescles automatitzades.
Rename: To rename a playlist, just enter a new playlist name and click OK.

Duplica: De vegades voldreu fer una llista nova basada en una llista existent. Seleccioneu la llista que voleu
duplicar, trieu Duplica, poseu el nou nom i feu clic a :guilabel” Acceptar™.

Remove: Removes an unlocked playlist. Tracks that were in the playlist remain in the library for later use.

Bloqueja els canvis: é Aquesta icona indica una llista bloquejada. Quan una llista esta bloquejada, no s’hi pot

afegir pistes, ni canviar el nom o esborrar la llista. Trieu Permet els canvis al ment contextual per treure el bloqueig.
Analyze entire playlist: Forces the analysis of the tracks in the playlist in the Analyze view.

Import playlist: Import tracks from external playlists in various file formats to the selected playlist. For more
information, go to Using libraries from other software.

Export playlist: Export a playlist to various file formats such as m3u, m3u8, pls, txt, or csv. This allows you
to use the data in other applications.

Export Track files: This copies all of the tracks in a playlist into a folder such as an external USB stick. Only files
are copied, not Mixxx-specific metadata like waveforms or cover art that is not embedded in the file.
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4.9

Crates - Organizing tracks into collections

’ Crates are unordered collections of tracks, just like DJ cases holding your favorite records.
L=1

Create a crate: Right-click on the Crates sidebar item and select Create New Crate. Name the crate and click OK.
The total number of tracks and total duration are displayed next to the name.

Import crates: Right-click on the Crates sidebar item and select Import Crate. Select one or more playlists and
click OK. Mixxx creates an import of these existing external playlists as new Mixxx crates.

Add Tracks: Add tracks to a previously created crate by dragging-and-dropping a selection of tracks from the
library or playlists onto the name of a crate in the sidebar. Alternatively use the context menu in the library’s rrack
list.

Feu clic amb el bot6 dret sobre del nom d’una caixa per a accedir a les segiients opcions del mend contextual:

Reanomena: Per canviar el nom d’una caixa, escriviu un nou nom i feu clic en Acceprar.

Duplica: Igual que amb les llistes de reproduccid, també podeu duplicar una caixa existent. Seleccioneu la caixa a
duplicar, trieu Duplica, indiqueu el nou nom i feu clic en Acceptar.

Elimina: Elimina una caixa no bloquejada. Les pistes de la caixa segueixen estant disponibles a la Biblioteca.
Bloqueja els canvis: La icona é indica una caixa bloquejada. Quan una caixa es bloqueja, no s’hi poden

afegir pistes, ni canviar el nom o esborrar la caixa. Trieu Permet els canvis des del menu contextual per a treure el
bloqueig.

Auto DJ Track Source: Use this crate as a source for random tracks in Auto DJ, see Auto DJ crates .
Analitza la caixa sencera: Inicia I'analisi de les pistes de la caixa a la vista Analitza.
Import crate: Import tracks from external playlists in various file formats to the selected crate.

Export crate: Export a crate to various file formats, such as m3u, m3u8, pls, txt, or csv. This allows you to
use the data in other applications.

Export Track files: This copies all of the tracks in a crate into a folder such as an external USB stick. Only files
are copied, not Mixxx-specific metadata like waveforms or cover art that is not embedded in the file.

4.9.1 Caixes o llistes de reproducci6o?

Crates are unordered collections of tracks. Unlike playlists, they cannot contain duplicate entries and do not support
arranging tracks within them.

Often DIJs group tracks by genre, keep lists of favorite tracks, and/or prepare lists of tracks they want to play at a particular
party. In these cases they rarely care about the order since they will choose it at the party based on the dance floor and
mood. They certainly don’t want duplicates in these lists. Crates serve these purposes. You can think of them like labels
in GMail or Web 2.0 tags for your music.

If however you want to plan out a specific set and practice the transitions, you will want an ordered list of tracks. Playlists
serve this purpose.
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4.10 Computer - Loading tracks from anywhere on your computer

Q This mode works like a file manager and allows you to load tracks from anywhere on your computer and connected

devices, that are not necessarily already in your Mixxx library.

Click the Computer sidebar item to navigate the computer and find your music. Depending on your operating system, your

music will usually be found in the “My Music” or “Music” folder. Drag the files you want to import to the ﬁ:ﬁ Tracks

icon or directly to the Visualitzacio de grafics d'ona.

Nota: Currently you can only drag files (not folders) to the Mixxx library.

Right-click on a folder and choose Add fo Library to add the folder as an additional music directory. Mixxx will watch
this directory and its subdirectories for new tracks.

Vegeu també:

For more information, go to Canvi de les carpetes de miisica.

4.10.1 Dreceres - Poseu enllacos per a les carpetes preferides

Gracies a les Dreceres, podeu mantenir dreceres a les carpetes preferides. Feu clic en Navega, a la barra lateral i aneu fins
a la carpeta que voleu afegir. Feu clic amb el bot6 dret i seleccioneu Afegeix a les Dreceres.

4.11 Enregistraments

E In this section of the library you can start and stop recording your session as well as view previous recordings and
the dates they were made.
Vegeu també:

Per a més informacid, aneu a Enregistra la mescla.

4.12 History - Keep track of your sessions

9 The history section automatically keeps a list of tracks you play in your DJ sets. This is handy for remembering

what worked in your DJ sets, posting set-lists, or reporting your plays to licensing organizations. Every time you start
Mixxx, a new history section is created. If you don’t play any tracks during the session, it will be discarded.

9 Aquesta icona indica la sessi6 actual.

Click on the History icon in the sidebar to switch to the History view, then right-click on a session’s name/date to access
the different features:

» Afegeix-ho a la cua del DJ Automatic: Afegeix el contingut de les session a la cua del DJ Automatic per a mescles
automatiques.

* Rename: Rename a session. The default is the calendar date (YYYY-MM-DD).

4.10. Computer - Loading tracks from anywhere on your computer 44



Mixxx User Manual, Versié 2.3.0

* Remove: Remove a previous (unlocked) session. (You cannot remove the current session.)

* Lock: Protect a previous session against accidental merge or deletion. An é icon indicates a locked session.

* Create new history playlist: Split off the current history session and add a new session without having to restart
Mixxx. The current history must contain at least one track for this option to be available.

« Join with previous: Append the selected history session to the end of the previous one.

« Export playlist: Export a session in various file formats. This allows you to use the data in other applications.

4.13 Analitza - Prepara les pistes

This section allows you to analyze your tracks in advance of loading them into a deck. Analyzing tracks requires consid-
erable CPU power and may cause skips in the audio while performing, so it helps to have your tracks analyzed before you
play. See Analisi de la Illibreria for details.

4.14 Using libraries from other software

Biblioteques compatibles:

. ﬁ iTunes (Windows, macOS)

. _o.‘ » Traktor (Windows, macOS)

h—4

E Rhythmbox (GNU/Linux)
. B Banshee (Windows, macOS, GNU/Linux)
. @ Serato (Windows, macOS)

. @ Rekordbox (Windows, macOS)

The external library views allow you to use music libraries you have created in these third-party applications. You can
access music as well as playlists. If available, Mixxx automatically loads the external libraries from their default locations
on your hard drive.

Nota: Si reproduiu una pista de la biblioteca externa, aquesta s’afegira també a la biblioteca del Mixxx.

Vegeu també:

External libraries can be disabled under Preferences » Library.
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4.14.1 Using the iTunes/Traktor/Rhythmbox/Bashee/Rekordbox library

Feu clic amb el bot6 dret sobre la icona iTunes de la biblioteca i seleccioneu Seleccioneu la biblioteca per a carregar el
fitxer iTunes Music Library.xml des d’una ubicacid diferent. Seleccioneu Utilitza la biblioteca per defecte per a
reiniciar-ho.

* Right-click on a iTunes/Traktor/Rhythmbox/Banshee playlist and choose Import Playlist to import it into a new
Mixxx playlist.

e If you have an iTunes configuration file (* . xm1) from a Windows or Mac partition mounted in Linux, you can
load it and use your iTunes tracks and playlists as well.

4.14.2 Using the Rekordbox library

To read Rekordbox databases for CDJ/XDJ players on USB or SD devices, the database has to be exported to a USB
or SD device with a FAT or HFS file system using the Rekordbox Export mode. Databases that have been moved to an
external device via Preferences > Advanced > Database management in Rekordbox are not supported.

1. Plug your USB or SD drive in while Mixxx is running.

2. Click on the Rekordbox item in the library sidebar to scan for Rekordbox prepared USB drives. If no Rekordbox
devices show up, you can click on Check for attached Rekordbox devices (refresh).

3. Click on the desired removable device. All your folders and playlists will be revealed for you to play from.

How Rekordbox hotcues, memory cues, and loops are imported

The following data is read:
* Folders
¢ Playlists
 Beatgrids
* Hot cues
* Memory cues
* Loops
Mixxx currently has one main cue point, one loop, and thirty eight hotcues. As such:

» All Rekordbox hotcues are mapped to Mixxx hotcues as expected, the first chronological Rekordbox memory cue
is mapped to the Mixxx main cue.

* The first chronological Rekordbox loop is also mapped to the Mixxx loop.

¢ All loops (including the first loop), and all subsequent Rekordbox memory cues are appended as Mixxx hotcues
following the previously imported Rekordbox hotcues.

¢ The hotcue and memory cue colors you assigned in Rekordbox are also imported, assisting in distinguishing between
them.

Although additional imported Rekordbox loops only appear in Mixxx 2.3 as hotcues, their loop information is stored in
the Mixxx library and will become usable in Mixxx 2.4.
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4.14.3 Using the Serato library
Mixxx supports reading your Serato library and crates both from your local hard drive as well as portable USB drives.
Smart crates are currently not supported.

Serato stores information such as hot cues, track color and beatgrid in the file tags. Regardless of whether a track is loaded
into deck from the library or directly from the file browser, Mixxx will import that information automatically if present.

Saved loops are imported as well, but since Mixxx is lacking support for multiple saved loops, only the first loop is usable
in Mixxx. All other saved loops can be used like regular hotcues for now.

Waveforms, Gain values and «Flips» are not imported from Serato.

Nota: Due to differences in the metadata format, importing Serato information from Ogg Vorbis files is currently not
supported.

To import Serato libraries from external USB drives:
1. Copy music library from Serato into external USB drive
2. Plug in USB drive while Mixxx is running
3. Click on Serato in the library. All USB drives containing a Serato library will be detected automatically.
4. For each removable device, the library and all crates from Serato will accessible.

If you have already added a track containing Serato Metadata to your Mixxx library in a Mixxx version that didn’t support
reading that data, you can reimport it from the file’s tags via the track context menu.

Avis: This action will clear your existing cuepoints in Mixxx if the file contains Serato Metadata

To reimport metadata from files:
* Right click on the track to show the context menu

* Select Metadata » Import From File Tags.

Suggerencia: Decoders may slightly detect different track start and end times for files from different sources, this could
possibly be because of the presence of countless encoders and decoders for MP3 and M4A/AAC. This problem may
cause your cues to be shifted up by a few milliseconds. Mixxx might not always be able to mitigate this problem, but it’s
possible to shift all cues for a track at once as a workaround.

4.15 Removing tracks from the library

Removing tracks from the Mixxx library will not physically delete them from your drive. However it does delete extra
metadata Mixxx might have (such as hotcues and the beatgrids), and removes links to playlists or crates.

1. Click the Library item in the sidebar.

2. Find and select the tracks you want to remove, perform a right-click on them and select Hide from Library from
the context menu.

3. Expand the Library item in the sidebar and click on the Hidden tracks sub-item. All tracks that were set to be
hidden from the library will appear here.
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4. Select the tracks you want to remove, or use the Select All button.

5. To confirm you want to permanently remove these tracks from the library, click Purge.

Suggerencia: If you want to hide or purge only tracks from a specific folder you may use the location: search
operator, or sort the table by «Location».

Suggerencia: If you later decide to add some of the deleted tracks back, import them to the Mixxx library again, see
Canvi de les carpetes de miisica.

4.16 Compatible file formats

Mixxx supports a variety of audio file formats:

Sense perdues | Amb perdues

FLAC (flac) MP3 (mp3)

Wave (wav) Ogg Vorbis (0gg)

Aiff (aiff, aif) AAC (aac, m4a, mp4)
Opus (opus)

Lossless formats preserve every detail of the original recording and are recommended for the best sound quality. The
FLAC format compresses the files to take less space on your computer without sacrificing audio quality. WAV and AIFF
files are uncompressed and take up much more space.

Lossy formats take up less storage space on your computer than lossless formats at the expense of reducing sound quality.
Assuming an average track length of about 4 minutes, a 1 TB hard drive or solid state drive can store about 42000 FLAC
files or about 115000 MP 3 files at 320 kbps.

There is no benefit to converting lossy file to lossless formats. The detail lost when making the lossy file cannot be
recovered.

AAC (M4R) is supported on Windows Vista and macOS 10.8 onwards. The Platform Update Supplement is required
for Windows Vista.

On Linux, AAC playback is disabled by default due to licensing restrictions. To enable the playback of AAC files, build
Mixxx from source with m4a/AAC files support.

Avis: DRM protected files, such as m4p files purchased in the iTunes Store in 2009 or earlier, are not supported.

Avis: ALAC files use the same container MP4 container format and file extensions (m4a, mp4) as AAC files, but
Mixxx cannot play ALAC files. It is recommended to convert ALAC files to FLAC for use in Mixxx. This will not
reduce the sound quality of the files.
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4.17 Music from audio CDs

Mixxx can not play music directly from audio CDs. Use a CD ripping program to copy the audio from the CD to files on
your computer. It is recommended to save the ripped files in the FLAC format. Many different programs are available to
rip CDs, but not every program is capable of saving them to FLAC.
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CHAPTER D

Maquinari DJ

Tot i que el Mixxx pot ser utilitzat només amb un portatil o ordinador de sobretaula, I'experiéncia completa s’obté mit-
jancant maquinari especialitzat per a DJ. Depenent del vostre pressupost i zona d’accid, la configuracié i requeriments
poden variar. Aquest capitol proporciona informacié general sobre diversos tipus de maquinari DJ.

To make DJing with Mixxx a fun experience, at least the following pieces are needed:
* speakers to play the music to the audience,
* an audio interface with 4 mono/2 stereo output channels (or 2 mono output channels + a DJ splitter cable),
* headphones for prelistening tracks while another track is playing on the speakers, and
* audio cables and adapters to connect the equipment to your computer.
Additionally, you might consider getting the following equiment:
e a controller,
e turntables, an audio interface with phono inputs and fimecode vinyl,
* alaptop/controller stand,
e asurge protector to protect the equipment from voltage spikes,
* cases for laptop, controller and headphones, and
* custom fader and knob caps to customize your gear.
Vegeu també:

Instructions how to use DJ Controllers that work out-of-the-box with Mixxx can be found in the Hardware Manuals section
of this manual. The Mixxx DJ Hardware Guide on the Mixxx Wiki also lists additional devices, including information
about their prices, features, and compatibility with Mixxx.
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5.1 Controladors

DJ controllers are devices with knobs, faders, buttons, and jog wheels to control DJ software such as Mixxx. Controllers
allow quick access to different controls while providing tactile and visual feedback indicating the state of each control,
such as the position of a knob or whether a switch is on or off. This allows you to focus on manipulating the music without
needing to look at your computer screen all the time. Controllers also allow using two hands to manipulate two different
controls at the same time, which is required for many mixing techniques.

DJ controllers typically do not do any actual audio processing. Instead, they send signals (typically MIDI or HID over a
USB cable) to the computer to instruct DJ software how to manipulate the audio. Many DJ controllers include an audio
interface with 2 separate stereo outputs built into the device. This allows the DJ to transport and setup only one piece of
hardware in addition to a laptop. Some devices can be used as both a controller and hardware mixer.

Mixxx can work with any MIDI or HID controller as long as there is a mapping file to tell Mixxx how to understand the
controller’s signals. Mixxx comes bundled with a number of MIDI and HID mappings, which are listed in the Hardware
Manuals section. For controllers that Mixxx does not yet support, you can search the forum to see if anyone has started
a mapping. You can also start one yourself using the information in the Controller Mapping Documentation on the wiki.

Vegeu també:

Amb controladores MIDI/HID describes how to configure Mixxx to use controllers.

5.2 Interficies d’audio

An audio interface (also known as a «sound card», although few of them are shaped like cards anymore) is a device that
allows a computer to send output to and receive input from audio equipment. Whether using infernal or external mixing,
it is recommended to use a single audio interface with at least 4 independent output channels (2 separate stereo pairs).

The headphone jack on most laptops is not a second audio output. Rather, plugging headphones into the jack simply
redirects the laptop’s single stereo output from its speakers to your headphones. A splitter cable can be used to separate
the stereo output of a headphone jack into two separate mono outputs for headphone cueing, but it is recommended to
use a sound card with at least four mono outputs (for two stereo pairs). Such sound cards tend to be higher quality than
those built into laptops and allow your mix to be enjoyed in stereo by your audience.

Unlike some proprietary DJ systems, Mixxx can use any audio interface and any MIDI or HID controller that your OS has
drivers to use. If your controller has an integrated audio interface, you may choose to use a different audio interface for
higher quality audio. Mixxx can also use multiple audio interfaces simultaneously.

5.2.1 Audio Interface Considerations

This section provides background information to help you choose an audio interface to use with Mixxx.

Bit Depth and Sample Rate

Most music is published with a bit depth of 16 bits at a sample rate of 44.1 kHz because this is all that is needed to store
all the detail of music in digital form.

Bit depth determines the possible dynamic range of the signal. 16 bits is more than enough for playing back music. While
24 bits is helpful for recording, it is useless for playback.

Half the sample rate determines the maximum frequency that can be represented by the signal. Humans generally can’t
hear frequencies above 20 kHz, so a sampling rate of 44.1 kHz, representing a maximum frequency of 22.05 kHz, is fine
for playback. Higher sample rates like 88.2 kHz and 96 kHz can be helpful to reduce aliasing distortion when recording,
but have no benefit for playback and make your computer work harder.
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For a more thorough and technical explanation of why 16 bits at 44.1 kHz is all that is needed for playback, read 24/192
Music Downloads Are Very Silly Indeed.

Especificacions

When considering specifications, higher dynamic range, higher signal-to-noise ratio (SNR), higher maximum output level,
lower THD+N (Total Harmonic Distortion + Noise; look for a more negative dB value or smaller percentage), and lower
crosstalk (more negative dB value) are better. Cheap audio interfaces tend to not have these specifications published.

Tipus de cables i connectors

If you are unfamiliar with professional audio equipment, read Digital DJ Tips” Essential Guide to Audio Cables for DJs
to understand the different kinds of connectors on audio interfaces. It is better to use an audio interface with balanced
outputs, especially if you will run long cables directly into an amplifier or active speakers without going through a hardware
mixer. Balanced signals reject interference and are less susceptible to ground loop hum issues (which can be a problem
when plugging unbalanced gear into separate power sources).

However, most venues have DJs plug into hardware DJ mixers, which typically only have RCA inputs (RCA cables cannot
be balanced). Most home/computer speakers and amplifiers have RCA and/or 1/8» TRS stereo inputs. Most live sound
mixers have balanced 1/4» TRS mono inputs. If you need to interconnect balanced and unbalanced gear, refer to this
guide from Presonus (deleted, via archive.org) and this guide from Rane (deleted, via archive.org).

Nombre de canals

Audio interfaces sometimes have multiple connectors for a single channel, resulting in more connectors than channels.
So, not every connector can send or receive and independent signal. For example, some audio interfaces made for DJing
have 4 output channels with 4 mono output connectors and 1 stereo headphone connector. This does not mean that the
audio interface can send out 6 different signals at the same time; rather, the signal on 2 of the mono outputs and the stereo
headphone output would be the same. Also, many controllers have separate master and booth outputs with independent
volume controls, but they both play the same signal.

Preamplificadors fono i control amb vinil

Turntables output low voltage (phono level) signals that need to be amplified to line level before most audio equipment
can work with them. So, if you want to use Control de vinil, sometimes referred to as a Digital Vinyl System (DVS), it
is best to have phono preamplifiers (one for each deck) somewhere between your turntable and sound card to boost the
turntable’s phono level signal to line level. Mixxx can amplify phono level signals in software, but it is better to do it in
hardware. The phono preamp can be in the turntable, in the audio interface, or a stand alone device. Most audio interfaces
do not have phono preamps; these are generally found on audio interfaces specifically made for controlling DJ software
with timecode vinyl. Mescladors with audio interfaces have phono preamps on their deck inputs, but not necessarily on
every deck input. Many higher-end all-in-one controllers also include audio interfaces with phono preamps.
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Driver Support

Unlike some proprietary DJ programs, Mixxx works with any audio interface that is compatible with your operating
system — including for timecode vinyl (DVS) use.

USB Audio Class compliant audio interfaces should work out of the box on all operating systems supported by Mixxx.
This is the case for the integrated audio interfaces in most DJ controllers. Sound cards that aren’t USB Audio Class
compliant need a driver for each OS.

Nota: On Windows, you should install the manufacturer’s drivers even for USB class compliant audio interfaces to be
able to use the recommended ASIO sound API.

Suggeréncia: If you are considering buying a controller or audio interface, the easiest way to tell if it is USB class
compliant before you buy it is to search for macOS drivers for the device on the manufacturer’s website. If it is advertised
as compatible with macOS or iOS but there are no drivers to download for macOS, the device is USB class compliant.

5.3 Mescladors

Mixers are devices that combine audio signals. DJ mixers are different from live and studio mixers because they have
multiple stereo channels with phono preamplifiers for connecting Tocadiscos. It is conventional to use a DJ mixer with
Control de vinil, but vinyl control can be used without a hardware mixer.

Using Mixxx with a DJ mixer requires an audio interface with at least 4 mono outputs (2 stereo pairs) to send Mixxx’s
decks to the mixer’s stereo channels. Some DJ mixers have a USB audio interface built into them. This lets Mixxx send
unmixed audio files directly to the mixer without needing a separate stand-alone audio interface.

Often DJs who use DJ software with internal mixing send their master output to a hardware mixer. This can be helpful
to send the mixed signal to both a main speaker output for the audience and booth speakers for the DJ with separate gain
controls for each output. It also facilitates smooth transitions between DIJs.

However, using an external mixer with internal mixing is not necessary and reduces the sound quality. Each piece of
equipment an audio signal passes through reduces the sound quality, so avoiding unnecessary equipment in the signal
path can provide better sound quality. Many DJ controllers provide separate master and booth outputs with independent
volume controls. Alternatively, a sound card with at least 6 output channels can be used with Mixxx’s Booth output.

Many people confuse «analog mixers» and «hardware mixers», but these are not the same. Many hardware mixers process
audio digitally with specialized signal processors as opposed to a general purpose CPU like those in laptop and desktop
computers.

Vegeu també:

Recording And Broadcasting With An External Hardware Mixer
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5.4 Tocadiscos

Els tocadiscos o plats, sén dispositius mecanics que reprodueixen musica i enregistraments fonografics mitjancant vinils.
Abans que el Mixxx fos una realitat, I'art del DJing s’obtenia amb els plats i DJ mixers mescladors. Actualment podeu
punxar als vostres plats amb vinils especials que tenen gravat un codi de temps i aixi controlar la reproduccié d’arxius
digitals des del Mixxx, com si aquest fitxer fos la gravaci6 original del vinil en comptes d’aquest codi.

Vegeu també:

control amb vinil

5.5 Reproductors de CD

Els reproductors de CD sén dispositius que reprodueixen fitxers digitals d’audio i disposen de controls per manipular
aquesta reproduccié. Originalment, els reproductors de CD només reproduien aquest tipus de suport, perd els més recents
inclouen també ports per a unitats USB o targetes SD. Alguns reproductors es poden connectar a un ordinador mitjangant
un cable USB per funcionar com un controller controlador per al Mixxx.

5.6 Microfons

El microfon converteix els canvis de so a la pressio de l'aire en impulsos electrics o voltatge (un senyal analogic d’audio).
El Mixxx pot treballar amb qualsevol mena de microfon que pugueu connectar a la interficie d audio.

Vegeu també:

microfons

5.7 Headphones

Being able to listen to what you will play next in headphones before your audience hears on the main speakers or your
broadcast stream is an essential part of DJing. DJ headphones are generally better quality than typical consumer head-
phones. Importantly, they are designed to have good isolation, meaning they block outside sound. This allows the DJ to
focus on the sound in the headphones better without having to turn up the volume to drown out sound from the moni-
tors, PA system, and chatter. Also, DJ headphones have hinges or flexible headbands that allow the DJ to take off one
headphone cup to hear the monitor or PA output better in one ear and compare it to the headphone output in the other
ear.

When shopping for headphones, consider how well they isolate sound and their durability. The most frequent places that
headphones break are the cable attachment point and the headband. Look for headphones with detachable cables, metal
headbands, and other individually replaceable parts. Avoid Bluetooth headphones because these may be unreliable and
will always reduce sound quality. Active noise canceling headphones also tend to have worse sound quality than other
headphones of a comparable price. DJ headphones with a closed design block out a lot of sound simply by being closed.

Whether to get on-ear or over-ear headphones is a matter of personal preference. Everyone’s head is different, so head-
phones that are comfortable for a friend or a reviewer may not be comfortable for you.

In-ear monitors (IEMs) isolate sound better than headphones but are more expensive. They usually cost more than double
the price of good DJ headphones with comparable quality. They may be a sound investment for musicians who play often
in very loud environments to preserve their hearing.
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5.8 Splitter Cables

DIJ splitter cables are the cheapest way to get two separate sound outputs from your computer. These plug into the onboard
audio interface built into computer motherboards and split the stereo signal into two separate mono signals. However,
onboard audio interfaces are not good quality, and you lose the stereo effect of hearing different sounds arranged in space.

Devices marketed as «headphone splitter» instead of DJ splitters duplicate one stereo signal in two jacks. These cannot
be used for headphone cueing. Also, generic stereo-to-mono splitter cables or adapters typically have two mono jack
outputs. Plugging headphones or stereo speakers into a generic stereo-to-mono splitter will only play sound on one side
of the headphones or speakers.
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CHAPTER O

Example Setups

This chapter presents some example hardware setups with instructions for how to configure Mixxx to work with them.
Vegeu també:

* Magquinari DJ: background information about different types of equipment.

 Configuring sound input and output: details about each available input and output option.

e Utilitzant microfons: details for configuring Mixxx to work with microphones.

e DJ Hardware Guide lists specific devices with information about their prices, features, and compatibility with
Mixxx.

6.1 Computer Only

The built-in audio interface on most computers comes with a single stereo line-out and a microphone input. This can be
set up with Mixxx in two ways:

6.1.1 Practicing Mixing / Broadcasting

This setup can be used with a single audio output for speakers or headphones to practice DJing without investing in any
equipment other than a computer and a set of speakers or headphones. With this configuration, use the Pre/Main Knob
to switch back and forth between the Master mix and PFL signal. This setup cannot be used to play for a live audience
because the Master mix is not sent to an audio interface output. However, it can be used by radio DJs who only need to
send the Master mix to a broadcast audience.

1. Obriu Preferéncies » Maquinari de so
2. Seleccioneu la pestanya Sortida

3. From the Headphones drop-down menu, select your built-in audio interface, then Channels 1-2. Although this is
labeled Headphones, you can also plug speakers into the output jack of your computer.

4. Depending on your audio interface, you can specify a microphone
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o

. Utilitzeu el vostre microfon integrat o connecteu un microfon al vostre ordinador

o

. Comproveu que el sistema operatiu detecta el microfon
c. Seleccioneu la pestanya Entrada
d. Des del primer menti desplegable al costat de Microfon, seleccioneu I'entrada on heu connectat el microfon

5. Feu clic a Aplica per desar els canvis.

6.1.2 Playing for an Audience

This setup allows for playing to an audience without headphone cueing.

8,086 = Preferences
Sound Hardware

» B Controllers Sound API | Core Audio o]
il Libran
ol nterace S G [ 44100 Hz 4
ilil Equalizers e (5Bms )
=l Crossfader
B Recording Buffer Underflow Count 2
N Beat Detection Latency Tips

=) Normalization
© Vinyl Control
X Live Broadcasting

# Increase your latency if the underflow counter is increasing or you hear pops during playback
* Reduce your latency to improve Mixxx's responsiveness

ouput W
k.
Master | Built-in Output +| | Channels 1 -2 =
Headphones | None 3 3
Deck 1 [ None 3] 2
Deck 2 | None 3| |
| Query Devices || Resetto Defaults | Apply

| Cancel | 0K

Figurel: Utilitzant el Mixxx amb la targeta de so integrada

1. Obriu Preferéncies » Maquinari de so
2. Seleccioneu la pestanya Sortida
3. From the Master drop-down menu, select your built-in audio interface, then Channels 1-2
4. Depending on your audio interface, you can specify a microphone
a. Utilitzeu el vostre microfon integrat o connecteu un microfon al vostre ordinador
b. Comproveu que el sistema operatiu detecta el microfon
c. Seleccioneu la pestanya Entrada
d. Des del primer menu desplegable al costat de Microfon, seleccioneu I'entrada on heu connectat el microfon

5. Feu clic a Aplica per desar els canvis.
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6.2 Portatil i cable divisor

The cheapest way to DJ and cue with headphones uses a stereo-to-mono DJ splitter cable (also known as a “Y cable”)
plugged into the headphone jack of a laptop or other computer. This cable divides the stereo output from a single jack
into two separate mono signals.

This setup allows you to start DJing without having to invest in expensive equipment. However, because the signals are
in mono, you and your audience will not be able to enjoy music producers” positioning of sound in space (although many
club PA systems are wired in mono anyway). Furthermore, audio interfaces built into computers are usually low quality
and often pick up interference from other components of the computer.

Using a built-in audio interface and a stereo-to-mono splitter

1.
2.

Obriu Preferéncies » Maquinari de so
Seleccioneu la pestanya Sortida

Comproveu que heu connectat els auriculars a 'extrem que té el simbol d’auriculars i els altaveus a I'extrem que té
el simbol d’un altaveu.

From the Master drop-down menu, select your built-in audio interface, then Channel 1
From the Headphones drop-down menu, select your built-in audio interface, then Channel 2

Feu clic a Aplica per desar els canvis.

Avis: Molts cables divisors, especialment si s’anuncien com a divisors per a auriculars, envien el mateix senyal als
dos connectors, de manera que no serveixen per a aquesta configuracié. D’altres divisors generics d’estéreo a mono
separen els canals, pero tan sols se sent un canal i no tots dos. Els cables divisors per a DJ, separen I'estereo i envien
el mateix senyal mono a tots dos canals dels auriculars o altaveus.

6.3 Laptop and External USB Audio Interface

©

2x InfOut
Audio Interface

[‘ouput’)

[ nput )

Figure2: Using Mixxx together with an external audio interface

Using two audio interfaces (built-in + external)

1.
2.

Obriu Preferéncies » Maquinari de so

Seleccioneu la pestanya Sortida
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3,
4.

From the Master drop-down menu, select the external audio interface, then Channels 1-2

From the Headphones drop-down menu, select the built-in audio interface, then Channels 1-2

Using an external multi-channel audio interface

1.

A

Obriu Preferéncies » Maquinari de so

Seleccioneu la pestanya Sortida

From the Master drop-down menu, select the external audio interface, then Channels 1-2
From the Headphones drop-down menu, select the external audio interface, then Channels 3-4

Feu clic a Aplica per desar els canvis.

6.4 Portatil amb un controlador HID o MIDI

Vegeu també:

The Controladors section of the Maquinari DJ chapter has background information about controllers.

6.4.1 Controllers with an integrated audio interface

Many DJ controllers include an integrated mulfi-channel audio interface. A setup with this kind of controller may look
like the diagram below:

e o O000 oSO
L\SDWDQO cO000OO0O
e ) C’:‘:\:’U}D =]
T\:l\:l!jft (am]

Ooo0Q

I I

Figure3: Using Mixxx together with a DJ controller and integrated audio interface

Using a controller with an integrated multi-channel audio interface

1. Obriu Preferéncies » Maquinari de so

2. Seleccioneu la pestanya Sortida

3. From the Master drop-down menu, select your controller’s audio interface, then Channels 1-2

4. From the Headphones drop-down menu, select your controller’s audio interface, then Channels 3-4

6.4.

Portatil amb un controlador HID o MIDI

59



Mixxx User Manual, Versié 2.3.0

5. Feu clic a Aplica per desar els canvis.

6.4.2 Controllers without an integrated audio interface

Controllers without an integrated audio interface can be used together with a USB audio interface as depicted in the
diagram below:
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Audio Interface
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Figure4: Using Mixxx together with a DJ controller and external audio interface

Using a controller without an integrated audio interface

1.

wooA »N

Obriu Preferéncies » Maquinari de so

Seleccioneu la pestanya Sortida

From the Master drop-down menu, select the external audio interface, then Channels 1-2
From the Headphones drop-down menu, select the built-in audio interface, then Channels 1-2

Feu clic a Aplica per desar els canvis.

6.5 Portatil, mesclador extern i control amb vinil

Aquesta configuracié permet utilitzar tecniques de DJing amb tocadiscos i vinils, combinant la flexibilitat d’'un portatil.
En comptes de carregar pesades caixes de discos o feixugues motxilles amb els CD, els DJ poden dur la seva discografia
sencera de musica dins el seu ordinador. A més d’un portatil i auriculars, aquesta configuracié requereix almenys una

targeta d’audio amb un minim de dues entrades i sortides estereo i els vinils especials amb el timecode codi de temps.

Vegeu també:

Per a més informacid, veieu el capitol control amb vinil.

6.5. Portatil, mesclador extern i control amb vinil
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Figure5: Us del Mixxx amb tocadiscos i mesclador extern
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CHAPTER /

Controls del Mixxx

El Mixxx es pot controlar amb el teclat, el ratoli, controladores MIDI/HID i CDs/vinils amb codis de temps o una com-
binacié d’aquests. La opci6 a triar depeén del vostre pressupost o I'estil de punxar.

7.1 Amb un ratoli o ratoli tactil.

Feu anar el ratoli per a interactuar amb els controls de la Interficie del Mixxx a la pantalla de I'ordinador. Podeu realitzar
diferents accions movent i fent clic amb el ratoli.

« Single Left Click: Performing a left mouse click on buttons triggers the default action for that control. Moreover
if you click on a value in the track list of the Mixxx library, you can change the value. For example the year of a
track.

* Clic amb el boté dret: A la majoria do botons, si es fa un clic amb el boté dret, es realitza una acci6 diferent a la
del boto esquerra. Podeu fer que una rodeta o control lliscant tornin al valor per defecte si hi feu clic amb el botd
dret.

¢ Arrossegar: Feu clic en una rodeta o control lliscant, manteniu el boté esquerra premut, i moveu el ratoli per
canviar el valor. També podeu arrossegar les pistes des de la llista de fitxers cap als plats, les caixes, llistes de
reproducci6 i altres.

¢ Rodeta del ratoli: A part d’arrossegant el control, també podeu canviar el valor de les rodetes i els controls lliscants
posant el ratoli sobre d’'un control, i movent la rodeta del ratoli.

Suggerencia: If you hover with the mouse over a control (e.g. the crossfader) in the Mixxx user interface, the tooltip
lists the left- and right-click action respectively.

Suggerencia: En un Macbook, o un ordinador amb un ratoli tactil que no tingui botons, el gest de clic amb dos dits fa
habitualment d’acci6 de boté dret.
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Vegeu també:

Si feu anar I'arrossegament o la rodeta del ratoli amb els grafics d’ona, podeu ajustar el zoom i la velocitat de reproducci6
de les pistes. Per a més informaci6 aneu a Visualitzacio de grafics d’ona

7.2 Amb un teclat d’ordinador

Esc rate - || rate +||temp -"temp + rate - ||rate + | [temp -"temp + . print || Scroll || Pause M I m
shuffle|| skil fade ||toggle
small || small || small || small small || small || small || small D oggl Soreen | Lock f Break L
Deck 1 _ Deck 2 AutoDJ
= SYNe || 1oop || loop ||reloop||Quick |f SYC || 1oop || loop ||reloop||Quick|| — + « Insert || Home Bage um / * —
§ tap in out ||/ exit ||Effect | tap in out ||/ exit ||Effect|| - = P 0c
Tab 14— 4-bar || loop || loop || R head || head || 4-bar || loop || loop || P { } Enter «— Delete || End Page 7 8 9 +
_N loop || +2 || x2 phone | phone || Toop || =2 || x2 I ] Dovn Home PgUp
Caps Lock back play " cue ||xF : ader|| back play " cue || | 4 5 6
fwd < > fwd -
rev cue set||cue gof | small |f small || rev icue set||cue gof| / \ lerary
Shift talk || hot1 || hot2 || hot3 || hot4 || 1o | jow || hot1 || hot2 || hot3 | hot 4 || shi 1 1 2 3 Enter
over || clear || clear || clear || clear || kill | kill || clear || clear || clear || clear End Pg Dn
ctrl Alt Alt ctrl load 1 load 2
! maximize library ! = { - 0
eject eject 2 Del

Figurel: Dreceres de teclat del Mixxx (per a la disposicid de teclat anglesa en-us)
Download the image

Controlar el Mixxx amb el teclat és util. A diferéncia del ratoli, el teclat permet fer accions simultaniament. Per exemple,
podeu iniciar la reproducci6 d’una pista al plat 1 i parar el plat 2 al mateix temps.

La disposici6 per defecte del teclat Angles es mostra a la imatge superior. Esta dividida en una part esquerra per al plat
1 i una part dreta per al plat 2. Tingueu en compte que també podeu accedir a aquestes funcions amb la interficie del
Mixxx.

For some user groups, like those using controllers or vinyl control, it might be useful to enable/disable the keyboard
mappings at runtime. You can do so by clicking Options » Enable Keyboard Shortcuts.

Suggeréncia: Si poseu el ratoli sobre un control (p. ex. el crossfader) de la interficie del Mixxx, es mostrara una nota
informativa amb les dreceres de teclat per al control, juntament amb la descripcid del control.

Vegeu també:
Per a veure una llista de les dreceres per defecte, aneu a Keyboard mapping table.

7.2.1 Personalitzacio les dreceres de teclat

El Mixxx permet personalitzar les dreceres de teclat. Per a més informacié aneu a:

e Personalitza les dreceres de teclat
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7.3 Amb controladores MIDI/HID

Mixxx supports MIDI and HID controllers which are external hardware devices used to control audio applications. Many
DJs prefer the hands-on feel of a controller with Mixxx because it can feel similar to using a real mixer and turntables or

CDJ.

7.3.1 Loading a controller mapping

*® Preferences

o) Sound Hardware
v [ Controllers

B Apple Internal...
B Apple Internal...
B Apple Internal...
B Apple Internal...
B Apple Keyboard
B Apple Keyboard
B Apple Mikey ...
& cTH-470

& CTH-470

& vCI300DJC...
i Library
& Interface
#* Waveforms
1§ Auto DJ
ilii Egualizers
M Effects
z= Crosstader
B Recording
i\ Beat Detection
&3 Key Detection
-)) Normalization
© Vinyl Control
X Live Broadcasting

VCI 300 DJ Controller

Enabled
Load Preset:

Preset Info
Name:
Author:
Description:
Support:

Restore Defaults Apply

Input Mappings Output Mappings Seripts

MIDI Controller

Learning Wizard (MID1 Only)

Vestax VCI-300
Uwe Klotz

Mo Description

Mizxoox Forums Mixoc Wiki Troubleshooting

Cancel

Figure2: Mixxx Preferences - Loading a controller mapping

Without loading the correct mapping, your controller does not work with Mixxx.

1

© N oA WD

Inicieu el Mixxx

. Connecteu la(es) controladora(es) a I'ordinador

Aneu a Preferéncies » Controladores

. Select the mapping for your controller from the Load Mapping drop-down menu
Make sure that the Enabled checkbox is ticked
Click Apply and Mixxx can now be controlled by your controller(s).

Repetiu els passos 4-7 per a cada una de les controladores que utilitzeu

B

Seleccioneu el dispositiu de la llista de dispositius disponibles de I’esquerra, i canviara la informacié al panell dret

Suggerencia: Si la controladora no apareix a la llista de dispositius connectats, assegureu-vos d’instal-lar els controladors

del dispositiu.

7.3. Amb controladores MIDI/HID
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7.3.2 Controladores compatibles

El Mixxx pot utilitzar qualsevol controladora MIDI/HID que reconegui el vostre sisterma operatiu (pot ser que necessiteu
instal-lar els controladors), sempre que hi hagi una configuraci6 preestablerta MIDI/HID per a que el Mixxx entengui les
ordres. El Mixxx incorpora un conjunt d’assignacions MIDI i HID per a diferents dispositius. Hi ha dues categories de
fitxers de configuracio:

» Configuracions certificades pel Mixxx: Aquestes assignacions de controls s’han verificat per I'equip de desen-
volupadors del Mixxx.

 Configuracions proporcionades per la comunitat: Aquestes assignacions les han realitzat i verificat la comunitat
del Mixxx, pero 'equip de desenvolupadors del Mixxx no ha pogut verificar la seva qualitat, perque no tenim accés
als dispositius. Hi ha la possibilitat que tinguin errors o estiguin incomplertes.

Si teniu algun problema amb aquestes configuracions, informeu-nos de l'error al Bug Tracker o contacteu utilitzant la llista
de distribuci6 de correu, els forums o el canal /RC. La compatibilitat dels dispositius varia per a cada sistema operatiu,
aixi que consulteu la documentacié del dispositiu.

Suggerencia: Additional mappings are available in the Controller mapping forum.

Vegeu també:

Abans de comprar una controladora per utilitzar-la amb el Mixxx, consulteu la Hardware compatibility a la nostra vikipe-
dia. Hi ha la informacié més actualitzada sobre quines controladores funcionen amb el Mixxx i detalls de cada una.

7.3.3 Installing a mapping from the forum

To use a controller mapping that did not come bundled with Mixxx, place the controller mapping in your User Mappings
folder. This is the folder called «controllers» inside your User Preferences folder. To open your User Mappings folder,
g0 to Preferences » Controllers and click the Open User Mapping Folder button. Alternatively, navigate to the folder in
your OS file browser:

e GNU/Linux: /home/<username>/.mixxx/controllers

* macOS: /Users/<username>/Library/Containers/org.mixxx.mixxx/Data/Library/
Application Support/Mixxx/controllers

¢ Windows Vista and newer: C:\Users\<username>\AppData\Mixxx\controllers
e Windows XP: C:\Documents and Settings\<username>\AppDatal\controllers

On Windows, the AppData folder is hidden, so if you have not already, you will need to set Windows Explorer to show
hidden files and folders (how to do this varies with each version of Windows).

If the mapping was posted as a . zip file, first extract the . zip file by right clicking on it in your file browser and
selecting the option for extracting an archive or compressed folder. Copy the . xm1 file into your User Mapping folder.
If there is a . js file, also copy that to your User Mapping folder. Restart Mixxx and load the mapping.
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7.3.4 Map your own controller

No hi ha una configuracié disponible per a la vostra controladora, o voleu canviar-ne una d’existent? Podeu fer les
assignacions de la vostra controladora utilitzant I’assistent d’aprenentatge o si voleu control total, utilitzeu el suport de
scripts de MIDI del Mixxx.

Vegeu també:

Aneu a Afegiu suport per a la vostra controladora MIDI/HID per a més informacid.

7.4 Amb CDs i disc de vinil amb codis de temps

Vinyl control allows a user to manipulate the playback of a track in Mixxx using a turntable or CDJ as an interface. In
effect, it simulates the sound and feel of having your digital music collection on vinyl. Many DIJs prefer the tactile feel of
vinyl, and vinyl control allows that feel to be preserved while retaining the benefits of using digital audio.

Vegeu també:

Aneu a Control de vinil per a més informacio.
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CHAPTER 8

Control de vinil

El control de vinil permet a 'usuari manipular la reproduccié d’una pista al Mixxx utilitzant un tocadiscs real com a
controladora. Té I'efecte de simular el so i la sensaci6 de tenir la musica digital en vinil. Molts DJs prefereixen la sensacié
d’utilitzar vinils, i el control de vinils permet mantenir aquesta sensaci6, amb els beneficis de I'audio digital.

8.1 Com funciona?

Vinyl control uses special fimecode records or CD’s which are placed on real turntables or CDJ. The audio output of the
turntables is plugged into a audio interface connected to a computer on which Mixxx is running. When a record is played
on one of the attached turntables, Mixxx reads the timecode from the record and uses the information to manipulate
whatever track is loaded.

8.2 Que necessito per a utilitzar-ho?

It is possible to use Mixxx’s vinyl control with a variety of setups. Unlike some proprietary DJ software, Mixxx can use
several types of timecode media and any audio interface that your operating system has drivers to use. Optionally, any
MIDI/HID controller can be used together with timecode control. The basic setups for timecode control are:

Configuracié 1: DJ de vinil

de 2-4 vinils de codis de temps, de 2-4 tocadiscs amb un pre-amplificador «phono» (o que tinguin sortida a
nivel-de-linia), i de 2-4 entrades d’audio estereo.

Your audio interface inputs must match the turntable outputs. Turntables output very quiet phono-level
outputs that must be amplified for Mixxx to use. You should either find a audio interface that has phono
pre-amplifiers built in (one for each deck), use standalone phono pre-amplifiers, or use turntables with built
in phono pre-amplifiers.

També podeu evitar I'ds d’'un preamplificador phono si utilitzeu la preamplificacié per programari del Mixxx,
a les prefereéncies del control de vinil. Aix0 pot no funcionar en alguns casos. Es prefereix i es recomana
utilitzar la entrada de linia estandard.
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For turntables a typical setup is depicted in the figure below. First, connect the RCA cables from the turntables
to the inputs on your audio interface. Second, connect the outputs of your audio interface to the inputs on
your mixer.

4x In/Out
Audio Interface

o o~ ma —
ond [125 «] [123 4

Figurel: Utilitza el Mixxx amb tocadiscs i mesclador extern

Nota: Molts tocadiscs nous tenen un selector Line/Phono. Si el vostre en té, assegureu-vos que esta configurat ade-
quadament per a la vostra targeta de so.

Configuraci6 2: CDJ
2-4 CD amb codis de temps, 2-4 reproductors de CD i 2-4 entrades d’audio estereo.

Setting up CDJs for use with timecode CDs is similar to setting up turntables. The figure below outlines a
typical configuration. First, connect the RCA cables of the CDJs to inputs of your audio interface. Second,
connect the inputs of your mixer to the outputs of your audio interface. Make sure the input mode of your
audio interface is set to Line.

Entrades de so
¢ It is recommended to use a DJ audio interface that has multiple stereo line inputs on it.
¢ Alternatively you can use multiple audio interfaces, each with a single stereo line in, but this is strongly discouraged.

Mixxx supports vinyl control input through a single audio interface with at least 4-channels of input (two stereo line-in
jacks), or through multiple separate audio interfaces which each have 2-channels of input (a single stereo line-in jack).
Vinyl control requires the use of stereo line-in jacks - Mono or microphone inputs will not work.

It is strongly recommended to use a audio interface that comes with native low latency drivers such as ASIO (Windows)
or CoreAudio (Mac). Linux users depend on the quality of the corresponding open source driver.

Nota: Per a poder fer scratch amb els controls de vinil, recomanem utilitzar un sistema capa¢ d’una laténcia de 10ms.
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Figure2: Us del Mixxx amb reproductors CDJs i un mesclador extern

Amb laténcies més altes, el so d’aquest efecte comencara a distorsionar.

Nota: No es necessita un mesclador fisic extern per a utilitzar el control amb codis de temps. Podeu utilitzar una
controladora MIDI o HID per a mesclar amb el mesclador intern del Mixxx.

8.2.1 Discs de codis de temps compatibles

Podeu utilitzar qualsevol dels discs amb codis de temps segiients amb el Mixxx:

Tipus Sensibilitat
Serato CV02/2.5 Vinyl Molt alta
Serato Control CD 1.0 Molt alta

Traktor Scratch MK1 Vinyl | Molt alta
Traktor Scratch MK2 Vinyl | No compatible
MixVibes DVS V2 Vinyl Molt alta

Actualment, es recomana els discs Serato si considereu comprar discs de vinil. Si voleu utilitzar CDs, podeu descarregar
una copia gratuita per a Us personal des de Serato.
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8.3 Configuracié dels dispositius d’entrada i sortida

8.0.6 ® Preferences
Sound Hardware
» & Controllers Sound API L3 | Core Audio 2]
il Library <
L Interface S bk | 44100 Hz s

ilii Equalisers

Latency | 5.8 ms s
== Crossfader
Recording Buffer Underflow Count (1]
2\ Beat Detection Latency Tips
=) Normalization
°) Vinyl Control * Increase your latency if the underflow counter is increasing or you hear pops during playback
’ ‘my ontro R * Reduce your latency to improve Mixxx's responsiveness
X Live Broadcasting
oo NN
Master | None 3] 3]
Headphones | None D )
Deck 1 | u46D) +| | Channels 1 - 2 i)
Deck 2 | u4eD) +| | Channels 3 - 4 )
| Output !@!
Vinyl Control 1 | u46D) 4| | Channels 1 -2 3]
Vinyl Control 2 | U46D) || Channels 3 - 4 B
Microphone | None s | 4
| Query Devices || Resetto Defaults | | Apply |
| Cancel | [ ok |

Figure3: Preferencies del Mixxx - Configuracié dels dispositius d’entrada i sortida per al control de vinil.

Es poden utilitzar fins a 4 plats amb vinils o CD de codis de temps amb el Mixxx.
1. Obriu Preferéncies » Maquinari de so
2. Seleccioneu la pestanya Entrada

3. From the Vinyl Control I - Vinyl Control 4 drop-down menus, select the audio interface(s) which your decks are
plugged into.

4. In the channel selection drop-down menu, select the channel pairs corresponding to the plug on your audio interface
that your deck(s) are plugged into, typically Channels 1-2 and Channels 3-4 etc.

5. Feu clic a Aplica per a desar els canvis.
6. Seleccioneu la pestanya Sortida

7. Indiqueu en els desplegables de Plat I a Plat 4 la targeta per a enviar la sortida del Mixxx directament al mesclador
extern

8. Feu clic a Aplica per a desar els canvis.
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8.4 Configurar el control de vinil

ece ® Preferences

o)) Sound Hardware Input

» [ Controllers .
i Library Turntable Input Signal Boost
o Interface
#* Waveforms 0dB 0dB 44 dB
1§ Auto DJ
ilii Equalizers Vinyl Configuration
M Effects
== Crosstader Deck 1 Vinyl Type = Serato CD ﬁ 33.3 RPM ﬁ Lead-in 0 | seconds
B Recording . .
\ Beat Defection Deck 2 Vinyl Type = Serato CD ﬂ 33.3 RPM ﬁ Lead-in 0 | seconds
&34 Key Deteclion Deck 3 Vinyl Type | Serato CD d 33.3 RPM d Lead-in 0  seconds
) Normalization 3 .

Deck 4 Vinyl Ty Serato CD 33.3 RPM Lead-in 0 | seconds
Vinyl Control S | &

& Live Broadcasting Show Signal Quality in Skin

Signal Quality

Hints

Select sound devices for Vinyl Control in the Sound Hardware pane.
Troubleshooting

Powered by xwax

Restore Defaults Apply Cancel *

Figure4: Preferencies del Mixxx - Configurar el control de vinil

Podeu configurar el control de vinil des de Preferéncies » Control de vinil.

8.4.1 Amplificacié de la senyal d’entrada del tocadisc

Many turntables provide unamplified “phono level” output which must be boosted to a “line level” signal. Normally, a
mixer or audio interface provides this amplification, but if you're plugging a turntable’s phono output directly into a audio
interface that doesn’t support phono input, Mixxx can do the amplification. The Turntable Input Signal Boost slider allows
you to adjust the level of preamplification applied to your decks” signal. However, it is always preferable to use a proper
phono preamplifier if you have one.

8.4.2 Configuracio6 del vinil

 Tipus de Vinil: Es poden utilitzar diferents tipus de discs amb codis de temps amb el Mixxx. Configureu el
desplegable per a que coincideixi amb el tipus de disc de temps que esteu utilitzant amb els plats.

* Tempo del Vinil: Canvieu aix0 si preferiu utilitzar el tocadisc configurat a 45 RPM. Per defecte és 33 RPM.

¢ Temps d’inici: Permet definit una zona no util al comengament del vinil o CD, on s’ignorara els codis de temps.
Aix0 és util en situacions on els codis de temps comencin molt a la vora del disc i pugui ser complicat posar I'agulla
al primer toc sense que I'agulla caigui del disc. Un temps de 20 segons o més permet evitar-ho, deixant més lloc al
vinil per a posar punts cue. També és til quan el disc esta desgastat i ja no funciona de forma fiable: tan sols can
posar el temps d’inici on comenci la part que esta ben conservada. Podeu fer aixo fins que s’acabi el disc, i no us
caldra comprar un nou disc tan aviat.

* Mostra la qualitat de senyal a ’aparenca: Si s’activa, una representacio circular de la senyal de temps es mostrara
en temps real al vinil giratori de la interficie del Mixxx.
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Suggeréncia: Tot i que no es recomana, podeu utilitzar un tipus diferent de disc a cada plat.

8.4.3 Mode de control

El Mixxx té tres modes de control independentment del disc de codis de temps utilitzat.

* Mode absolut: Proporciona al Mixxx informaci6 del to/velocitat i de la posici6 del disc de temps, i permet canviar
la posici6 de la pista, posicionant I'agulla al vinil, o cercant amb el CDJ.

* Relative Mode: Pren la posici6 com a relativa a la posicié d’inici del plat, i només controla el to/velocitat al Mixxx.
No és possible cercar amb I'agulla o el CDJ en mode relatiu, amb una excepcid. Si poseu 'agulla en I'area de Temps
d’inici (veieu Configuracio de vinil), aleshores el Mixxx tornara a l'inici de la pista. Un cop una pista comenca la
reproduccio en mode relatiu, el Mixxx no permetra canviar al mode Absolut. Sind, la pista saltaria de cop a una
altra posicié. Assegureu-vos que el disc estigui parat i aleshores podreu canviar al mode Absolut.

* Mode Constant: Aquest mode especial només s’utilitza si necessiteu que el Mixxx continui reproduint tot i que
no es rebi la senyal de control de vinil. El mode Constant s’activa automaticament quan I'agulla arriba al final del
disc de control de vinil.

8.4.4 Modes de punt cue

El Mixxx té dos modes de cue opcionals per al control de vinil que només funcionen amb el Mode Relatin. Aquests
modes s6n utils per anar rapidament a una posicié de la pista sense tocar el portatil. Es habitual haver de cercar una pausa,
0 unes veus, i els punts cue fan que sigui més facil trobar-los.

¢ Cue: En aquest mode, quan poseu I'agulla al disc després del punt Cue, el Mixxx anira a aquell punt.

* Hot Cue: Quan l'agulla es posa al disc, el Mixxx anira al punt hotcue més proper, cap endarrera. Si teniu un punt
hotcue al minut u, i un altre al minut dos, aleshores podeu posar I’agulla a qualsevol punt entre el minut u i el minut
dos i el Mixxx anira al punt hotcue del minut u.

Suggeréncia: Podeu canviar el Control i el mode Cue directament des de la interficie del Mixxx mentre mescleu, aneu
a Mode de control de vinil i punts cue. També podeu utilitzar els Application shortcuts.

8.4.5 Qualitat de la senyal

Una configuracié de control de vinil Optima depén d’'una bona qualitat de la senyal. Molts factors poden afectar la qualitat
de la senyal, perd la més important és assegurar que el nivell de volum de la senyal de codis de temps és moderada. Una
senyal massa forta o massa fluixa degradara la qualitat, provocant normalment una pérdua de la informaci6 de posicid,
fent que el mode absolut es comporti com el mode relatiu.

El Mixxx representa la qualitat de la senyal de codis de temps com un grafic circular generat a partir de I'audio mateix.
Els grafics es corresponen als dispositius d’entrada actius Control de vinil 1 a Control de vinil 4.

Si la senyal del vinil funciona, veureu un cercle rod6 i verd, amb dues linies. Aquest “donut” de vinil hauria de ser tant
circular com sigui possible, i les linies haurien de ser clares, amb el minim nivell de soroll.

Suggereéncia: Podeu fer que es mostri la qualitat de la senyal a la interficie del Mixxx mentre mescleu, aneu a Configuracio
dels dispositius d'entrada i sortida.
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8.5 Activacio del control de Vinil

Per a cada plat, seleccioneu Opcions » Control per Vinils » Activa el control de Vinil, o utilitzeu les Application shortcuts.

8.5.1 Informacio de I'estat del control de vinil

Figure5: La informacié d’estat i qualitat de la senyal del plat

Un rectangle proporciona informaci6 visual respecte I'estat del control de vinil d’un plat.
* No es mostra: El control de vinil esta desactivat per al plat.
¢ Verd: El control de vinil esta activat al plat.

e Groc: L’agulla ha arribat al final del disc.

8.6 Control amb un sol plat

Si només teniu un tocadisc, també podeu utilitzar-lo amb el Mixxx per a les vostres sessions. A Preferéncies » Maquinari
de so » Entrada, utilitzeu la mateixa entrada per als dos Control de Vinil.

Durant la mescla, tindreu una pista reproduint, mentre que l'altra la controlareu amb el tocadisc. Comenceu activant el
control de vinil al primer plat, i comenceu la mescla. Quan estigueu a punt per preparar el segiient disc, deshabiliteu el
control de vinil del primer plat i activeu-lo al segon. La reproduccid continuara al primer plat sense interrupcid. Posicioneu
la segiient pista i mescleu-la. Quan estigueu llest per a posar de nou el primer plat, torneu a desactivar el segon plat i activeu
el primer.

Utilitzeu els Application shortcuts per a canviar el focus d’un plat a I'altre. També podeu configurar Control de vinil »
Segiient plat del control de vinil a Assistent d aprenentatge, per a assignar I'acci6 a una tecla de la vostra controladora.
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8.7 Model de fi-del-disc

Algunes vegades la pista que reproduiu pot ser més llarga que I'area de codis de temps del vostre disc. Si I'agulla arriba
al final del disc, el Mixxx es posa en un mode especial Fi-del-disc. Quan aix0 passa, 'indicador de vinil (habitualment
un rectangle verd) es posara groc de forma intermitent avisant d’aquest fet. Al mateix temps, el Mixxx activara el Mode
constant 1 ignorara el to/velocitat del plat. En aquest punt la pista continuara reproduint fins al final. Quan es carregui una
nova pista, el mode Fi-del-disc es desactivara automaticament aixi com el Mode constant.

Quan arribeu al Mode Fi-del-disc 1 necessiteu utilitzar el tocadiscs per a controlar el to/velocitat, poseu de nou I'agulla
al disc. No passa res, la pista no deixara de sonar. Tan aviat com el Mixxx detecti que l'agulla ja reprodueix, canviara
automaticament al Mode Relatiu.

8.8 Control de la pista

Alguns discs de control de vinil tenen una zona especial, a prop del centre del disc per a seleccionar i carregar pistes a
la interficie. Podeu veure aquestes zones perque hi ha una separacio entre la zona de codis de temps i el cercle intern.
Alguns discs no s’han provat amb el MixxXx, i les seves zones no sén compatibles. Els vinils Serato CV02 Vinyl i Traktorl
Vinyl MK1 sabem que funcionen. Els Serato CV02 CDs sabem que no funcionen.

Poseu I'agulla a la zona de control i feu anar el disc endavant o endarrera. La linia seleccionada a la biblioteca hauria de
moure’s cap dalt i cap a baix. Aixequeu I'agulla i poseu-la en la zona de codis de temps per a carregar la pista.

8.9 Solucié de problemes

Configuracio
Per a que tot funcioni, heu de configurar el Mixxx adequadament. Assegureu-vos que heu fet el segiient:

* configurat les sortides Plat I a Plat 4 a Preferéncies » Maquinari de so per a enviar la sortida del Mixxx directament
al mesclador extern

* configurades les entrades Control de vinil 1 a Control de vinil 4 a Preferéncies » Maquinari de so » Entrada

* seleccionat el tipus correcte de control a Preferéncies » Control de vinil » Tipus de vinil. Podeu consultar la llista de
discs amb codis de temps suportats

* enabled vinyl control via the menu under Options > Vinyl Control » Enable Vinyl Control.
Qualitat de la senyal

El grafic es mostra en Preferéncies » Control de vinil. Hi ha més informacié a Qualitat de la senyal.
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Senyal

Significat

Solucié de problemes

Els canals d’entrada del control de vinil no s’han
configurat correctament. El control de vinil no
funcionara.

Obriu Preferéncies / Maquinari de so i configureu els
dispositius que voleu utilitzar, podeu consultar Config-
uracio dels dispositius d’entrada i sortida

Els canals d’entrada del control de vinil estan
configurats correctament. No es rep senyal de
codis de temps.

Poseu en marxa el tocadisc o el CDJ amb el disc de
codis de temps.

Nearly perfect green doughnut about half the
width of the graph. Rotating radar sweeps in the
direction your record on the turntable is spin-
ning.

Tot esta perfecte, no cal fer res. Podeu comencar a
posar pistes.

No heu triat el tipus de vinil correcte. El donut
sembla correcte, perod és de color vermell.

Seleccioneu el tipus correcte de vinil a les preferéncies.
P. ex. potser heu seleccionat la cara B del vinil Serato,
pero el disc esta a la cara A.

La senyal d’entrada és dolenta. Com més do-
lenta sigui la senyal de vinil, veureu que el color
del donut canvia de verd cap a taronja fins a ver-
mell.

Comproveu el cable / connexié de terra del tocadisc
/ CDJ. El disc de codi de temps pot esta desgastat, o
l'agulla de tocadisc esta bruta.

Direcci6 equivocada. El donut verd sembla cor-
recte, per0 el radar es mou cap a la direccid con-
traria que el disc al tocadisc/CDJ.

Potser teniu un problema amb els cables. Intenteu in-
vertir els canals esquerra i dret del tocadisc. Potser
també I'agulla no esta ben connectada.

La senyal d’entrada no és d’un disc de codis de
temps. El Mixxx rep una senyal d’audio normal,
pero espera una senyal de codis de temps.

Poseu en marxa el tocadisc o el CDJ amb el disc de
codis de temps adequat. També podeu revisar si heu se-
leccionat els dispositius d’entrada correctes a les prefer-
encies.

Falta el canal esquerra o dret. El Mixxx només
rep una senyal mono perd necessita una senyal
estereo de codis de temps per a funcionar.

Comproveu els cables del tocadisc/CDJ i també de
I'agulla del tocadisc.

La senyal de codis de temps esta massa forta. El
Mixxx rep la senyal amb massa amplificacio.

Lower the amplification, either on your external mixer,
audio interface, or with the Turntable Input Signal
Boost.

La senyal de codis de temps esta massa fluixa.
El Mixxx rep la senyal perd no té prouta ampli-
ficaci6.

Boost the amplification, either on your external Mixer,
audio interface, or with the Turntable Input Signal
Boost.

8.9. Solucio6 de problemes
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CHAPTER 9

Utilitzant microfons

Mixxx can work with any microphone that can be plugged into your audio interface. There are three ways to use micro-
phones with Mixxx, each with their own pros and cons:

* Programari de monitoratge: Cheapest and simplest to set up, but you cannot hear yourself without a disorienting
delay, referred to as «latency».

* Monitoratge directe: Recommended for most users. This is the cheapest to set up with good sound quality and
without the latency of software monitoring.

* Mescladors per maquinari: Most expensive option to set up with high sound quality. This does not have the latency
of software monitoring.

Avis: USB microphones are not recommended. These devices have their own audio interface built in and can only be
used with software monitoring. Some USB microphones have headphone jacks for direct monitoring, but the music
from Mixxx cannot be heard in this headphone jack. Also, they can be difficult to configure at the same time as a
different audio interface for music output.

Vegeu també:

The Mixxx DJ Hardware Guide lists specific audio interfaces with information about their prices, features, and suitability
for use with microphones.
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9.1 Programari de monitoratge

Software monitoring can be used with the built-in microphone on a laptop or with a headset plugged into the built-in
audio interface on a computer. However, there is a delay between the time you make sound into the microphone and hear
it in the Master output. Due to the nature of digital audio, it takes time for input from the audio interface to be available
for Mixxx to process, time for Mixxx to process the audio, and more time to send the audio back out the audio interface.
This time is referred to as «latency».

Mixxx can be configured to run at low latencies by choosing a smaller Memoria intermédia d'audio, but there is no way
to completely eliminate latency. Although latency is measured in milliseconds, even a few milliseconds of latency can be
disorienting and distracting to hear, whether you are using the microphone for spoken announcements, vocals, or playing
a musical instrument.

Per utilitzar programari de monitoratge:
1. Open Preferences » Sound Hardware.
Select the Input tab.
For Microphone 1, select the audio interface that your microphone is plugged into.
Click the Apply button.
Click the OK button.

Click the Mics button in the main Mixxx window to show the microphone controls.

NS A »N

Click the Talk button when you are using the microphone.

Suggerencia: If you would prefer to not hear the microphone input, you can set the Microphone Monitor Mode option
to Direct monitor (recording and broadcasting only). This will still mix the microphone input with your recorded and
broadcasted mixes, but it will not mix the microphone with the Master output. Don’t forget to press the Talk button when
using the microphone if you use this option.

9.2 Monitoratge directe

An audio interface with direct monitoring and a Bucle d'entrada is the recommended way to use microphones with Mixxx
for most users. Except for audio interfaces built into computers, most audio interfaces with microphone inputs support
direct monitoring. However, not all audio interfaces that support direct monitoring also have a loopback input.

Direct monitoring routes the audio from the audio interface’s inputs directly its outputs. This avoids the latency of sending
it into the computer and back out with Programari de monitoratge. At the same time, the audio interface sends the input
into the computer so Mixxx can record and broadcast it.

9.2.1 Bucle d’entrada

Some audio interfaces that support Monitoratge directe have a loopback input feature. They add Mixxx’s output to the
microphone signal before sending it to the computer. This makes it easier to set up Mixxx with direct monitoring than
configuring Compensacio de la laténcia.

To configure Mixxx with a loopback input:
1. Open Preferences » Sound Hardware.

2. Click the Input tab.
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Select the audio interface for the Record/Broadcast input. Do not configure anything for the Microphone 1-4 inputs.
Click the Apply button.
Click the OK button.

A

Activate direct monitoring and loopback on your audio interface.
7. Adjust the microphone volume with the input gain knob on your audio interface.

The microphone controls in Mixxx will not affect your microphones because they are mixed by the audio interface and
not sent directly to Mixxx.

9.2.2 Compensacio de la laténcia

When using Monitoratge directe, you will hear the microphone mixed with the music from Mixxx without any noticeable
latency. However, it still takes time for Mixxx to receive the microphone signal and process it. Without compensating for
this latency or using a Bucle d'entrada, the microphone inputs will be out of time relative to the music in your recorded
and broadcasted mixes.

Mixxx can compensate for this timing misalignment, but it is complicated to set up. If you do not want to record your
microphone into your mix or broadcast, you can activate direct monitoring on your audio interface without configuring
latency compensation.

Measuring Round Trip Latency

To configure Mixxx to compensate for input latency while using direct monitoring, first you must measure the round trip
latency of your setup. The round trip latency is different from the size of the Memoria intermedia d’audio configured in
Mixxx. It is the amount of time it takes for audio to make a complete trip from your audio interface’s input, through your
computer, and back out the audio interface.

Mixxx cannot calculate the round trip latency because it depends on details of your audio interface’s hardware, your
operating system, your audio interface’s driver, and other factors in your computer’s hardware. The round trip latency can
only be found by measuring it. To do this, use a physical cable to connect the audio interface’s output to its input. Then,
use a third party program to measure the round trip latency. These programs are recommended on each OS:

* GNU/Linux: jack_iodelay
¢ Windows: RTL Utility
* macOS: Audacity

You must use the same sample rate and audio buffer size in the measurement program as you do in Mixxx for the
measurement to be accurate. If you decide to change the sample rate or buffer size you use with Mixxx, you will need to
remeasure your round trip latency to have your microphone inputs aligned in your recorded and broadcasted mixes.

Avis: Make sure direct monitoring is not activated on your audio interface while you are measuring the round trip
latency or you will not get an accurate measurement.
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Configuring Latency Compensation

1. Before opening Mixxx, measure the round trip latency.
Obriu el Mixxx.
Open Preferences » Sound Hardware.

Click the Input tab.

A

Select the audio interface input(s) for the Microphone 1-4 inputs. Select a single mono channel for each Microphone
input unless you are using stereo microphones.

For the Microphone Monitor Mode option, select Direct monitor (recording and broadcasting only).
Enter the measured round trip latency in milliseconds for the Microphone Latency Compensation option.
Click the Apply button.

Click the OK button.

v »® 2o

10. Activate direct monitoring on your audio interface.
11. Click the Mics button in the main Mixxx window to show the microphone controls.
12. Click the Talk button when you are using the microphone.

13. Adjust the microphone volume with the input gain knob on your audio interface. Do not adjust the microphone gain
in Mixxx. If you do, the relative volume of the mics and music will be different in your recorded and broadcasted
mixes compared to what you hear out of your audio interface.

Mixxx will not record or broadcast your microphone if the 7alk button is not active. However, you will still hear the
microphone in your main output because the microphone is mixed by your audio interface, not Mixxx. You may leave
the Talk button on to ensure you do not forget it, but this will record and broadcast background noise when you are not
actively using the microphone. If your microphone has an on/off switch on it, you may leave the 7alk button enabled in
Mixxx and use the switch on the microphone to avoid adding background noise to your mix. Alternatively, you can adjust
the input gain on your audio interface throughout your mix.

9.2.3 Activating Direct Monitoring And Loopback On The Audio Interface

General tips for activating direct monitoring and loopback are described below. However, every audio interface is dif-
ferent, so refer to the audio interface manual from the manufacturer for more details.

On stand-alone audio interfaces, there is often a knob on the device that controls direct monitoring. This knob crossfades
the audio interface’s output between the signal from the computer and the directly monitored inputs. If your audio
interface has a knob like this, set the knob to the center. Alternatively, some audio interfaces have a switch to toggle
direct monitoring instead of a knob.

To hear mono microphone inputs on both sides of the stereo output with direct monitoring, you typically need to toggle
a switch on the device.

If the audio interface supports Bucle d'entrada, that may be activated by a switch on the device.

Audio interfaces with lots of inputs and outputs often have a control panel program provided by the manufacturer that is
installed automatically with the driver. This may be used instead of knobs and switches on the hardware to control direct
monitoring, loopback, stereo/mono switches, and other audio interface features. On GNU/Linux, you might be able to
access these controls with alsamixer.

Refer to the section below for details about Controladors DJ amb entrades de microfon.
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9.3 Mescladors per maquinari

Mixxx can be used with a microphone plugged into an external hardware mixer. This does not have the problem with
latency that happens with Programari de monitoratge. However, it is generally recommended to use an audio interface
that supports Monitoratge directe and a Bucle d’entrada instead of an external mixer. If you are using Control de vinil and
a microphone, you may need an external mixer.

Mixxx can send each deck to separate stereo channels on an external mixer by using the Deck 1-4 outputs. This requires
an audio interface with at least 4 output channels (2 stereo pairs). Audio interfaces built into computers only have one
stereo output and they do not have high sound quality. Thus, another audio interface is recommended. Audio interfaces
with at least 4 output channels typically have microphone inputs and support Monitoratge directe, so there is no need for
the external mixer.

However, audio interfaces with phono preamplifiers for Control de vinil do not have microphone inputs. If you want to
use vinyl control with a microphone, it is recommended to plug the microphone into a DJ mixer.

Avis: Some mixers that are not designed for DJing have a built-in USB audio interface. However, the audio interfaces
in these mixers typically send only 2 channels (one stereo pair) to the mixer, so they are not recommended.

9.3.1 Recording And Broadcasting With An External Hardware Mixer

To record or broadcast with an external hardware mixer, the output of the mixer needs to be connected to the input of
an audio interface. Most DJ mixers have an extra output for this which may be labeled «record», «session», «auxiliary»,
or «booth». Some audio interfaces for vinyl control have enough input channels to receive the output of the mixer and
timecode from two turntables. If yours does not, you may use the input of the audio interface built into your computer,
but these do not have high sound quality.

Alternatively, some DJ mixers have a built-in USB audio interface. These have inputs with phono preamplifiers for vinyl
control and usually can send the record output back to the computer without a separate audio interface. Many (but not all)
of these mixers are digital mixers, so they can send signals back and forth to Mixxx without converting them to analog.
This results in higher sound quality for your recorded and broadcasted mixes compared to using a separate audio interface
with an external mixer.

To configure Mixxx for using a hardware mixer for recording and/or broadcasting:
1. Open Preferences » Sound Hardware.

2. In the Output tab, select the audio interface for the Deck 1-2 outputs (and Deck 3-4 outputs if your audio interface
and mixer support 4 decks).

3. Click the Input tab.

4. For the Record/Broadcast input, select the audio interface connected to the mixer’s output. For mixers with a
built-in USB audio interface, refer to the mixer manufacturer’s manual to find which channels of the mixer’s audio
interface send the record output.

5. If you are using vinyl control, select the audio interface connected to the turntables for the Vinyl Control 1-4 inputs.
6. Click the Apply button.
7. Click the OK button.

Do not configure anything for the Microphone 1-4 inputs when using an external mixer. The microphone controls in
Mixxx will not affect your microphones because the microphone is mixed by the external mixer.

DJ mixers typically do not supply phantom power required for condenser microphones. Stand-alone audio interfaces
typically do supply phantom power.
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9.4 Controladors DJ amb entrades de microfon

DJ controllers with microphone inputs typically mix the microphone input with the master output without sending it to
the computer. This does not have the problem with latency that happens with Programari de monitoratge. However, many
cheap DJ controllers do not digitize the signal to make it available to the computer. Refer to the controller’s page on the
Mixxx wiki or the manual from the controller manufacturer for details about your particular controller.

If the controller does not digitize the microphone input, you cannot use Mixxx’s microphone input to record or broadcast
with the microphone using Mixxx’s Microphone 1-4 inputs. It is still possible to record and broadcast the microphone by
connecting the booth output of the controller to an audio interface input and configuring this for Mixxx’s Record/Broadcast
input. If the controller does not have a booth output, a Y splitter cable can be used on each side of the stereo main output
to connect the main output to both the speakers and to another audio interface’s input.

DJ controllers typically do not supply phantom power required for condenser microphones. Stand-alone audio interfaces
typically do supply phantom power.

9.5 Microphone Ducking

Microphone ducking is a technique to improve the audibility of speech by reducing the volume of background music
while a voice signal is recorded by the microphone and allows listeners to hear the voice more clearly and consistently.
While using Mixxx with a microphone, you might want the music to automatically fade into the background each time you
speak, or you might prefer lowering the volume of the music to a specific level. Microphone ducking helps you achieve
this. The music will “duck” out of the way of the microphone audio.

MIC 2 ' O

Figurel: The microphone ducking controls

The Strength knob adjusts the microphone talkover ducking strength and its behaviour depends on any of the Microphone
talkover modes described below. Clicking on the Auto button will switch it to any of three modes:

* Off: When you speak through the microphone, the music volume does not reduce.

¢ Auto: When you speak through the microphone, the music volume will be reduced when Mixxx detects your voice.
You can adjust the amount by which the volume is automatically reduced with the Strength knob.

* Manual:In this mode, the music will play at the volume set by the Strength knob whenever the microphone Talk
button is active, regardless of the volume coming through the microphone input. When you speak through your
microphone, set the volume to which the music should reduce by turning the Strength knob to a level that suits you.
When you disable Talk mode, the music will return to the regular volume

Suggeréncia: To set the Ducking volume correctly, you can use manual mode to adjust the knob to your taste and then
set to auto when happy.
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cHAPTER 10

Emissid en viu - Posa en marxa la teva propia emissora de radio d’internet

La emissi6 en viu amb el Mixxx et permet emetre la teva mescla per internet a oients arreu del mén.
Vegeu també:

The Utilitzant microfons chapter has detailed instructions for including input from microphones in your broadcasted mixes.

10.1 Servidors d’emissio

Servidor d’emissié remot Mixxx allows you to feed your audio stream directly to Shoutcast and Icecast streaming
servers. Depending on the number of listeners, streaming audio requires a significant amount of bandwidth.
Streaming servers provide the required bandwidth and broadcast the stream to your listeners. A popular free
streaming service is Caster.fm. A review of several free and paid stream hosts is available at broadcastingworld.net.

Internet Listenerl

Mixxx ﬂ»: Router :mtﬂ» StreamingServer Internet Listener2
l_____ 1 Internet

Listener3

Figurel: El Mixxx com a font d’emissié utilitzant un servidor d’emissié remot

Servidor d’emissié local Per a usuaris experimentats, pot ser interessant muntar el vostre propi servidor d’emissi6 local.
Aix0 fa que el vostre ordinador esdevingui una emissora de radio i els oients es connectin directament al vostre
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10.

servidor. No és necessari que el Mixxx s’executi al mateix ordinador que té el servidor d’emissi6. Tot i aix0, les
estacions professionals acostumen a tenir la font d’emissié i el servidor al mateix ordinador per motius d’estabilitat de
la emissié. Tingueu en compte que si voleu emetre a una quantitat alta d’oients, necessitareu forca ample de banda.
Llegiu la Documentaci6 Shoutcast o la Documentaci Icecast per a informacié de com configurar un servidor.

Internet Listenerl
R
Mixxx —» StreamingServer ﬂu Router : Internet Listener2
-
Listener3

Figure2: El Mixxx com a font d’emissid, utilitzant un servidor d’emissi6 local

2 Configurant el Mix

Comenceu indicant al Mixxx la informacid necessaria per a connectar-se al servidor d’emissio:

Obriu Preferéncies » Emissio en viu.
Introduiu la informacio segons s’indica en Preferéncies del Mixxx - Configurant una emissio en viu
Feu clic a Acceptar

Aneu a Opcions » Activa la emissio en viu o utilitzen les Application shortcuts per a comengar la emissio.

10.2.1 Server Connection

Tipus:Seleccioneu el tipus de servidor d’emissi6 al que us connectareu. El Mixxx és compatible amb Shoutcast 1,
Icecast 1 1 Icecast 2.

Mixxx works with Shoutcast 2 using the Shoutcast 1 protocol if you provide a stream name in Preferences > Live
Broadcasting » Stream Settings. If you don’t provide a stream name, Shoutcast 2 rejects the connection (where
Shoutcast 1 would accept this case).

Magquina: Podeu indicar la maquina ja sigui utilitzant el nom DNS, o I'adreca IP.

Usuari: El que us proporcioni el servidor d’emissié. Sense ell no podreu connectar-vos al servidor amb exit.
L’usuari per defecte per a Icecast és source mentre que per a Shoutcast és admin.

Muntatge: Un punt de muntatge és un nom tnic que identifica una emissié concreta. Per a Shoutcast no és necessari
indicar un punt de muntatge. En canvi, amb Icecast cal que ho informeu. Podeu posar el valor per defecte /mount
0 /1ive. Sino us han donat cap punt de muntatge, potser podeu posar el que us sembli. Cal que comenci amb /
(barra) i continui amb un text sense caracters especials.

Port: El que us proporcioni el vostre proveidor d’emissi6. Molts servidors utilitzen el port 8000.

10.2
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® Preferences

o)) Sound Hardware
B Controllers
i Library

o Interface

#* Wavetorms
i Auto DJ

ilil Equalizers
H Effects

[l Crossfader
B Recording

A, Beat Detection
&3 Key Detection
-9) Normalization
© Vinyl Control

Live Broadcasting

v

Enable Live Broadcasting
Server connection

Type Icecast2
Host

Login

Stream settings

Public stream
Use UTF-8 encoding for metadata.
Dynamically update Ogg Vorbis metadata.

Stream name

Website http/fwww.mixxx.org

This stream is online for testing
Description | purposes!

Genre Live Mix

Restore Defaults Apply

a Mount

Port 8000
Password

Encoding

Bitrate Format Channels

128 kbps a MP3 a Stereo a

Shoutcast metadata format
$artist - Stitle
Custom metadata
Enable custorn metadata
Artist
Title

Cancel | i

Figure3: Preferencies del Mixxx - Configurant una emissio en viu

¢ Contrasenya: La que us proporcioni el vostre proveidor d’emissid, a no ser que tingueu el vostre propi servidor.
Es necessita per a realitzar la connexi6 al servidor i iniciar la transmissio.

Avis: No poseu una URL a I'adreca de la maquina! http://exemple.com: 8000 no us funcionara. Heu de
posar exemple.coma Maquinai 8000 a Port.

10.2.2 Stream Settings

¢ Transmissio piiblica: Si s’activa, aquesta opci6 afegeix la vostra emissora de radio a I'index d’emissores de Shout-

cast/Icecast.

« Utilitza la codificacio UTF-8 per a les metadades: Si s’activa, la opcié corregeix els accents i simbols estrangers
a les metadades, sempre i quan el servidor estigui configurat per a permetre metadades UTF-8.

* Dynamically update Ogg Vorbis metadata: Due to flaws in some streaming clients, updating Ogg Vorbis meta-
data dynamically can cause listener glitches and disconnections. Check this box to update the metadata anyway.
Some players that listeners can use have bugs that can cause audio glitches or disconnections when the Ogg Vorbis
metadata is updated dynamically. If this is not a problem, you can enable this checkbox.

* Nom de la emissio: I doncs, quin és el nom del vostre xou?

» Pagina web: La pagina web que poden visitar els vostres oients.

* Descripcid: Introduiu el vostre nom de DJ i algun comentari.

» Genere: Indiqueu els estils musicals que posareu. Aix0 atreu més oients que cerquin als index d’emissores. El

Genere no pot estar en blanc.

10.2. Configurant el Mix
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10.2.3 Encoding

» Taxa de bits: Utilitzar una taxa de bits de 128 o 160 kbps és habitual i proporciona una qualitat suficient per als
vostres oients. Taxes de bits majors utilitzaran més ample de banda de la vostra connexié a internet, i per als oients
per a rebre la emissio.

e Format: El Mixxx permet emetre als servidors Icecast tant en format MP3 com en Ogg Vorbis, mentre que per a
servidors Shoutcast, només es pot utilitzar el format MP3.

10.2.4 Metadata

Shoutcast metadata format

This allows to set custom metadata formats for the Shoutcast title field. Previously only artist - title
was allowed. For example if you were broadcasting as part of a station, you could add the station’s name or
the presenter’s name in the title: MyStation | $Sartist - $title. Orif you were doing a live mix
with several artists, you could have: Live mix by MyName - currently playing: S$artist.
Or even if you wanted a very unusual format: Hey, I like S$artist, here is $title by
Sartist.

Aquestes opcions no s’apliquen si s’emet amb Ogg i Icecast2.

Custom metadata
Per defecte, el Mixxx envia l'artista i el titol de les cancons que reproduiu als vostres oients. Podeu desactivar
aquesta caracteristica i utilitzar metadades personalitzades.
¢ Activa les metadades personalitzades: Activa o desactiva les metadades personalitzades.
* Artista: Indica el valor que voleu enviar enlloc de 'artista, per exemple el vostre nom de DJ.

* Titol: Indiqueu les metadades que voleu enviar enlloc del titol.

10.2.5 Icecast contra Shoutcast

Tots dos ofereixen basicament la mateixa funcionalitat. Un servidor Icecast pot emetre tant en M/P3 com en Ogg Vorbis.
Tot i aix0, tot i que Ogg és més eficient i efectiu (ofereix millor qualitat que el MP3 a taxes de bits menors), no tots els
reproductors poden reproduir emissions en Ogg. Per aixo, el MP3 és probablement la opcié més segura a no ser que
sapigueu que els vostres oients poden escoltar emissions en Ogg sense problemes.

10.2.6 Index d’emissores
Habitualment, el servidor d’emissié afegeix la vostra estaci6 de radio a I'index d’emissores de Shoutcast/Icecast, si heu
activat la opcié Transmissio publica a les Preferéncies » Emissio en viu » Configuracio de la emissio.

 Shoutcast radio directory: www.shoutcast.com

« Index d’emissores de radio Icecast: dir.xiph.org

Often streaming hosts will run their own directories. Check your host’s FAQ to find out. If you want to promote your
streaming radio station even more, register at services like streamfinder.com. An overview of different internet radio
directories is available at shoutcheap.com
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10.3 Soluci6 de problemes

* Si teniu problemes connectant-vos al servidor d’emissid, comproveu la configuracié a Preferéncies del Mixxx -
Configurant una emissio en viu.

* Potser heu seleccionat el format Ogg Vorbis que no es compatible amb servidors Shoutcast.

* Potser heu de canviar les opcions del tallafoc. Tant el Icecast com el Shoutcast utilitzen dos ports. Si emeteu pel
un port (per exemple, el 8000), aleshores també heu d’obrir el port segiient, (8001).

* Potser cal que configureu el vostre ruter per a que reenvii les connexions entrants per a que no bloquegi les conexions
al port d’emissi6 (per exemple, port 8000)
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cHAPTER 11

Efectes

El Mixxx té un sistema molt potent d’efectes. Entendre el seu funcionament us facilitara un ventall molt variat de teécniques
per mesclar.

11.1 Unitat d’efectes

El Mixxx té 4 unitats d’efectes, perd només 2 es mostren per defecte, Les altres 2 restants es poden habilitar alternant
I'opcié adient al ment de configuracié de la interficie.

¢ MASTER

O{ 0@
Bitcrusher ~ Moog Filter -~ Echo

Figurel: Una unitat d’efectes

Each effect unit can load up to 3 effects in a chain. These effects are processed one after the other in series. You will hear
different sounds depending on the order of effects within the chain. Each effect in the chain has its own button to toggle
it on and off.

Effect units can process sound from:
e reproductors
¢ microfons
* entrades auxiliars
* the master mix

e the PFL (headphone) mix
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¢ left/middle/right crossfader buses

The buttons to route effect units to decks, microphones, and auxiliary inputs are located in the deck, microphone, and
auxiliary sections of the skin. The buttons for routing other inputs to effect units are in different locations depending on
the skin.

Figure2: The effect unit buttons located in the deck.

If a channel is assigned to multiple effect units, those effect units are chained together. This allows you to chain more
than 3 effects at a time.

To route deck 1 to effect unit 1, click the FX button on deck 1 to turn it on. To route deck 2 to effect unit 2, click the
FX2 button on deck 2, and so on. It’s also possible to route a single deck to multiple effect units, or multiple decks to a
single effect unit.

The mix knob adjusts the mix between the dry signal (input to the unit) and the wet signal (output of the last effect in the
unit). It changes the level of all 3 effects in the unit together. Refer to the Effect Unit Mix Modes section below for details.

Effects are processed after the deck faders and crossfader. This allows effects like Echo and Reverb to continue outputting
sound after their input has been cut off by lowering the fader. Unlike other DJ software and hardware, effects can also
be heard in headphones even though they are processed after the faders for the master output. Refer to the Effects In
Headphones section below for details.

Note that equalizer and filter effects create a phase shift. If the mix knob is anywhere in the middle between dry and
wet and any of these effects are enabled in the unit, there will be comb filtering which is probably not desired. For more
background information, read Equalizers and Phase Shift.

11.2 Effect Parameters & Metaknobs

Every effect within an Effect Unit has its own set of parameters. By default, these are hidden. Instead, there is a single
knob called a «metaknob» for each effect which is linked to the different parameters. The metaknob allows you to easily
control the effects in a unit without having to manipulate every parameter individually.

If you want more detailed control of effects, press the expansion button on the effect unit to reveal the effect parameters:

You can customize how the metaknob is linked to the parameters by clicking the buttons below the parameter knobs. The
button under the parameter name controls the metaknob link mode:

¢ Inactiu: parametre no enllagat

* Active: parameter moves with metaknob

» Left side active: parameter moves with left half of metaknob turn

¢ Right side active: parameter moves with right half of metaknob turn

 Left and right side active: parameter moves across range with half of metaknob turn and back with the other half
The button below the metaknob link button inverts the parameter’s relationship to the metaknob.

For information about specific effects and their parameters, hover your mouse over them to show the tooltip. If you do
not see tooltips, check that you have them enabled for the skin in Preferences » Interface.
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Figure3: An effect unit with parameters showing

Effects (except for Reverb) that have a length of time as a parameter are synchronized to the tempo of decks.

11.3 Effect Unit Mix Modes

The effect unit mix knob controls the level of all 3 effects in the unit together. It can be toggled between two different
modes with the mix mode button adjacent to it.

§ ¢ MASTER

Figure4: An effect unit in Dry/Wet mode
In the default Dry/Wet mode, the mix knob crossfades between the dry signal (input to the first effect in the unit) and the

wet signal (output of the last effect in the unit). When the knob is fully left, no sound will be heard from the effect unit.
When the knob is fully right, only the output of the effect unit will be heard without any of the dry input signal.

¢ MASTER

Figure5: An effect unit in Dry+Wet mode

In Dry+Wet mode, the dry signal is always at full volume. The mix knob controls how much of the wet signal is added
to the dry signal. A useful example for Dry+Wet mode is loading a filter or equalizer effect before the Echo effect.
With this setup, the filter or equalizer can remove bass frequencies from the echoed signal without removing them from
the unechoed signal. If the effect unit is switched to Dry/Wet mode with the same effects in the same order, the bass
frequencies will be taken out of the echoed signal, but they will also be removed from the unechoed signal.
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11.4 Effects In Headphones

To preview how a track will sound with effects before you mix in the track, simply assign the deck to an effect unit and
enable the headphone button for the deck. Note that this will increase CPU compared to assigning an effect unit to a
deck without the headphone button enabled. This is because effects are processed in parallel for the headphone output
(prefader) and master output (postfader).

Effects can also be previewed in headphones on decks that are playing to the audience, but this requires a few more steps:
1. Disable the effect unit for the deck
2. Enable the headphone button for the deck
3. Enable the headphone button for the effect unit

Enable effects and adjust their metaknobs and parameters for how you want the effects to sound.

When you are ready to mix in the effect, turn the mix knob fully left (dry)

Enable the effect unit for the deck

Turn the mix knob right so the effects are heard in the master output

®© N A

Disable the headphone button for the effect unit so you do not forget to turn it off later

11.5 Controller Effects Mapping

This section describes how to use the standard Mixxx mapping for effects sections on controllers with the typical layout
of 4 knobs (or 3 knobs + 1 encoder) and 4 buttons for effects. It allows you to switch between controlling all 3 effects of
a chain or controlling each parameter of one effect.

By default, 3 knobs are used for controlling effect metaknobs and the buttons under them toggle each effect on/off. To
temporarily toggle an effect on/off, press and hold an effect enable button. The 4th knob is used for the mix (dry/wet)
knob of the whole chain. On controllers designed for Serato, the Beats encoder is used as the mix knob.

The button next to the mix knob is used for focusing effects. On controllers designed for Serato, this button is labeled
Tap. While holding this button pressed, the enable buttons for each effect switch to choosing which effect is focused.
When an effect is focused:

* the knobs switch to controlling the first 3 parameters of that effect instead of the metaknobs of each effect in the
chain;

* the buttons switch to controlling the first 3 button parameters of the effect; and

The LED of the focus button indicates whether any effect is focused. When its LED is on, you can hold the button down
to see which effect is focused without having to look at the computer screen. To unfocus the effect, you can short press the
focus button. The focused effect is remembered, so when you short press the focus button again, the previously focused
effect will be refocused (it is not remembered when you shut down Mixxx though).

Alternatively, if you want to keep all the parameters showing on screen, you can press and hold the focus button, then
press the button of the focused effect to unfocus it. Showing all the parameters without having an effect focused is helpful
for experimenting with different ways of linking parameters to the metaknob.

When the focus button is pressed with shift, it toggles the Effect Unit between controlling different Effect Units in Mixxx.
Typically this is used to toggle between Effect Units 1 & 3 or 2 & 4, like deck toggle buttons.

To load different effects, hold shift and turn the knob for an effect.

To load chain presets 1-4, press the buttons with shift (new in Mixxx 2.4).
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CHAPTER 12

Fes de DJ amb el Mixxx

El Mixxx ha estat dissenyat per a que sigui facil d’aprendre tant per a novells com per a DJ experimentats.

Aquesta part del manual us déna indicacions per a utilitzar les caracteristiques del Mixxx per fer les vostres propies
mescles.

12.1 Ajust dels nivells de forma adequada (Gain Staging en angleés)

Establir els nivells adequadament, anomenat en angles «gain staging», és essencial per a obtenir la millor qualitat de
Iequipament que feu servir. A cada element de la cadena, des dels guanys del canal del Mixxx fins a 'amplificador, heu
de mantenir un nivell ben per sobre del soroll de fons, perd per sota de 'amplitut maxima abans de que distorsioni.
Els Monitors de nivell hauriaen d’estar al voltant de la part superior de la zona verda. El monitor a la imatge de
I'esquerra ensenya com hauria d’estar en les parts de la pista més altes. El nivell no hauria d’estar normalment a la
zona groga. Deixeu la zona groga com a marge per a evitar distorsid. Només hi haurien d’entrar els pics de la pista
a la zona groga.

mm

Figurel: Una ona d’audio a un nivell correcte. Tingueu en compte que els grafics d’ona d’aquesta secci6 s’han fet ajustant
el guany visual del mateix al Mixxx per intentar descriure els conceptes. Canviar el guany visual del grafic d’ona no canvia
el nivell de I'audio.

Si un monitor de nivell esta en la zona vermella, la senyal satura i haurieu de reduir el guany. Alguns equipa-

ments no tenen un monitor de nivell, perd disposen d’'un LED que s’ilumina quan la senyal satura. La saturacié
implica que els pics de la ona de so queden retallats perque s’ha assolit en nivell maxim possible al qual es pot amplificar
la senyal. Aix0 fa que soni distorsionat i no sigui agradable i també pot fer que I'equipament s’espalli per requerir més
potencia que la que esta dissenyat per utilitzar. Com més s’incrementi el guany, més es distorsionara la senyal. Si voleu
que soni més alt sense que distorsioni, i ja heu ajustat els guanys per a que no saturi, haureu d’utilitzar més altaveus, o
utilitzar altaveus més eficients.
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Figure2: Una ona d’audio que satura

Per altra banda, la senyal no hauria d’estar massa baixa. Aix0 és degut a que tot dispositiu d’audio genera una mica
de soroll, que es coneix per soroll de fons. A més a més, els dispositius analogics poden capturar soroll pels cables.
La senyal que ensenyem al monitor de I'esquerra esta propera al soroll de fons. Quan incrementem el guany d’un
dispositiu, el soroll de fons no augmenta, només ho fa la senyal. Pero si amplifiquem la senyal en un dispositiu
posterior, amplificarem tant la senyal com aquest primer soroll de fons. Es a dir, si teniu el volum baix a la targeta
de so, i augmenteu el guany amb el mesclador extern, la ratio de senyal respecte soroll (SNR) sera petita i el guany
del mesclador amplificara tant la senyal com el soroll de fons, a més de possibles sorolls capturats pel cable. En
definitiva, tindreu més soroll que no si haguéssiu augmentat el guany a la sortida de la targeta de so, abans que arribés
al mesclador.

Figure3: Una ona d’audio que esta massa aprop del soroll de fons

Nota: To adjust the output volume of a sound system while maintaining a high signal-to-noise ratio, the gain should be adjusted as
close to the speakers as possible. Refer to the Gain Knob section for details.

12.2 Enquadrament dels ritmes

Beatmatching is the process of adjusting the playback rate of a track so that it matches the tempo of another track.
Beatmatching also involves adjusting the phase of the beats in a track so that they are aligned with the beats in the other
track. Matching the fempo and aligning the beats are the two things a DJ must do to beatmatch.

El Mixxx us pot igualar el tempo i alinear els tocs automaticament, perd és necessari que el BPM i la graella de ritme
de les dues pistes s’hagin detectat acuradament. Per a utilitzar aquesta caracteristica, feu clic al boté SYNC. Per a fer-ho
manualment, heu d’ajustar el tempo de les dues pistes utilitzant el control lliscant de velocitat. Podeu ajustar la fase dels
tocs fent clic amb el bot6 dret i arrossegant el grafic d’ona de reproduccié per accelerar o frenar momentaniament una de
les pistes fins que quedin alineades. També ho podeu fer amb els botons d’ajustament de velocitat momentanis. Podeu
consultar el capitol Controls de sincronia i velocitat.

Dues pistes estan enquadrades quan el tempo coincideix i els seus tocs estan alineats. Un enquadrament “perfecte” és
gairebé impossible - sempre hi ha una lleugera diferéncia en la velocitat. Heu de parar l'orella i estar atents a que els tocs
es desquadrin. Sentireu un so caracteristic com de «doble tamb6» precedit d'una perdua d’intensitat del mateix degut a
la perdua de fase. Quan aix0 passa, podeu tornar a enquadrar els tocs prement un dels botons d’ajustament de velocitat
momentani en la direcci6 correcta.
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12.3 Sincronitzacio mestra

Master Sync is an intelligent assistant that allows you to leave the beatmatching to Mixxx so you can focus on track
selection, effects manipulation, looping, 4 deck mixing, and other advanced DJing techniques.

To activate Master Sync on a deck, push and hold (or click and hold) the SYNC button. You’ll know Master Sync is on
because the sync button will remain lit. Changing the rate of any deck that has Sync lit will change the rates of all other
decks that also have the Sync button lit. There is no need to set specific decks to be a master or followers. You can play,
stop, eject, load, and queue any track with master sync and it won’t interrupt the playback of the other decks. However,
changing the rate of a stopped deck will change the rate of playing decks.

La Sincronitzacié mestra es capa¢ de determinar que una pista té el doble de BPM que una altra pista, i igualar-les
correctament. Aixidoncs, si mescleu una pista drum & bass de 140 BPM amb una de 70BPM de dubstep, la Sincronitzacié
mestra les igualara adequadament.

Suggerencia: Habitualment, la Sincronitzacié mestra només s’encarrega del control de velocitat. Si voleu que també
s’encarregui d’alinear els tocs, heu d’habilitar el boté Quantitza. Si esta activat, la sincronitzacié també fara que els tocs
estiguin perfectament alineats.

12.4 Mescla harmonica

Harmonic mixing is a technique to mix songs with matching melodies and harmonies. To learn more about harmonic
mixing you might want to check out the mixshare archive.

Mixxx has two features to help you with harmonic mixing. The first is a key lock. When it is active changing the speed
of a track won'’t affect the key. To enable key lock, click the key lock button in the Grup de botons d’opcions del plat.
The second is that Mixxx can automatically detect the key of a track and will display it in the library and the decks. The
notation which is used to display a key can be changed in Key Detection Preferences.

12.5 Enregistra la mescla

With the integrated recording feature you can record your mix as an audio file and listen to it later, distribute it as a
Podcast or burn it to CD.

By default, Mixxx records the Master output. Alternatively, Mixxx can record the output of an external mixer if you have
an audio interface configured for the Record/Broadcast input in Preferences » Sound Hardware. Refer to Recording And
Broadcasting With An External Hardware Mixer for details.

Mixxx can record your mix in various audio formats and quality settings. You can split your recordings, generate cue
files, choose a custom recording directory and even set your own metadata. By default, Mixxx saves your recordings as
lossless WAV files to a Mixxx/Recordings sub-folder in the Mixxx music directory. Before you start recording, we
recommend that you adjust the settings in Preferences » Recording.

Si feu clic a la icona Enregistraments de la barra lateral de la biblioteca del Mixxx, es mostraran els enregistraments a la
taula de la dreta. Els nous enregistraments es desen aqui automaticament, junt amb el fitxer cue en cas que hagueu indicat
que s’utilitzin.

Suggerencia: Enregistrar les mescles i escoltar-les després per estudiar-les és una eina ttil per a millorar les vostres
habilitats de DJ. Envieu les mecles a altres DJ per a que us donin la opinié també pot ser Titil.
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Recording to file: 2012-11-05_15h:38m:54s.wav ( 0.69MB written )
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Figure4: Biblioteca del Mixxx - Vista d’enregistrament

12.5.1 Enregistra la mescla al disc

Click on the recording icon on top of the application window to start, and stop the recording session. The duration of the
running recording is displayed next to the icon.

Nota: The recording widget might not be available in some skins.

Alternatively:
¢ Feu clic a la icona d”Enregistraments de la barra lateral per anar a la vista de Enregistraments.
* Feu clic al bot6 Inicia l'enregistrament o a Opcions * Enregistra la mescla del menu principal del Mixxx.

¢ The display above the track table shows how much data has already been recorded, as well as the duration of the
recording.

¢ Realitza la teva mescla

* Feu clic al boté Atura l'enregistrament per a parar 'enregistrament un cop heu acabat la mescla.

Suggerencia: You can instantly play your recording as a track in Mixxx. Simply drag-and-drop the track to a deck.

12.6 Intro and Outro Cues

Intro/Outro cues are used to mix in and out of tracks and they can also be used with Auto DJ to mix in and out at those
points. Unlike hofcues, they do not mark only one point. The into and outro are sections and each section is defined by
two points.

Mixxx detects where the first and last sounds are when analyzing a track making it easy to stop playing silent parts at the
beginning and at the end of the track. The analyzer places the intro start point at the first sound and the outro end point
at the last sound. The first and last sounds are determined by the first time the signal rises above -60 dBFS and the last
time it goes below -60 dBFS.

You can decide where to place the intro end and the outro start points. Marking the whole intro and outro allows Mixxx
to calculate how long each section is and show it on the overview waveform. This information can help you know when to
press play on the next track. Auto DJ can also use this information to line up tracks and determine how long to crossfade.
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Figure5: Intro start and outro end cues placed at the first and last sound of a track respectively by the analyzer

|4 4 I N

Figure6: Intro end and outro start markers placed on the track alongside the intro start and the outro end markers to make
sections
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12.6.1 Mixing With Intro & Outro Cues

You can line up the ends of the intro and outro so the energy of the new song picks up right as the old track ends.

Figure7: Intro and outro end markers aligned showing on the waveform

If the intro and outro are short enough to fit on the waveform at the same time, you can simply watch the waveforms
and press play when the markers align. Otherwise, you can watch the time remaining on the deck and hover your mouse
cursor over the outro end line on the overview waveform. Mixxx will show you how much time is left until that point.
When that time equals the length of the intro, press play to precisely line up the end of the intro. If you have changed the
tempo of the track, the time remaining scales to show the real time remaining at the adjusted tempo.

R

ld 4 I x| |4 4 N |

Alternatively, you can line up the start of the intro & outro. In this case, watch the scrolling waveform when the outro
start point is coming up on the old track. Then, press play on the new track when the old track reaches the outro start.

Nota: There are no rules on which method should be used. The method you decide to use is an artistic
judgement based on the musical content of each track, what the vibe of the crowd is at that moment, and
what you want to do with the mix.

If you do not have the intro end and outro start points marked when loading a track, you can find and mark these in
headphones before you mix in the track. Then seek back to the intro start to get the track ready. If you don’t have time to
find the outro end point before mixing in the track, you can use the deck cloning feature to drag and drop to a new deck,
then seek ahead on the new deck and listen in headphones to mark the outro start point. If you don’t have time to do that
either, you can right click on the overview waveform where you think the outro starts. Then look for how far that is from
the end of the track to compare it to the length of the intro of the next track.

3:39-0:30
105

Figure8: Here the outro is approximately 30 seconds long. However, the analyzer placed the outro end point before the
end of the track, so the outro is actually a little bit shorter than 30 seconds. Without marking the outro start point, you
would have to do some math in your head to find exactly how long the outro is.
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12.7 Auto DJ

Skip Track
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Figure9: Biblioteca del Mixxx - Vista de DJ automatic

El DJ automatic permet carregar pistes automaticament de la seva cua de reproduccio i passar d’una a Ialtra amb I'ts del
crossfader quan s’esta acabant. Consulteu DJ Automatic - Mescleu de manera automatitzada.

Auto DJ does not take into account the volume of each track, nor the frequency content, nor the rhythms, so it’s not
intended to be a replacement for a human DJ. However, it is good enough to give a human DJ a break without a major

disruption to the mix.

12.7.1 Carrega de pistes al DJ automatic

Heu de carregar les pistes que voleu reproduir a la cua de reproduccié del DJ automatic. Aquesta llista esta buida inicial-

ment.

Search...

Library
Auto DJ
Playlists

sample (30) 01:16:47

timecode
Crates
Browse
Recording
History
Analyze
iTunes
Traktor

# Preview Cover Art

Fiam
Fue g
Fie g

Create New Playlist
Add to Auto DJ Queue (bottom)

Add to A

s

Duplicate
Remove
Lock

Analyze entire Playlist

Import Playlist
Export Playlist

Figure10: Biblioteca del Mixxx - Afegint una llista reproduccié al DJ automatic

Hi ha diverses maneres de carregar pistes a la cua de reproduccié del DJ automatic:

* Seleccioneu una o més pistes de la Biblioteca, una llista de reproduccid, o una caixa i arrossegueu-les a la icona del

DJ automatica de I'esquerra.

12.7. Auto DJ
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Seleccioneu una caixa o llista de reproduccio, feu clic amb el boté dret del ratoli i seleccioneu la opcié de ment
Afegeix a la cua del DJ automatic. Aixo afegira les pistes al DJ automatic.

Mentre esteu a la vista de DJ automatic, arrossegueu pistes des d’exploradors de fitxers externs a la icona del DJ
automatic, de la barra lateral, o directament a la cua del DJ automatic.

12.7.2 Automatically adding tracks from crates

Instead of inserting the contents of the crates directly into the Auto DJ playlist, Auto DJ crates are associated crates that
become a source of random track selections.

Add a crate to the Auto DJ track sources: Expand the Auto DJ item in the sidebar, and right-click on the Crates
sub-item. Select one of the existing crates from the list. This makes the content of the crate available for random
selection into the Aufo DJ queue for automatic mixing. The name of the crate is now listed as sub-item below.

If you do not have any crates available for selection in the list, go and create a crate first and add some tracks, see
Crates - Organizing tracks into collections.

Manually add tracks from track sources to Auto DJ: Click the Auto DJ item in the sidebar and switch to the
Auto DJ view of the library. Click the Add random button to add one track at the time from Auto DJ track sources
to the bottom of the Auto DJ playlist.

Nota: If you did not set any crates as an Auto DJ track source, clicking the Add Random button will add a
randomly selected track from the whole library instead.

Automatically add tracks from track sources to Auto DJ: Mixxx can randomly add tracks to the Auto DJ
playlist from track sources as soon as a specified minimum number of tracks remain. Select Preferences » Auto DJ
» Enable random track addition to queue » On. Set Minimum allowed tracks before addition to change the minimum
number of tracks after which random tracks may be added.

Nota: If you did not set any crates as an Auto DJ track source, tracks are selected from the whole library instead.

Remove a crate from the Auto DJ track sources: Expand the Auto DJ item in the sidebar, and right-click on
one of the crates listed below the Crates sub-item. Select Remove Crate as Track Source to remove the crate from
the Auto DJ track sources.

12.7.3 Reproduccio6 de les pistes amb DJ automatic

Un cop tingueu pistes carregades a la cua del DJ automatic, podeu activar-lo de la segiient manera:

Feu clic a la icona de DJ automatic de la barra lateral per anar a la vista del DJ automatic.
Feu clic al bot6 Activa el Dj automatic.

Les primeres pistes de la cua es carreguen als plats i comenca la reproduccid.

El Mixxx continuara mesclant automatiament fins que es buidi la cua del DJ automatic.

Feu clic al boté Desactiva el DJ automatic per a parar la mescla desatesa

Suggerencia: You can add a track to the end of the Auto DJ playlist once it is played instead of removing it. Set
Preferences » Auto DJ » Re-queue tracks after playback » On.
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12.7.4 Auto DJ Mix Modes

Auto DJ has several modes it can use to mix tracks:
e Full Intro + Outro
¢ Fade At Outro Start
 Full Track
« Skip Silence

The Full Intro + Outro and Fade At Outro Start modes both use the intro and outro cues but the Full Track and Skip
Silence cues do not.

Full Intro + Outro and Fade At Outro Start

The Full Intro + Outro and Fade At Outro start Auto DJ modes use the infro & outro cues to determine how long to
crossfade and how to align the tracks in time. In both modes, Auto DJ compares the duration of the outro of the old track
and the intro of the new track. Auto DJ picks the time of the shorter section as the crossfade time.

In both modes, if the outro is shorter than the intro, Auto DJ will align the start of the outro with the start of the intro.
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Figurel1: Intro and outro start markers aligned by Auto DJ

The two modes work differently when the outro is longer than the intro.

Full Intro + Outro Mode The full length of both the intro and the outro are always played. When the outro is longer
than the intro, Auto DJ aligns the end of the intro and outro by starting the next track during the outro of the
previous track. This mode is the most likely to sound good with the widest variety of tracks. Therefore, it is the
default mode.
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Figure12: Intro and outro start cues aligned by Auto DJ in Full Intro + Outro mode

Fade At Outro Start Auto DJ always aligns the start of the intro and outro. When the outro is longer than the intro,
Auto DJ cuts off the end of the outro. This can be helpful if you want to prevent the energy of the mix from
declining during a long outro. However, the transition may sound abrupt if the intro is short.
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Figure13: Intro and outro start cues aligned by Auto DJ in Fade At Outro mode

Full Track and Skip Silence

The Full Track and Skip Silence Auto DJ modes do not use the intro and outro cues. They crossfade tracks over a number
of seconds that you specify in the box next to the mode selection menu. The Full Track mode plays the entire length of
every file. The Skip Silence mode works the same way but automatically cuts out silence at the beginning and ends of
tracks (defined as when the signal first goes above or below -60 dBFS).

Suggeréncia: If you still want to use Auto DJ like a normal music player application, use one of these modes with a
transition time of 0 seconds.
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Preferéncies
Mixxx has many options to customize in Options > Preferences.
- .
13.1 Maquinari de so
eCe # Preferences
L3
Sound Hardware -
» & Controllers Sound API Core Audio H
i Library Sample Rate 44100 Hz E
o Interface . f—
#¢ Waveforms Audio Buffer 23.2ms H
Auto DJ Multi-Soundcard Synchronization Default (long delay) E
Equalizers " . . =
T Effects Keylock/Pitch-Bending Engine Rubberband (better) g
gl Crossiader Master Mix Enabled H
I Recording Master Output Mod St &
N\ Beat Detection L © ereo g
44 Key Detection Microphone/Talkover Mix Master output u
) Normalization —~
Headphone Del 0,00
© Vinyl Control B o ms e
X Live Broadcasting Master Delay 0,00 ms z
Query Devices
[ Outout JLEN,
Master Built-in Output E Channels 1 - 2 E
Headphones None E E
Restore Defaults Apply Cancel *

Figurel: Prefereéncies de maquinari de so del Mixxx

To achieve the best performance with Mixxx it is essential to configure your audio buffer, sample rate, and audio API.
These three factors largely determine Mixxx’s responsiveness and reliability. The optimal settings will vary based on your
computer and hardware quality.

For information about the different input and output options, refer to Configuring sound input and output. The Maquinari
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DJ chapter explains different types of DJ hardware and how to set them up with the input and output options. If you are
using a microphone, refer to the Utilitzant microfons chapter.

13.1.1 Memoria intermedia d’audio

La memoria intermedia d’audio és la quantitat d’audio en mil-lisegons que el Mixxx processa al mateix temps. Aquest
factor determina la laténcia entre els canvis als controls del Mixxx com ara en moure el crossfader o prémer el boté de
pausa i el que triga a poder-se apreciar aquests canvis a 'audio. Per exemple, amb una memoria intermedia de 23 ms, el
Mixxx trigara aproximadament 23 mil-lisegons a reproduir 'audio una vegada premeu el boté Inicia. La latencia actual
dependra de diversos factors.

The audio buffer setting determines how quickly your operating system expects Mixxx to react. A smaller audio buffer
means Mixxx will be more responsive, but requires a faster CPU and quality audio interface. Setting your audio buffer too
small may be too much for your computer and audio interface to handle. In this situation, Mixxx playback will be choppy
and very clearly distorted as your system will not be able to keep up with how frequently Mixxx is trying to process audio.
It is recommended to set your audio buffer as small as your system can handle reliably without glitches. Experiment with
different audio buffer sizes to find what works for your system.

An audio buffer between 23-64 ms is acceptable if you are using Mixxx with a keyboard/mouse or a controller. An audio
buffer below 10 ms is recommended when vinyl control is used because Mixxx will feel unresponsive otherwise.

The Adjusting Audio Latency page on the Mixxx Wiki has tips for different operating systems that may help you use a
smaller audio buffer reliably.

Avis: Your system may glitch only occasionally if you have your audio buffer set a little too low. This will happen
at unpredictable times and you may not notice if you are only doing brief tests of each audio buffer size. When you
think you have found a good buffer size for your system, play with Mixxx for at least a half hour before performing
to ensure no glitches happen.

13.1.2 Frequiéncia de mostreig

The sample rate setting in Mixxx controls how many samples (chunks of audio) per second are produced by Mixxx. This
determines the maximum frequency in Mixxx’s signal, which is half the sample rate. Humans can only hear up to 20
kHz, so there is generally no need to use more than a 44.1 kHz (44100 Hz) sample rate for playback. Most music is
published with a 44100 Hz sample rate, and playing music in a different sample rate than the audio file slightly reduces
sound quality.

Avis: A sample rate of 96 kHz gives your computer less than half the time to as to do the same processing. Increasing
the sample rate will increase CPU usage and likely raise the minimum audio buffer size you can use reliably.

13.1.3 APl de so

The Sound API that Mixxx uses is the method by which Mixxx talks to your operating system in order to deliver audio to
your audio interface. Your choice of Sound API can drastically affect Mixxx’s performance on your computer. Therefore
it is important to take care to choose the best Sound API available to you.
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Windows

Per a Windows estan disponibles aquestes API de so:
¢ ASIO: Bona
« WDM-KS: Bona
* WASAPI: Acceptable
* DirectSound: Dolenta
e MME: Dolenta

It is best to use the ASIO Sound API that bypassses the sound processing of the Windows kernel. Using ASIO requires
a driver for your audio interface from the manufacturer. Check the manufacturer’s website to see if a driver download is
available. Soundcards designed for musicians almost always have an ASIO driver available, but audio interfaces built into
computers and very cheap audio interfaces typically do not have an ASIO driver. If there is no ASIO driver available for
your audio interface, use the WDM-KS API. There is generally no advantage to using ASIO4ALL, a wrapper around the
WDM-KS APIL

GNU/Linux

Per a GNU/Linux estan disponibles aquestes API de so:
* ALSA: Bona
* JACK: Bona
* OSS: Acceptable

ALSA is the simplest sound API to configure. Using ALSA will prevent any other programs from using the audio
interface(s) that Mixxx is using.

JACK allows you to route audio between JACK-compatible applications in flexible ways and output sound from multiple
programs at the same time. However, JACK can be complicated to set up. Unless you will be connecting Mixxx to other
JACK-compatible applications, JACK offers no advantages over ALSA. To use JACK, start the JACK daemon before
running Mixxx. Otherwise JACK will not appear as a Sound API in the preferences.

Most modern GNU/Linux distributions use PulseAudio by default. When launched from a GUI menu entry or icon,
Mixxx suspends PulseAudio while it is running so that Mixxx can use ALSA directly. Like JACK, PulseAudio allows
multiple programs to access one audio interface, but PulseAudio and JACK have opposite design goals. PulseAudio is
designed to make ordinary computer usage such as watching videos online and listening to music easy whereas JACK
is designed for demanding low latency audio programs like Mixxx. It can be difficult to setup JACK and PulseAudio to
work well together. So, unless you already use JACK, it is easiest to let Mixxx suspend PulseAudio and use ALSA.

If the PulseAudio plugin for alsalibs is installed on GNU/Linux, you can choose the virtual device pulse. This allows
Mixxx to share the default system audio interface with other media players. This only works if you start Mixxx without
pasuspender, which you can do by running mixxx from a console rather than clicking the launcher icon in a menu or on
your desktop. Since the sound stream is routed from ALSA to Pulse and back to ALSA, this adds an additional latency
of ~2 x the selected audio buffer size.

OSS is an Sound API that predates ALSA. Few modern audio interfaces have OSS drivers.
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macOS

CoreAudio és I'inica API de so disponible per a macOS.

13.1.4 Altres opcions de maquinari de so

¢ Multi-Soundcard Synchronization: Mixxx is able to use two or more audio interface at a time, each with its own
clock. When multiple audio interfaces are in use, the Mixxx engine is driven by the Master audio interface. Here
you can select the synchronization used for the other audio interfaces to avoid buffer overflows or underflows.

¢ Keylock/Pitch-Bending Engine: This allows you to select the engine used for independent tempo and pitch
changes (e.g. key lock). Use Soundtouch on lower power machines (such as netbooks) or if you experience buffer
underflows while using key lock.

e Master Mix: You may disable the master mix to reduce Mixxx’s CPU usage if you do not use the Master output,
recording or live broadcasting.

* Master Output Mode: In Mono mode, the left and right channel are combined into a mono signal which is passed
to both channels of your master audio interface. This is useful for setups where the audience cannot hear your mix
in stereo because of speaker placement or playing in a space with lots of reverberation.

* Buffer Underflow Count: Underflows (data is not available when needed) indicate that some of the subsystems in
Mixxx can’t keep up with real-time deadlines imposed by the current audio buffer size. This is useful to tune the
latency settings. If the counter increases, then increase your audio buffer size, decrease the sample rate setting or
change the sound API setting if available.

13.2 Biblioteca

13.2.1 Canvi de les carpetes de musica

Podeu afegir, reenllacar i elimiliar del Mixxx les carpetes de musica des de Preferéencies *» Biblioteca.

Addiccié d’una carpeta nova de miisica El Mixxx permet utilitzar més d’una carpeta de musica per a la Biblioteca.
Feu clic a Afegeix per a seleccionar la carpeta on teniu la mudsica. El Mixxx revisara aquesta carpeta i les seves
subcarpetes per si s’afegeixen noves pistes.

If you add a directory that is already in your library, or you are currently rescanning your library, the operation is
canceled.

Directories can also be added from the Computer sidebar item inside the library.

Corregiu una carpeta de musica existent If an existing music directory is moved or renamed, Mixxx doesn’t know
where to find the audio files in it. The tracks will still show in library but they can’t be loaded on decks and the
tracks will become missing after the library is rescanned.

To relink the music directory, go to Preferences *» Library, click Relink to select the music directory in its new
location. This will re-establish the links to the audio files in the Mixxx library.

Click Library » Rescan Library, this will update the tracks and cause them to show up again in the library, check
the location column in the library and you should see that it now points to the new music directory.

The playlists, crates, history and all track data like cue points, rating, comments etc. are preserved after relinking
the library, the tracks are also not re-analyzed as the cached analysis is reused. You can confirm this by checking
the Key and BPM columns to see if there is a key and BPM for every track.

13.2. Biblioteca 104



Mixxx User Manual, Versié 2.3.0

Nota: Itis recommended to take a backup of your Mixxx configuration files before moving or renaming music directories
used in Mixxx. The location of Mixxx configuration files vary based on the operating system:

¢ Windows: $USERPROFILE%\Local Settings\Application Data\Mixxx\
e macOS: Library/Application Support/Mixxx

 Linux: The configuration files are found in the .mixxx folder in your home directory.

Supressié d’una carpeta de misica Feu clic a Elimina, i el Mixxx no revisara més la carpeta i les subcarpetes per trobar
noves pistes. Us preguntara que ha de fer amb les pistes d’aquestes carpetes que estan a la Biblioteca.

* Seleccioneu Amaga les pistes per amagar totes les pistes d’aquesta carpeta i les subcarpetes.

* Seleccioneu Esborra les metadades de les pistes per a esborrar les metadades de la Biblioteca del Mixxx
permanentment.

¢ Seleccioneu Deixa les pistes sense canviar par a mantenir les pistes a la Biblioteca.
Si amagueu les pistes es mantindran les seves metadades en cas que les torneu a afegir més endavant.

Metadades significa tots els detalls de la pista (artista, titol, comptador de reproduccid, etc.) aixi com les graelles
de rtime, les marques directes i els bucles. Aquesta acci6 només afecta a la biblioteca del Mixxx. Els fitxers del
disc no es canviaran ni s’esborraran.

Suggeréncia: Quan canvieu els directoris de muisica, necessitareu actualitzar les dades de la Biblioteca. Ho podeu pel
menu Biblioteca » Torna a escanejar la biblioteca.

13.3 Colors

13.3.1 Selecting Palettes and Default Colors
Track/Hotcue Palette It is possible to assign colors to tracks and hotcues to highlight them. Mixxx offers a selection of
different palettes that you can choose colors from.

You can also make your own palette by clicking the Edit button next to the palette name. This will open a the palette
editor.

Default Hotcue Color It is possible to either select a single color from the current hotcue palette that will be assigned to
all newly created hotcue colors, or select the By hotcue number option. The latter will automatically assign a color
from the palette to new hotcues based on the hotcue number.

13.3.2 Editing Palettes

The palette editor allows you add, modify, reorder and remove colors in a color palette and save it under a new name.
You can also delete custom palettes.

To modify a color, double-click it to open the color picker window.

When editing the hotcue palette, the palette editor also allows assigning a specific default color to a hotcue number. This
setting is honored when Hotcue default color is set to By hotcue number.

That makes it possible to assign just a few distinct colors to your hotcues automatically, but still have more colors available
in the palette in case you want to override the color manually.
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For example, if you have a color palette consisting of 4 colors, and you configure the palette to assign the first color to
hotcue 1 and the third color to hotcue 2, then hotcue 1 will use the first color and hotcue 2 will be assigned the third color.
The colors will repeat when setting a hotcue with a number greater than those used in the palette. In the example above,
hotcue 3 will use the first color and hotcue 4 the second color, and so on.

You can also assign the same color to more than one hotcue. For example by separating the hotcue numbers with a comma
(“2, 4, 7”), expressing a range of numbers (“1 - 3”) or any combination of that (“6, 1 - 3, 77).

If no color in the palette has a hotcue number assigned to it, new hotcues will use the color at the same index from the
palette (i.e. hotcue 1 will be assigned the first color in the palette, hotcue 2 uses the second color in the palette, etc.).

13.3.3 Replacing Hotcue Colors

Sometimes it’s necessary to bulk replace colors of existing hotcues in your library. Instead of changing the color of every
single hotcue manually, you can Replace to open the cue color replace dialog.

In addition to selecting the new color, you may set conditions that determine which hotcues the new color will be assigned
to. If you tick both checkboxes, the new color will only applied if both conditions match.

13.4 Deteccio de ritme

El Mixxx utilitza un detector de BPM i de ritme ultra-precis. No és necessari els ajustaments manuals en la majoria de
caos perque el Mixxx ja sap on es troben els tocs.

La detecci6 del BPM i de la graella de ritme és una operacié complexa. Depenent de I'ordinador, de la taxa de bits de la
pista i de la durada, pot tardar una estona. Per defecte el Mixxx analitza la pista completa. Per tal d’accelerar la detecci6
en ordinadors lents, hi ha la opcié “d’analisi rapida”. Si I'activeu, el BPM es calcula analitzant el primer minut de la pista.
En general, aix0 no afecta la detecci6 de la graella perque la majoria de musica de ball actual té la signatura de 4/4 amb
un tempo fix.

La taula segiient resumeix les opcions de detecci6 de ritme

Opcid Descripcio
Activa I'analisi rapid If enabled, BPM will be detected by only using the first minute of audio.
Assumeix un tempo constant Si l’activeu, el Mixxx assumeix que la distancia entre els tocs és constant. Si el

desactiveu, s’utilitzara la graella de ritme tal qual s’ha detectat. Aquest cas és
util per a pistes que tinguin un tempo variable.

Activaci6 de la correccié de de- | Evita que els tocs s’ubiquin incorrectament.

splagcament
Torna a analitzar el ritme si les | If enabled, Mixxx over-writes old beat grids from prior versions. Moreover, it
preferéncies canvien o si la infor- | will re-analyze the BPM if your beat detection preferences change or BPM data
maci6 de ritme és obsoleta. from 3rd party programs are present.
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00 # Preferences
) Sound Hardware Enable BPM and Beat Detection
» [ Controllers
Choose Analyzer
fiii Library
o Interface Beat Analyzer: Queen Mary Tempo and Beat Tracker a
#* Waveforms
i Auto DJ Analyzer Settings
ilil Equalizers Enable Fast Analysis (For slow computers, may be less accurate)
M Effects Assume constant tempo (Recommended)
=[l= Crossfader Enable Offset Correction (Recommended)
B Recording Re-analyze beats when settings change or beat detection data is outdated
&3 Key Detection BPM Range
i) Normalization . = . =
© Vinyl Control Min: |70 |2 Max: 140 | 7
X Live Broadcasting
M Modplug Decoder
Restore Defaults Apply Cancel “

Figure2: Preféncies del Mixxx - Opcions de BPM

13.4.1 Correccio de les graelles de ritme

Hi ha situacions en les que el BPM i la detecci6 de ritme no generen una graella de ritme correcta.

Typically, the detected BPM is correct but the analyzer has failed to detect the location of the first beat. Consequently,
the beat markers are shifted, i.e. the beat markers are a fixed distance from the true beat. To adjust the beat grid, cue the
track before a real beat and click the Beat-grid Adjust button in the Grup de botons d opcions del plat.

Si el BPM detectat no és precis, la graella de ritme també sera imprecisa. Una desviaci6 de 0,02 BPM pot causar problemes
dalineaci6 en pistes llargues (com en un club mix). Si aix0 passa, la graella semblara estar ben alineada al comengament,
pero anira desplacant-se a mesura que la cancé avanga. En general, podeu trobar el BPM facilment, seguiu la suggeréncia
seglient.

Nota: Si el valor de BPM detectat és gairebé un nombre enter, proveu de posar el valor enter manualment al camp de
BPM.

13.5 Deteccio de clau musical

Mixxx comes with a high precision musical key detector to help you make smooth mixes by ensuring that your tracks are
musically compatible.
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13.5.1 Configuracié de I'analitzador

La detecci6 de clau musical és una operaci6 complexa. Depenent de I'ordinador, de la taxa de bits de la pista i de la durada,
pot tardar una estona. Per defecte el Mixxx analitza la pista completa. Per tal d’accelerar la detecci en ordinadors lents,
hi ha la opci6 “d’analisi rapida”. Si I'activeu, la clau musical es calcula analitzant el primer minut de la pista.

[ I ) # Preferences

#) Sound Hardware Enable Key Detection

» @ Controllers

Cheose Analyzer
i Library
o Interface Key Analyzer: Queen Mary Key Detector d
e Waveforms
i@ Auto DJ Analyzer Settings
ilil Equalizers Enable Fast Analysis {For slow computers, may be less accurate)
W Effects Re-analyze keys when settings change or 3rd-party keys are present
- Crosstader
B Recording Key Notation
2\, Beat Detection
Key Detection Lancelot OpenKey o Traditional Custom
-)) Normalization
© Vinyl Control A A Bb Bb BB cc Db Db DD
X Live Broadcasting Eb Eb EE FF F# F/G b G G Ab Ab
Am Am Bbm Bbm Bm Bm Cm Cm Cé#m Ctm Dm Dm
Ebm }#m/Ebm Em Em Fm Fm F#m F#m Gm Gm G#m GHm
Restore Defaults Apply Cancel “

Figure3: Preferencies del Mixxx - Opcions de clau musical

La taula segiient resumeix les opcions de detecci6 de clau musical:

Opcid Descripci6

Activa I'analisi rapid Si l’activeu, la clau es detecta només en el primer minut d’audio.

Torna a detectar la clau musical si les op- | Si 'activeu, el Mixxx torna a analitzar les pistes si heu seleccionat un com-
cions canvien, o la informacié de clau és | plement de detecci6 de clau diferent, o I'analisi es va generar amb un altre
antiga. programa.

Notacié musical Canvia la manera en que es mostren les claus a la Biblioteca.

13.6 Equalitzadors

Preferences » Equalizer allows you to setup the equalizers.

* Equalizer Rack: The Equalizer Rack is a special effect rack that is connected to the deck’s equalizer and filter
controls.

In this section you can select the equalizers and quick effects that are used with the decks.

¢ Equalizer Plugin: Here you can select the effect that is used as the mixing EQ in each deck. By default only
built-in equalizers are displayed. Unchecking Only allow EQ knobs to control EQ specific effects allows you to select
any other effect.

* Quick Effect: Here you can select the effect that is controlled by the dedicated filter knob in each deck. By default
only built-in filter effects are selected for all decks, but that can be changed as above.

* High/Low Shelf EQ: This slider sets the crossover frequencies of the mixing EQ. It controls which frequency
range is affected by the low, mid, and high channel EQ knobs. By default the low knob controls the bass and sub
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eCe

o) Sound Hardware
» [ Controllers

il Library

o Interface

#* Waveforms

i Auto DJ

.M Effecis

=l Crosstader

= Recording

A, Beat Detection

43 Key Detection

-4) Normalization

© Vinyl Control

X Live Broadcasting

# Preferences

Equalizer Rack
Only allow EQ knobs to control EQ-specific effects
Use the same EQ filter for all decks

Equalizer Plugin Quick Effect

EQ Effect Bessel8 LV-Mix EQ d Filter

High Shelf EQ
16 Hz 2,484 kHz
Low Shelf EQ
16 Hz 246 Hz
Master EQ

None d

Miscellaneous

Reset equalizers on track load
Bypass EQ effect processing

Restore Defaults Apply

Figure4: Preferéncies d’equalitzaci6

20.05 kHz

20.05 kHz

Cancel | |

bass range up to 246 Hz. The mid knob controls the mid range up to 2.5 kHz. The remaining treble range is

controlled by the high knob.

¢ Master EQ: This section allows you to setup an EQ that affects the master output.

13.6.1 Mixing Equalizers

Mixxx offers three types of mixing equalizers with a full kill option. These equalizers are «isolators», adapted from
analog crossover networks. Each EQ is combination of a high shelf filter, a band pass filter, and a low shelf filter. Each
EQ type has a unique sound, so try them out to find out which one you prefer.

The Bessel EQs with Lipshitz and Vanderkooy Mix (LV-Mix) do not alter the sound or take any processing time when
their knobs are in the center position. They activate once you adjust an EQ knob.

The Linkwitz-Riley EQ on the other hand always applies a minimum, natural sounding phase shift to the sound. Their
processing time does not change when you adjust the EQ knobs.

The following table compares some technical parameters:

Tipus tall roll-off phase shift | bit perfect | CPU usage
Besseld LV-Mix | suau -24 db/Oct | linear si low

Bessel8 LV-Mix | medium | -48 db/Oct | linear s medium
Linkwitz-Riley sharp -48 db/Oct | minimum no high

* cut: the frequency response (curve form) at the cross over frequency.

* roll-off: The steepness of the EQ bands.

* linear phase: No phase distortion, all frequencies are processed with the same group delay.
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e minimum phase: A natural phase distortion, the group delay changes by the frequency.
* bit perfect: Whether the EQ leaves the original samples untouched when the EQ is at unity.

* CPU usage: Processing time needed to calculate the EQ output.
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cHAPTER 14

Opcions avancades

14.1 Afegiu suport per a la vostra controladora MIDI/HID

With several dozens of DJ controllers supported out-of-the-box, Mixxx gives you comprehensive hardware control for
your DJ mixes, see Amb controladores MIDI/HID.

Support for additional devices can be added to Mixxx by creating a new mapping file. This file tells Mixxx how to translate,
or map, MIDI/HID messages from a controller into commands that Mixxx understands.

You can download and share custom controller mappings in the Mixxx User customizations forums.

For a list of controls that can be used in a controller mapping, see Mixxx Controls.

14.1.1 Assistent d’aprenentatge

By far, the easiest way to create a new MIDI mapping is by using the Controller Wizard.

1.

._
e

© ® 2N ok w N

Connecteu la(les) controladora(es) a I'ordinador

Inicieu el Mixxx

Aneu a Preferéncies » Controladores

Seleccioneu el dispositiu de la llista de dispositius disponibles de I'esquerra, i canviara la informaci6 al panell dret
Marqueu la opcié Activat

Feu clic a Assistent d'aprenentatge per a obrir la finestra de seleccid

Feu clic a qualsevol control de la interficie

També podeu fer clic al botd Trieu el control i trieu-ne un de la llista

Premeu Aprén i moveu el control o premeu el boté de la vostra controladora per a mapejar-lo. També podeu moure
el control sense prémer el boté Apreén si esteu aprenent miiltiples controls.

Si esteu aprenent un botd, pulseu-lo un sol cop. Si esteu aprenent una rodeta o un control lliscant, moveu-lo de
principi a fi per tal d’aprendre el rang complet.
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800 Controller Learning Wizard

Click any control in the Mixxx interface or choose one from
the list. Then move a control on your controller to map it.
Repeat this as many times as you wish. When you are
finished mapping controls, click Done.

Mixer Choose Control
Transport
BPM and Sync
Pitch and Rate
Equalisers
Vinyl Control
Cues

Hotcues
Looping
Beat-Looping
Library
Effects
Microphone
Auto D)

User Interface

[ Done '

Y Y Y Y Y Y YYYYYYYYY

Figurel: Assistent d’aprenentatge del Mixxx - Assignant un control

11. After Mixxx detects the control, you may click Learn Another or you can click on another button in the Mixxx GUI
to learn another control.

12. Un cop hagueu acabat d’assignar els controls, feu clic a Fet
Hi ha algunes opcions avancades a I’assistent de MIDI que potser necessitareu utilitzar:

 Soft Takeover: Use this option for knobs or sliders to avoid sudden jumps in when the knob in the GUI doesn’t
match the physical knob. If you select this option, you won’t be able to perform super-fast motions as easily.
(Recommended off)

* Invert: Use this option for controls that you want to work backwards from how they were detected.

¢ Mode de boté: Utilitzeu aquesta opcié amb controladores que tinguin controls que facin d’interruptors i emetin un
valor en activar-se i un de diferent en desactivar-se (Com un selector, o un boté que es queda illuminat quan es
prem, i s’apaga al tornar a prémer).

* Jog Wheel / Select Knob: Utilitzeu aquesta opcié amb rodetes que no tinguin un inici i u final, sin6 que giren sense
parar.

The Controller wizard saves the new mapping to the following file paths:
e Linux: /home/<username>/.mixxx/controllers

* macOS: /Users/<username>/Library/Containers/org.mixxx.mixxx/Data/Library/
Application Support/Mixxx/controllers

¢ Windows: $LOCALAPPDATA%\Mixxx\controllers

You can then modify the XML file it creates (or any of the ones that ship with Mixxx) if you'd like
to fine-tune it or add more mappings. For more information, go to https://github.com/mixxxdj/mixxx/wiki/
MIDI-Controller-Mapping- File-Format.

L’assistent d’aprenentatge només funciona amb dispositius MIDI. Per ara no es pot mapegar tecles de modificadors (ma-
juscules) i controls. Utilitzeu Scripts MIDI en aquest cas.
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14.1.2 Scripts MIDI
El Mixxx ofereix suport per a caracteristiques avancades de moltes controladores MIDI/HID amb el que anomenem scripts
de MIDI.

It enables MIDI controls to be mapped to QtScript (aka Javascript/EMCAScript) functions stored in function library files,
freeing Mixxx from a one-to-one MIDI mapping ideology. These user-created functions can then do anything desired with
the MIDI event such as have a single controller button simultaneously affect two or more Mixxx properties (“controls”),
adjust incoming control values to work better with Mixxx (scratching), display a complex LED sequence, or even send
messages to text displays on the controller.

For more information, go to https://github.com/mixxxdj/mixxx/wiki/Midi-Scripting and https://github.com/mixxxdj/
mixxx/wiki/hid_mapping_format.

14.2 Personalitza les dreceres de teclat

Les dreceres de teclat predefinides estan definides en fitxers de text que trobareu a la segiient ubicacio:
e Linux: /usr/local/share/mixxx/keyboard/en_US.kbd.cfg
* macOS: /Applications/Mixxx.app/Contents/Resources/keyboard/en_US.kbd.cfg
¢ Windows: <Mixxx installation directory>\keyboard\en_US.kbd.cfg

Depending on your system’s language settings, Mixxx might use a different file as default, e.g. de_DE.kbd.cfg for
German or es_ES . kbd. cfg for Spanish.

It is not recommended that you modify the system-wide keyboard mapping file because all your changes may be lost if
you uninstall or upgrade Mixxx. Instead, copy the default mapping file to the following location:

e Linux: ~/.mixxx/Custom.kbd.cfg

¢ macOS: ~/Library/Containers/org.mixxx.mixxx/Data/Library/Application
Support/Mixxx/Custom.kbd.cfg

e Windows: $LOCALAPPDATA%\Mixxx\Custom.kbd.cfg

Then edit this file and save the changes. On the next startup, Mixxx will check if Custom.kbd.cfg is present and
load that file instead of the default mapping file. This has the advantage that you can always revert back to the default
mapping by deleting Custom.kbd.cfg.

For a list of controls that can be used in a keyboard mapping, see Mixxx Controls.

You can download and share custom keyboard mappings in the Mixxx User customizations forums.

14.3 Efectes addicionals utilitzant el mesclador extern

Mixxx comes with a set of native effects. Additionally, using the external mixer mode you can route each deck directly to
3rd party effect hosts.

The following examples are only intended to encourage experimentation, they are not definitive guidance.
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14.3.1 Effects via AU Lab on macOS

2 1| Mixoxx external FX 500 & Preferences

Deck 1 Deck2 |/ Output1 |

Soun..ut 1-2 [(Soun...ut 3-4 F1LCTE-T0 S
P ] [ o) Sound Hardware

» [ Controllers Sound API | Core Audio B
iiii Library
= f =
; & Interface Sample Rate 48000 Hz -
Qutput 1: AUMultibandComp ) Latency [ 10.7 ms d

Multiband Compressor » Increase your latency if you hear pops during playback
192 384 768 15 33k 6.1 = Reduce your latency to improve Mixxx's responsiveness

120 -100 -80 -60 40 -20 0 20 4048 Band 1Band 2Band 3Band 4 Master | None ] | +

Headphones | None B =]

Deck 1 [ Soundflower (16ch) % | [ Channels 1 -2 H

Deck 2 ['soundflower (16ch) ¢ [Channels3-4 %]

Query Devices | [ Reset to Defaults | Apply

-120
Mute Solo | Mute Solo | Mute Rec Compression Levels
Details
( Cancel ) € oK )
(_ Cancel oK )
W Audio Engine Running _— /=

Figure2: The Au Lab routing for external effects on macOS

On macOS there is a simple and free way to give Mixxx access to the collection of AU/VST/MAS plugins that are installed
on your system.

* Install the free SoundflowerBed, a system extension for inter-application audio routing.

* Install the free digital audio mixing application AU Lab.

Suggerencia: macOS 10.15 (Catalina) introduces additional restrictions on running non-Apple software. Make sure to
grant permission in System Preferences —> Security & Privacy —> Microphone —> AU Lab.

Alternatively, try Blackhole, a modern virtual audio driver that allows applications to pass audio to other applications with
zero additional latency, and Hosting AU, a free micro-sized DAW that hosts Audio Unit instruments and effect plugins.

Al Mixxx
e Aneu a Preferéncies » Maquinari de so > Sortida
* Des del primer desplegable al costat de Plat 1, el dispositiu Soundflower 16 i al segiient Canals 1-2
* Des del primer desplegable al costat de Plat 2, el dispositiu Soundflower 16 i al segiient Canals 3-4
¢ Feu clic al bot6 Accepta
Al AU Lab
¢ Feu clic al bot6 + per a crear una nova configuracid
¢ Add 2 stereo input tracks in the Audio Input Tab
* Afegiu dues sortides estereo a Audio Output Tab
* Feu clic a Acceptar
* Canvieu el dispositiu d’entrada a Soundflower 16
* Canvieu el dispositiu de sortida, per exemple a Built-in Output

¢ Feu clic a Create document
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¢ In the Output I channel, select an effect from the drop-down menu, for example Apple » AUCompressor

L’efecte s’hauria de sentir si reproduiu una pista al Mixxx.

14.3.2 Efectes amb el JACK Rack a GNU/Linux

N JACK Audio Connection Kit [(defaul)] Started.  [JO][X]T = Mixxx
» 5ta & 1 z File Library Options Help

= -. [x] Preferences X
[secomea | pazsiby | 10| & [»] 0 » [orme ||
e B ) Snund Hacduara
b Connections - JACK Audie Connection Kit BE [JACK Audio Connection Kit ¢ l
‘Audio” MIDI | ALSA | (48000 Hz &
Readable Clients / Output Ports e Writable Clients / Input Ports v 121ms 6o
~ [ jack_rack_2305 ~ @ jack_rack_2305
ﬁ 25:’; :: ::’; e your latency if you hear pops during playback
i jack rack 2318 B jack Tack 2318 your latency to improve Mixxx's responsiveness
- -
& out_1 _in_i [
~out 2 ®in_2
~ H PortAudio ~ @ system [N - l [ A]
& out_0 % i ¢ playback_1 2B M d
& out_1 : i playback_2 [None 2 l [ 2 ]
& out 2 - playback_3
# out_3 ¢ playback_4 [jack_rack_2305 o | [channels 1-2 B
b ¢ - playback_5
e ﬁ Elgbik’s [jack_rack_2318 ¢ | channels 1-2 o]
playbacki?
R S ] Reset to Defaults 5- '
Setup - JACK Audio Connection Kit 2| € Expand All & Refresh
Misc. EL |

v hw0,0 Muitichannel
[v]| msave || %Oy pyey usB owygenao [REEER :
O hw:2 HDA NVidia 2395) L)O)[x]| = JACK Rack (2318)

| v | Name: [(default) [ v | Driver: (alsa | oo ALces3 Analog = e . Flle Rack Help : =
Chw21  ALCBE3 Digital | [ + v o [ 2 e = B

Priority: Interface: [Thw3  Brooktree Bt878
rames/Period: Eihels 7 (default)

Figure3: Enrutament amb el JACK per a efectes externs a GNU/Linux

Use Jack to route each deck directly through JACK Rack effect racks, or for more control you can use Ardour (or another
DAW) using sends for effects. This gives Mixxx access to the extensive collection of LADSPA plugins.

Make sure the correct multichannel audio interface has been selected in Jack (Jack settings visible bottom left). Note that
Mixxx possibly labels its Jack ports as Portaudio.

14.4 Esborrar el contingut de la biblioteca

Les dades de la biblioteca es desen a les segiients ubicacions depenent del sisterma operatiu:

Windows La llibreria del Mixxx s’emmagatzema a la carpeta $USERPROFILE%\Local Settings\
Application Data\Mixxx\ . Per esborrar la llibreria al Windows, suprimiu el fitxer mixxxdb.sqglite
d’aquesta carpeta.

macOS The Mixxx library is stored in the Library/Application Support/Mixxx folder in your home di-
rectory. To delete your library on macOS type the following command into a terminal:

rm ~/Library/Application\ Support/Mixxx/mixxxdb.sglite

GNU/Linux La biblioteca del Mixxx es desa a la carpeta .mixxx de la vostra carpeta personal. Per esborrar la bib-
lioteca a GNU/Linux, escriviu aquesta comanda en un terminal:
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rm ~/.mixxx/mixxxdb.sqglite

Avis: Si esborreu la biblioteca s’esborraran les metadades. Aixo inclou les punts hotcue, els bucles, comentaris, la
puntuaci6 i altres metadades de la biblioteca. Esborreu la biblioteca només si no us importa perdre aquestes dades.
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cHAPTER 15

Contribuir al projecte

El Mixxx és un projecte impulsat per la comunitat i que involucra molts DJs arreu del mén. Sense les contribucions
d’aquests DJs, el Mixxx no existiria, i estem agraits de rebre nous voluntaris en tot moment.

Volem que us sigui tan facil com sigui possible el fet d’involucrar-vos amb el desenvolupament del Mixxx. Ho volem
deixar clar no us cal ser programador per a ajudar-nos.

15.1 Si no sou un programador

* Donate to Mixxx using Paypal to help support and enhance development.

* Make skins

e Make MIDI mappings for your controller

 Aviseu-nos dels errors

» Update our Wiki to make sure the information on it is up to date.

¢ Traduiu el Mixxx utilitzant Transifex (en angles)

¢ Answer questions on the Troubleshooting Forum and the Launchpad Answers page

* Ajudeu a promocionar el Mixxx: Si teniu un bloc, escriviu un article sobre el Mixxx. Escriviu sobre les noves
versions quan surtin. Tota exposicid a la web i en mitjans impressos ajuda al nostre projecte a creixer, i ho agraim.

 Envieu-nos fotografies de com feu servir el Mixxx en els vostres events!
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15.2 Si sou programador

* No cal que sapigueu C++. Hi ha desenvolupadors que s’han unit al desenvolupament del Mixxx al mateix temps
que aprenien C++.

¢ Join our mailing list: mixxx-devel
¢ Join our Zulip chat.
e Tell us your ideas! Email us, talk on Zulip, file wishlist bugs, or post on the forums.
¢ Register an account on our development platform Github and fork our code. See Using Git for Mixxx Development
* Uniu-vos al Mixxx Development Team a Launchpad.
 Familiaritzeu-vos amb el codi. Agafeu un error de la lista de bugs senzills
* Get help fixing the bug on Zulip, talk to us about the best way to do it.
Com contribuir al Mixxx amb 3 passos senzills:
1. Agafeu un error de la lista de bugs senzills
2. Talk to us on Zulip for help on how to fix it.

3. Fix it! Done! Your name will now be on the Mixxx contributor list.
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cHAPTER 16

Apéendix

16.1 Keyboard mapping table

Shortcuts let you work more efficiently. This table lists the default keyboard shortcuts for accessing Mixxx with an English
keyboard layout. Depending on your language settings the defaults may be different.

Mixer

Crossfade Left G

Crossfade Right H

Small Crossfade Left Shift +G
Small Crossfade Right Shift +H
Microphone Talkover :

Deck 1 | Deck 2

Activate/Disable Effects Unit 5 0
Headphone Cue (Pre-fader listen) | T Y

Bass Kill B N
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Playback Deck 1 Deck 2
Load selected track to deck Shift ++« Shift +-
Unload track from deck Alt +Shift +<« | Alt + Shift +~
Playback D L
Seek Backwards A J
Reverse Playback Shift +A Shift+J
Seek Forwards S K
Tempo Adjust Down F1 F5
Tempo Adjust Up F2 F6
Small Tempo Adjust Down Shift +F1 Shift +F5
Small Tempo Adjust Up Shift +F2 Shift +F6
Temporary Tempo Adjust Down F3 F7
Temporary Tempo Adjust Up F4 F8
Small Temporary Tempo Adjust Down | Shift +F3 Shift +F7
Small Temporary Tempo Adjust Up Shift +F4 Shift +F8
Tempo (BPM) Sync 1 6
BPM Tap Tempo Adjust Shift + ! Shift +"
Cue and Loop Deck 1 Deck 2
Set Cuepoint Shift +D | Shift + L
Cue F ;
Cue Go-to-and-stop Shift +F | Shift + :
Activate 4 Beat Loop o] U
Halve Beat Loop Size W I
Double Beat Loop Size E 0]
Set Loop In Point 2 7
Set Loop Out Point (Activates Loop) | 3 8
Toggle Loop On/Off 4 9
Set Hot cue 1 Z M
Set Hot cue 2 X ,
Set Hot cue 3 C .
Set Hot cue 4 \Y /
Clear Hot cue 1 Shift +Z | Shift+M
Clear Hot cue 2 Shift +X | Shift +<
Clear Hot cue 3 Shift +C | Shift +>
Clear Hot cue 4 Shift +V | Shift +7?
Vinyl Control Deck 1 Deck 2
Passthrough Ctrl+J Ctrl+K
Vinylcontrol Mode Ctrl+ Shift+Y | Ctrl+ Shift +U
Vinylcontrol Cueing Ctrl+Alt+Y Ctrl+Alt+U

Single Deck Toggle / Swap Decks

Ctrl+T

16.1. Keyboard mapping table
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Library

Maximize the library view Space

Load selected track to deck Shift + < (Deck 1) \ Shift + - (Deck 2)
Select all files in current list Ctrl+A

Select group of files in current list | Click first item, hold Shi ft key, click last item
Focus search bar Ctrl+F

Clear search input Ctrl + Back

Exit search and leave focus ESC

Preview Deck

Load Selected Track And Play | A1t + Return

Start/Stop Return

Seek Backwards Alt + <«

Seek Forwards Alt +~
Auto DJ
Shuffle Auto DJ playlist Shift +F9
Skip next track in Auto DJ Shift +F10
Fade to next track in Auto DJ | Shift +F11
Toggle Auto DJ on/Off Shift +F12

Vegeu també:

Mixxx allows you to customize the keyboard shortcuts. For more information, and to download a keyboard mapping
image, go to Amb un teclat d’ordinador.

16.2 Application shortcuts

Use these shortcuts to access features available in the menu on top of the application window.

Function | Key

File menu

Load Track to Deck 1 Ctrl+0

Load Track to Deck 2 Ctrl+Shift+0
Library menu

Add new Playlist Ctrl+N

Add new Crate Ctrl+Shift +N
View menu

Show Skin Settings Menu Ctrl+1

Show Microphone Section Ctrl+2

Show Vinyl Control Section Ctrl+3

Show Preview Deck Ctrl+4

Show Cover Art Ctrl+6
Maximize Library Space

Full Screen (Windows & Linux) F11

Full Screen (macOS) Shift + Command + F
Options menu

continues on next page
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Table 1 - ve de la pagina anterior

Function Key

Enable Vinyl Control 1 Ctrl+T

Enable Vinyl Control 2 Ctrl+yY

Enable Vinyl Control 3 Ctrl+U

Enable Vinyl Control 4 Ctrl+1I

Enable Live Broadcasting Ctrl+L

Record Mix Ctrl+R

Enable Keyboard Shortcuts Ctrl+"

Open Preferences (Windows & Linux) Ctrl+P

Open Preferences (macOS) Ctrl+,

Exit Mixxx Ctrl+0Q
Developer menu

Reload skin Ctrl+Shift +R
Developer Tools Ctrl+Shift+T
Stats: Base Bucket Ctrl+ Shift +B
Stats: Experiment Bucket Ctrl+Shift +E
Debugger Enabled Ctrl+ Shift+D

Suggerencia: The Ctrl key on Windows & Linux is equivalent to the Command key on macOS. The A1t key on
Windows & Linux is equivalent to the Opt ion key on macOS. Application shortcuts are not customizable.

Nota: The Developer menu is available if Mixxx is started using the Launching Mixxx from the Command Line.

16.3 Launching Mixxx from the Command Line

To launch Mixxx using the command line:

Windows Locate the folder where Mixxx is installed and copy the file path. You can also obtain the file path by right
clicking on the Mixxx icon and then choosing “Properties”. Copy the path and paste it in terminal and add \mixxx
at the end - everything should be inside quotes. Press Enter. The entire command will look like this

’"C:\Proqram Files\Mixxx\mixxx"

macOS Similarly, for macOS, the command will be

’/Applications/Mixxx.app/Contents/MacOS/mixxx

GNU/ Linux If Mixxx is in your system’s search path (SPATH), you can just type

’mixxx
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16.3.1 Command line options

Mixxx is designed to be as user-friendly as possible. As such, its command line options are only useful for development
or debugging, as they make these tasks easier. Command line options are case-sensitive.

To launch Mixxx with any of these command line options, simply append the option to the base command for your
operating system. For example, to launch Mixxx in developer mode on Windows, type this in terminal

"C:\Program Files\Mixxx\mixxx" —--developer

In addition to these options, it is possible to specify one or more music file(s) on the command line. These will be loaded at
start-up. Each file you specify will be loaded into the next virtual deck. For a list of supported file types, go to Compatible
file formats.

--resourcePath PATH Top-level directory where Mixxx will look for its resource files such as MIDI
mappings, overriding the default installation location.

--pluginPath PATH Top-level directory where Mixxx will look for sound source plugins in addition to
default locations.

--settingsPath PATH Top-level directory where Mixxx will look for user settings files such as the library
database and preferences configuration file.

--controllerDebug  Log all controller data Mixxx sends and receives as well as scripts it loads.

--developer Enable developer mode. Includes extra logs, stats on performance and the Developer
tools menu as well as tooltips and logs useful for skin developers.

--safeMode Disable OpenGL widgets (scrolling waveforms, spinnies) to work around GPU
driver bugs. If Mixxx is crashing on startup, try using this.

* Automatically loads empty waveforms
 Disables spinning vinyl widgets
* Disables synchronization polling
* Doesn’t open controllers by default
--locale LOCALE  Use a custom locale for loading translations (e.g £r)
-f, --fullScreen Start Mixxx in full-screen mode.

--logLevel LEVEL  Set the verbosity of command line logging.

Value Meaning
critical | Critical/Fatal only
warning Above + Warnings

info Above + Informational messages
debug Above + Debug/Developer messages
trace Above + Profiling messages

--logFlushLevel LEVEL Set the logging level at which the log buffer is flushed tomixxx . log. LEVEL
is one of the values defined at ——1ogLevel above.

--debugAssertBreak Breaks (SIGINT) Mixxx if a DEBUG_ASSERT evaluates to false.
A debugger can then be wused to continue. This disables the
MIXXX_DEBUG_ASSERTIONS_FATAL flag which can otherwise lead to a
time consuming full rebuild.

-h, --help Display this help message and exit

16.3.

Launching Mixxx from the Command Line
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16.4 Developer tools

To start Mixxx in Developer mode from a custom resource directory with MIDI and HID logging enabled, type the
following line into the terminal and hit return:

’./mixxx ——controllerDebug —-developer —-resourcePath res

16.4.1 Experiment modes for rapid development and testing

¢ Adds a static Experiment class with a tri-state mode flag that indicates whether the experiment mode is OFF, BASE,
or EXPERIMENT.

* Adds Developer » Stats:Experiment Bucket and Developer > Stats:Base Bucket. Each one toggles between OFF and
BASE/EXPERIMENT so you can choose exactly what time spans you would like to collect in your base and
experiment buckets.

e Updates StatsManager to segment collected stats into a base and experiment bucket. This allows you to quickly
measure the difference a code change has on relevant counters / timers within the same execution of Mixxx.

This is useful for quickly enabling and disabling a code change without a re-compile/re-run cycle to get an anecdotal sense
of how it «feels» as well as a quantified sense of how it differs in terms of stats Mixxx collects.

All stats collected via the usual Counter/Timer/ScopedTimer/etc. tools are segmented into a BASE STATS and EXPER-
IMENT STATS section printed to the log on exit.

16.5 Mixxx Controls

Nearly every knob, button, or fader you see in Mixxx’s interface is controllable via Mixxx’s «control» system. The control
system allows skins, MIDI controllers, HID controllers and keyboards to control Mixxx via a single interface.

A control is identified by a «group» (which is used for grouping associated controls) and a «key» (the name of the
individual control).

For example, the volume fader for Deck 1 is identified by the group [Channell] and key volume. Similarly, the
volume fader for Sampler 1 is identified by the group [Samplerl] and key volume.

The group is used to collect all the controls that affect one component of Mixxx into one collection. Some groups have a
high overlap of controls in common (e.g. samplers, decks, and the preview deck all share the same control keys).

In addition to controlling Mixxx, the control system can be used to inspect Mixxx’s state. For example, the sample rate
of the track loaded in Deck 1 can be accessed via the [Channell], track_samplerate control. You can read
the [Channel3], play control to determine whether Deck 3 is playing.

The default value range is 0.0 to 1.0, unless otherwise noted. Binary means that it is either “ON” (non-zero) or “OFF”
(zero).

Suggerencia: Discovering Controls used in Skins

You can view the control connected to any part of a skin by running Mixxx with the ——developer command line
option and hovering your mouse cursor over part of the skin. If no tooltip appears, enable tooltips for the Library and
Skin in Options » Preferences *» Interface.

Suggerencia: Changing any control from the GUI in Developer Mode
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When running Mixxx in Developer Mode (with the ——developer command line option), you can view and manually
set the state of any control in Mixxx by going to Developer » Developer Tools.

Vegeu també:

See controlindex for a full list.

16.5.1 ControlPotMeter controls

The following extensions add some features to Cont rolPotMeter controls (volume, crossfader, ...). Use in conjunc-
tion with [ChannelN], [SamplerN], [Master], ... groups.

Control Suffix

Description, example

_up Increases the value, e.g. [ChannelN], rate_perm_up sets the speed one step higher (4 %
default)

_down Decreases the value, sets the speed one step lower (4 % default)

_up_small Increases the value by smaller step, sets the speed one small step higher (1 % default)

_down_small | Decreases the value by smaller step, sets the speed one small step lower (1 % default)

_set_one Sets the value to 1.0, sets the channel volume to full

_set_minus_og

nSets the value to -1.0, sets the channel volume to zero

_set_default

Input: sets the control to its default, return to default waveform zoom level

_set_default

Output: set to 1.0 if the control is at its default, light up the pitch fader center indicator

_set_zero

Sets the value to 0.0, put the crossfader in the middle again

_toggle Sets the value to 0.0 if the value was > 0.0, and to 1.0 if the value was 0.0, will cut oftf/on a track
while you're playing
mi-— Sets the value to -1.0 if the value was > -1.0, and to 1.0 if the value was -1.0, can tilt the crossfader

nus_toggle from left to right

These controls can be used in JavaScript files like this:

// This won't
engine.setValue (group,

work:

"pitch_up_small", 1.0);

// Use this instead:

script.triggerControl (group, "pitch_up_small", 50);
To use *_toggle the respective shortcut for scripts is:
script.toggleControl (group, "keylock_toggle", 100);

16.5.2 The [Master] group
The [Master] group generally corresponds to controls that affect the mixing engine. This will bear some similarity to
what you will find on a DJ mixer (e.g. crossfader controls, headphone cueing controls, etc.).

[Master]audio_latency_usage
Reflects fraction of latency, given by the audio buffer size, spend for audio processing inside Mixxx. At value near
25 % there is a high risk of buffer underflows

This is a ControlPotMeter control.
Range 0.. 25 %

Feedback latency meter
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Novetat de la versié 2.0.0.

[Master]audio_latency_overload
Indicates a buffer under or over-flow. Resets after 500 ms

This is a ControlPotMeter control.
Range binary
Feedback Overload indicator
Novetat de la versi6 2.0.0.

[Master]audio_latency_overload_count
Counts buffer over and under-flows. Max one per 500 ms

Range 0 .. n
Feedback Counter in hardware preferences
Novetat de la versi6 2.0.0.

[Master]balance
Adjusts the left/right channel balance on the Master output.

This is a ControlPotMeter control.
Range -1.0..1.0
Feedback Center Balance knob

[Master]booth_enabled

Indicates whether a Booth output is configured in the Sound Hardware Preferences.

Range binary
Feedback Booth gain knob shown or hidden
Novetat de la versi6 2.1.0.

[Master]booth_gain
Adjusts the gain of the Booth output.

This is a ControlPotMeter control.
Range 0.0...1.0...5.0
Feedback Booth gain knob

Novetat de la versi6 2.1.0.

[Master]crossfader
Adjusts the crossfader between players/decks (-1.0 is all the way left).

This is a ControlPotMeter control.
Range -1.0..1.0
Feedback Crossfader slider

[Master]crossfader_down
Moves the crossfader left by 1/10th.

Range binary
Feedback Crossfader slider

[Master]crossfader_down_small
Moves the crossfader left by 1/100th.

16.5. Mixxx Controls
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Range binary
Feedback Crossfader slider
Novetat de la versi6 1.10.0.

[Master]crossfader_up
Moves the crossfader right by 1/10th.

Range binary
Feedback Crossfader slider

[Master]crossfader_up_small
Moves the crossfader right by 1/100th.

Range binary
Feedback Crossfader slider
Novetat de la versié 1.10.0.

[Master]duckStrength
Microphone ducking strength

This is a ControlPotMeter control.
Range 0.0..1.0
Feedback Strength knob
Novetat de la versi6 2.0.0.

[Master]enabled
Indicator that the master mix is processed.

Range binary
Feedback None
Novetat de la versi6 2.0.0.

[Master]gain

Adjusts the gain for the master output as well as recording and broadcasting signal.

This is a ControlPotMeter control.
Range 0.0..1.0..5.0
Feedback Master volume knob
Novetat de la versi6 2.0.0.

[Master] headEnabled
Indicator that the headphone mix is processed.

Range binary
Feedback None
Novetat de la versi6 2.0.0.

[Master]headGain
Adjusts the headphone output gain.

This is a ControlPotMeter control.

Range 0.0..1.0..5.0
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Feedback Headphone volume knob
Novetat de la versi6 2.0.0.

[Master]headMix
Adjusts the cue/main mix in the headphone output.

This is a ControlPotMeter control.
Range default
Feedback Pre/Main knob
[Master]headSplit

Splits headphone stereo cueing into right (master mono) and left (PFL mono).

Range binary
Feedback Split Cue button
Novetat de la versi6 2.0.0.

[Master] latency
Latency setting (sound buffer size) in milliseconds (default 64).

Range >=0 (absolute value)
Feedback Latency slider in the prefs

[Master]maximize_library
Toggle maximized view of library.

Range binary
Feedback Toggle maximized view of library
Novetat de la versi6 2.0.0.

[Master]num_decks
The number of decks currently enabled.

Range integer
Feedback None
Novetat de la versié 1.9.0.

[Master]num_effectsavailable

The number of available effects that can be selected in an effect slot.

Range integer, read-only
Feedback None
Novetat de la versi6 2.1.0.

[Master]num_samplers
The number of samplers currently enabled.

Range integer
Feedback None
Novetat de la versi6 1.9.0.

[Master]num_preview_decks
The number of preview decks currently enabled.

Range integer
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Feedback None
Novetat de la versié 1.11.0.

[Master]PeakIndicator

Indicates when the signal is clipping (too loud for the hardware and is being distorted) (composite).

This is a ControlPotMeter control.
Range binary
Feedback Clip light (mono)

[Master]PeakIndicatorL

Indicates when the signal is clipping (too loud for the hardware and is being distorted) for the left channel.

This is a ControlPotMeter control.
Range binary
Feedback Clip light (left)

[Master]PeakIndicatorR

Indicates when the signal is clipping (too loud for the hardware and is being distorted) for the right channel.

This is a ControlPotMeter control.
Range binary
Feedback Clip light (right)

[Master] samplerate
The current output sample rate (default: 44100 Hz).

Range absolute value (in Hz)
Feedback None

[Master]talkoverDucking
Toggle microphone ducking mode (OFF, AUTO, MANUAL)

Range FIXME
Feedback Ducking mode button
Novetat de la versi6 2.0.0.

[Master]VuMeter
Outputs the current instantaneous master volume (composite).

This is a ControlPotMeter control.
Range default
Feedback Master meter (mono)

[Master]VuMeterL
Outputs the current instantaneous master volume for the left channel.

This is a ControlPotMeter control.
Range default
Feedback Master meter L

[Master]VuMeterR

Outputs the current instantaneous master volume for the right channel.

This is a ControlPotMeter control.
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Range default
Feedback Master meter R

[Master]headVolume
Adjust headphone volume.

Range 0.0..1.0..5.0
Feedback Headphone Gain knob
Obsolet desde la versi6 2.0.0: Use [Master], headGain instead.

[Master]volume
Adjust master volume.

Range 0.0..1.0..5.0
Feedback Master Gain knob

Obsolet desde 1a versi6 2.0.0: Use [Master], gain instead.

16.5.3 Decks, Preview Decks and Samplers

Each deck in Mixxx corresponds to a [ChannelN] group. Whenever you see [ChannelN], think «Deck N». N can
range from 1 to the number of active decks in Mixxx.

Preview decks and Sample decks («samplers») in Mixxx are identical to regular decks, they simply have a different
purpose (previewing tracks or playing samples, respectively). Any control listed above for [ChannelN] will work for
a samplers and preview decks, just replace [ChannelN] with [PreviewDeckN] or [SamplerN].

Vegeu també:
There are some additional global controls for samplers.

[ChannelN]back
[PreviewDeckN]back
[SamplerN]back

Fast rewind (REW)

Range binary
Feedback << button

[ChannelN]beat_active

[PreviewDeckN]beat_active

[SamplerN]beat_active
Indicates whether the player is currently positioned within 50 milliseconds of a beat or not. This can be used to
make controller LEDs blink on every beat.

Range binary
Feedback None
Novetat de la versié 1.10.0.

[ChannelN]beat_closest

[PreviewDeckN]beat_closest

[SamplerN]beat_closest
Its value is set to the sample position of the closest beat of the active beat and is used for updating the beat LEDs.
rrange: -1, 0.0, real-valued :feedback: None

[ChannelN]beat_distance
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[PreviewDeckN]beat_distance

[SamplerN]beat_distance
Outputs the relative position of the play marker in the section between the the previous and next beat marker.
rrange: 0.0 - 1.0, real-valued :feedback: None

[ChannelN]beat jump

[PreviewDeckN]beat jump

[SamplerN]beat jump
Jump forward by beat jump_size (positive) or backward by beat jump_ size (negative). If a loop is active,
the loop is moved by beat jump_size.

Range real number, -1, 0, 1
Feedback Player jumps forward or backward by X beats.
Novetat de la versi6 2.0.0.

[ChannelN]beat jump_size
[PreviewDeckN]beat jump_size
[SamplerN]beatjump_size
Set the number of beats to jump with beat jump_forward/beat jump_backward.

Range positive real number
Feedback Beatjump size spinbox
Novetat de la versi6 2.1.0.

[ChannelN]beatjump_forward
[PreviewDeckN]beat jump_forward
[SamplerN]beatjump_forward
Jump forward by beat jump_size. If aloop is active, the loop is moved forward by X beats.

Range binary
Feedback Player jumps forward by beat jump_size.
Novetat de la versi6 2.1.0.

[ChannelN]beat jump_backward
[PreviewDeckN]beat jump_backward
[SamplerN]beatjump_backward
Jump backward by beat jump_size. If aloop is active, the loop is moved backward by X beats.

Range binary
Feedback Player jumps backward by beat jump_size.
Novetat de la versi6 2.1.0.

[ChannelN]beatjump_X forward

[PreviewDeckN]beat jump_X_forward

[SamplerN]beatjump_X_ forward
Jump forward by X beats. A control exists for X = 0.03125, 0.0625, 0.125, 0.25, 0.5, 1, 2, 4, 8, 16, 32, 64. If a
loop is active, the loop is moved forward by X betas.

Range binary
Feedback Player jumps forward by X beats.
Novetat de la versi6 2.0.0.

[ChannelN]beat jump_X_ backward

[PreviewDeckN]beat jump_X_backward
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[SamplerN]beatjump_X backward

Jump backward by X beats. A control exists for X = 0.03125, 0.0625, 0.125, 0.25,0.5, 1,2, 4, 8, 16,32, 64. If a
loop is active, the loop is moved backward by X beats.

Range binary
Feedback Player jumps backward by X beats.
Novetat de la versi6 2.0.0.

[ChannelN]beatloop_activate
[PreviewDeckN]beatloop_activate
[SamplerN]beatloop_activate

Set a loop that is beat Ioop_size beats long and enables the loop

Range binary
Feedback A loop is shown over beat loop_size beats
Novetat de la versié 2.1.0.

[ChannelN]beatloop_X_activate
[PreviewDeckN]beatloop_X_activate
[SamplerN]beatloop_X activate
Activates a loop over X beats. A control exists for X = 0.03125, 0.0625, 0.125, 0.25,0.5, 1, 2, 4, 8, 16, 32, 64

Range binary
Feedback A loop is shown over X beats.
Novetat de la versié 1.10.0.

[ChannelN]beatloop_size

[PreviewDeckN]beatloop_size

[SamplerN]beatloop_size
Set the length of the loop in beats that will get set with beatloop_activate and beat-
looproll_activate. Changing this will resize an existing loop if the length of the loop matches beat -
loop_size.

Range positive real number
Feedback Beatloop size spinbox and possibly loop section on waveform
Novetat de la versi6 2.1.0.

[ChannelN]beatloop_X toggle
[PreviewDeckN]beatloop_X_toggle
[SamplerN]beatloop_X_toggle
Toggles a loop over X beats. A control exists for X = 0.03125, 0.0625, 0.125, 0.25, 0.5, 1, 2, 4, 8, 16, 32, 64

Range binary
Feedback A loop is shown over X beats.
Novetat de la versi6 1.10.0.

[ChannelN]beatloop_X enabled
[PreviewDeckN]beatloop_X_enabled
[SamplerN]beatloop_X enabled

1 if beatloop X is enabled, O if not.

Range binary

Feedback Beatloop X button in skin is lit.
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Novetat de la versié 1.10.0.

[ChannelN]beatlooproll_activate

[PreviewDeckN]beatlooproll_activate

[SamplerN]beatlooproll_activate
Activates a rolling loop over beat loop_ size beats. Once disabled, playback will resume where the track would
have been if it had not entered the loop.

Range binary
Feedback A loop overlay is shown over beat loop_size beats on waveform.
Novetat de la versi6 2.1.0.

[ChannelN]beatlooproll_X_activate

[PreviewDeckN]beatlooproll_X_activate

[SamplerN]beatlooproll_X_activate
Activates a rolling loop over X beats. Once disabled, playback will resume where the track would have been if it
had not entered the loop. A control exists for X = 0.03125, 0.0625, 0.125, 0.25, 0.5, 1, 2, 4, 8, 16, 32, 64

Range binary
Feedback Beatloop X button in skin is lit. A loop overlay is shown over X beats on waveform.
Novetat de la versi6 1.11.0.

[ChannelN]beats_adjust_faster

[PreviewDeckN]beats_adjust_faster

[SamplerN]beats_adjust_faster
Adjust the average BPM up by +0.01

Range binary
Feedback The beargrid lines move closer to each other.
Novetat de la versi6 2.0.0.

[ChannelN]beats_adjust_slower

[PreviewDeckN]beats_adjust_slower

[SamplerN]beats_adjust_slower
Adjust the average BPM down by -0.01.

Range binary
Feedback The beargrid lines move further apart from each other.
Novetat de la versi6 2.0.0.

[ChannelN]beats_translate_curpos
[PreviewDeckN]beats_translate_curpos
[SamplerN]beats_translate_curpos

Adjust beatgrid so closest beat is aligned with the current playposition.

Range binary
Feedback The beatgrid moves to align with current playposition.
Novetat de la versi6 1.10.0.

[ChannelN]beats_translate_match_alignment

[PreviewDeckN]beats_translate_match_alignment

[SamplerN]beats_translate_match_alignment
Adjust beatgrid to match another playing deck.

Range binary

16.5. Mixxx Controls 133



Mixxx User Manual, Versié 2.3.0

Feedback Instead of syncing the beatgrid to the current playposition, sync the beatgrid so the nearest

beat lines up with the other track’s nearest beat.
Novetat de la versi6 2.0.0.

[ChannelN]beats_translate_earlier

[PreviewDeckN]beats_translate_earlier

[SamplerN]beats_translate_earlier
Move beartgrid to an earlier position.

Range binary
Feedback The beatgrid moves left by a small amount.
Novetat de la versi6 2.0.0.

[ChannelN]beats_translate_later

[PreviewDeckN]beats_translate_later

[SamplerN]beats_translate_later
Move beatgrid to a later position.

Range binary
Feedback The beatgrid moves right by a small amount.
Novetat de la versi6 2.0.0.

[ChannelN]beatsync
[PreviewDeckN]beatsync
[SamplerN]beatsync

Syncs the tempo and phase (depending on quantize) to that of the other track (if BPM is detected on both).

range binary

feedback The Sync button flashes and the fempo slider snaps to the appropriate value.

Canviat a la versi6 1.10.0.

[ChannelN]beatsync_phase
[PreviewDeckN]beatsync_phase
[SamplerN]beatsync_phase

Syncs the phase to that of the other track (if BPM is detected on both).

Range binary
Feedback The Sync button flashes and the fempo slider snap to the appropriate value.
Novetat de la versi6 1.10.0.

[ChannelN]beatsync_tempo
[PreviewDeckN]beatsync_tempo
[SamplerN]beatsync_tempo

Syncs the tempo to that of the other track (if BPM is detected on both).

Range binary

Feedback The Sync button flashes and the tempo slider snaps to the appropriate value.

Novetat de la versié 1.10.0.

[ChannelN]bpm
[PreviewDeckN]bpm
[SamplerN]bpm
Reflects the perceived (rate-adjusted) BPM of the loaded file.
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This is a ControlPotMeter control.
Range real-valued
Feedback BPM value display

Canviat a la versi6 1.10.0.

[ChannelN]bpm_tap
[PreviewDeckN]bpm_tap
[SamplerN]bpm_tap
When tapped repeatedly, adjusts the BPM of the track on the deck (not the tempo slider!) to match the taps.

Nota: If you want to change the rafe of the deck use script.bpm.tapButton(deck) in your controller mapping
instead.

Range binary
Feedback BPM value display (playback speed doesn’t change)

Novetat de la versi6 1.9.2.

[ChannelN]CloneFromDeck

[PreviewDeckN]CloneFromDeck

[SamplerN]CloneFromDeck
Clone the given deck number, copying the play state, position, rate, and key. If 0 or a negative number is given,
Mixxx will attempt to select the first playing deck as the source for the clone.

Range integer between 1 and [Master], num_decks (inclusive)
Feedback The channel will start playing at the rate and position of the source deck.
Novetat de la versi6 2.3.0.

[ChannelN]CloneFromSampler
[PreviewDeckN]CloneFromSampler
[SamplerN]CloneFromSampler

Clone the given sampler number, copying the play state, position, rate, and key.

Range integer between 1 and [Master], num_samplers (inclusive)
Feedback The channel will start playing at the rate and position of the source deck.
Novetat de la versi6 2.3.0.

[ChannelN] cue_cdj
[PreviewDeckN] cue_cdj
[SamplerN] cue_cdj
Represents a Cue button that is always in CDJ mode.

Range binary
Feedback None
Novetat de la versié 1.10.0.

[ChannelN] cue_clear
[PreviewDeckN] cue_clear
[SamplerN] cue_clear
Deletes the already set cue point and sets [ChannelN], cue_point to-1.

Range binary
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Feedback None

[ChannelN]cue_goto
[PreviewDeckN] cue_goto
[SamplerN] cue_goto
If the cue point is set, recalls the cue point.

Range binary
Feedback Player may change position

[ChannelN] cue_default
[PreviewDeckN] cue_default
[SamplerN] cue_default

In CDJ mode, when playing, returns to the cue point and pauses. If stopped, sets a cue point at the current location.

If stopped and at a cue point, plays from that point until released (set to 0.)

Range binary
Feedback Cue button

[ChannelN] cue_gotoandplay
[PreviewDeckN] cue_gotoandplay
[SamplerN] cue_gotoandplay

If the cue point is set, seeks the player to it and starts playback.

Range binary
Feedback Player may change position and start playing.
Novetat de la versi6 1.11.0.

[ChannelN] cue_gotoandstop
[PreviewDeckN] cue_gotoandstop
[SamplerN] cue_gotoandstop
If the cue point is set, seeks the player to it and stops.

Range binary
Feedback Player may change position.
Novetat de la versi6 1.11.0.

[ChannelN] cue_indicator
[PreviewDeckN] cue_indicator
[SamplerN] cue_indicator

Indicates the blinking pattern of the CUE button (i.e. 1.0 if the button is illuminated, 0.0 otherwise), depending on

the chosen cue mode.
Range binary
Feedback Cue button

Novetat de la versi6 2.0.0.

[ChannelN] cue_mode
[PreviewDeckN] cue_mode
[SamplerN] cue_mode
Represents the currently chosen cue mode.

Range
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Value | compatible hardware
0.0 Mixxx mode (default)

1.0 Pioneer mode

2.0 Denon mode

3.0 Numark mode

4.0 Mixxx mode (no blinking)
5.0 CUP (Cue + Play) mode

Feedback None

[ChannelN]cue_play
[PreviewDeckN] cue_play
[SamplerN] cue_play
Go to cue point and play after release (CUP button behavior). If stopped, sets a cue point at the current location.

Range binary
Feedback None
Novetat de la versi6 2.1.0.

[ChannelN] cue_point
[PreviewDeckN] cue_point
[SamplerN] cue_point
The current position of the cue point in samples.

Range absolute value
Feedback Cue point marker

[ChannelN] cue_preview
[PreviewDeckN] cue_preview
[SamplerN] cue_preview

Plays from the current cue point.

Range binary
Feedback Cue button lights and waveform moves

[ChannelN] cue_set
[PreviewDeckN] cue_set
[SamplerN] cue_set

Sets a cue point at the current location.

Range binary
Feedback Cue mark appears on the waveform

[ChannelN]cue_simple
[PreviewDeckN] cue_simple
[SamplerN] cue_simple
If the player is not playing, set the cue point at the current location otherwise seek to the cue point.

Range binary
Feedback Cue button

[ChannelN]duration
[PreviewDeckN]duration
[SamplerN]duration

Outputs the length of the current song in seconds
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Range absolute value
Feedback None

[ChannelN]eject
[PreviewDeckN]eject
[SamplerN]eject

Eject currently loaded track

Range binary

Feedback Eject button is lit. Be sure to set back to 0 with scripts so the button does not stay lit.

Novetat de la versi6 1.9.0.

[ChannelN]end
[PreviewDeckN] end
[SamplerN] end

Jump to end of track

Range binary
Feedback Track jumps to end

[ChannelN]end_of_track
[PreviewDeckN]end_of_ track
[SamplerN]end_of_track

Switches to 1 if the play position is within the end range defined in Preferences » Waveforms » End of track warning.

Range binary, read-only

Feedback Waveform and Overview widgets show a flashing border

[ChannelN] file_bpm
[PreviewDeckN] file_bpm
[SamplerN] file_bpm

The detected BPM of the loaded track.

Range positive value, read-only
Feedback None

[ChannelN] file_key
[PreviewDeckN] file_key
[SamplerN] file_key

The detected key of the loaded track.

Range ?, read-only
Feedback None
Novetat de la versi6 2.0.0.

[ChannelN] fwd
[PreviewDeckN] fwd
[SamplerN] fwd

Fast forward (FF)

Range binary
Feedback > button

[ChannelN]hotcue_X_activate

[PreviewDeckN]hotcue_X_activate

16.5. Mixxx Controls

138



Mixxx User Manual, Versié 2.3.0

[SamplerN]hotcue_X_ activate
If hotcue X is not set, this sets a hotcue at the current play position and saves it to hotcue slot X.

If hotcue X is set, the player seeks to hotcue X’s position. Setting the control to 1 when the track is currently not
playing (i.e. play is set to 0) will start hotcue previewing. After resetting the control to 0, playback will usually be
stopped and the player will seek to the hotcue position. If p1ay is set to 1 while previewing is active, the playback
will continue and no seek occurs.

Range binary
Feedback Player may change position. Hotcue X marker may change on waveform.
Novetat de la versi6 1.8.0.

[ChannelN]hotcue_X clear
[PreviewDeckN]hotcue_X_clear
[SamplerN]hotcue_X_clear

If hotcue X is set, clears its hotcue status.

Range binary
Feedback Hotcue X marker changes on waveform.
Novetat de la versi6 1.8.0.

[ChannelN]hotcue_X_ color
[PreviewDeckN]hotcue_X_color
[SamplerN]hotcue_X color

Color of hotcue X or -1 if the hotcue is not set.

Range 3-Byte RGB color code (or -1)
Feedback Color of Hotcue X button and waveform marker changes.
Novetat de la versi6 2.3.0.

[ChannelN]hotcue_X_enabled
[PreviewDeckN]hotcue_X_ enabled
[SamplerN]hotcue_X_ enabled
Indicates if hotcue slot X is set. The value is 1 if the hotcue is set (position is not -1), O otherwise.

Range binary, read-only
Novetat de la versié 1.8.0.

[ChannelN]hotcue_X_ goto
[PreviewDeckN]hotcue_X_goto
[SamplerN]hotcue_X_goto

If hotcue X is set, seeks the player to hotcue X’s position.

Range binary
Feedback Player may change position.
Novetat de la versi6 1.8.0.

[ChannelN]hotcue_X_ gotoandplay
[PreviewDeckN]hotcue_X_gotoandplay
[SamplerN]hotcue_X gotoandplay

If hotcue X is set, seeks the player to hotcue X’s position and starts playback.

Range binary

Feedback Player may change position.
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Novetat de la versié 1.11.0.

[ChannelN]hotcue_X_ gotoandstop
[PreviewDeckN] hotcue_X_ gotoandstop
[SamplerN]hotcue_X_ gotoandstop

If hotcue X is set, seeks the player to hotcue X’s position and stops.

Range binary
Feedback Player may change position.
Novetat de la versi6 1.8.0.

[ChannelN]hotcue_X_position
[PreviewDeckN]hotcue_X_position
[SamplerN]hotcue_X position

The position of hotcue X in samples, -1 if not set.

Range positive integer
Feedback Hotcue X marker changes on waveform.
Novetat de la versi6 1.8.0.

[ChannelN]hotcue_X_set
[PreviewDeckN] hotcue_X_set
[SamplerN]hotcue_X_set
Set hotcue X to the current play position. If hotcue X was previously set, clears its hotcue status.

Range binary
Feedback Hotcue X marker changes on waveform.
Novetat de la versi6 1.8.0.

[ChannelN]hotcue_focus
[PreviewDeckN] hotcue_focus
[SamplerN]hotcue_focus
Contains the number of the most recently used /hozcue (or -1 if no hotcue was used).

Range positive integer (or -1)
Feedback None
Novetat de la versi6 2.3.0.

[ChannelN]hotcue_focus_color_prev
[PreviewDeckN]hotcue_focus_color_prev
[SamplerN]hotcue_focus_color_prev

If there is a focused /ofcue, sets its color to the previous color in the palette.

Range binary
Feedback Color of focused hotcue button and waveform marker changes.
Novetat de la versi6 2.3.0.

[ChannelN]hotcue_focus_color_next
[PreviewDeckN]hotcue_focus_color_next
[SamplerN]hotcue_focus_color_next

If there is a focused hortcue, sets its color to the next color in the palette.

Range binary

Feedback Color of focused hotcue button and waveform marker changes.
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Novetat de la versié 2.3.0.

[ChannelN]intro_end_activate

[PreviewDeckN] intro_end_activate

[SamplerN]intro_end_activate
If the intro end cue is set, seeks the player to the intro end position. If the intro end is not set, sets the intro end to
the current play position.

Range binary
Feedback Player may change position. Intro end marker may change on waveform.
Novetat de la versi6 2.3.0.

[ChannelN]intro_end_clear
[PreviewDeckN] intro_end_clear
[SamplerN]intro_end_clear

If the intro end cue is set, clears its status.

Range binary
Feedback Intro end marker changes on waveform.
Novetat de la versi6 2.3.0.

[ChannelN]intro_end_enabled
[PreviewDeckN] intro_end_enabled
[SamplerN] intro_end_enabled

1 if intro end cue is set, (position is not -1), 0 otherwise.

Range binary, read-only
Feedback Intro end button lights up.
Novetat de la versi6 2.3.0.

[ChannelN]intro_end_position
[PreviewDeckN] intro_end_position
[SamplerN]intro_end_position

The position of the intro end in samples, -1 if not set.

Range positive integer
Feedback Intro end marker changes on waveform.
Novetat de la versi6 2.3.0.

[ChannelN]intro_end_set
[PreviewDeckN] intro_end_set
[SamplerN]intro_end_set
Set intro end to the current play position. If intro end was previously set, it is moved to the new position.

Range binary
Feedback Intro end marker changes on waveform.
Novetat de la versi6 2.3.0.

[ChannelN]intro_start_activate

[PreviewDeckN] intro_start_activate

[SamplerN]intro_start_activate
If the intro start cue is set, seeks the player to the intro start position. If the intro start is not set, sets the intro start
to the current play position.

Range binary
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Feedback Player may change position. Intro start marker may change on waveform.
Novetat de la versi6 2.3.0.

[ChannelN]intro_start_clear
[PreviewDeckN] intro_start_clear
[SamplerN]intro_start_clear

If the intro start cue is set, clears its status.

Range binary
Feedback Intro start marker changes on waveform.
Novetat de la versi6 2.3.0.

[ChannelN]intro_start_enabled
[PreviewDeckN] intro_start_enabled
[SamplerN]intro_start_enabled

1 if intro start cue is set, (position is not -1), O otherwise.

Range binary, read-only
Feedback Intro start button lights up.
Novetat de la versi6 2.3.0.

[ChannelN]intro_start_position
[PreviewDeckN] intro_start_position
[SamplerN]intro_start_position

The position of the intro start in samples, -1 if not set.

Range positive integer
Feedback Intro start marker changes on waveform.
Novetat de la versi6 2.3.0.

[ChannelN]intro_start_set
[PreviewDeckN] intro_start_set
[SamplerN]intro_start_set
Set intro start to the current play position. If intro start was previously set, it is moved to the new position.

Range binary
Feedback Intro start marker changes on waveform.
Novetat de la versi6 2.3.0.

[ChannelN] key
[PreviewDeckN] key
[SamplerN] key

Current key of the track

Range
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Value | OpenKey | Lancelot | Traditional
1 1d 8b C

2 8d 3b Db

3 3d 10b D

4 10d 5b Eb

5 5d 12b E

6 12d 7b F

7 7d 2b Fﬁ/Gb
8 2d 9b G

9 9d 4b Ab
10 4d 11b A

11 11d 6b Bb
12 6d 1b B

13 10m S5a Cm
14 S5m 12a CHm
15 12m 7a Dm
16 7m 2a D#m/Ebm
17 2m 9a Em
18 9m 4a Fm
19 4m 11a Fgm
20 11lm 6a Gm
21 6m la Gfm
22 1m 8a Am
23 8m 3a Bbm
24 3m 10a Bm

Novetat de la versié 2.0.0.

[ChannelN] keylock
[PreviewDeckN] keylock
[SamplerN] keylock
Enable key-lock for the specified deck (rate changes only affect tempo, not key)

Range binary
Feedback key-lock button activates
Novetat de la versi6 1.9.0.

[ChannelN] LoadSelectedTrack
[PreviewDeckN] LoadSelectedTrack
[SamplerN] LoadSelectedTrack

Loads the currently highlighted track into the deck

Range binary
Feedback Track name & waveform change

[ChannelN] LoadSelectedTrackAndPlay
[PreviewDeckN] LoadSelectedTrackAndPlay
[SamplerN] LoadSelectedTrackAndPlay
Loads the currently highlighted track into the deck and starts playing

Range binary
Feedback Track name & waveform change & Play/pause button

Novetat de la versié 1.11.0.
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[ChannelN] local_bpm
[PreviewDeckN] local_bpm
[SamplerN]local_bpm
Reflects the average bpm around the current play position of the loaded file.

Range positive value
Feedback None

[ChannelN] loop_double
[PreviewDeckN] loop_double
[SamplerN] loop_double
Doubles beatloop_size. If beatloop_size equals the size of the loop, the loop is resized.

Range binary

Feedback Beatloop size spinbox changes
Novetat de la versi6 1.10.0.
Canviat a la versi6 2.1.0.

[ChannelN] loop_enabled
[PreviewDeckN] loop_enabled
[SamplerN] loop_enabled

Indicates whether or not a loop is enabled.

Range binary, read-only
Feedback Loop in waveform is active.
Novetat de la versi6 1.8.0.

[ChannelN] loop_end_position
[PreviewDeckN] loop_end_position
[SamplerN] loop_end_position
The player loop-out position in samples, -1 if not set.
Range positive integer
Feedback Loop-out marker shows on waveform.
Novetat de la versi6 1.8.0.

[ChannelN] loop_halve
[PreviewDeckN] loop_halve
[SamplerN] loop_halve
Halves beatloop_size. If beatloop_size equals the size of the loop, the loop is resized.

Range binary

Feedback Beatloop size spinbox changes
Novetat de la versi6 1.10.0.
Canviat a la versi6 2.1.0.

[ChannelN]loop_in

[PreviewDeckN] loop_in

[SamplerN] loop_in
If loop is disabled, sets the player loop in position to the current play position. If loop is enabled, press and hold to
move loop in position to the current play position. If quantize is enabled, beatloop_size will be updated to
reflect the new loop size.

Range binary
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Feedback Loop-in marker changes on waveform.
Novetat de la versi6 1.8.0.
Canviat a la versi6 2.1.0.

[ChannelN] loop_in_goto
[PreviewDeckN] loop_in_goto
[SamplerN] loop_in_goto

Seek to the loop in point.

Range binary
Feedback Waveform position jumps
Novetat de la versi6 2.1.0.

[ChannelN] loop_out

[PreviewDeckN] loop_out

[SamplerN] loop_out
If loop is disabled, sets the player loop out position to the current play position. If loop is enabled, press and hold
to move loop out position to the current play position. If quantize is enabled, beat loop_size will be updated
to reflect the new loop size.

Range binary

Feedback Loop-out marker changes on waveform.
Novetat de la versi6 1.8.0.
Canviat a la versi6 2.1.0.

[ChannelN] loop_out_goto
[PreviewDeckN] loop_out_goto
[SamplerN] loop_out_goto

Seek to the loop out point.

Range binary
Feedback Waveform position jumps
Novetat de la versi6 2.1.0.

[ChannelN] loop_move
[PreviewDeckN] loop_move
[SamplerN] loop_move
Move loop forward by X beats (positive) or backward by X beats (negative).

Range real number
Feedback Loop moves forward or backward by X beats.
Novetat de la versi6 2.0.0.

[ChannelN] loop_move_X_forward

[PreviewDeckN] loop_move_X_forward

[SamplerN] loop_move_X_ forward
Moves the loop in and out points forward by X beats. A control exists for X = 0.03125, 0.0625, 0.125, 0.25, 0.5,
1,2,4,8,16,32, 64

Range binary
Feedback Loop moves forward by X beats.

Novetat de la versi6 2.0.0.
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[ChannelN] loop_move_X_ backward
[PreviewDeckN] loop_move_X_backward
[SamplerN] loop_move_X_backward
Loop moves by X beats. A control exists for X = 0.03125, 0.0625, 0.125, 0.25, 0.5, 1, 2, 4, 8, 16, 32, 64

Range binary
Feedback Loop moves backward by X beats.
Novetat de la versi6 2.0.0.

[ChannelN] loop_scale

[PreviewDeckN] loop_scale

[SamplerN] loop_scale
Scale the loop length by the value scale is set to by moving the end marker. beat Ioop_size is not updated to
reflect the change.

Range 0.0 - infinity
Feedback Loop length is scaled by given amount on waveform.
Novetat de la versi6 1.10.0.

[ChannelN] loop_start_position
[PreviewDeckN] loop_start_position
[SamplerN] loop_start_position

The player loop-in position in samples, -1 if not set.

Range positive integer
Feedback Loop-in marker changes on waveform.
Novetat de la versi6 1.8.0.

[ChannelN]orientation
[PreviewDeckN]orientation
[SamplerN]orientation

Set channel orientation for the crossfader.

Range
Value | Meaning
0 Left side of crossfader
1 Center (not affected by crossfader)
2 Right side of crossfader

Feedback None
Novetat de la versi 1.9.0.

[ChannelN]orientation_center
[PreviewDeckN]orientation_center
[SamplerN]orientation_center
[AuxiliaryN]orientation_center
Assign channel to the center of the crossfader.

[ChannelN]orientation_left
[PreviewDeckN]orientation_left
[SamplerN]orientation_left
[AuxiliaryN]orientation_left

Assign channel to the left side of the crossfader.

16.5. Mixxx Controls 146



Mixxx User Manual, Versié 2.3.0

[ChannelN]orientation_right
[PreviewDeckN]orientation_right
[SamplerN]orientation_right
[AuxiliaryN]orientation_right

Assign channel to the right side of the crossfader.

[ChannelN]outro_end_activate

[PreviewDeckN]outro_end_activate

[SamplerN]outro_end_activate
If the outro end cue is set, seeks the player to the outro end position. If the outro end is not set, sets the outro end
to the current play position.

Range binary
Feedback Player may change position. Outro end marker may change on waveform.
Novetat de la versi6 2.3.0.

[ChannelN]outro_end_clear
[PreviewDeckN]outro_end_clear
[SamplerN]outro_end_clear

If the outro end cue is set, clears its status.

Range binary
Feedback Outro end marker changes on waveform.
Novetat de la versi6 2.3.0.

[ChannelN]outro_end_enabled
[PreviewDeckN]outro_end_enabled
[SamplerN]outro_end_enabled

1 if outro end cue is set, (position is not -1), 0 otherwise.

Range binary, read-only
Feedback Outro end button lights up.
Novetat de la versi6 2.3.0.

[ChannelN]outro_end_position
[PreviewDeckN]outro_end_position
[SamplerN]outro_end_position

The position of the outro end in samples, -1 if not set.

Range positive integer
Feedback Outro end marker changes on waveform.
Novetat de la versi6 2.3.0.

[ChannelN]outro_end_set
[PreviewDeckN]outro_end_set
[SamplerN]outro_end_set
Set outro end to the current play position. If outro end was previously set, it is moved to the new position.

Range binary
Feedback Outro end marker changes on waveform.
Novetat de la versi6 2.3.0.

[ChannelN]outro_start_activate
[PreviewDeckN]outro_start_activate
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[SamplerN]outro_start_activate
If the outro start cue is set, seeks the player to the outro start position. If the outro start is not set, sets the outro
start to the current play position.

Range binary
Feedback Player may change position. Outro start marker may change on waveform.
Novetat de la versi6 2.3.0.

[ChannelN]outro_start_clear
[PreviewDeckN]outro_start_clear
[SamplerN]outro_start_clear

If the outro start cue is set, clears its status.

Range binary
Feedback Outro start marker changes on waveform.
Novetat de la versi6 2.3.0.

[ChannelN]outro_start_enabled
[PreviewDeckN]outro_start_enabled
[SamplerN]outro_start_enabled

1 if outro start cue is set, (position is not -1), 0 otherwise.

Range binary, read-only
Feedback Outro start button lights up.
Novetat de la versi6 2.3.0.

[ChannelN]outro_start_position
[PreviewDeckN]outro_start_position
[SamplerN]outro_start_position

The position of the outro start in samples, -1 if not set.

Range positive integer
Feedback Outro start marker changes on waveform.
Novetat de la versi6 2.3.0.

[ChannelN]outro_start_set
[PreviewDeckN]outro_start_set
[SamplerN]outro_start_set
Set outro start to the current play position. If outro start was previously set, it is moved to the new position.

Range binary
Feedback Outro start marker changes on waveform.
Novetat de la versi6 2.3.0.

[ChannelN]passthrough

[PreviewDeckN] passthrough

[SamplerN]passthrough
Connects the vinyl control input for vinyl control on that deck to the channel output. Allows to mix external media
into DJ sets.

Range binary
Feedback Passthrough label in the waveform overview and passthrough button

Novetat de la versi6 2.0.0.
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[ChannelN]PeakIndicator
[PreviewDeckN]PeakIndicator
[SamplerN]PeakIndicator
Indicates when the signal is clipping (too loud for the hardware and is being distorted)

This is a ControlPotMeter control.
Range binary
Feedback Clip light

[ChannelN]PeakIndicatorL
[PreviewDeckN]PeakIndicatorL
[SamplerN]PeakIndicatorL
Indicates when the signal is clipping (too loud for the hardware and is being distorted) for the left channel

This is a ControlPotMeter control.
Range binary
Feedback Clip light (left)
Novetat de la versi6 2.0.0.

[ChannelN]PeakIndicatorR
[PreviewDeckN]PeakIndicatorR
[SamplerN]PeakIndicatorR
Indicates when the signal is clipping (too loud for the hardware and is being distorted) for the right channel

This is a ControlPotMeter control.
Range binary
Feedback Clip light (right)
Novetat de la versi6 2.0.0.

[ChannelN]pfl
[PreviewDeckN] pfl
[SamplerN]pfl

Toggles headphone cueing (PFL).

Range binary
Feedback Headphone button

[ChannelN]pitch

[PreviewDeckN]pitch

[SamplerN]pitch
The total adjustment to the track’s pitch, including changes from the rate slider if keylock is off as well as
pitch_adjust.

Nota: Do not map this to knobs or sliders on controllers; map pitch_adjust instead.

This is a ControlPotMeter control.
Range -6.0..6.0
Feedback Key display

Novetat de la versi6 2.0.0.

[ChannelN]pitch_up
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[PreviewDeckN]pitch_up
[SamplerN]pitch_up
Changes the track pitch up one half step, independent of the tempo.

Range binary
Feedback Key display
Novetat de la versi6 2.0.0.

[ChannelN]pitch_down
[PreviewDeckN]pitch_down
[SamplerN]pitch_down
Changes the track pitch down one half step, independent of the tempo.

Range binary
Feedback Key display
Novetat de la versi6 2.0.0.

[ChannelN]pitch_adjust
[PreviewDeckN]pitch_adjust
[SamplerN]pitch_adjust

Adjust the pitch in addition to the fempo slider pitch.

This is a ControlPotMeter control.
Range -3.0..3.0
Feedback Key display

Novetat de la versi6 2.0.0.

[ChannelN]play
[PreviewDeckN]play
[SamplerN]play

Toggles playing or pausing the track.

The value is set to 1 when the track is playing or when previewing from cue points and when the play command is

adopted and track will be played after loading.
Range binary
Feedback Play/pause button

[ChannelN]play_indicator
[PreviewDeckN]play_ indicator
[SamplerN]play_ indicator

Provides information to be bound with the a Play/Pause button e.g blinking when play is possible

Range binary, read-only
Feedback Play/pause button
Novetat de la versi6 2.0.0.

[ChannelN]play_latched
[PreviewDeckN]play_ latched
[SamplerN]play_latched

This is set to 1 when the track is playing, but not when previewing (see play).

Range binary, read-only

Feedback Play/pause button

16.5. Mixxx Controls

150



Mixxx User Manual, Versié 2.3.0

Novetat de la versié 2.3.0.

[ChannelN]play_ stutter
[PreviewDeckN]play_stutter
[SamplerN]play_stutter
A play button without pause. Pushing while playing, starts play at cue point again (Stutter).

Range binary
Feedback Play/Stutter button
Novetat de la versi6 2.0.0.

[ChannelN]playposition
[PreviewDeckN]playposition
[SamplerN]playposition

Sets the absolute position in the track.

This is a ControlPotMeter control.
Range -0.14 to 1.14 (0 = beginning -> Midi 14, 1 = end -> Midi 114)
Feedback Waveform

[ChannelN]pregain
[PreviewDeckN]pregain
[SamplerN]pregain
Adjusts the pre-fader gain of the track (to avoid clipping)

This is a ControlPotMeter control.
Range 0.0..1.0..4.0
Feedback GAIN knob

[ChannelN]quantize
[PreviewDeckN] quantize
[SamplerN]quantize
Aligns Hot-cues and Loop In & Out to the next beat from the current position.

Range binary
Feedback Hot-cues or Loop In/Out markers
Novetat de la versi6 1.10.0.

[ChannelN] rate

[PreviewDeckN] rate

[SamplerN] rate
Speed control

This is a ControlPotMeter control.
Range -1.0..1.0
Feedback Speed slider

[ChannelN]rate_dir
[PreviewDeckN] rate_dir
[SamplerN] rate_dir

Indicates orientation of speed slider.

Range -1or1l

[ChannelN] rate_perm_down
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[PreviewDeckN] rate_perm_down
[SamplerN] rate_perm_down
Sets the speed one step lower (4 % default) lower

Range binary
Feedback Perm down button & Speed slider

[ChannelN] rate_perm_down_small
[PreviewDeckN] rate_perm_down_small
[SamplerN] rate_perm_down_small

Sets the speed one small step lower (1 % default)

Range binary
Feedback Perm down button & Speed slider

[ChannelN] rate_perm_up
[PreviewDeckN] rate_perm_up
[SamplerN] rate_perm_up

Sets the speed one step higher (4 % default)

Range binary
Feedback Perm up button & Speed slider

[ChannelN] rate_perm_up_small
[PreviewDeckN] rate_perm up_small
[SamplerN] rate_perm_up_small

Sets the speed one small step higher (1 % default)

Range binary
Feedback Perm up button & Speed slider

[ChannelN]rate_temp_down
[PreviewDeckN] rate_temp_down
[SamplerN] rate_temp_down

Holds the speed one step lower while active

Range binary
Feedback Temp down button & Speed slider

[ChannelN] rate_temp_down_small
[PreviewDeckN] rate_temp_down_small
[SamplerN] rate_temp_down_small

Holds the speed one small step lower while active

Range binary
Feedback Temp down button & Speed slider

[ChannelN] rate_temp_up
[PreviewDeckN] rate_temp_up
[SamplerN] rate_temp_up

Holds the speed one step higher while active

Range binary
Feedback Temp up button & Speed slider

[ChannelN]rate_temp_up_small
[PreviewDeckN] rate_temp_up_small
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[SamplerN] rate_temp_up_small
Holds the speed one small step higher while active

Range binary
Feedback Temp up button & Speed slider

[ChannelN] rateRange
[PreviewDeckN] rateRange
[SamplerN] rateRange
Sets the range of the Speed slider (0.08 = 8%)

This is a ControlPotMeter control.
Range 0.0..4.0
Feedback none, until you move the Speed slider

[ChannelN] rateSearch
[PreviewDeckN] rateSearch
[SamplerN] rateSearch
Seeks forward (positive values) or backward (negative values) at a speed determined by the value

This is a ControlPotMeter control.
Range -300..300
Feedback Deck seeks

[ChannelN] rateEngine
[PreviewDeckN] rateEngine
[SamplerN] rateEngine

Actual rate (used in visuals, not for control)

[ChannelN] reloop_andstop
[PreviewDeckN] reloop_andstop
[SamplerN] reloop_andstop
Activate current loop, jump to its loop in point, and stop playback.

Range binary
Feedback Loop range in waveform activates or deactivates and play position moves to loop in point.
Novetat de la versi6 2.1.0.

[ChannelN] reloop_toggle

[PreviewDeckN] reloop_toggle

[SamplerN] reloop_toggle
Toggles the current loop on or off. If the loop is ahead of the current play position, the track will keep playing
normally until it reaches the loop.

Range binary
Feedback Loop range in waveform activates or deactivates.
Novetat de la versi6 2.1.0.

[ChannelN] repeat
[PreviewDeckN] repeat
[SamplerN] repeat
Enable repeat-mode for the specified deck

Range binary

Feedback when track finishes, song loops to beginning
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Novetat de la versié 1.9.0.

[ChannelN] reset_key
[PreviewDeckN] reset_key
[SamplerN] reset_key

Resets the key to the original track key.

Range binary
Novetat de la versi6 2.0.0.

[ChannelN] reverse
[PreviewDeckN] reverse
[SamplerN] reverse

Toggles playing the track backwards

Range binary
Feedback REV button

[ChannelN] reverseroll
[PreviewDeckN] reverseroll
[SamplerN] reverseroll
Enables reverse and slip mode while held (Censor)

Range binary
Feedback REV button
Novetat de la versié 2.0.0.

[ChannelN] scratch2
[PreviewDeckN] scratch2
[SamplerN] scratch2

Affects absolute play speed & direction whether currently playing or not when [ChannelN],
scratch2_enabled is active. (multiplicative). Use JavaScript engine.scratch functions to manipulate

in controller mappings.
Range -3.0..3.0
Feedback Waveform

Novetat de la versi6 1.8.0.

[ChannelN] scratch2_enabled
[PreviewDeckN] scratch2_enabled
[SamplerN] scratch2_enabled

Takes over play speed & direction for [ChannelN], scratch?.

Range binary
Feedback Waveform
Novetat de la versi6 1.8.0.

[ChannelN]slip_enabled
[PreviewDeckN] slip_enabled
[SamplerN]slip_enabled

Toggles slip mode. When active, the playback continues muted in the background during a loop, scratch etc. Once
disabled, the audible playback will resume where the track would have been.

Range binary
Feedback Slip mode button
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Novetat de la versié 1.11.0.

[ChannelN]stars_up
[PreviewDeckN] stars_up
[SamplerN]stars_up
Increase the rating of the currently loaded track (if the skin has star widgets in the decks section).

Range binary
Feedback Star count is increased in the deck’s star widget and in the library table.
Novetat de la versi6 2.3.0.

[ChannelN]stars_down
[PreviewDeckN] stars_down
[SamplerN] stars_down
Decrease the rating of the currently loaded track (if the skin has star widgets in the decks section).

Range binary
Feedback Star count is decreased in the deck’s star widget and in the library table.
Novetat de la versi6 2.3.0.

[ChannelN]start

[PreviewDeckN]start

[SamplerN]start
Jump to start of track

Range binary
Feedback Track jumps to start

[ChannelN]start_play
[PreviewDeckN]start_play
[SamplerN]start_play

Start playback from the beginning of the deck.

Range binary
Feedback Deck plays from beginning
Novetat de la versi6 1.10.0.

[ChannelN]start_stop
[PreviewDeckN] start_stop
[SamplerN]start_stop

Seeks a player to the start and then stops it.

Range binary
Feedback Deck stops at the beginning.
Novetat de la versi6 1.10.0.

[ChannelN] stop
[PreviewDeckN] stop
[SamplerN] stop

Stops a player.

Range binary
Feedback Pause Button. Deck pauses at the current position.

Novetat de la versio 1.10.0.
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[ChannelN] sync_enabled

[PreviewDeckN] sync_enabled

[SamplerN] sync_enabled
Syncs the tempo and phase (depending on quantize) to that of the other track (if BPM is detected on both). Click
and hold for at least one second activates sync lock on that deck.

Range binary

Feedback If enabled, the Sync button stays lit and tempo slider snap to the appropriate value. Slider
adjustments are linked on all decks that have sync lock enabled.

Novetat de la versi6 2.0.0.

[ChannelN] sync_master
[PreviewDeckN] sync_master
[SamplerN] sync_master

Sets deck as leader clock.

Range binary

Feedback If enabled, the Sync button stays lit and tempo slider snap to the appropriate value. Slider
adjustments are linked on all decks that have sync lock enabled.

Novetat de la versi6 2.0.0.

Canviat a la versi6 2.3.0: This button just enables sync lock mode (similar to [ChannelN], sync_enabled),
it does not actually guarantee the deck will be the sync leader. This will be fixed in a future version.

[ChannelN] sync_mode

[PreviewDeckN] sync_mode

[SamplerN] sync_mode
Novetat de la versi6 2.0.0.

Range
Value | Meaning
0 Sync lock disabled for that deck
1 Deck is sync follower
2 Deck is sync leader

[ChannelN] sync_key
[PreviewDeckN] sync_key
[SamplerN] sync_key

Feedback Key value widget
Match musical key.
Novetat de la versi6 2.0.0.

[ChannelN]track_color
[PreviewDeckN] track_color
[SamplerN]track_color
Color of the currently loaded track or -1 if no track is loaded or the track has no color.

Range 3-Byte RGB color code (or -1)
Feedback Track color changes in the library view.
Novetat de la versi6 2.3.0.

[ChannelN]track_loaded
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[PreviewDeckN] track_loaded
[SamplerN]track_loaded
Whether a track is loaded in the specified deck

Range binary, read-only
Feedback Waveform and track metadata shown in deck
Novetat de la versi6 2.1.0.

[ChannelN]track_samplerate
[PreviewDeckN] track_samplerate
[SamplerN]track_samplerate

Sample rate of the track loaded on the specified deck

Range absolute value, read-only
Feedback None
Novetat de la versié 1.9.0.

[ChannelN]track_samples
[PreviewDeckN]track_samples
[SamplerN]track_samples

Number of sound samples in the track loaded on the specified deck

Range absolute value, read-only
Feedback None

[ChannelN]volume
[PreviewDeckN] volume
[SamplerN]volume

Adjusts the channel volume fader

This is a ControlPotMeter control.
Range default
Feedback Deck volume fader

[ChannelN]mute

[PreviewDeckN]mute

[SamplerN]mute
Mutes the channel

Range binary
Feedback Mute button
Novetat de la versi6 2.0.0.

[ChannelN]vinylcontrol_enabled
[PreviewDeckN]vinylcontrol_enabled
[SamplerN]vinylcontrol_enabled

Toggles whether a deck is being controlled by digital vinyl.

Range binary

Feedback When enabled, a vinyl indication should appear onscreen indicating green for enabled.

Novetat de la versié 1.10.0.

[ChannelN]vinylcontrol_cueing
[PreviewDeckN]vinylcontrol_cueing
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[SamplerN]vinylcontrol_cueing
Determines how cue points are treated in vinyl control relative mode.

Range
Value | Meaning
0 Cue points ignored
1 One Cue - If needle is dropped after the cue point, track will seek to that cue point
2 Hot Cue - Track will seek to nearest previous hotcue

Novetat de la versié 1.10.0.

[ChannelN]vinylcontrol_mode
[PreviewDeckN]vinylcontrol_mode
[SamplerN]vinylcontrol_mode

Determines how vinyl control interprets needle information.

Range
Value | Meaning
0 Absolute Mode (track position equals needle position and speed)
1 Relative Mode (track fempo equals needle speed regardless of needle position)
2 Constant Mode (track fempo equals last known-steady tempo regardless of needle in-
put

See Control Mode for details.
Feedback 3-way button indicates status
Novetat de la versié 1.10.0.

[ChannelN]vinylcontrol_status
[PreviewDeckN]vinylcontrol_status
[SamplerN]vinylcontrol_status

Provides visual feedback with regards to vinyl control status.

Range 0.0-3.0, read-only

Feedback Off for control disabled, green for control enabled, blinking yellow for when the needle
reaches the end of the record, and red for needle skip detected

Novetat de la versio 1.10.0.

[ChannelN]visual_bpm
[PreviewDeckN]visual_bpm
[SamplerN]visual_bpm
BPM to display in the GUI (updated more slowly than the actual BPM).

Range ?
Feedback BPM value widget
Novetat de la versi6 2.0.0.

[ChannelN]visual_key
[PreviewDeckN]visual_key
[SamplerN]visual_key
Current musical key after pitch shifting to display in the GUI using the notation selected in the preferences

Range ?
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Feedback Key value widget
Novetat de la versi6 2.0.0.

[ChannelN]visual_key_distance
[PreviewDeckN]visual_key_distance
[SamplerN]visual_key_distance

The distance to the nearest key measured in cents

This is a ControlPotMeter control.
Range -0.5..0.5
Feedback Key value widget
Novetat de la versi6 2.0.0.

[ChannelN]VuMeter
[PreviewDeckN]VuMeter
[SamplerN] VuMeter

Outputs the current instantaneous deck volume

This is a ControlPotMeter control.
Range default
Feedback Deck VU meter

[ChannelN]VuMeterL
[PreviewDeckN]VuMeterL
[SamplerN]VuMeterL
Outputs the current instantaneous deck volume for the left channel

This is a ControlPotMeter control.
Range default
Feedback Deck VU meter L

[ChannelN]VuMeterR
[PreviewDeckN]VuMeterR
[SamplerN]VuMeterR
Outputs the current instantaneous deck volume for the right channel

This is a ControlPotMeter control.
Range default
Feedback Deck VU meter R

[ChannelN]waveform_zoom
[PreviewDeckN]waveform_zoom
[SamplerN]waveform_zoom

Zooms the waveform to look ahead or back as needed.

Range 1.0-10.0
Feedback Waveform zoom buttons
Novetat de la versio 1.11.0.

[ChannelN]waveform_zoom_up

[PreviewDeckN]waveform_zoom_up

[SamplerN]waveform_ zoom_up
Waveform Zoom Out
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Range ?
Feedback Waveform zoom buttons
Novetat de la versi6 1.11.0.

[ChannelN]waveform_zoom_down

[PreviewDeckN]waveform_zoom_down

[SamplerN]waveform zoom_ down
Waveform Zoom In

Range ?
Feedback Waveform zoom buttons
Novetat de la versié 1.11.0.

[ChannelN]waveform_zoom_set_default

[PreviewDeckN]waveform_zoom_set_default

[SamplerN]waveform_zoom_set_default
Return to default waveform zoom level

Range ?
Feedback Waveform zoom buttons
Novetat de la versio 1.11.0.

[ChannelN]wheel
[PreviewDeckN]wheel
[SamplerN]wheel
Affects relative playback speed and direction persistently (additive offset & must manually be undone).

Range -3.0..3.0
Feedback Waveform

Deprecated controls

These controls have been deprecated, new controller mappings should use the alternatives.

[ChannelN]beatloop
[PreviewDeckN]beatloop
[SamplerN]beatloop

Setup a loop over the set number of beats.

Range positive real number
Feedback A loop is shown over the set number of beats.

Obsolet desde la versié 2.1.0: Use [ChannelN], beatloop_size and [ChannelN], beatloop_toggle instead.

[ChannelN] reloop_exit
[PreviewDeckN] reloop_exit
[SamplerN] reloop_exit

Toggles the current loop on or off. If the loop is ahead of the current play position, the track will keep playing
normally until it reaches the loop.

Range binary
Feedback Loop range in waveform activates or deactivates.

Obsolet desde 1a versi6 2.1.0: Use [ChannelN], reloop_toggle instead.
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[ChannelN] jog
[PreviewDeckN] jog
[SamplerN] jog
Affects relative playback speed and direction for short instances (additive & is automatically reset to 0).

Range -3.0..3.0
Feedback waveform
Obsolet desde la versié ??7: Use the JavaScript engine . scratch functions instead.

[ChannelN] scratch

[PreviewDeckN] scratch

[SamplerN] scratch
Affects playback speed and direction ([differently whether currently playing or not](https://bugs.launchpad.net/
mixxx/+bug/530281)) (multiplicative).

Range -3.0..3.0
Feedback Waveform
Obsolet desde la versié ??7: Use the JavaScript engine . scratch functions instead.

[ChannelN] filter

[PreviewDeckN] filter

[SamplerN] filter
Toggles the filter effect.

Range binary
Feedback Filter button
Novetat de la versi6 2.0.0.
Obsolet desde la versi6 2.0.0: Use [QuickEffectRackl_ [ChannelN]_Effectl],enabled instead.

[ChannelN] filterDepth
[PreviewDeckN] filterDepth
[SamplerN] filterDepth

Adjusts the intensity of the filter effect.

Range default
Feedback Filter depth knob
Novetat de la versi6 2.0.0.
Obsolet desde la versi6 2.0.0: Use [QuickEffectRackl_[ChannelN] ], super] instead.

[ChannelN] filterLow
[PreviewDeckN] filterLow
[SamplerN] filterLow

Adjusts the gain of the low EQ filter.

Range 0.0..1.0..4.0
Feedback Low EQ knob
Obsolet desde 1a versi6 2.0.0: Use [EqualizerRackl_[ChannelN]_Effectl], parameter] instead.

[ChannelN] filterLowKill
[PreviewDeckN] filterLowKill
[SamplerN] filterLowKill

Holds the gain of the low EQ to -inf while active
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Range binary
Feedback Low EQ «kill switch

Obsolet  desde la  versio 2.0.0: Use [EqualizerRackl_[ChannelI]_Effectl],
button_parameter] instead.

[ChannelN] filterMid
[PreviewDeckN] filterMid
[SamplerN] filterMid

Adjusts the gain of the mid EQ filter..

Range 0.0..1.0..4.0
Feedback Mid EQ knob
Obsolet desde la versi6 2.0.0: Use [EqualizerRackl_[Channell]_ Effectl], parameter?Z instead.

[ChannelN] filterMidKill
[PreviewDeckN] filterMidKill
[SamplerN] filterMidKill

Holds the gain of the mid EQ to -inf while active.

Range binary
Feedback Mid EQ kill switch

Obsolet desde la  versi6  2.0.0: Use [EqualizerRackl_[ChannelI]_Effectl],
button_parameter? instead.

[ChannelN] filterHigh
[PreviewDeckN] filterHigh
[SamplerN] filterHigh

Adjusts the gain of the high EQ filter.

Range 0.0..1.0..4.0
Feedback High EQ knob
Obsolet desde 1a versi6 2.0.0: Use [EqualizerRackl_[Channell]_Effectl], parameter3 instead.

[ChannelN] filterHighKill
[PreviewDeckN] filterHighKill
[SamplerN] filterHighKill

Holds the gain of the high EQ to -inf while active.

Range binary
Feedback High EQ Fkill switch

Obsolet  desde la  versio 2.0.0: Use [EqualizerRackl_[ChannelI]_Effectl],
button_parameter3 instead.

[ChannelN]beatloop_X
[PreviewDeckN]beatloop_X
[SamplerN]beatloop_X
Setup a loop over X beats. A control exists for X = 0.03125, 0.0625, 0.125, 0.25,0.5, 1, 2, 4, 8, 16, 32, 64

Range toggle
Feedback A loop is shown over X beats.
Novetat de la versi6 1.10.0.

Obsolet desde 1a versi6 2.0.0: Use [ChannelN], beatloop_X_activate instead.
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Global Sampler controls

These controls can be used to control all samplers.
[Samplers] show_samplers

Range binary

Feedback Shows Sampler bank(s)

[Sampler] SaveSamplerBank
Save sampler configuration. Make currently loaded tracks in samplers instantly available at a later point.

Range binary
Feedback Opens file dialog. Configuration file can be named and saved.

[Sampler] LoadSamplerBank
Load saved sampler configuration file and add tracks to the available samplers.

Range binary
Feedback Opens file dialog. Select configuration file.

16.5.4 Microphones and Auxiliary Channels

In contrast to decks, preview decks and samplers, microphones and auxiliary channels are input channels. You can map
audio interface’s inputs to mixxx’s auxiliary input channels and connect external audio source to it (cellphone, mp3 player).
Then you can use your MIDI controller to control its volume and some other parameters (orientation, gain, volume), apply
effects and use the prelisten function.

Nota: Although the first auxiliary group is named [Auxiliaryl], the group for the first microphone is just called
[Microphone], not [Microphonel].

[MicrophoneN]enabled
[AuxiliaryN]enabled
1 if a channel input is enabled, O if not.

Range binary
Feedback Microphone is enabled.
Novetat de la versi6 1.10.0.
Obsolet desde 1a versi6 2.0.0: Use [MicrophoneN], input_configured instead.

[MicrophoneN] input_configured
[AuxiliaryN]input_configured
1 if there is input is configured for this channel, O if not.

Range binary, read-only
Feedback Configured channel in the sound preferences.

[MicrophoneN]master

[AuxiliaryN]master
Hold value at 1 to mix channel input into the master output. For [MicrophoneN] use [MicrophoneN],
talkover instead. Note that [AuxiliaryN] alsotake [AuxiliaryN], orientation into account.

Range binary
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Feedback Auxiliary: Play button Microphone: N/A

[AuxiliaryN]orientation
Set channel orientation for the crossfader.

Range
Value | Meaning
0 Left side of crossfader
1 Center (not affected by crossfader)
2 Right side of crossfader

Feedback None
Novetat de la versio 1.10.0.

[MicrophoneN]orientation
Novetat de la versié 1.10.0.

Obsolet desde la versi6 1.10.0: The control is not processed in the Mixer, which is also why there are no orientation
controls for Microphones in the GUL

[MicrophoneN]PeakIndicator
[AuxiliaryN]PeakIndicator
Indicates when the signal is clipping (too loud for the hardware and is being distorted)

This is a ControlPotMeter control.
Range binary
Feedback Microphone Clip light
Novetat de la versi6 1.10.0.

[MicrophoneN]PeakIndicatorL
[AuxiliaryN]PeakIndicatorL
Indicates when the signal is clipping (too loud for the hardware and is being distorted) for the left channel

This is a ControlPotMeter control.
Range binary
Feedback Clip light (left)
Novetat de la versi6 2.0.0.

[MicrophoneN]PeakIndicatorR
[AuxiliaryN]PeakIndicatorR
Indicates when the signal is clipping (too loud for the hardware and is being distorted) for the right channel

This is a ControlPotMeter control.
Range binary
Feedback Clip light (right)
Novetat de la versi6 2.0.0.

[MicrophoneN]pfl
[AuxiliaryN]pfl
Toggles headphone cueing (PFL).

Range binary
Feedback Headphone button
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[MicrophoneN] talkover

[AuxiliaryN]talkover
Hold value at 1 to mix channel input into the master output. For [AuxiliaryN] use [AuxiliaryN],
master instead. Note that [AuxiliaryN] alsotake [AuxiliaryN], orientation into account.

Range binary
Feedback Microphone: Talk button Auxiliary: N/A
Novetat de la versi6 1.10.0.

[MicrophoneN] volume
[AuxiliaryN]volume
Adjusts the channel volume fader

This is a ControlPotMeter control.

Range default

Feedback Microphone volume fader changes
Novetat de la versi6 1.10.0.

[MicrophoneN]pregain
[AuxiliaryN]pregain
Adjusts the gain of the input

This is a ControlPotMeter control.
Range 0.0..1.0..4.0
Feedback Microphone gain knob

[MicrophoneN]mute
[AuxiliaryN]mute
Mutes the channel

Range binary
Feedback Mute button
Novetat de la versi6 2.0.0.

[MicrophoneN]VuMeter
[AuxiliaryN]VuMeter
Outputs the current instantaneous channel volume

This is a ControlPotMeter control.

Range default

Feedback Microphone VU meter changes
Novetat de la versi6 1.10.0.

[MicrophoneN]VuMeterL
[AuxiliaryN]VuMeterL
Outputs the current instantaneous deck volume for the left channel

This is a ControlPotMeter control.
Range default
Feedback Deck VU meter L

Novetat de la versi6 2.0.0.
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[MicrophoneN]VuMeterR
[AuxiliaryN]VuMeterR
Outputs the current instantaneous deck volume for the right channel

This is a ControlPotMeter control.
Range default
Feedback Deck VU meter R

Novetat de la versié 2.0.0.

16.5.5 The [VinylControl] group

The [VinylControl] group can toggle the vinyl control feature.
[VinylControl] Toggle
Moves control by a vinyl control signal from one deck to another if using the single deck vinyl control (VC) feature.

Range binary

Feedback If VC isn’t enabled on any decks, enable it on the first one we'’re receiving samples for. If
VC is enabled on a single (exclusive) deck, and another deck is setup to receive samples, disable

it on the former deck and enable it on the next eligible deck (ordered by deck number). If VC is
enabled on multiple decks, don’t do anything.

Novetat de la versié 1.10.0.

[VinylControl] show_vinylcontrol
Toggle the vinyl control section in skins.

Range binary
Feedback Vinyl controls are shown
Novetat de la versi6 1.10.0.

[VinylControl]gain

Allows to amplify the «phono» level of attached turntables to «line» level. This is equivalent to setting the rurntable
boost in Options > Preferences » Vinyl Control

Range binary

Feedback position of Boost slider in Options » Preferences » Vinyl Control (is not updated while viewing
this Preferences page)

Novetat de la versié 1.10.0.

16.5.6 The [Recording] controls

The controls in the [Recording] group can be used to query and control the recording of your mix.

[Recording]toggle_recording
Turns recording on or off.

Range binary
Feedback Recording icon

[Recording] status
Indicates whether Mixxx is currently recording.
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Range
Value | Meaning
0 Recording Stopped
1 Initialize Recording
2 Recording Active

Feedback Recording icon

16.5.7 AutoDJ controls

The [AutoDJ] controls allow interacting with AutoDJ.

[AutoDJ] enabled
Turns Auto DJ on or off.

Range binary
Feedback AutoDJ button
Novetat de la versi6 1.11.0.

[AutoDJ]shuffle_playlist
Shuffles the content of the Auto DJ playlist.

Range binary
Feedback Order of tracks in the AutoDJ playlist changes.
Novetat de la versi6 1.11.0.

[AutoDJ] skip_next
Skips the next track in the Auto DJ playlist.

Range binary
Feedback Skipped track is removed from the AutoDJ playlist.
Novetat de la versi6 1.11.0.

[AutoDJ] fade_now
Triggers the transition to the next track.

Range binary
Feedback Crossfader slider moves to the other side.

Novetat de la versi6 1.11.0.

16.5.8 The [Library] controls
The controls in the [Library] group can be used to navigate the /ibrary. Note that [Library], MoveUp and other
Move and Scroll controls emulate keypresses and therefore require the Mixxx window to be focused.

[Library]MoveUp
Equivalent to pressing the Up key on the keyboard

Range Binary

Feedback Currently selected item changes
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Novetat de la versié 2.1.0.

[Library]MoveDown
Equivalent to pressing the Down key on the keyboard

Range Binary
Feedback Currently selected item changes
Novetat de la versi6 2.1.0.

[Library]MoveVertical

Move the specified number of locations up or down. Intended to be mapped to an encoder knob.

Range Relative (positive values move down, negative values move up)
Feedback Currently selected item changes
Novetat de la versi6 2.1.0.

[Library] ScrollUp
Equivalent to pressing the PageUp key on the keyboard

Range Binary
Feedback Currently selected item changes
Novetat de la versi6 2.1.0.

[Library] ScrollDown
Equivalent to pressing the PageDown key on the keyboard

Range Binary
Feedback Currently selected item changes
Novetat de la versi6 2.1.0.

[Library] ScrollVertical
Scroll the specified number of pages up or down. Intended to be mapped to an encoder knob.

Range Relative (positive values move down, negative values move up)
Feedback Currently selected item changes
Novetat de la versi6 2.1.0.

[Library]MoveLeft
Equivalent to pressing the Le ft key on the keyboard

Range Binary
Feedback Currently selected item changes
Novetat de la versi6 2.1.0.

[Library]MoveRight
Equivalent to pressing the Right key on the keyboard

Range Binary
Feedback Currently selected item changes
Novetat de la versi6 2.1.0.

[Library]MoveHorizontal

Move the specified number of locations left or right. Intended to be mapped to an encoder knob.

Range Relative (positive values move right, negative values move left)
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Feedback Currently selected item changes

Novetat de la versi6 2.1.0.

[Library]MoveFocusForward
Equivalent to pressing the Tab key on the keyboard

Range Binary

Feedback Currently focused pane changes

Novetat de la versi6 2.1.0.

[Library]MoveFocusBackward
Equivalent to pressing the Shift + Tab key on the keyboard

Range Binary

Feedback Currently focused pane changes

Novetat de la versié 2.1.0.

[Library]MoveFocus
Move focus the specified number of panes forward or backwards. Intended to be mapped to an encoder knob.

Range Relative (positive values move forward, negative values move backward)

Feedback Currently focused pane changes

Novetat de la versi6 2.1.0.

[Library]GoToItem
Triggers different actions, depending on which interface element currently has keyboard focus:

Search bar

text box moves focus to tracks table

Clear but- | clears search text

ton

Sidebar

collapsed | expands the item (except Tracks and Auto DJ)

node

leaf node | moves focus to tracks table

Tracks Performs the action selected in Preferences » Library » Track Double-Click Action (default is «Load
table selected track»). Also see Preferences » Decks » Playing track protection
Dialogs / | presses Enter. Note: the Move. . controls allow to move button focus.
popups

Range Binary

Feedback Context dependent

Novetat de la versi6 2.1.0.

[Library]AutoDjAddBottom
[Playlist]AutoDjAddBottom
Add selected track(s) to Auto DJ Queue (bottom).

Range Binary

Feedback Append track(s) to Auto DJ playlist

Novetat de la versi6 2.0.0.
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[Library]AutoDjAddTop
[Playlist]AutoDjAddTop
Add selected track(s) to Auto DJ Queue (top).

Range Binary
Feedback Prepend track(s) to Auto DJ playlist
Novetat de la versi6 2.0.0.

[Library] show_coverart
Toggle the Cover Art in Library

Range Binary

[Library] font_size_increment

Increase the size of the library font. If the row height is smaller than the font-size the larger of the two is used.

Range Binary
Feedback Library view
Novetat de la versi6 2.0.0.

[Library] font_size_decrement
Decrease the size of the library font

Novetat de la versi6 2.0.0.
Range Binary
Feedback Library view

[Library] font_size_knob
Increase or decrease the size of the library font

Novetat de la versié 2.0.0.
Range Relative
Feedback Library view

[Library] sort_column
Indicates the sorting column the track table

Range
Value | Description Library | Playlist | Crate | Browse
1 Artist X X X X
2 Title X X X X
3 Album X X X X
4 Albumartist X X X X
5 Year X X X X
6 Genre X X X X
7 Composer X X X X
8 Grouping X X X X
9 Tracknumber X X X X
10 Filetype X X X X
11 Native Location X X X X
12 Comment X X X X
13 Duration X X X X
14 Bitrate X X X X

continues on next page
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Table 2 - ve de la pagina anterior

Value | Description Library | Playlist | Crate | Browse
15 BPM X X X X
16 ReplayGain X X X X
17 Datetime Added X X X X
18 Times Played X X X X
19 Rating X X X X
20 Key X X X X
21 Preview X X X X
22 Coverart X X X

23 Position X

24 Playlist ID X

25 Location X

26 Filename X
27 File Modified Time X
28 File Creation Time X
29 Sample Rate

30 Track Color X X X

Feedback Sorting indicator in the column headers of the track table
Novetat de la versi6 2.3.0.

[Library] sort_column_toggle
Equivalent to clicking on column headers. A new value sets [Library], sort_column to that value and
[Library], sort_order to 0, setting the same value again will toggle [Library], sort_order.

Range Sameasfor [Library], sort_column orvalue 0 for sorting according the current column
with the cursor on it

Feedback Sorting indicator in the column headers of the track table
Novetat de la versi6 2.3.0.

[Library] sort_order
Indicate the sort order of the track tables.

Range Binary (0 for ascending, 1 for descending)
Feedback Sorting indicator in the column headers of the track table
Novetat de la versi6 2.3.0.

[Library]track_color_prev
Set color of selected track to previous color in palette.

Range Binary
Feedback Track color changes in the library view.
Novetat de la versi6 2.3.0.

[Library]track_color_next
Set color of selected track to next color in palette.

Range Binary
Feedback Track color changes in the library view.

Novetat de la versi6 2.3.0.
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16.5.9 The [Shoutcast] controls

[Shoutcast]enabled
Shows if live Internet broadcasting is enabled.

Range ?
Feedback shoutcast only supports mp3 format as field

[Shoutcast]status
This control displays whether broadcasting connection to Shoutcast server was successfully established.

Range binary
Feedback None

16.5.10 The [Playlist] controls

[Playlist] controls allow navigating the sidebar and tracks table directly without considering the currently focused
widget. This is helpful when another application’s window is focused. This group is going to be deprecated at some point,
with its controls added to [Library] above.

Vegeu també:
See bug #1772184 for the current status.

[Playlist]SelectPlaylist
Scrolls the given number of items (view, playlist, crate, etc.) in the side pane (can be negative for reverse direction).

Range relative value
Feedback Library sidebar highlight

[Playlist] SelectTrackKnob
Scrolls the given number of tracks in the track table (can be negative for reverse direction).

Range relative value
Feedback Library track table highlight

[Playlist]LoadSelectedIntoFirstStopped
Loads the currently highlighted song into the first stopped deck

Obsolet desde 1a versi6 2.1.0: Use [Library], GoToItem instead.

[Playlist]SelectNextPlaylist
Switches to the next view (Library, Queue, etc.)

Obsolet desde la versi6 2.1.0: Use [Library], MoveDown instead.
[Playlist] SelectPrevPlaylist
range binary
feedback Library sidebar
Switches to the previous view (Library, Queue, etc.)
Obsolet desde 1a versi6 2.1.0: Use [Library], MoveUp instead.

[Playlist] ToggleSelectedSidebarItem
Toggles (expands/collapses) the currently selected sidebar item.

Novetat de la versi6 1.11.0.
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Obsolet desde 1a versi6 2.1.0: Use [Library], GoToItem instead.

[Playlist]SelectNextTrack
Scrolls to the next track in the track table.

Obsolet desde 1a versi6 2.1.0: Use [Library], MoveDown instead.

[Playlist]SelectPrevTrack
Scrolls to the previous track in the track table.

Obsolet desde la versi6 2.1.0: Use [Library], MoveUp instead.

16.5.11 The [Controls] controls

The [Controls] group contains controls that didn’t fit in any other group.

[Controls]touch_shift
Once enabled, all touch tab events are interpreted as right click. This control has been added to provide touchscreen
compatibility in 2.0 and might be replaced by a general modifier solution in the future.

Range binary
Feedback All Widgets
Novetat de la versi6 2.0.0.

[Controls]AutoHotcueColors
If enabled, colors will be assigned to newly created hofcues automatically.

Range binary
Feedback None
Novetat de la versi6 2.3.0.

[Controls] ShowDurationRemaining
Represents the current state of the remaining time duration display of the loaded track.

Range
Value | Meaning
0 currently showing elapsed time, sets to remaining time
1 currently showing remaining time , sets to elapsed time
2 currently showing both (that means we are showing remaining, set to elapsed

Feedback None

16.5.12 The Effects Framework

In the list below,
 EffectRack] leaves room for future expansion to multiple EffectRacks.
e Nranges from 1 to [EffectRackl],num_effectunits, inclusive.

¢ M ranges from 1 to [EffectRackl_EffectUnitN],num_effectslots, inclusive. (For a given value
of N)

e Krangesfrom 1to [EffectRackl_EffectUnitN_EffectM], num_parameters,inclusive. (For given
values of N and M)
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e Iranges from 1 to [Master], num_decks, inclusive.

e Jranges from 1 to [Master], num_samplers, inclusive.

Novetat de la versié 2.0.0.

Linking Values

Effect parameters can be linked to the effect’s metaknob. This linkage can be user-controlled by changing the
link_type and the 1ink_inverse control of the parameter. The default link type is loaded from the effect param-

eter’s manifest’s LinkHint property.

Link Type Integer Value | Interpretation

None 0 Not controlled by the metaknob

Linked 1 Controlled by the metaknob as it is

Linked Left 2 Controlled by the left side of the metaknob
Linked Right 3 Controlled by the right side of the metaknob
Linked Left Right | 4 Controlled by both sides of the metaknob

Link Inverse | Integer Value | Interpretation

Normal 0 Linked in equal relation

Inverse 1 Linked in an inverse relation.

EQs and Filters

Equalizers and filters are special effects units.

are controlled by [Equalizer-

Rackl_[ChannelI]_Effectl] and the filter knob is controlled by [QuickEffectRackl_[ChannelI]],
superl and [QuickEffectRackl_[Channell]_Effectl],enabled. Users can choose between several
options for the effects loaded in these racks in the Equalizers section of the Preferences window.

Controls

[EffectRackl] show
Show the Effect Rack

Range binary

[EffectRackl]num_effectunits

[EqualizerRackl]num_effectunits

[QuickEffectRackl]num_effectunits
The number of EffectUnits in this rack

Range integer, read-only

[EffectRackl]clear

[EqualizerRackl]clear

[QuickEffectRackl]clear
Clear the Effect Rack

Range binary

[EffectRackl_EffectUnitN]chain_selector
[EqualizerRackl_[ChannelI] ]chain_selector
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[QuickEffectRackl_[Channell] ]chain_selector
Select EffectChain preset. > 0 goes one forward; < 0 goes one backward.

Range +1/-1

[EffectRackl_EffectUnitN]clear
[EqualizerRackl_[ChannelI]]clear
[QuickEffectRackl_[ChannellI]]clear

Clear the currently loaded EffectChain in this EffectUnit.

Range binary

[EffectRackl_EffectUnitN]enabled

[EqualizerRackl_[Channell] ]enabled

[QuickEffectRackl_[Channell] ]enabled
If true, the EffectChain in this EffectUnit will be processed. Meant to allow the user a quick toggle for the effect
unit.

Range binary, default true

[EffectRackl_EffectUnitN] focused effect
[EqualizerRackl_[ChannelI]]focused_effect
[QuickEffectRackl_[ChannelI]]focused_effect
0 indicates no effect is focused; > 0 indicates the index of the focused effect. Focusing an effect only does something
if a controller mapping changes how it behaves when an effect is focused.

Range 0..num_effects

[EffectRackl_EffectUnitN]group_[ChannelI]_enable

[EqualizerRackl_[ChannelI] ]group_[Channell]_enable

[QuickEffectRackl_[Channell] ]group_[ChannelI]_enable
Whether or not this EffectChain applies to Deck I

Range binary

[EffectRackl_EffectUnitN]group_[Headphone]_enable
Whether or not this EffectChain applies to the Headphone output

Range binary

[EffectRackl_EffectUnitN]group_[Master]_enable
Whether or not this EffectChain applies to the Master output

Range binary

[EffectRackl_EffectUnitN]group_[SamplerJ]_enable
Whether or not this EffectChain applies to Sampler J

Range binary

[EffectRackl_EffectUnitN]loaded

[EqualizerRackl_[ChannelI]]loaded

[QuickEffectRackl_[Channell]]loaded
Whether an EffectChain is loaded into the EffectUnit

Range binary, read-only

[EffectRackl_EffectUnitN]mix
[EqualizerRackl_[ChannelI] ]mix
[QuickEffectRackl_[ChannellI] ]mix
The dry/wet mixing ratio for this EffectChain with the EngineChannels it is mixed with

This is a ControlPotMeter control.
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Range 0.0..1.0

[EffectRackl_EffectUnitN]next_chain
[EqualizerRackl_[ChannelI] ]next_chain
[QuickEffectRackl_[ChannelI] ]next_chain

Cycle to the next EffectChain preset after the currently loaded preset.

Range binary

[EffectRackl_EffectUnitN]num_effects

[EqualizerRackl_[ChannelI] ]num_effects

[QuickEffectRackl_[ChannelI] ]Jnum_effects
The number of Effects that this EffectChain has

Range integer, read-only

[EffectRackl_EffectUnitN]num_effectslots

[EqualizerRackl_[ChannelI] ]num_effectslots

[QuickEffectRackl_[ChannelI] ]Jnum_effectslots
The number of effect slots available in this EffectUnit.

Range integer, read-only

[EffectRackl_EffectUnitN]prev_chain
[EqualizerRackl_[ChannelI] ]prev_chain
[QuickEffectRackl_[Channell] ]prev_chain

Cycle to the previous EffectChain preset before the currently loaded preset.

Range binary

[EffectRackl_EffectUnitN]show_focus

[EqualizerRackl_[ChannelI]]show_focus

[QuickEffectRackl_[Channell] ]show_focus
Whether to show focus buttons and draw a border around the focused effect in skins. This should not be manipulated
by skins; it should only be changed by controller mappings.

Range binary

[EffectRackl_EffectUnitN]show_parameters
[EqualizerRackl_[ChannelI]]show_parameters
[QuickEffectRackl_[ChannelI] ] show_parameters

Range binary
Whether to show all the parameters of each effect in skins or only show metaknobs.

[EffectRackl_EffectUnitN]superl
[EqualizerRackl_[ChannelI]]superl
[QuickEffectRackl_[ChannelI]]superl

The EffectChain superknob. Moves the metaknobs for each effect in the chain.

This is a ControlPotMeter control.
Range 0.0..1.0

[EffectRackl_EffectUnitN_EffectM]clear
[EqualizerRackl_[Channell]_Effectl]clear
[QuickEffectRackl_[Channell]_Effectl]clear

Clear the currently loaded Effect in this Effect slot from the EffectUnit.

Range binary

[EffectRackl_EffectUnitN_EffectM]effect_selector
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[EqualizerRackl_[Channell]_Effectl]effect_selector
[QuickEffectRackl_[Channell]_Effectl]effect_selector
Select Effect — >0 goes one forward, <0 goes one backward.

Range +1/-1

[EffectRackl_EffectUnitN_EffectM]enabled
[EqualizerRackl_[Channell]_Effectl]enabled
[QuickEffectRackl_[Channell]_Effectl]enabled

If true, the effect in this slot will be processed. Meant to allow the user a quick toggle for this effect.

Range binary, default true

[EffectRackl_EffectUnitN_EffectM] loaded

[EqualizerRackl_[Channell]_Effectl]loaded

[QuickEffectRackl_[ChannelI]_Effectl]loaded
Whether an Effect is loaded into this EffectSlot

Range binary, read-only

[EffectRack]l_EffectUnitN_EffectM]next_effect

[EqualizerRackl_[ChannelI]_Effectl]next_effect

[QuickEffectRackl_[ChannelI]_Effectl]next_effect
Cycle to the next effect after the currently loaded effect.

Range binary

[EffectRackl_EffectUnitN_EffectM]num_parameters

[EqualizerRackl_[ChannelI]_Effectl]num_parameters

[QuickEffectRackl_[ChannellI]_Effectl]num_parameters
The number of parameters the currently loaded effect has.

Range integer, read-only, O if no effect is loaded

[EffectRackl_EffectUnitN_EffectM]num_parameterslots

[EqualizerRackl_[ChannelI]_Effectl]num parameterslots

[QuickEffectRackl_[ChannellI]_Effectl]num_parameterslots
The number of parameter slots available.

Range integer, read-only

[EffectRackl_EffectUnitN_EffectM]num_button_parameters

[EqualizerRackl_[ChannelI]_Effectl]num_button_parameters

[QuickEffectRackl_[Channell]_Effectl]num_button_parameters
The number of button parameters the currently loaded effect has.

Range integer, read-only, O if no effect is loaded

[EffectRackl_EffectUnitN_EffectM]num_button_parameterslots

[EqualizerRackl_[ChannellI]_Effectl]num_button_parameterslots

[QuickEffectRackl_[Channell]_Effectl]num_button_parameterslots
The number of button parameter slots available.

Range integer, read-only

[EffectRackl_EffectUnitN_EffectM]meta

[EqualizerRackl_[Channell]_Effectl]meta

[QuickEffectRackl_[Channell]_Effectl]meta
Controls the parameters that are linked to the metaknob.

This is a ControlPotMeter control.

Range 0..1
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[EffectRackl_EffectUnitN_EffectM]prev_effect

[EqualizerRackl_[ChannelI]_Effectl]prev_effect

[QuickEffectRackl_[Channell]_Effectl]prev_effect
Cycle to the previous effect before the currently loaded effect.

Range binary

[EffectRackl_EffectUnitN_EffectM]parameterk
[EqualizerRackl_[ChannelI]_Effectl]parameterkK
[QuickEffectRackl_[Channell]_ Effectl]parameterK

The scaled value of the Kth parameter. See the Parameter Values section for more information.

This is a ControlPotMeter control.
Range double

[EffectRackl_EffectUnitN_EffectM]parameterK_link_inverse

[EqualizerRackl_[ChannelI]_Effectl]parameterK_link_inverse

[QuickEffectRackl_[Channell]_Effectl]parameterK_link_inverse
The link direction of the Kth parameter to the effect’s metaknob.

Range bool

[EffectRackl_EffectUnitN_EffectM]parameterK_link_type

[EqualizerRackl_[ChannellI]_Effectl]parameterK_link_type

[QuickEffectRackl_[Channell]_Effectl]parameterK_link_type
The link type of the Kth parameter to the effects’s metaknob.

Range enum

[EffectRackl_EffectUnitN_EffectM]parameterK_loaded

[EqualizerRackl_[Channell]_Effectl]parameterK_loaded

[QuickEffectRackl_[Channell]_Effectl]parameterK_loaded
Whether or not the Kth parameter slot has an effect parameter loaded into it.

Range binary, read-only

[EffectRackl_EffectUnitN_EffectM]parameterK_type

[EqualizerRackl_[Channell]_Effectl]parameterK_type

[QuickEffectRackl_[Channell]_ Effectl]parameterK type
The type of the Kth parameter value. See the Parameter Value Types table.

Range integer, read-only

[EffectRackl_EffectUnitN_EffectM]button_parameterK
[EqualizerRackl_[ChannelI]_Effectl]button_parameterK
[QuickEffectRackl_[ChannelI]_Effectl]button_parameterK

The value of the Kth parameter. See the Parameter Values section for more information.

Range double

[EffectRackl_EffectUnitN_EffectM]button_parameterK_loaded

[EqualizerRackl_[ChannelI]_Effectl]button_parameterK loaded

[QuickEffectRackl_[ChannelI]_Effectl]button_parameterK_ loaded
Whether or not the Kth parameter slot has an effect parameter loaded into it.

Range binary, read-only

[EffectRackl_EffectUnitN_EffectM]button_parameterK_type

[EqualizerRackl_[ChannelI]_Effectl]button_parameterK_type

[QuickEffectRackl_[ChannelI]_Effectl]button_parameterK_type
The type of the Kth parameter value. See the Parameter Value Types table.
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Range integer, read-only

16.5.13 Removed controls

These controls have been removed from Mixxx. Skins and controller mappings that attempt to use them will not work
correctly.

[ChannelN] flanger
Toggles the flanger effect.

Obsolet desde la versi6 2.0.0: This control has been removed without a direct replacement. Use the effects frame-
work instead.

[ChannelN]Herculesl
[ChannelN]Hercules2
[ChannelN]Hercules3
[ChannelN]Hercules4
Obsolet desde la versié ??: This control has been removed.

[ChannelN]NextTask
Obsolet desde la versio ??: This control has been removed.

[ChannelN]NextTrack
Obsolet desde la versié ??: This control has been removed.

[ChannelN]PrevTask
Obsolet desde la versio ??: This control has been removed.

[ChannelN]PrevTrack
Obsolet desde la versié ??: This control has been removed.

[ChannelN]transform
Obsolet desde la versio ??: This control has been removed.

[Flanger]lfoDepth
Adjusts the intensity of the flange effect

Obsolet desde la versi6 2.0.0: This control has been removed without a direct replacement. Use the effects frame-
work instead.

[Flanger]lfoDelay
Adjusts the phase delay of the flange effect in microseconds

Obsolet desde la versi6 2.0.0: This control has been removed without a direct replacement. Use the effects frame-
work instead.

[Flanger]lfoPeriod
Adjusts the wavelength of the flange effect in microseconds

Obsolet desde la versi6 2.0.0: This control has been removed without a direct replacement. Use the effects frame-
work instead.
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16.6 The Mixxx Settings Directory

The Mixxx settings directory contains all user data and settings of your Mixxx installation.

16.6.1 Location

Linux
~/.mixxx/

Note: make sure you have «Show hidden files» enabled in your file manager in order to show all dot-files
and directories.

Windows

Vista and up: $LOCALAPPDATAS% \Mixxx
XP and below: $USERPROFILE%\Local Settings\Application Data\Mixxx\
Type either of those into the location bar of a Computer or Folder window.

macOS

Mixxx 2.3: ~/Library/Containers/org.mixxx.mixxx/Data/Library/Application
Support /Mixxx

Mixxx 2.2 and earlier: ~/Library/Application Support/Mixxx

16.6.2 Content

analysis This contains all waveform analysis data. This is used to compose a track’s scrolling waveform and track
overview. If not existent, this data will be recreated each time a track is loaded into a Mixxx deck. Thus it does
not belong to the essential data that needs to be backed up.

broadcast_profiles All broadcast profiles you have configured.

controllers All controller mappings you stored. This can be downloaded and self-built mappings, as well as built-in
mappings that you modified in Preferences > Controllers > YourController manually or with the MIDI Wizard.

effects.xml The current configuration of the 4 effect units, incl. the state of all controls.

mixxx.cfg Everything you configured in the Preferences, deck settings, skin settings, AutoDJ configuration, effect routing
etc.

mixxx.log[.NN] Log files of the last few Mixxx sessions, with mixxx .log being the most recent one, followed by
mixxx.log.1 etc.

mixxxdb.sqlite The Mixxx library database. All track locations, all track metadata, saved cues, loops, colors, playlists,
crates, ...

samplers.xml Stores tracks currently loaded to sample decks.
sandbox.cfg This is used under macOS to track which files Mixxx will have access to

soundconfig.xml Sound device configuration from Preferences > Sound Hardware
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16.7 Additional Resources

Got questions? Need more information? Want to contribute? There are a variety of other resources where you can find
out more:

Mixxx Website: For general information and updates, as well as the latest news on Mixxx, go to: https://mixxx.org

Mixxx Wiki: For up-to-date information about supported DJ hardware, documentation on making controller map-
pings, and other tips and tricks, go to: https://github.com/mixxxdj/mixxx/wiki

Keyboard Shortcuts: This a list for all default Mixxx keyboard shortcuts. Please note that these shortcuts are
for keyboards configured in English layout and default shortcuts may be different if your language setting is not
English. default keyboard mappings

Mixxx Community Forums: To search for answers, post your question or answer other DJ’s questions, go to:
https://mixxx.org/forums

Mixxx Zulip Chat: Hang out with Mixxx developers and users on our Zulip chat. Stand-alone apps for Zulip can
be configured to use the server mixxx.zulipchat.com.

Mixxx Source Code: To download the source code for Mixxx, go to: https://github.com/mixxxdj/mixxx
Mixxx Bug Tracker: To report a bug or request a feature, go to: https://bugs.launchpad.net/mixxx

Mixxx Translations: To translate Mixxx and promote your mother tongue, go to: https://www.transifex.com/
mixxx-dj-software/public/. Please read the Translation FAQ first.

Social Media: Follow us on Twitter, and Facebook.

16.8 Changelog

16.8.1 2.3.2 (Unreleased)

Playlist: Enable sorting by color #4352 Ip:1945976

Fix crash when using Doubling/Halving/etc. BPM from track’s Properties window on tracks without BPM #4587
1p:1955853

Fix writing metadata on Windows for files that have never been played #4586 Ip:1955331
Preserve file creation time when writing metadata on Windows #4586 1p1955314
Fix handling of file extension when importing and exporting sampler settings #4539

Fix crash when using an empty directory as resource path using the ——resource-path command line option
#4575 1p1934560

Packaging

Downloads of external dependencies are placed in build/downloads

The sources for libkeyfinder are now expected in build/downloads/libkeyfinder-2.2.5.zip instead of
build/download/libkeyfinder/v2.2.5.zip

CMake: Adjust the download directory and name of external dependencies #4511
Fix/Improve Appstream metainfo #4344 #4346 #4349
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16.8.2 2.3.1 (2021-09-29)

¢ Added mapping for the Numark DJ2GO2 Touch controller #4108 #4287

* Added mapping for the Numark Mixtrack Pro FX controller #4160

¢ Updated mapping for Behringer DDM4000 mixer #4262

» Updated mapping for Denon MC7000 controller #4021

» Hercules Inpulse 300: Add better FX controls and other minor improvements #4246
¢ Denon MC7000: Improve slip mode and jog wheel handling #4021 #4324

¢ Disabled detection of keyboards and mice as HID controllers #4243

» Disabled detection of all HID controllers with Apple’s vendor ID. Apple doesn’t build actual controllers. #4260
#4273

* Add support for HiDPI scale factors of 125% and 175% (only with Qt 5.14+) Ip1938102 #4161
* Fix unhandled exception when parsing corrupt Rekordbox PDB files Ip1933853 #4040

¢ Fix Echo effect adding left channel samples to right channel #4141

* Fix bad phase seek when starting from preroll Ip1930143 #4093

* Fix bad phase seek when a channel’s audible status changes #4156

 Tango skin: Show crossfader assign buttons by default #4046

* Fix keyfinder library in arm64 builds #4047

¢ Fix wrong track being recorded in History Ip1933991 #4041 #4059 #4107 #4296

* Fix support for relative paths in the skin system which caused missing images in third-party skins #4151
* Fix relocation of directories with special/reserved characters in path name #4146

» Update keyboard shortcuts sheet #4042

* Library: resize the Played checkbox and BPM lock with the library font #4050

* Don’t allow Input focus on waveforms #4134

* Fix performance issue on AArch64 by enabling flush-to-zero for floating-point arithmetic #4144
* Fix custom key notation not restored correctly after restart #4136

 Traktor S3: Disable scratch when switching decks to prevent locked scratch issue #4073

* FFmpeg: Ignore inaudible samples before start of stream #4245

* Controller Preferences: Don’t automatically enable checkbox if controller is disabled #4244 1p:1941042
 Tooltips: Always show tooltips in preferences #4198 1p:1840493

* Tooltips: Use item label for tooltips in library side bar and show ID when debugging. #4247
 Library sidebar: Also activate items on PageUp/Down events. #4237

* Fix handling of preview button cell events in developer mode. #4264 1p:1929141

 Auto DJ: Fix bug which could make an empty track stop Auto DJ. #4267 1p:1941743

* Fix Auto DJ skipping tracks randomly #4319 1p1941989

* Fix high CPU load due to extremely high internal sync clock values #4312 1p1943320

* Fix preference option for re-analyzing beatgrids imported from other software #4288
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* Fix wrong base tag used for deployment and displayed in About dialog #4070

Packaging

* It is no longer necessary to manually copy the udev rule file in packaging scripts. Now pkg-config is used to
determine the udevdir used to install the rules file in the CMake install step when CMAKE_INSTALL_PREFIX
is / or /usr. #4126

* Various build issues on FreeBSD are fixed #4122 #4123 #4124
* .desktop file has be renamed to org.mixxx.Mixxx.desktop according to Freedesktop standards #4206
 Uses system provided hidapi library if version >=0.10.1 #4215

* Please update PortAudio to 19.7 if you have not done so already. This is required for Mixxx to work with PipeWire
via the JACK API for many devices.

* Install multiple sizes of rasterized icons #4204 #4315 #4254
* CMake: Fixed detection of SoundTouch pkgconfig file and version #4209
* Fix AppStream metainfo #4205 #4317

16.8.3 2.3.0 (2021-06-28)
Hotcues
* Add hotcue colors and custom labels by right clicking hotcue buttons or right clicking hotcues on overview wave-

forms #2016 #2520 #2238 #2560 #2557 #2362

* Mouse hover cues on overview waveform to show time remaining until the cue #2238

Hotcue & Track Colors

* Add configurable color per track #2470 #2539 #2545 #2630 Ip:1100882
* Add customizable color palettes for hotcue and track colors #2530 #2589 #3749 #2902
* Add hotcue color find-and-replace tool #2547

Importing From Other DJ Software

* Import cue points, track colors, and playlists from Serato file tags & database #2480 #2526 #2499 #2495 #2673
#3885

— Note: Mixxx does not yet support multiple loops per track. We are working on this for Mixxx 2.4. In Mixxx
2.3, if you import a track with multiple loops from Serato, Mixxx will use the first loop cue as the single loop
Mixxx currently supports. The imported loops are still stored in Mixxx’s database and are treated as hotcues
in Mixxx 2.3. If you do not delete these hotcues, they will be usable as loops in Mixxx 2.4. Serato keeps
loops and hotcues in separate lists, but Mixxx does not, so loops from Serato are imported starting as hotcue
9.

 Import cue points, track colors, and playlists from Rekordbox USB drives #2119 #2555 #2543 #2779

— Note: The first Rekordbox memory cue is imported for the main cue button in Mixxx and the remaining
Rekordbox memory cues are imported as Mixxx hotcues, starting with the next hotcue number after the last
hotcue from Rekordbox.
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— Note: Mixxx does not yet support multiple loops per track. Imported loops from Rekordbox are treated like
imported loops from Serato, so refer to the note above for details.

Intro & Outro Cues

¢ Add intro & outro range cues with automatic silence detection #1242
* Show duration of intro & outro ranges on overview waveform #2089

e Use intro & outro cues in AutoDJ transitions #2103

Deck cloning
* Add deck cloning (also known as «instant doubles» in other DJ software) by dragging and dropping between decks
#1892 and samplers #3200
¢ Clone decks by double pressing the load button on a controller (with option to disable this) #2024 #2042

Skins & GUI

¢ Aesthetically revamped LateNight skin #2298 #2342

* Right click overview waveform to show time remaining until that point #2238

 Show track info dialog when double clicking track labels in decks #2990

» Show track context menu when right clicking text in decks #2612 #2675 #2684 #2696

* Add laptop battery widget to skins #2283 #2277 #2250 #2228 #2221 #2163 #2160 #2147 #2281 #2319 #2287
» Show when passthrough mode is active on overview waveforms #2575 #2616

* Changed format of currently playing track in window title from «artist, title» to «artist - title» #2807

¢ Workaround Linux skin change crash #3144 1p:1885009

* Fix touch control Ip:1895431

* Fix broken knob interaction on touchscreens #3512

* AutoDJ: Make «enable» shortcut work after startup #3242

¢ Add rate range indicator #3693

* Allow menubar to be styled #3372 #3788

¢ Add Donate button to About dialog #3838 #3846

* Add Scrollable Skin Widget #3890

* Fix minor visual issues in Skins #3958 #3954 #3941 #3938 #3936 #3886 #3927 #3844 #3933 #3835 #3902 #3931
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Music Feature Analysis

Multithreaded analysis for much faster batch analysis on multicore CPUs #1624 #2142 Ip:1641153
Fix bugs affecting key detection accuracy #2137 #2152 #2112 #2136

— Note: Users who have not manually corrected keys are advised to clear all keys in their library by pressing
Ctrl + A in the library, right clicking, going to Reset -> Key, then reanalyzing their library. This will freeze
the GUI while Mixxx clears the keys; this is a known problem that we will not be able to fix for 2.3. Wait
until it is finished and you will be able to reanalyze tracks for better key detection results.

Remove VAMP plugin support and use Queen Mary DSP library directly. vamp-plugin-sdk and vamp-hostsdk are
no longer required dependencies. #926

Improvements BPM detection on non-const beatgrids #3626

Fix const beatgrid placement #3965 #3973

Music Library

Add support for searching for empty fields (for example crate: " ") Ip:1788086

Improve synchronization of track metadata and file tags #2406

Library Scanner: Improve hashing of directory contents #2497

Rework of Cover Image Hashing Ip:1607097 #2507 #2508

MusicBrainz: Handle 301 status response #2510

MusicBrainz: Add extended metadata support Ip: 1581256 #2522

TagLib: Fix detection of empty or missing file tags Ip:1865957 #2535

Fix caching of duplicate tracks that reference the same file #3027

Use 6 instead of only 4 compatible musical keys (major/minor) #3205

Fix possible crash when trying to refocus the tracks table while another Mixxx window has focus #3201
Don’t create new tags in file when exporting metadata to it #3898

Fix playlist files beginning with non-english characters not being loaded #3916

Enable sorting in «Hidden Tracks» and «Missing Tracks» views #3828 1p:1828555 1p:1924616
Fix track table being empty after start #3935 1p:1930546 1p:1924843

Audio Codecs

Add FFmpeg audio decoder, bringing support for ALAC files #1356

Include LAME MP3 encoder with Mixxx now that the MP3 patent has expired Ip:1294128 buildserver:#37 build-
server:9e8bcee

Add Opus streaming and recording support. 1p:1338413

Remove support for SoundSource plugins because the code was not well-maintained and could lead to crashes
1p:1792747

Add HE-AAC encoding capabilities for recording and broadcasting #3615
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Audio Engine
* Fix loss of precision when dealing with floating-point sample positions while setting loop out position and seeking
using vinyl control #3126 #3127
¢ Prevent moving a loop beyond track end #3117 1p:1799574
¢ Fix possible memory corruption using JACK on Linux #3160
* Fix changing of vinyl lead-in time Ip:1915483 #3781
* Fix tempo change of non-const beatgrid track on audible deck when cueing another track #3772
¢ Fix crash when changing effect unit routing #3882 1p:1775497

* Make microphone ducking use strength knob the same way in automatic & manual mode #2750

Controllers

* Improve workflow for configuring controller mappings and editing mappings #2569 #3278 #3667
* Improve error reporting from controller scripts #2588

» Make hotcue and track colors mappable on controllers #2030 #2541 #2665 #2520

¢ Add way to change library table sorting from controllers #2118

 Add support for velocity sensitive sampler buttons in Components JS library #2032

* Add logging when script ControlObject callback is disconnected successfully #2054

* Add controller mapping for Roland DJ-505 #2111

¢ Add controller mapping for Numark iDJ Live IT #2818

* Add controller mapping for Hercules DJControl Inpulse 200 #2542

* Add controller mapping for Hercules DJControl Jogvision #2370

¢ Add controller mapping for Pioneer DDJ-200 #3185 #3193 #3742 #3793 #3949

* Add controller mapping for Pioneer DDJ-400 #3479

* Add controller mapping for ION Discover DJ Pro #2893

* Add controller mapping for Native Instrument Traktor Kontrol S3 #3031

¢ Add controller mapping for Behringer BCR2000 #3342 #3943

* Add controller mapping for Behringer DDM4000 #3542

» Update controller mapping for Allen & Heath Xone K2 to add intro/outro cues #2236
¢ Update controller mapping for Hercules P32 for more accurate headmix control #3537

¢ Update controller mapping for Native Instruments Traktor Kontrol S4MK2 to add auto-slip mode and pitch fader
range #3331

* Fix Pioneer DDJ-SB2 controller mapping auto tempo going to infinity bug #2559 1p:1846403
¢ Fix Numark Mixtrack Pro 3 controller mapping inverted FX on/off control #3758
¢ Gracefully handle MIDI overflow #825
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Other
¢ Add CMake build system with ccache and sccache support for faster compilation times and remove SCons
#2280 #3618

¢ Make Mixxx compile even though QT_NO_OPENGL or QT_OPENGL_ES_ 2 is defined (fixes build on Raspberry
Pi) 1p:1863440 #2504

* Fix ARM build issues #3602

* Fix missing manual in DEB package 1p:1889776 #2985

¢ Add macOS codesigning and notarization to fix startup warnings #3281

* Don’t trash user configuration if an error occurs when writing #3192

* Enable CUE sheet recording by default #3374

* Fix crash when double clicking GLSL waveforms with right mouse button #3904
¢ Derive Mixxx version from git describe #3824 #3841 #3848

 Improve tapping the BPM of a deck #3790 Ip:1882776

* And countless other small fixes and improvements (too many to list them all!)

16.8.4 2.2.4 (2020-06-27)

* Store default recording format after «Restore Defaults» 1p:1857806 #2414

* Prevent infinite loop when decoding corrupt MP3 files #2417

* Add workaround for broken libshout versions #2040 #2438

» Speed up purging of tracks Ip:1845837 #2393

* Don’t stop playback if vinyl passthrough input is configured and PASS button is pressed #2474
* Fix debug assertion for invalid crate names Ip: 1861431 #2477

* Fix crashes when executing actions on tracks that already disappeared from the DB #2527
¢ AutoDJ: Skip next track when both deck are playing Ip:1399974 #2531

* Tweak scratch parameters for Mixtrack Platinum #2028

* Fix auto tempo going to infinity on Pioneer DDJ-SB2 #2559

* Fix bpm.tapButton logic and reject missed & double taps #2594

¢ Add controller mapping for Native Instruments Traktor Kontrol S2 MK3 #2348

¢ Add controller mapping for Soundless joyMIDI #2425

* Add controller mapping for Hercules DJControl Inpulse 300 #2465

¢ Add controller mapping for Denon MC7000 #2546

¢ Add controller mapping for Stanton DJC.4 #2607

* Fix broadcasting via broadcast/recording input Ip: 1876222 #2743

¢ Only apply ducking gain in manual ducking mode when talkover is enabed Ip:1394968 Ip:1737113 1p:1662536
#2759

¢ Ignore MIDI Clock Messages (0xF8) because they are not usable in Mixxx and inhibited the screensaver #2786
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16.8.5 2.2.3 (2019-11-24)

* Don’t make users reconfigure sound hardware when it has not changed #2253

* Fix MusicBrainz metadata lookup lp:1848887 #2328

* Fix high DPI scaling of cover art #2247

* Fix high DPI scaling of cue point labels on scrolling waveforms #2331

* Fix high DPI scaling of sliders in Tango skin #2318

¢ Fix sound dropping out during recording Ip:1842679 #2265 #2305 #2308 #2309

* Fix rare crash on application shutdown #2293

* Workaround various rare bugs caused by database inconsistencies Ip:1846971 #2321

* Improve handling of corrupt FLAC files #2315

¢ Don’t immediately jump to loop start when loop_out is pressed in quantized mode lp:1837077 #2269
* Preserve order of tracks when dragging and dropping from AutoDJ to playlist Ip:1829601 #2237
» Explicitly use X11 Qt platform plugin instead of Wayland in .desktop launcher Ip:1850729 #2340
* Pioneer DDJ-SX: fix delayed sending of MIDI messages with low audio buffer sizes #2326

* Enable modplug support on Linux by default Ip: 1840537 #2244 #2272

¢ Fix keyboard shortcut for View > Skin Preferences Ip:1851993 #2358 #2372

* Reloop Terminal Mix: Fix mapping of sampler buttons 5-8 1p:1846966 #2330

16.8.6 2.2.2 (2019-08-10)

* Fix battery widget with upower <= 0.99.7. #2221

* Fix BPM adjust in BpmControl. 1p:1836480

* Disable track metadata export for .ogg files and TagLib 1.11.1. Ip:1833190
* Fix interaction of hot cue buttons and looping. 1p:1778246

* Fix detection of moved tracks. #2197

* Fix playlist import. #2200 Ip:1687828

* Fix updating playlist labels. Ip:1837315

* Fix potential segfault on exit. 1p:1828360

* Fix parsing of invalid BPM values in MP3 files. Ip:1832325

* Fix crash when removing rows from empty model. #2128

¢ Fix high DPI scaling of RGB overview waveforms. #2090

¢ Fix for OpenGL SL detection on macOS. Ip:1828019

* Fix OpenGL ES detection. 1p:1825461

* Fix FX1/2 buttons missing Mic unit in Deere (64 samplers). Ip:1837716
* Tango64: Re-enable 64 samplers. #2223

* Numark DJ2Go re-enable note-off for deck A cue button. #2087
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* Replace Flanger with QuickEffect in keyboard mapping. #2233

16.8.7 2.2.1 (2019-04-22)

¢ Include all fixes from Mixxx 2.1.7 and 2.1.8

¢ Fix high CPU usage on MAC due to preview column Ip:1812763

* Fix HID controller output on Windows with common-hid-packet-parser.js

* Fix rendering slow down by not using QStylePainter in WSpinny Ip:1530720
¢ Fix broken Mic mute button Ip:1782568

¢ added quick effect enable button to the control picker menu

* Fix Cover Window close issue with empty cover arts

* Fix Numark Mixtrack 3 mapping. #2057

16.8.8 2.2.0 (2018-12-17)
General

¢ Update from Qt4 to Qt5.
» Use Qt5’s automatic high DPI scaling (and remove the old scaling option from the preferences).

* Vectorize remaining raster graphics for better HiDPI support.

Effects

¢ Add mix mode switch (Dry/Wet vs Dry+Wet) for effect units.
* Add support for LV2 effects plugins (currently no way to show plugin GUIs).

» Add preference option for selecting which effects are shown in the list of available effects in the main window (all
LV2 effects are hidden by default and must be explicitly enabled by users).

Skins

* Add 8 sampler and small sampler options to LateNight.
¢ Add key / BPM expansion indicators to Deere decks.

¢ Add skin settings menu to LateNight.

16.8. Changelog 189


https://github.com/mixxxdj/mixxx/pull/2233
https://bugs.launchpad.net/mixxx/+bug/1812763
https://bugs.launchpad.net/mixxx/+bug/1530720
https://bugs.launchpad.net/mixxx/+bug/1782568
https://github.com/mixxxdj/mixxx/pull/2057

Mixxx User Manual, Versié 2.3.0

Controllers

¢ Add controller mapping for Numark Mixtrack Platinum.
» Update controller mapping for Numark N4.
¢ Add spinback and break for Vestax VCI-400 mapping.

Miscellaneous

¢ Add preference option to adjust the play position marker of scrolling waveforms.
* Add preference option to adjust opacity of beatgrid markers on scrolling waveforms.

* Support IRC/AIM/ICQ broadcast metadata.

16.8.9 2.1.8 (2019-04-07)

* Fix a rare chance for a corrupt track file while writing metadata in out of disk situations. Ip:1815305
¢ Fix export of BPM track file metadata. 1p:1816490

* Fix sending of broadcast metadata with TLS enabled libshout 2.4.1. Ip:1817395

* Fix resdicovering purged tracks in all cases. Ip:1821514

* Fix dropping track from OSX Finder. Ip:1822424

16.8.10 2.1.7 (2019-01-15)

* Fix syncing to doublespeed Ip:1808697

* Fix issues when changing beats of a synced track 1p:1808698

* Fix direction of pitch bend buttons when inverting rate slider Ip:1770745
 Use first loaded deck if no playing deck is found Ip:1784 185

* Encode file names correctly on macOS Ip:1776949

16.8.11 2.1.6 (2018-12-23)

¢ Fix crash when loading a Qt5 Soundsource / Vamp Plug-In. Ip:1774639
 Validate effect parameter range. Ip:1795234

* Fix crash using the bpm_tap button without a track loaded. 1p:1801844
* Fix possible crash after ejecting a track. Ip:1801874

* Fix wrong bitrate reported for faulty mp?3 files. Ip:1782912

¢ Fix Echo effect syncing 1p:1793232

¢ Fix iTunes context menu Ip:1799932

¢ Fix loading the wrong track after delete search and scroll. Ip:1803148

* Improve search bar timing. 1p:1635087

* Fix quoted search sentence. 1p:1784141
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¢ Fix loading a track formerly not existing. 1p:1800395

* Fix importing m3u files with blank lines. Ip:1806271

* Fix position in sampler overview waveforms. Ip:1744170

* Don’t reset rate slider, syncing a track without a beatgrid. 1p:1783020
¢ Clean up iTunes track context menu. Ip:1800335

¢ Collapsed sampler are not analyzed on startup. Ip:1801126

« search for decoration characters like «°». 1p:1802730

* Fix cue button blinking after pressing eject on an empty deck. Ip:1808222

16.8.12 2.1.5 (2018-10-28)

* Code signing for Windows builds. 1p:1517823

* Fix crash on exit when preferences is open. Ip:1793185

* Fix crash when analyzing corrupt MP3s. 1p:1793387

* Fix crash when importing metadata from MusicBrainz. 1p:1794993

* Library search fixes when single quotes are used. 1p:1784090 1p:1789728

¢ Fix scrolling waveform on Windows with WDM-KS sound API. Ip:1729345

* Fix right clicking on beatgrid alignment button in Tango and LateNight skins. Ip:1798237
* Improve speed of importing iTunes library. Ip:1785545

¢ Add 2 deck mapping for DJTechTools MIDI Fighter Twister.

16.8.13 2.1.4 (2018-08-29)

Fix track selection not getting shown in the track table on Windows. There are no changes to the source code, but the
Jenkins build configuration was changed to delete the Jenkins workspace before each build. Ip:1751482

16.8.14 2.1.3 (2018-08-20)

Fix a severe performance regression on Windows: Mixxx 2.1.2 running much slower than 2.1.1

16.8.15 2.1.2 (2018-08-10)

Yet another bugfix release of Mixxx 2.1. Here is a quick summary of what is new in Mixxx 2.1.2:
¢ Allow maximum deck speed of 4x normal.
* Don’t always quantize hotcues, a 2.1.1 regression. Ip:1777429
* Fix artifacts using more than 32 samplers. 1p:1779559
* store No EQ and Filter persistently. 1p:1780479
 Pad unreadable samples with silence on cache miss. Ip:1777480

* Fixing painting of preview column for Qt5 builds. 1p:1776555
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LateNight: Fix play button right click. Ip:1781829

LateNight: Added missing sort up/down buttons.

Fix sampler play button tooltips. 1p:1779468

Shade: remove superfluid margins and padding in sampler.xml. 1p:1773588
Deere: Fix background-color code.

ITunes: Don’t stop import in case of duplicated Playlists. 1p:1783493

16.8.16 2.1.1 (2018-06-13)

After two months it is time to do a bugfix release of Mixxx 2.1. Here is a quick summary of what is new in Mixxx 2.1.1:

Require Soundtouch 2.0 to avoid segfault. Ip:1577042

Improved skins including library view fix. Ip:1773709 Ip:1772202 1p:1763953
Fix crash when importing ID3v2 APIC frames. 1p:1774790

Synchronize execution of Vamp analyzers. Ip:1743256

DlgTrackInfo: Mismatching signal/slot connection.

Detect M4A decoding errors on Windows. 1p:1766834

Fix spinback inertia effect.

Fix decoding fixes and upgrade DB schema. Ip:1766042 Ip:1769717

Fix integration of external track libraries. 1p:1766360

Fix memory leak when loading cover art. 1p:1767068

Fix clearing of ReplayGain gain/ratio in file tags. Ip:1766094

Fix crash when removing a quick link. Ip:1510068

Fidlib: Thread-safe and reentrant generation of filters. Ip:1765210

Fix unresponsive scrolling through crates & playlists using encoder. 1p:1719474

Swap default values for temp/perm rate changes. Ip:1764254

16.8.17 2.1.0 (2018-04-15)

After two years of hard work, we are pleased to announce Mixxx 2.1. We have overhauled the effects system, redesigned
the skins, added and improved lots of controller mappings, rewrote the audio file decoders twice, and of course fixed a
bunch of bugs. Download it!

Here is a quick summary of what is new in Mixxx 2.1.0:

Graphical interface scales for high resolution screens

Overhauled Deere and LateNight skins

New Tango skin

Effects are synchronized to the tempo

Effects are processed post-fader and post-crossfader and can be previewed in headphones

One metaknob per effect with customizable parameter control for intuitive use of effect chains
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Nine new effects: Autopan, Biquad Equalizer, Biquad Full Kill Equalizer, Loudness Contour, Metronome, Para-
metric Equalizer, Phaser, Stereo Balance, Tremolo

Loaded effects and their parameters are saved and restored when Mixxx restarts

More transparent sounding equalizers (Biquad Equalizer and Biquad Full Kill Equalizer)

Improved scratching sounds with jog wheels, vinyl control, and dragging waveforms with the mouse
Simplified looping and beatjump controls

Configurable rows of 8 samplers with up to 8 rows available for a total of 64 samplers

Files loaded to samplers are reloaded when Mixxx restarts

Improved volume normalization algorithm (EBU-R 128)

Filter library table by crates

Sort musical keys in library table by circle of fifths

Write metadata tags back to audio files

New JavaScript library for controller mapping

Configure multiple Internet broadcasting stations and use multiple stations at the same time
Broadcast and record microphones with direct monitoring and latency compensation

Broadcast and record from an external mixer

Booth output with independent gain knob for using sound cards with 6 output channels without an external mixer
Prevent screensaver from starting while Mixxx is running

CUP (Cue And Play) cue button mode

Time remaining and time elapsed now take into account the tempo fader

Clicking cover art now shows it full size in a separate window

and of course, lots and lots of bug fixes.

Here are controllers with mappings that have been added or updated since the 2.0 release. Mappings marked with an
asterisk (*) have been updated for the new effects interface:

American Audio VMS2
American Audio VMS4

Allen & Heath Xone K2/K1*
Behringer CMD Micro
Behringer CMD MM1*
Behringer CMD Studio 4a
Denon MC4000*

Denon MC6000 Mk2*
FaderFox DJ2

Hercules DJ Console 4-Mx*
Hercules DJ Control MP3 LE / Glow
Hercules DJ Control Compact
Hercules P32*

16.8.

Changelog 193



Mixxx User Manual, Versié 2.3.0

¢ Jon Discover DJ

» Korg Nanokontrol 2

* Korg KAOSS DJ

¢ M-Audio Xponent

* Native Instruments Traktor Kontrol S4 Mk2*
* Novation Launchpad Mk1 & Mk2

¢ Novation Twitch

e Numark Mixtrack Pro 3 & Numark Mixtrack 3*
¢ Pioneer DDJ-SB2*

* Pioneer DDJ-SX*

¢ Reloop Beatmix 2

* Reloop Beatmix 4

* Reloop Digital Jockey 3 ME

* Reloop Terminal Mix 2

¢ Reloop Terminal Mix 4

* Vestax VCI-100 Mk2

* Vestax Typhoon

For users upgrading from older versions of Mixxx, we have a few important announcements. First, if you are using
Windows, you will have to uninstall any old versions of Mixxx before you can install 2.1. How to uninstall Mixxx varies
on different versions of Windows:

* Windows Vista, 7, and 8: Start > Control Panel > Programs > Uninstall a Program
¢ Windows 10: Start > Control Panel > Programs > Programs And Features > look for Mixxx > Uninstall

If you are upgrading from an older version of Mixxx and have MP3 files in your library, we have another important
announcement. The good news is that we fixed a bug where the waveforms and audio playback of MP3 files were mis-
aligned. The bad news is that we have no way of knowing which MP3 files were affected or how much the offset was. That
means that waveforms, beatgrids, cues, and loops from older versions of Mixxx may be offset by an unknown amount
for any MP3 file. Only MP3 files were affected by this bug; other audio file types are unaffected. You can either correct
your beatgrids and cue points manually for each track, or you can clear this information for all MP3s and start fresh.
Regardless, we recommend clearing the waveforms for all MP3 files. To clear these, type «location:mp3» into the library
search bar, press Control + A to select all tracks, right click, and select the information you want to clear from the menu.

In the works for Mixxx 2.2, we have a big redesign of the library GUI. Along with that will come saving & restoring
search queries plus nested crates. We are also planning on adding support for saving and loading custom effect chain
presets with the ability to import and export them to share online.

Want to help make Mixxx even more awesome? The biggest thing we need is more people. You do not need to be a
programmer to help out. Giving feedback on the design of new features as they are being made is very valuable. Refer
to the Testing page on the wiki for more information on how to get involved with that. Reporting bugs and telling us
your ideas on the Launchpad bug tracker is a big help too! We cannot fix problems we do not know about, so please let
us know if you find any issues with Mixxx. If you would like to help translate Mixxx into another language, refer to the
Internationalization wiki page. Of course, more programmers could always help. Read the Developer Documentation on
the wiki for tips on getting started contributing code to Mixxx.

We hope you have as much fun with Mixxx as we do!

For a full list of new features and bugfixes, check out the 2.1.0 milestone on Launchpad.
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16.8.18 2.0.0 (2015-12-31)

For a full list of new features and bugfixes, check out the 2.0.0 milestone on Launchpad.

4 Decks with Master Sync

New Effects Framework with 4 Effect Units and 5 Built-in Effects:
— Flanger, Bit Crusher, Reverb, Echo, Filter
— More to come!

Configurable, Resizeable User Interface with 3 Brand New Skins

Cover Art Display

Music Key Detection and Shifting

Vinyl Audio Pass-Through

4 Microphone inputs and 4 Auxiliary inputs

MIDI Mapping GUI and Improved Learning Wizard

MusicBrainz metadata fetching

RGB Musical Waveforms

Hundreds of Bug Fixes and Improvements

New Pitch-Independent Algorithm for Better-Sounding Key-lock

Vegeu també:

For an overview of previous versions, take a look at the timeline.
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CHAPTER 17

Hardware Manuals

17.1 Controllers

Mixxx supports the following controllers out of the box. Additional third-party controller mappings that were contributed
by the community (but are not yet included in Mixxx) can be found at Mixxx” Controller Mapping Forum.

Vegeu també:

Amb controladores MIDI/HID describes how to configure Mixxx to use controllers.

17.1.1 Akai LPD8

e Manufacturer’s product page
¢ Forum thread

Novetat de la versié 1.10.1.

Nota: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller, please
consider contributing one.

17.1.2 Akai MPD24

e Manufacturer’s product page
¢ Forum thread

Novetat de la versio 1.8.
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Nota: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller, please
consider contributing one.

17.1.3 Allen & Heath Xone:K2

The Allen & Heath Xone:K2 is a flexible controller that is mapped to control Mixxx’s decks, effects, or both. It has an
integrated 4 channel audio interface with 2 RCA jacks and an 1/8» stereo headphone jack. The Xone K1 is the same as
the Xone K2 but without the built in audio interface and does not come with the EVA travel case that the K2 comes with.

e Manufacturer’s product page
* Forum thread

* Manufacturer’s User Guide
 Blank template diagrams

Novetat de la versio 1.11.

Audio Setup

The Xone:K2 is setup in Mixxx > Preferences > Sound Hardware > Output

Output Device Channel
Master XONE:K2 | Channel 3 - 4
Headphones | XONE:K2 | Channel 1 -2

Note: This Channel setup is the opposite of what most DJ controllers with an integrated audio interface use. The design
choice to not use Channel 1 - 2 for Master Output is known to cause problems, when users want to use the Xone:K2
as default system audio output as the operating system will always use Channel 1 - 2. Thus system audio will go to the
headphones.

There are no hardware controls for the volume so they are always at max volume. Adjusting the volume of master and
headphone outputs is done by adjusting the gain for those outputs in Mixxx using the controller mapping.

Setup

Requirement: The Xone K2 must have Latching Layers turned off, which is the default. Refer to the Xone K2 manual
page 12 for details. The K1 does not have Latching Layers.

This mapping can used with one or multiple Xone K2s/K1s. Multiple Xone K2s/K1s can be connected to each other via
X-Link with one of them connected to the computer via USB. Alternatively, when using 2 K2s/K1s, they can both be
connected with their own USB cable and this same mapping can be loaded for each.

The layout of the mapping depends on the configured MIDI channel of the controller. Change the MIDI channel of the
controller by pressing the bottom right encoder (labeled “Power On Setup/Scroll/Set”) while plugging in the controller.
Scroll with the encoder to select a MIDI channel. The letter in parentheses corresponds to the last lit button when selecting
the channel:

¢ Channel 15 (O, default out of the box): two decks + two effect units with decks in the middle
¢ Channel 14 (N): two decks + two effect units with effect units in the middle

¢ Channel 13 (M): two decks + two effect units with decks on left
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Channel 12 (L): two decks + two effect units with decks on right
Channel 11 (K): four decks ordered 312 4

Channel 10 (J): four decks ordered 1 2 3 4

Channel 9 (I): four effect units ordered 3 12 4

Channel 8 (H): four effect units ordered 12 3 4

Global Controls

These are available on any configuration with decks, but not the 4 effect unit layout.

Bottom left encoder:

adjust tempo of all decks with sync enabled

press and turn: PFL/master mix in headphones

shift: headphone gain

press with shift: toggle split cue mode

Bottom right encoder

scroll through tracks in library

press and release: load selected track into first stopped deck

press and hold: load selected track into a deck by pressing the play button of the deck

shift: master gain

Decks

The bottom right button is the shift button. The bottom left button toggles the bottom button grid between a loop layer
(amber) and a hotcue layer (red). Holding shift then holding the bottom left layer button at the same time activates
supershift mode.

Top encoder: jog
— shift: gain
— supershift: adjust key
Top encoder press: reset gain
— shift: master sync
— supershift: reset key
Knobs: high/mid/low equalizer knobs
Top button 1: headphones/PFL
— shift: reset tempo
— supershift: set beatgrid to current position
Top button 2: cue
— shift: go to beginning of track and stop

— supershift: keylock
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 Top button 3: play

— shift: reverse

— supershift: quantize
¢ Fader: volume

* Bottom buttons (intro/outro cue layer, amber): Intro/outro cues from top to bottom are ordered: - Intro start - Intro
end - Outro start - Outro end

— press: jump to that cue or sets it if it is not set
— shift: seek forward/back. The top two (intro) buttons seek quickly; the bottom two (outro) seek slowly
— supershift: delete cue
* Bottom buttons (hotcue layer, red): Hotcues are ordered 1-4 from top to bottom
— press: jump to that hotcue or sets it if it is not set
— shift: seek forward/back. The top two buttons seek quickly; the bottom two seek slowly
— supershift: delete hotcue
* Bottom buttons (loop layer, green):
¢ Bottom button 1 (red): reloop/disable loop
— shift: jump to to beginning of loop, stop playback, and activate loop
— supershift: set loop in point. Hold to move loop in point with play position.
¢ Bottom button 2 (green): activate loop of selected size
— shift: activate rolling loop of selected size
— supershift: set loop out point. Hold to move loop out point with play position.
* Bottom button 3 (amber): double loop size

— shift: beatjump forward by selected size if no loop is enabled. If loop is enabled, move the loop forward by
the beatjump size.

— supershift: double beatjump size
* Bottom button 4 (amber): halve loop size

— shift: beatjump backward by selected size if no loop is enabled. If loop is enabled, move the loop backward
by the beatjump size.

— supershift: halve beatjump size

Effects

The top part of the column uses the Standard Effects Mapping. Pressing the top encoder acts as the effect focus button.
When no effect is focused, the buttons are red. When holding the top encoder to choose an effect to focus, the buttons
are green. When an effect is focused, the buttons are amber.

The fader acts as the mix knob.

The bottom buttons assign the effect unit to different input channels and light up red. On the two deck layouts, from top
to bottom, they assign the effect unit to deck 1, deck 2, master mix, and headphones. On the four effect unit layouts, they
assign the effect unit to decks 1-4 going down the column. You can look down a column to see which decks an effect unit
is assigned. You can look across a row to see which effect units are assigned to a deck. When shift is pressed, the bottom
two buttons switch to controlling the routing buttons for the master and headphones channels and light up amber.
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The bottom encoders are not mapped in the 4 effect unit layout.

Effect unit focusing

In addition to focusing one effect in a unit at a time with the Standard Effects Mapping, the Xone K2/K1 has another
mode for focusing a whole effect unit. This allows for controlling the parameters of all 3 effects in the unit at a time. This
mode is only available on the 4 effect unit layouts. To access it, press the Layer button in the bottom left. Press one of
the top encoders to choose which effect unit to focus.

In this mode, each horizontal row of knobs and buttons controls one effect. The knobs control the parameters of the
effects. Turning any of the knobs with shift loads different effects. The button in the leftmost column controls the enable
button of the effect and turns amber when it is on. The rest of the buttons control the button parameters of the effect and
turn green when active (not all effects have button parameters). The faders still control the dry/wet knobs and the bottom
button grid still controls the routing buttons.

To get back to controlling all 4 effect units, press the Layer button again. The next time Layer is pressed, the effect unit
that was focused before will be remembered (but it will not be remembered after restarting Mixxx).

Troubleshooting

If general functionality or supershift are not working, double check that Latch Layers is turned off and MIDI CH is
selected. Refer to the Xone K2 manual page 12 for details.

Known Issues

There are a few known issues with the Xone K2/K1 firmware:

» Since there is no way for Mixxx to ask the controller about the positions of all the knobs and faders when Mixxx
starts, they are out of sync with the state of Mixxx until they are first moved.

¢ When the USB connection is interrupted and the controller stays powered on, such as leaving the controller plugged
into a powered USB hub and disconnecting the hub from the computer, the controller will not send MIDI input
until it is powered down (unplugged) and plugged back in.

If you would like these issues to be fixed, please let Allen & Heath Support know.

17.1.4 American Audio Radius 2000

A CD and USB media player that can control Mixxx over USB with MIDI. It can also play timecode from CDs or USB
drives which can control Mixxx when they are connected by a sound card.

e Manufacturer’s product page

Novetat de la versio 1.10.

Nota: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller, please
consider contributing one.
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17.1.5 American Audio VMS2

The American Audio VMS?2 is a 2-deck all-in-one controller. It is a USB class compliant MIDI and audio device that
works with GNU/Linux, Mac OS X, and Windows. It features a 4 channel input and 4 channel output sound card with
2 phono preamps. The main output has XLR and RCA outputs (do not use both at once). There is a separate RCA
booth output. The VMS?2 can also be used as a stand-alone mixer with analog sources without a computer by setting the
USB/Analog switches on the front of the device to “Analog”.

* Manufacturer’s product page, provides manual and drivers for download.
e Forum thread, for discussion of mapping options.
¢ Pull Request, which this wiki page describes.

Novetat de la versio 1.11.

Audio Setup

No driver needs to be installed on GNU/Linux or Mac OS X. However, on Windows, it is recommended to install the
driver from the manufacturer to be able to use the ASIO sound API.

Unlike most controllers with built in sound cards, which rely on Mixxx to do all mixing in software, the VMS2 mixes
signals from the sound card in hardware. To use it with Mixxx:

 Bypass the built-in hardware equalizer of the VMS2 (i.e. use Post-EQ Mode). Hold the forward search button on
the right deck as you turn the VMS2 on to switch between Post-EQ and Pre-EQ modes. See section 15 of the
manufacturer’s manual for details.

* Set the USB/Analog switches on the front side of the VMS2 to “USB”
¢ In Mixxx’s Sound Hardware Preferences:

 Set the sample rate to 48000 Hz

¢ Select channels 1-2 for Deck 1 output

¢ Select channels 3-4 for Deck 2 output

Note: You cannot use the preview deck to pre-listen in this setup, as Mixxx routes the preview deck to Mixxx’s headphone
output, which is not mixed with the Deck 1/2 outputs. You could use a separate soundcard and route the headphone output
there to also pre-listen using the preview deck. Of course, if you do so, attach the headphones to that other soundcard
instead of the VMS2.

Input and Recording

The analog inputs are captured by the built-in soundcard as input signals. They can be used for timecode signals (e.g. time-
code vinyl), as the VMS2 also features built-in phono preamps. FIXME I did not try that, please verify!

The microphone input is mixed directly into the master output signal of the VMS2 in hardware and cannot be captured
through software. If you want to record voice over using the Mixxx software, you will need a different solution. You can
use a separate microphone attached to the computer, but that signal will not be routed to the VMS2 and therefore not be
on the VMS2 master output (but in the Mixxx recording from the software master/record output).

Mixxx’s Deck 1/2 outputs are affected by the Mixxx software EQs. However, the VMS2’s volume faders and crossfader
(as well as the headphone buttons) control the VMS2’s hardware mixer and do not affect Mixxx’s Deck 1 and Deck 2
output signals. Therefore, a recording using the Mixxx software will sound different from what is played through the
VMS2 master output, as the crossfader curve and signal mixing are not the same in hardware and software. If you require
a recording that captures exactly what the audience will hear, use a separate soundcard and recording software to record
from the VMS2 booth output.
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Mapping description

Mixer section

All main functions are mapped straightforwardly:

VMS2 Control Mixxx Control

Crossfader Crossfader

Volume Fader Volume Fader

Cue (PFL) PFL

Cue Mix Cue Mix (PFL / Master)

Headphone Gain | Headphone Gain
Channel Gain Channel Gain
Master Gain Master Gain

As noted in the #Audio Setup section, these control the VMS2’s hardware mixer. Although the state of the controls is
reflected on screen in Mixxx, the actual mixing is done by the VMS2’s hardware mixer.

Deck Control

Deck control is straightforward, too:

VMS2 Control Mixxx Control

Play Toggle deck play/pause

Pause Pause the deck

Cue Cue Point (configure behavior in software)
Pitch +/- Temporary pitch bend +/-

Pitch Fader Pitch Fader

Range (Shift+Sync) Cycle pitch fader range (+-8/10/30/100%)
Sync Sync to other deck

Search <</>> Search through currently loaded track
Keylock (Shift+Vinyl) | Toggle pitch independent time stretch (KeyLock)
Vinyl Toggle between Scratch mode and Pitch mode
Platter Touch sensitive platters! Scratch or Pitchbend
Shift + Platter Scroll through library quickly

In Pitch mode, moving the platters from either the top or side will only bend the pitch of the deck. In Scratch mode, the
platters act like vinyl turntables and can be used for scratching. Touching and holding them from the top stops the deck.
Moving them from the edge does not stop the deck.

Library and Track loading

Use the encoder in the center of the controller to browse through the library. Press the encoder to switch between library
main window and sidebar. Unfortunately there seems to be no way to expand entries in the sidebar through the controller
script.

Use the [LOADY] buttons to load the currently selected track into either the left or right deck.

The four directional buttons around the knob also control the library:
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Button | Library function

Up Previous library entry
Down Next library entry
Left Previous sidebar entry
Right Next sidebar entry

If you hold Shift and then rotate a platter, you can scroll through the library much faster.

Equalizer

The per deck EQ rotaries are mapped to their software counterparts. The VMS2 has no dedicated kill switches for the
EQ. However, in Mixxx, pressing the following buttons with Shift acts as EQ kill switches.

Hotcues

VMS2 Control | Mixxx Control

Shift+IN Kill Switch Low
Shift+OUT Kill Switch Mid
Shift+RELOOP | Kill Switch High

The VMS2 can control 6 hotcues per deck.

VMS2 Control

Mixxx Control

1/2/3

Set/Jump HotCue 1 /2 /3

Vinyl+1/2/3

Delete HotCue 1/2/3

4/5/6=(Shift+1/2/3)

Set/Jump HotCue 4/5/6

Vinyl +4/5/6 =

(Vinyl + Shift + 1/27/3)

Delete HotCue 4/5/6

Pressing the vinyl/keylock button will not toggle scratch mode or keylock as long as a hotcue is deleted before releasing
the vinyl/keylock button.

Loops

VMS2 Control Mixxx Control

IN Mark beginning of loop

ouT Mark end of loop

RELOOP Leave / Reenter current loop

LOOP Start a 4 Beat loop from current position
Smart (Shift + Loop) | Toggle quantize

(:2)/ (*2) Halve or double the current loop length

As Mixxx currently only supports one active loop per deck, the secondary loop controls have been remapped to EQ kill

switches.
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17.1.6 American Audio VMS4/4.1

The original VMS4 has problems with sound quality. The microphone input impedance is off and the output volume is
low. The VMS4.1 is the same controller, except that those hardware issues have been fixed. The Traktor edition has
different labels on some buttons & knobs, but it’s otherwise the same hardware as the VMS4.1.

* VMS4
e VMS4.1
e VMS4.1 Traktor edition

Novetat de la versio 1.9.

Setup

Nota: Mixxx expects the VMS4 to be set to “Post EQ” mode for best sound quality. Do this by holding down the
Headphone Cue button on Midilog 4 while powering on the unit. You only need to do this once. (Each time you do, it
changes the mode back and forth.) Consult the user manual for more information.

To check the status of this in Linux, at a console, issue the command 1susb -v|grep 'iSerial\|iProduct'
and look at the serial number under the VMS4 device per the instructions in the user manual. As of this writing, the
leading digit should be 1.

1. Make sure the VMS4 is off
2. Slide the switch on the front of the VMS4 to “8 OUT”

« If you’re using vinyl control or aux devices (or Mixxx 1.11 & below) set the switch to “4 OUT” for 2-deck
output and 2-deck input

Turn on the unit (and plug in the USB cable if you haven’t yet)
Start Mixxx

Open Preferences

A

Click Sound Hardware. In the right pane:
1. Set the sample rate to 44100Hz
Set the Master output to None
Set the Headphone output to None
Set the Deck 1 output to the VMS4 device and Channel 3-4 (may show as “USB Audio Device” on Windows)
Set the Deck 2 output to the VMS4 device and Channel 5-6
Set the Deck 3 output to the VMS4 device and Channel 1-2
Set the Deck 4 output to the VMS4 device and Channel 7-8

AT R

* If you're using 4 OUT mode, (for vinyl control/aux input or Mixxx 1.11 & below):
1. Set the Deck 1 output to the VMS4 device and Channel 1-2
2. Set the Deck 2 output to the VMS4 device and Channel 3-4

3. For vinyl control, set the Vinyl Control 1 input to the VMS4 device and Channel 1-2, connect a
turntable to Midilog 1, and set it to Analog.
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4. For vinyl control, set the Vinyl Control 2 input to the VMS4 device and Channel 3-4, connect a
turntable to Midilog 4, and set it to Analog.

7. Plug your headphones into the VMS4’s jack on the front. You will use the VMS4’s CUE buttons and knobs for
headphone control.

8. Still in the Preferences, expand “Controllers” on the left
9. Select the “VMS4 MIDI” device (may show as “USB Audio Device” on Windows)
* Do not choose the the HID one. That’s for the little mouse pad and button area.
10. Click the Enable checkbox in the right pane
11. Click the drop-down and choose the American Audio VMS4 preset
12. Click OK and the controller should light up. (In 1.9.x, the controller will light up when you load a track to a deck.)

13. Continue reading below to know how everything is mapped

Direct deck output implications

This setup uses direct deck outputs because mixing takes place in the VMS4 hardware. The down side to this is that you
won’t be able to use Mixxx features that play to Master or Cue buses like the Preview Deck or Samplers. Using these
features with a hardware + MIDI mixer like the VMS4 is not really feasible unless you used a separate sound interface or
controlled Mixxx’s internal mixer another way.

Control

This guide explains how the VMS4 is mapped by default in Mixxx.

Easy customization: We have provided the following customization variables at the top of the script you can set to your
liking:

1. RateRanges: Set the pitch slider range each time you toggle it with Shift+Sync.

Just open the midi/American—-Audio-VMS4-scripts. js file in your favorite text editor (Wordpad works too)
and you’ll see these variables right near the top. Edit & save, then restart Mixxx and enjoy.

Deck controls

Nota: There are a number of different face plates in the wild so these images and control descriptions may not exactly
match yours. The locations of the controls are the key things to pay attention to.

The controls are the same on both sides of the controller. The left side controls Deck 1 and the right side controls Deck 2.

* Sync/Range button - Changes the BPM of this deck to match that of the other. When shifted, toggles the pitch
slider range. (See top of page to customize.)

* Hot cue buttons - Press to set or recall a hot cue. The buttons light up red when one is set. Hold Shift and press
to access hot cues 5-8. (The buttons light up blue for these.) Hold Vinyl and press to delete the cue. (Note: there
is a bug in some firmware versions that causes hot cues 5 and 6 to be deleted simultaneously.) the cue.

* Pitch Bend +/-
¢ Momentarily speeds up or slows down the deck while the button is held down.

* Hold Shift and press to adjust the key (pitch) of the song (independent of the tempo.)
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Loop In - Set the in point of a loop

Loop Out - Set the out point of a loop

Reloop - Toggle a previously-set loop. Lights red when a loop is active.

Loop/Smart Start a 4-beat loop. Hold Shift and press to toggle quantization (locking to the nearest beat.)
Vinyl/Keylock - (Does nothing on its own when un-shifted at the moment.) When shifted, toggles key lock.
<< Search/ /2 - Fast-rewind Hold Shift and press to halve the current loop length

Search >>/ *2 - Fast-forward Hold Shift and press to double the current loop length

Touch strip Scroll through the respective Library panes. (Left for the folders/crates list, right for the track list.)
Hold Shift and touch: - to affect the Dry/Wet knob on the respective effect unit while the deck is playing - for
Needle drop - search through the track while the deck is stopped

Wheel Move the wheel while touching the top to scratch the current track like a vinyl record Move the wheel
without touching the top (so on the sides) to perform a temporary pitch bend

CUE - Operates according to the Cue mode set in Mixxx’s preferences Hold Shift and press to play immediately
from the cue point (known as Cue+Play or CUP.)

Play - Press to toggle deck playback Hold Shift and press to set this deck as the master for syncing with another

Pause - Stops the deck playback

Effects section

The left side controls effect unit 1 and the right side controls effect unit 2.

Select knob

Rotate to choose the effect chain preset

Press to toggle whether the effect unit is on or not

Control knob

Adjusts the wet/dry ratio

When Parameter is on, this becomes the Wonder Knob, adjusting all effect parameters at once
On/OfAf - Toggles the effect for the deck matching the effect unit number

Parameter - Toggles what the above Control knob adjusts

Sample section

The left side of the controller controls Sampler 1, and the right, Sampler 2.

Select knob Rotate to move the highlight in the library. Press to load the currently highlighted track into the
sampler. Hold Shift and press to eject the current track from the sampler (when the sampler is not playing.)

Volume knob - Adjusts the volume of the sampler

Play Press to play the sample from the beginning. Press while playing for a stutter-play effect (play again from the
beginning.) Hold Shift and press to stop playing.

Rec - Currently does nothing
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Mixer controls

The volume sliders don’t control the ones in Mixxx because direct Deck outputs are affected by Mixxx’s internal ones.
* Midilog 1: This strip controls Deck 3/C
¢ Midilog 2: This strip controls Deck 1/A
* Midilog 3: This strip controls Deck 2/B
* Midilog 4: This strip controls Deck 4/D

17.1.7 Behringer BCD2000

The Behringer B-Control Deejay BCD2000 features a USB 4-channel audio interface plus 24-bit A/D and D/A converters.
This controller has been discontinued. The Behringer BCD3000 is its successor.

e Manufacturer’s product page

e Forum thread

Novetat de la versio 1.11.

Nota: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller, please
consider contributing one.

17.1.8 Behringer BCD3000

e Manufacturer’s page

The B-Control Deejay BCD3000 controller is a 4-channel audio interface. It offers a fully fitted controller console with
24-bit A/D und D/A converters, a USB audio interface with a microphone preamplifier, a 3-band kill EQ for each channel,
faders, a crossfader and talkover function.

By default, the input channels 1-2 use the RCA phono inputs for the source signal. On Windows, this can be switched to
the microphone in the ASIO driver control panel. On GNU/Linux and Mac OS X, a particular MIDI message must be
sent to switch channels 1-2 to the microphone input.

Novetat de la versio 1.6.

Nota: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller, please
consider contributing one.

17.1.9 Behringer BCR2000

e Manufacturer’s product page
* Forum thread

The B-CONTROL BCR2000 is a general-purpose USB MIDI controller containing 20 buttons, 24 rotary encoders and 8
push encoders. Every control is backed by LEDs that show the current value. As a pure MIDI controller it contains no
interfaces for audio or microphones.

The controller can be be configured extensively. It offers 32 presets that may be programmed by the user.
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BCR2000 = behringer

00/[0[0D

Figurel: Behringer BCR2000 (schematic view)
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Novetat de la versi6 2.3.

Compatibility

This controller is a class compliant USB MIDI and audio device, so it can be used without any special drivers on
GNU/Linux, Mac OS X, and Windows.

Setup

Controller Preset

The default mapping works out-of-the-box for the factory settings of controller preset 1.
If you don’t want to use this preset, you can choose one of the following options:

1. Load the dump file bcr_Only_Controllers.syx via Sysex to any other preset slot and update the preset
number in the init function in the file Behringer—-BCR2000~-scripts. js. The dump file and instructions
how to install it in the controller is available on the manufacturer’s webpage.

2. Factory reset the controller.

Button Behaviour

It is recommended, but not required, to change the button behaviour from Toggle On (default) to Toggle Off. Both
behaviours send an On message on button press, but the action to send an Of £ message is different: Toggle Off responds
to a button release while 7oggle On ignores the release and requires a second press. To change the behaviour:

1. Hold EDIT, press a button, then release both
2. Turn the MODE encoder until the display shows toFF
3. Press the EXIT button

To make the change persistent, press Store twice. See the controller manual for details.

Mapping Description

The BCR2000 is a general purpose controller that allows different mappings.

The file Behringer-BCR2000-scripts. js contains a default mapping which works out-of-the-box for a factory-
reset controller, but may be customized freely according to your needs.

The controls are divided into five parts:
 Top left area (4 push encoders + 4 buttons): loop, reverse & pitch controls for Deck 1
 Top right area (4 push encoders + 4 buttons): loop, reverse & pitch controls for Deck 2
¢ Middle left area (4 buttons + 4 encoders): controls for Effect Unit 1
» Middle right area (4 buttons + 4 encoders): controls for Effect Unit 2

¢ Bottom right area (4 buttons): controls for assignment of effect units to decks
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Control

Description

Location

Affects

Hardware control

Push Encoder Row

Deck 1

Encoder 1 (TYPE)

* Rotate: Manipulates
the key of the track
in semitones.

Deck 2

Encoder 5 (VAL 2)

¢ Push: Resets the key
to the original track
key.

Deck 1

Encoder 2 (CH)

e Rotate: Increases or
decreases the size of

Deck 2

Encoder 6 (VAL 2)

the current loop in
beats.

Deck 1

Encoder 3 (PAR)

* Rotate: Moves the
current loop left or

Deck 2

Encoder 7

right.

Deck 1

Encoder 4 (VAL 1)

¢ Rotate: Increases or
decreases the num-

Deck 2

Encoder 8

ber of beats to move
the loop.

Button Row 1

Deck 1

Button 1

¢ Press: Toggles key-
lock.
* Shift + Press: Tog-

Deck 2

Button 5

gles vinyl control
mode.

Deck 1

Button 2

e Press: Toggles a
loop that ends at
the current play po-
sition.

e Shift +  Press:
Toggles a rolling

Deck 2

Button 6

loop. Playback will
resume where the
track would have
been if it had not
entered the loop.

Deck 1

Button 3

¢ Press: Toggles re-
verse playback.

 Shift + Press: Tog-
gles rolling reverse
playback. Playback

Deck 2

Button 7

continues where the
track would have
been if it had not
been temporarily
reversed.

continues on next page
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Table 1 - ve de la pagina anterior

Control

Location

Affects

Hardware control

Description

All controls

Button 4

* Press: Toggles shift.
Shift changes the
behaviour of con-
trols as described
in this table, and
additionally the
behaviour of the
effect units.  See
Standard Effects

Mapping for details.
All controls Button 8 Nota: Both Shift buttons
have the same effect, they
are not deck-specific. This
design decision was made
to keep the layout symmet-
ric so that you don’t have
to press a button on the left
side when you’re working
on the right side.
Button Row 2 Effect Unit 1 Button 1 * Press: Toggles effect
focus mode.
Effect Unit 2 Button 5  Shift + Press: Tog-
gles effect unit.
Effect Unit 1 Button 2 * Press: Toggles pa-
Effect Unit 2 Button 6 rameter button 1.
Effect Unit 1 Button 3 * Press: Toggles pa-
Effect Unit 2 Button 7 rameter button 2.
Effect Unit 1 Button 4 ¢ Press: Toggles pa-
Effect Unit 2 Button 8 rameter button 3.
Encoder Row 1 Effect Unit 1 Encoder 1 * Rotate: Adjusts the
mixing of the dry
(input) signal with
Effect Unit 2 Encoder 5 the wet (output) sig-
nal of the effect unit.
Effect Unit 1 Encoder 2 * Rotate: Controls the
parameter of effect
Effect Unit 2 Encoder 6 1.
Effect Unit 1 Encoder 3 * Rotate: Controls the
parameter of effect
Effect Unit 2 Encoder 7 2.
Effect Unit 1 Encoder 4 * Rotate: Controls the
parameter of effect
Effect Unit 2 Encoder 8 3.
Button Box Row 1 Deck 1 Left Button  Press: Toggles as-
signment of Effect
Deck 2 Right Button Unit 1.
Button Box Row 2 Deck 1 Left Button  Press: Toggles as-
signment of Effect

contiiu@s2on next page
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Table 1 - ve de la pagina anterior

Control Description
Location Affects Hardware control
Deck 2 Right Button
Overlay

Overlay to print on cardboard or paper for lamination:
e PDF, DIN A4
e PDF, DIN A3
¢ ODG (LibreOffice)

e SVG (without labels)

17.1.10 Behringer CMD Micro

] L@ N @ [ C=J

behringer
MAIN LEVEL CGUE LEVEL
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— BROWSE

CMD MIIERG MIDI CONTROLLER

|H1III>H|

PITCH BEND ——
1111
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| l L ‘ | PITCH BEND

= ==

Figure2: Behringer CMD Micro (schematic view)

The Behringer CMD Micro is a simple controller for basic two-channel mixing. This device does not have a built in sound
card, so it would require a splitter cable or separate audio interface to be able to preview tracks in headphones.

e Manufacturer’s product page

Novetat de la versid 2.1.

Mapping description

¢ Cue, Play/Pause, Sync, Load A, Load B, the Level / Browse knobs, and the crossfader all behave as labeled.
¢ Cue A and Cue B send the respective track to the headphones.

 The inner vertical sliders control the track’s volume.

¢ The outer sliders control the playback speed.

e The 1, and 2 buttons toggle a 4 and 8 beat loop, respectively.

» The Pitch Bend buttons temporarily adjust the playback rate. They can be configured to change the key of the
track instead by setting the PitchBendsKey option to true at the top of the JS file (open the JS file in a text
editor such as Notepad, TextEdit, or gEdit to change this). With the PitchBendsKey option, when both buttons are
pressed simultaneously, the key is reset to the track’s default key.
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Jog Wheels

The jog wheels are touch enabled. When the top is pressed, they emulate turntable scratching. When the side is touched,
they affect the playback speed (jog).

17.1.11 Behringer CMD MM-1

The Behringer CMD MM-1 is a flexible controller that controls 4 decks by default. The mapping can be easily configured
to control any combination of decks and effect units. The Behringer CMD DC-1 and Behringer CMD DV-1 are designed
to be used together with the CMD MM-1, but the CMD MM-1 can be used alone or with other controllers (especially
the Novation Launchpad).

e Manufacturer’s product page
* Forum thread

Novetat de la versio 2.1.

Mapping description

Architecture

The controller has four strips of channels, each of which can be configured to control a different Deck or even an Effec-
tUnit. These options can be changed during runtime via the Buttons in the of the ThirdLayer. You can find more about
how to use this at the end of this document.

Mapping options

There are a few user configurable options available for you to customize. You can change these by opening the
Behringer-CMD-MM-1-scripts. js file with your text editor of choice (such as Notepad, TextEdit, Kate, or
gEdit) and editing the lines at the very top of the file.

¢ channelNumber: change this if your controller LEDs do not light up.

* invertColor: Swaps the colors which suits certain skins more

* defaultChannelSequence: Defines how the channels are mapped when Mixxx starts
¢ channelMode: Defines if a channel is in Deck or FX Mode when Mixxx starts
 faderMode: Defines how the faders behave in FX Mode by default

« standardKnobBehavior: Defines the mapping of the knobs when Mixxx starts

» navEncoderScale: the factor of speedup when using the encoder with a modifier
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Top row

FX1 Super FX3 Super FX2 Super FX4 Super Navigate Library - Navigate Preview Deck
[Load selected Track into Preview Deck]
FX1 mix  FX3 Mix FX2 mix  FX4 Mix Play Priview Deck

Head Volume Head Mix

OUT |y @ OUTi2 BROWSE CUE VOL CUE MIX

Figure3: Behringer CMD MM-1 (top row)

The top left knobs control the Master balance and Master gain. The top right knobs control the headphone gain and cue
mix (PFL/master mix in Headphones output).

You can see the L/R buttons besides the encoder as [SHIFT] and [CTRL] buttons. These allow each button to have up
to four functionalities. They behave like the Shift and Control keys on a computer keyboard.

Knobs

The Knobs have three different modes which can be cycled while in operation. The knobs in each mode, from top to
bottom, control:

1. Deck: High, Mid, Low, QuickEffect (filter by default)
2. Deck: Gain, High, Mid, Low
3. Effect Unit: Meta 1, Meta 2, Meta 3, Mix

The Effect Unit number is the same as the channel/deck number, so the channel that controls the knobs/buttons/faders of
deck 1 also controls the knobs of EffectUnitl, Channel 2 controls EffectUnit2, and so on.

FX Mode

The Knobs in FxMode overwrite the assigned mapping and are mapped as [Effect 1 Meta, Effect 2 Meta, Effect 3 Meta,
Super] and the fader is also mapped to the mix of the EffectUnit. The buttons are documented in their own section.

Middle button

¢ Normal: recenter Crossfader

« Shift: Cycle Knob assignment (swaps the mapping of the knobs as mentioned earlier)
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Buttons

Deck Mode

[1]&[2] Buttons:

¢ Normal: Change Crossfader side (Orientation)

« Shift: Toggle Fx1&2 for desired Channel

o Ctrl: Toggle Fx3&4 for desired Channel

* Third: Change ChannelNumber/Assignment
[CUE] Buttons:

e Normal: Pre-Fader-Listening

* Shift: Load selected Track to Deck

¢ Ctrl: enable Sync for the Deck.

¢ Third: Change Channelmode

FX Mode

Toggle EffectUnit for
Channel 1&2

Toggle EffectUnit for
Channel 3&4

Toggle Effect 1&2
of FxUnit

Pre-Fader-Listening

Change for FxUnit

ChannelNumber/ i
Assignment assign to master

Toggle Effect 3 for
desired FxUnit

Change
Channelmode

Figure4: Behringer CMD MM-1 (FX mode)

[1]&][2] Buttons:
e Normal: Toggle Effect 1&2 in desired FxUnit
* Shift: Toggle Channell&?2 for desired FxUnit
e Ctrl: Toggle Channel3&4 for desired FxUnit
* Third: Change ChannelNumber/Assignment
[CUE] Buttons:
» Normal: Toggle Effect 3 for desired FxUnit
* Shift: Pre-Fader-Listening for FxUnit
* Ctrl: change mix_mode of Unit

¢ Third: Change Channelmode
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Faders

DeckMode:

e Normal: Volume Fader
FxMode:

* EffectUnit Mix (dry/wet)

¢ Third: Reconfigure Fader to control Rate/BPM/Pitch of the Channel as if it was in Deckmode

Reassigning channel mode and number

The channel modes and numbers can be set by changing the #mapping options at the top of the script. They can also be
changed while using the controller when in thirdMode. Pressing the cue- button toggles between Deck and FX Mode.
The Channel number is assigned with the [1]&[2] buttons.

They are mapped in a sort of two bit encoded system:
e [J&[]=Channel 1
¢ X1 & [ ] = Channel 2
e [ & [x] = Channel 3
¢ Xl & [x] = Channel 4
So you can change between channel 1&3 by pressing the [1] button, and channel 2&4 by pressing the [2] button.

You can change the Channel mode (Deck/Fx) via the Cue Button. (Note: there is a rare issue where you have to change
the Channel mode after the assignment for it to work. So it is suggested that you always change the assignment first).

Troubleshooting

Controller does not light up

The issue is probably the MIDI channel of your MM-1. Behringer had a tool that can set the controller to a different
MIDI channel, however this is no longer available for download from Behringer’s website. So you will have to modify the
controller mapping to use the MIDI channel that your controller is set to.

Once you know the MIDI channel of your controller, open the file Behringer-CMD-MM—-1-scripts. js file with
your text editor of choice (such as Notepad, TextEdit, Kate, or gEdit) and replace the number 5 in the line where it says
var CHANNELNUMBER = 5;. Then, open the file Behringer CMD-MM-1.midi.xml in the same folder and
replace the 4 at the end of 0x94, 0x84 and 0xB4 with your channel number - 1. Restart Mixxx, reload the mapping in
Mixxx’s preferences, and then it should work.
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17.1.12 Behringer CMD STUDIO 4a

The Behringer CMD STUDIO 4a is a 2 deck controller that supports 4 virtual decks and has a built in 4 channel (one
stereo master, one stereo headphones) USB sound card built in.

e Manufacturer’s product page
* Mixxx Forum Thread

Novetat de la versi6 2.1.

Mixxx Sound Hardware Preferences
* Master output: channels 1-2
* Headphone output: channels 3-4
Mapping description

Most of the buttons and knobs on the controller behave as they are labelled:

FX Assign and 3-Band EQ&
Navigation Control FX Control Track Load Buttons  Kill Buttons Loop Control Deck Select Buttons

—— BROWSE —

ffffff

e
L1101

‘--’

HOT CUE HOT CUE

C = ) ) Ce 0 e )

C )] T )]

== (@ o s ] (-

l_I_J

Touch Sensitive Pitch  Hot Cue Transport Volume Fader  Cross Fader Phones/ Headphone Pitch Fader
Platter Bend  Buttons Control PFL button Monitoring

(AN
(NN
I

+
Firrrrnn

Figure5: Behringer CMD STUDIO 4a (top view)

The only major departure from the above are the 4 “FX Control” knobs and buttons at the top of each deck.
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Mixer

¢ The HIGH, MID, and LOW EQ knobs & kill buttons, deck faders, cross-fader, master, and headphone monitoring
(mix & volume) knobs all operate as labelled.

» Each deck also has a gain knob (leftmost “FX Control” knob).

Navigation Control

* The BROWSE knob scrolls thorough the track list in the library panel.
e The BROWSE LEFT/RIGHT buttons move through the library tree (and can also select effects, see later).

e The ENTER button expands/collapses library tree items.

Deck Select Buttons

» The deck select buttons (A, B, C, D) make the respective “virtual” deck active.
¢ On the left deck: A = Channel 1, C = Channel 3.
* On the right deck: B = Channel 2, D = Channel 4.

Transport Control

* The deck LOAD buttons will load the currently highlighted track in the library window into that deck.
¢ The deck CUE, PLAY, SYNC, and LOOP buttons work as labelled (SYNC toggles master sync for the deck).

Wheels

* While a track is playing, spinning the wheels temporarily speeds up or slows down the track.
* When a track is stopped, spinning the wheels results in a fast search.
* When the top wheel surface is touched the wheels act as as a precision jog.

¢ When the SCRATCH button is activated, moving the wheel while touching the top surface scratches the track.

Hot Cue Buttons

* If not currently set, pressing a HOT CUE button sets that hot cue at the current playback position.

* If already set, pressing a HOT CUE button jumps to that hot cue position.

If the DEL button is *held*, pressing an already set HOT CUE button will clear that hot cue.

 Tapping the DEL button toggles #DEL-mode. The button will light up blue. DEL-mode alters some of the other
button functions like a shift button on other controllers.
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Playback Pitch/Rate

The pitch sliders control the pitch.

The PITCH BEND +/- buttons step the playback rate up or down (pressing both resets the rate back to normal).
The LOCK buttons turn on key lock so the pitch doesn’t change when the playback rate changes.

The PITCH BEND button lights will indicate whether the current pitch is higher or lower than normal.

FX Control Buttons

These do not control effects; they have other functions:

FX Control button 1 toggles the deck slip-mode on/off, (button lights blue when active). Slip-mode is not available
in any Mixxx skin yet so may be unfamiliar. When slip-mode is active, playback continues (muted in the back-
ground) during a loop/scratch etc. Once disabled, playback will resume where the track would have been if the
loop/scratch has not taken place (thus preserving the track beat).

FX Control button 2 toggles the deck repeat mode, (button lights blue when active).
FX Control button 3 can be tapped to adjust the beat-grid position.

FX Control button 4 toggles the deck quantise mode on/off, (button lights blue when active).

FX Control knobs

FX Control knob 1 = Deck gain.
FX Control knob 2 = FX 1 “super” control (FX unit 1 on left deck, unit 3 on right deck).
FX Control knob 3 = FX 2 “super” control (FX unit 2 on left deck, unit 4 on right deck).

FX Control knob 4 = Deck “quick effect” control (by default this is a filter effect but can be changed in Mixxx’s
preferences).

FX Assign Buttons

Tapping either of the 2 FX ASSIGN buttons on each deck will toggle the deck’s output to one (or both) of two
effects in the (default) 4-unit effects rack. The left deck (A or C) can be assigned to effect units 1 and/or 2. The
right deck (B or D) can be assigned to effect units 3 and/or 4.

¢ *Holding* an FX ASSIGN button allows the effect in that effect unit to be changed using the BROWSE

LEFT/RIGHT buttons.

DEL-mode

DEL-mode is activated by tapping the deck’s hot cue DEL button (the button will light up blue). This is equivalent to a
shift button on other controllers and so changes the behaviour of a number of the controller buttons as follows:

e The HOT CUE buttons act as auto-loop triggers (when *held*) in DEL-mode. The button layout follows the default

“LateNight” skin (i.e. top row = [1/8] to [1], bottom row = [2] to [16] beats). Longer auto-loops can be “locked”
(so the HOT CUE button doesn’t have to be held) by pressing the LOOP ON/OFF button after an auto-loop is
selected, (locked/playing auto-loops can also be resized by selecting a different auto-loop and then re-locking the
new size with the LOOP ON/OFF button).
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¢ The CUE button triggers reverse playback (while *held*).

» The PLAY button triggers reverse-slip playback (while *held*). NB: if you already have slip-mode activated before
you trigger reverse-slip playback, (e.g. by having pressed FX-Control button 1), then slip-mode will be turned off
as soon as you release the PLAY button (and you will return to the playback point where you would have been if
you hadn’t altered the playback).

e The PITCH BEND +/- buttons step the key up/down without altering the playback rate. If both PITCH BEND
buttons are pressed together, the playback key is reset to normal.

Auto-Loops and Slip-Mode

There are no “slip-mode aware” skins in Mixxx yet so the auto-loop behaviour of this controller (which *is* “slip-mode
aware”) may be a little different than you might expect to take advantage of this feature.

¢ Auto-loop buttons are (by default) only active when held.

* In slip-mode, releasing an auto-loop button will immediately “re-sync” playback (by disabling, then immediately
re-enabling slip mode), you may see the slip-mode button flash briefly when this happens. This allows for some
very interesting “slip-auto-loop” effects.

17.1.13 Behringer DDM4000

The Digital Pro Mixer DDM4000 is a 5-Channel Digital DJ Mixer with Sampler, 4 FX Sections, BPM Counters and MIDI
support. Each of the following sections can be configured separately to be used either for audio or as MIDI controller:

¢ Channel 1-4
* Microphone Channel
* Crossfader
» Sampler
The mixer contains no digital interfaces for audio or microphones.
e Manufacturer’s product page
e User Manual
e Forum thread

Novetat de la versi6 2.3.

Compatibility

This controller contains a MIDI interface with 5-pin DIN jacks In/Out/Thru. If your soundcard does not offer DIN jacks,
a separate USB/MIDI interface is required to use it on GNU/Linux, Mac OS X, and Windows.
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Figure6: Behringer DDM4000 (schematic view)
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Setup

Configure at least one mixer section as MIDI controller:
1. Long press the CONSOLE SETUP knob
2. Select MIDI SETTINGS by turning and pressing the CONSOLE SETUP knob
3. Select the sections that you want to use as MIDI controller
4. Press the ESC button to exit MIDI Setup
5

. To make the change persistent, save the settings in a user preset. See the controller manual for details.

Controller Mapping

A schematic drawing with the control numbers that are used here can be found on the specified page in the User Manual
in the Links section.

Stereo channels 1 -4 (p. 6)

No. | Control Function

4 HIGH / MID / LOW knobs | Adjust high/mid/low-frequencies.

6 P1/P2/P3 buttons Toggle the kill function for high/mid/low-frequencies.
7 PFL button Toggle headphone pre-fader listening.

8 Channel faders Adjust the output volume.

10 CF ASSIGN button Assign the channel to either side of the crossfader.

Nota: On some units of this mixer, the LEDs of the buttons P1 / P2 / P3 show an unexpected behavior in MIDI mode.
When such a LED is turned on via MIDI, it flashes shortly but does not stay lit. The problem occurs only when at least
1 channel is in audio (non-MIDI) mode. It does not occur when all channels are in MIDI mode. Firmware version 1.02
(Dec 14 2007) is known to show this behavior, and there’s no fix available according to a reply from the technical support:

«I see the issue, but sorry, the code is 15 years old and getting the 15 year old tools (plus license, plus old
windows version) needed to compile it, together with finding the bug in a very complex code base (without
access to the developer) makes fixing this nearly impossible.»

---[MUSIC Tribe Care] Behringer - Technical Support (08 Sep 2021)

Microphone (p. 6)

No. | Control Function
19 TALK ON | Switch the Talkover function.
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Crossfader section (p. 7)

No. | Control Function

20 | Crossfader Fade between the signals that are assigned to its two sides A and B.

21 CF ON button | Toggle crossfader function. When disabled, the crossfader control in the Mixxx user inter-

face is hidden.

24 | CURVE knob Adjust the response of the crossfader.

25 REVERSE Toggle a permanent reverse of the crossfader sides A and B. This means that A and B are
HOLD button interchanged.

26 | REVERSE Toggle a momentary reverse of the crossfader sides A and B. This means that A and B are
TAP button interchanged as long as the TAP push button is held down.
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Sampler (p. 8)

No. | Control Function
55 | VOLUME/MIX Control the volume of sampler 1.
knob
57 | PFL button Toggle headphone pre-fader listening for sampler 1.
58 | SAMPLE Adjust the beatloop size of sampler 1.
LENGTH but-
tons
61 MODE buttons for | Select the playback type for the selected sampler (Reverse or Loop). A short press
bank 1/2 toggles the Reverse function, a long press toggles the Loop function.

62 | PLAY/OUT but- | Start or stop playback for the selected sampler. When the Loop function is disabled, the
tons for bank | sample is only played back while the button is pressed.

172

63 SMP FX ON but- | Toggle effect unit 1 for sampler 1.
ton

65 CF ASSIGN but- | Assign sampler 1 to either side of the crossfader.
ton

17.1.14 Denon DN-HS5500

e Manufacturer’s product page (archived)

Novetat de la versi6 2.0.

Nota: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller, please
consider contributing one.

17.1.15 Denon DN-SC2000

e Forum thread

Novetat de la versio 1.8.

Nota: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller, please
consider contributing one.

17.1.16 Denon MC3000

* Manufacturer’s product page (archived)

Novetat de la versi6 2.0.

Nota: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller, please
consider contributing one.
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17.1.17 Denon MC4000

The MC4000 is a 2-deck DJ controller for the professional entertainer wrapping in-demand audio manipulation tools in
a robust steel chassis for rugged durability. In addition to precision touch-activated jog wheels, performers get access to
dedicated hot cue and sample pads for on-the-fly remixes.

¢ Manufacturer’s product page
e Manual / Midi commands
¢ Forum thread

The microphone and auxiliary inputs are mixed with the master output in hardware. They are not available to the computer
through the MC4000’s sound card, so this controller’s sound card is not suitable for broadcasting or recording the inputs.
You could use the controller with a separate USB sound card that has a microphone input for that purpose.

Novetat de la versi6 2.1.
Mapping Description

The Mixxx mapping is mostly the same as the standard Serato mapping, with a few exceptions which are highlighted below
with underlined text where a specific functionality that exists in Serato is not (yet) implemented in the Mixxx mapping.
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Figurel1: Denon MC4000 (layout)

1. Channel Level: Adjust the level of the pre-fader, pre-EQ audio signal

2. Channel EQ: Boost or cut the high, mid-range, and low frequencies

3. Channel Filter: Turn counterclockwise to apply a low-pass filter. Turn clockwise to apply a high-pass filter.
4

. Channel Cue: Send the channel’s pre-fader signal to the headphones’ cue channel.
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10.
11.

12.
13.

14.

15.

16.

17.

18.

19.

20.

21.
22.

23.

24.

25.

Channel Fader: Adjust the channel’s volume level.
Crossfader: Mix between the two decks.
Shift: Press and hold this button to access secondary functions of other controls.

Sync/ Sync Off: Automatically match the corresponding Deck’s tempo with the opposite Deck’s tempo and phase.
Unlike Serato, Shift + sync is not mapped to anything.

Cue / Track Start: Behavior changes according to the cue mode selected in Mixxx’s preferences. Hold Shift and
press this button to return to the start of the track.

Play/Pause / Stutter: Play/pause playback. Hold Shift and press to “stutter-play” the track from the cue point.

Hot Cues: Press a pad to set or jump to a hot cue point. To set a hot cue point, press an unlit pad at the desired
location in the track (the pad will then be lit). To jump to that hot cue point, press the lit pad. To delete a hot cue
point, hold Shift and press a lit pad.

Pad Mode: Currently unmapped

Platter: This capacitive, touch-sensitive platter controls the audio playhead when the wheel is touched and moved.
When the Vinyl button is on, move the platter to “scratch” the track like a vinyl record. When the Vinyl button is
off (or if you are touching only the side of the platter), move the platter to temporarily adjust the track’s speed.

Vinyl/ Censor: Toggle “vinyl mode” for the platter. When activated, you can use the platter to scratch the track as
you would with a vinyl record. Hold Shift and this button to activate the Censor feature: the playback of the track
will be reversed, but when you release the button, normal playback will resume from where it would have been if
you had never engaged the Censor feature (i.e., as if the track had been playing forward the whole time).

Key Lock / Range: Toggle Key Lock. When Key Lock is activated, the track’s key will remain the same even if
you adjust its speed. Hold Shift and press to cycle through the available ranges of the pitch fader (+/- 8%, 16%,
50%). Other ranges for the fader can be selected in Mixxx’s Preferences in the Interface section, but pressing this
button with Shift will only cycle through 8%, 16%, and 50%.

Pitch Bend -/+ : Hold one of these buttons to momentarily reduce or increase (respectively) the speed of the track.
Hold Shift and then press and hold one of these buttons to rewind or fast-forward (respectively) through the track.

Pitch Fader: Move this fader to adjust the speed (pitch) of the track. You can adjust its total range with the Key
Lock / Range button.

FX Level: Turn the knobs on the left side of the controller to adjust the effect intensity (i.e. “meta” parameter) for
the effects in Effect Unit 1. Turn the knobs on the right side of the controller to adjust the meta parameter for the
effect in Effect Unit 2. The FX On button under the knob must be lit for the effect to be enabled.

FX Beats: Currently changes the wet/dry ratio of the effect chain. This will probably change in the future.

FX On / Select: Press to toggle the corresponding effect on or off. Hold Shift and press to assign a different effect
to this slot.

FX Tap: Currently not mapped

Auto-Loop / Auto 4: Toggle a 4 beat loop on or off. Hold Shift and press to toggle beat quantize on or off (I.e
quantization of loop start / end points to the nearest beat). Note: this behavior is different from Serato.

X 1/2 Loop / Loop In: Halve the length of the current loop. Hold Shift and press to create a Loop In point at the
current location.

X 2 Loop / Loop Out: Double the length of the current loop. Hold Shift and press to create a Loop Out point at
the current location.

Reloop: Exit the current loop if a loop is active, or skip to the last-played loop and activate it immediately if there
is no loop active.
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26.

217.
28.
29.

30.

31.
32.

33.

34.
35.

36.
37.
38.

Browse / Library Knob: Turn to browse through the items in the currently focused pane (i.e. library or sidebar).
Press shift and turn to scroll quickly through the items in the currently focused pane. Press the knob to select the
current item.

Load: Load the currently selected track to the deck.
Back / Panel: Change the currently focused pane (i.e. library or sidebar) to the next or previous pane.

Load Prep / Open Prep: Load the currently selected track to the preview deck. Hold Shift and press to eject the
current track from the preview deck. (Different from Serato mapping).

Sampler Pads: Press to play the corresponding samples in the software’s sampler (1-4). Hold Shift and press a
pad to stop its sample playback.

Sample Level: Turn this knob to adjust the volume level of the software’s samplers (1-4).

Level Meters: These LEDs display the level of the audio signal depending on the state of each deck and Channel
Fader. The meters are not affected by the position of the Master Knob.

Mic Volume: Adjust the input gain of the microphone. This adjusts the hardware microphone preamplifier, not
Mixxx’s mic gain. The microphone input is not available to the computer through the MC4000’s sound card; it is
mixed with the master output in hardware.

Mic Echo: Toggle an echo effect on the microphone input. This effect is done in hardware, not in Mixxx.

Mic Talk Over / Post: Toggle microphone talkover, which automatically reduces the volume of the music when
using the microphone. Hold shift and press to toggle whether the microphone input is routed to the booth output.
These controls are done by the MC4000 in hardware and do not affect Mixxx.

Master: Adjust the master output level of the sound card. This does not affect the master gain in Mixxx.
Booth: Adjust the booth output level of the sound card. This does not affect anything in Mixxx.

Aux: Adjust the auxiliary output level of the sound card. This does not affect anything in Mixxx.

17.1.18 Denon MC6000MK2

e Manufacturer’s product page (archived)

¢ Forum thread

¢ Mixxx maintainer

Novetat de la versi6 2.0.

The number in the first column refers to the corresponding label in the Owner’s Manual in the chapter Part names and
functions starting on page 20.

# User Manual | Control Modifier | Context Function
1 BEATS/V.FX SEL. Knob is turned Effect unit dry/wet mix
Knob is pressed Focus/unfocus effect unit

2 TAP NONE Toggle (enable/disable) EFX unit
3 EFX 1/2/3 KNOB Effect meta knob
4 EFX 1/2/3 ON Enable/disable effect
5 EFX CH. ASSIGN NONE Assign/unassign deck

SHIFT Assign deck exclusively
6 LOOP IN NONE Set loop in point

SHIFT Delete loop
6 LOOP OUT NONE Set loop out point
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Table 2 - ve de la pagina anterior

# User Manual | Control Modifier | Context Function
SHIFT Delete loop out point
7 AUTO LOOP NONE Loop is undefined | Activate a loop over beatloop size beats
SHIFT Loop is undefined | Activate a rolling loop over beatloop size beats
NONE Loop is defined Toggle reloop
SHIFT Loop is defined Delete loop
7 LOOP + NONE Double beatloop size beats
SHIFT Move loop forward by beatloop size beats
7 LOOP - NONE Halve beatloop size beats
SHIFT Move loop backward by beatloop size beats
8 HOT CUE 1/2/3/4 NONE Deck is stopped Jump to hot cue and start playing while pressed
NONE Deck is playing Jump to hot cue
SHIFT Delete hot cue
8 SAMPLE 1/2/3/4 NONE Sampler is empty | Load selected track into sampler
NONE Press button Play track from beginning while pressed
NONE Release button Stop playback
SHIFT Release button Continue playback
SHIFT Press button Eject track from sampler
9 DECK Switch active deck
10 SHIFT Modifier that activates a 2nd layer of functions. It
11 KEY LOCK Enable/disable key lock mode
12 HOT CUE / SAMPLE Switch between hot cues and samplers
13 JOG WHEEL NONE Bend or scratch (vinyl mode)
SHIFT Deck is stopped Fast track seek (wheel search)
14 PITCH SLIDER Change playback speed
15 SYNC Trigger sync mode by short/long press
16 CUE NONE Trigger cue according to configured cue mode
SHIFT Stop playback and jump to beginning of track
17 PLAY NONE Start/stop/continue playback
SHIFT Reverse playback direction
18 SLIP/CENSOR NONE Censor: Enable reverse and slip mode while presse
SHIFT Toggle (enable/disable) slip mode permanently
19 PITCH BEND + Deck is stopped Fast forward
NONE Deck is playing Pitch bend up
SHIFT Deck is playing Pitch bend up (small)
19 PITCH BEND - Deck is stopped Fast rewind
NONE Deck is playing Pitch bend down
SHIFT Deck is playing Pitch bend down (small)
20 VINYL Enable/disable vinyl mode (scratching)
23 X-F LINK Not yet mapped
21 PANEL Not yet mapped
22 VIEW Not yet mapped
24 AREA Not yet mapped
25 LIST Toggle maximized library view
26 BACK NONE Scroll up
SHIFT Move focus backward to previous panel
26 FWD NONE Scroll down
SHIFT Move focus forward to next panel
27 SELECT KNOB NONE Knob is turned Move through focused panel/list
SHIFT Scroll through focused panel/list
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# User Manual | Control Modifier | Context Function
NONE Knob is pressed Go to the selected item
SHIFT Move focus backward to previous panel
28 LOAD NONE Load selected track into active deck
SHIFT Eject loaded track from active deck
29 FILTER ON Enable/disable filter effect for deck 1/3 or 2/4
30 FILTER KNOB Control filter effect (low/high pass) for deck 1/3 or
31 MIC LEVEL 1/2 Not yet mapped
32 MIC ON 1/2 Not yet mapped
33 MIC DUCKING Not yet mapped
34 MIC ECHO ON 1/2 Not yet mapped
35 CUE MIX NONE Enable/disable cue mix
SHIFT Enable solo cue mix (only this channel)
36 VU METER DISP. SWITCH Select channel(s) for display
37 CHANNEL FADER Control channel output volume
38 CROSS FADER Control balance between assigned channels
39 VU METER Display channel/master output volume
40 BOOTH ASSIGN Select source for booth output
41 BOOTH LEVEL Control booth output volume
42 MASTER LEVEL Control master output volume
43 HI KNOB Control channel EQ (high freq.)
43 MID KNOB Control channel EQ (mid. freq.)
43 LOW KNOB Control channel EQ (low freq.)
44 LEVEL KNOB Control channel gain
45 CHANNEL INPUT SELECT Select channel input source

17.1.19 Denon MC7000

The Denon MC7000 is a professional DJ controller which has got 4-channel capability and dual USB connections. These
two USB audio interfaces enable two DJs to play together. This controller includes Denon’s high build quality and superior
24-bit audio reproduction, makes this suited to both mobile and club DJs.

Novetat de la versi6 2.2.4.

Canviat a la versi6 2.3.0: Fixed a vinyl mode bug on deck 4 and added new features, like library sorting, searching through
track with jog wheel, ejecting track from deck, waveform zoom, fixed loops and an experimental beat counter (slicer-like)
and improved parameter and censor/reverse/spinback button mappings.

Canviat a la versi6 2.3.1: Some improvements for slip mode, sampler play and rate range toggle. Added browsing through

library using jog wheel.

Useful links

e Denon MC7000 Mapping thread
e Manufacturer’s product page

» User Guide

» Hardware Setting Specification

¢ Mixxx showcase on YouTube
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Compatibility

¢ Mac users should be just fine connecting the MC7000 and go.
¢ Windows users need to install the latest Windows Driver from Denon Download Site.

¢ Linux users need a minimum LTS Kernel version 4.19.105 or 5.4.21. All Kernels 5.6.x and following are sup-
porting the device out-of-the-box.

Mapping
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Figure12: Denon MC7000 (schematic view)

This controller is made for Serato DJ and most of the mapping is made for Mixxx accordingly. Anyhow, there are several
differences for functions not matching the Serato mapping. If you have any wishes to improve the mapping, then please
discuss it in the Denon MC7000 Mapping thread.
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User Variables

User variables can be set to suit individual needs inside the Denon-MC7000-scripts. js mapping file:
* MC7000.experimental activate experimental beat count feature (default: false)
¢ MC7000.needleSearchPlay activate NEEDLE DROP sensor while a track is playing (default: false)
* MC7000.prevSamplerStop set to single play samplers (default: t rue)
* MC7000.rateRanges set the available Pitch Fader ranges (default: 4, 6, 8, 10, 16, 24, 50, 90)
* MC7000.modeSingleLED set single LED on or off (default: 1). Can be toggled with SHIFT + Deck

e MC7000.VinylModeOn set the Vinyl Mode on or off at Mixxx start which also triggers the Platter Ring LED
function (default: 1)

e MC7000.scratchParams set Scratch Parameters (default: 33+1/3, 1/10, 1/10/32)

e MC7000.jogSensitivity set the Jog Sensitivity (default: 1)
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Mixer Section

NoControl Function

1| Input Selector Switch Set to the desired audio source for this channel.

LINE/PHONO will disable the corresponding Deck (switches off all LEDs and the
controller will not send MIDI signals to control Mixxx). This allows the mixer to
use an external source.

USB will turn the corresponding Deck on and allows to control Mixxx via USB
connection.

2| USB1/USB2 Press to select whether the deck is controlling the computer connected to USB Port
1 or USB Port 2. If only one USB Port is connected the controller activates this
automatically.

3| LEVEL Turn to adjust the level of the pre-fader, pre-EQ audio signal for the channel.

4| Channel Level Meters Display the audio signal level of the channel as in Mixxx GUL

5| Channel EQ Turn to boost or cut the HI, MID and LOW frequencies for the channel.

6| FILTER Turn this knob to adjust the filter applied to the channel. Turn the knob counter-
clockwise to apply a low-pass filter. Turn the knob clockwise to apply a high-pass
Filter.

7| CUE Press to send the channel’s pre-fader signal to the headphones’ cue channel.

8| Channel fader Use to adjust the channel’s volume level.

9| Crossfader Assign Routes the audio playing on the corresponding channel to either side of the cross-
fader (A or B), or bypasses the crossfader and sends the audio directly to the program
mix (THRU).

10 Crossfader Use this crossfader to mix between the left and right decks.

12 SAMPLER LEVEL Turn this knob to adjust the volume level of the software’s sampler. If the volume
is set to O then the Sampler banks are hidden, otherwise shown.

13 Master Level Meters These LEDs show the Master Audio signal.

14 MASTER LEVEL Turn to adjust the volume level of the master outputs.

15 BOOTH LEVEL Turn to adjust the volume level of the booth outputs.

2(0 PHONES LEVEL Turn to adjust the volume level of the headphones.

2] PHONES MIX Adjusts the software’s audio output to the headphones, mixing between the cue out-
put and the master mix output.

22 SPLIT Press to switch Headphone “split” mode. When this switch is lit, the headphone
audio will be “split” such that all channels sent to cue channel are summed to mono
and sent to the left headphone channel and the master mix is summed to mono and
sent to the right channel. When the switch is unlit, the cue channel and master mix
will be “blended” together.

59 X FADER CONTOUR Turn to adjust the slope of the crossfader curve, to the left for a smooth fade (mixing)
or to the right for a sharp cut (scratching.

Nota: The Input source selection, Master Level Meters, USB1 / USB2, MASTER LEVEL, BOOTH LEVEL, PHONES
LEVEL, PHONES MIX and SPLIT are handled by the controller. The status of Mixxx will not be changed.
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Microphone Section

N

0.Control

Function

14 MIC ON/OFF

Press to activate/deactivate the microphones.

177 MIC LEVEL

Turn to adjust the volume levels of the corresponding microphone inputs.

1§ MIC 1 HI/MIC

Turn to boost or cut the high or low frequencies for Microphone 1.

Turn to adjust the tone (high-low) for Microphone 2.

1 LOW (left
deck)

1§ MIC 2 TONE
(right deck)

1§ ECHO MIC
1&2 (right
deck)

Turn to adjust the amount of the echo effect for both Microphones.

19 TALKOVER

MIC 1&2 (left
deck)

Press to use the “talkover” feature, which automatically reduces the volume level of the master
mix when you speak into the microphones.

19 SHIFT +

TALKOVER
MIC 1&2 (left
deck)

Press to activate/deactivate the “Post” feature. When on, the microphones signal will be sent to
the Booth Outputs. When off, the microphones signal will not be routed to the Booth Outputs.

19 ECHO MIC

1&2 (right
deck)

Press this button to activate or deactivate the echo effect on the microphones’ audio signal.

Nota: All functions are handled by the controller in hardware. The status of Mixxx will not be changed.

FX Section
NoControl Function
11 FX ASSIGN Press assign FX 1 and/or FX 2 to the corresponding channel.
55 FXON Press to turn the corresponding effect on or off.
55 SHIFT + FX ON Press to select an effect from the list that was enabled in the Mixxx Preferences FX

section.

5¢

h FX 1, FX 2, FX 3

Turn to adjust the level of the corresponding effect. The FX ON button under the
knob must be lit for this knob to function.

57 FX BEATS Turn to adjust the Wet/Dry rate of the effects.

58 FX TAP Press to activate effects for the Master output. This can be overlapped with Channel
Effects.

58 SHIFT + FX TAP Press to activate effects for headphones cue.
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Library Section

oControl

Function

o P

8 SELECT/LOAD

Turn to navigate through lists. Press the left side button to load a track into the
active Deck (1 or 3), press the right side button to load a track into the active Deck
(2 or 4).

When you keep the knob pressed down longer than 0,5 sec an actual loaded track
will be ejected from the deck upon release of the knob.

N

3 SHIFT + SELECT/LOAD

Turn to browse quickly through the tracks in the library or push the knob to open
folders on the left side of the library.

49 SORT Press and hold to activate sort functions.

50 BACK Press to switch between right and left side of the library.

50 SHIFT + BACK Press to move through frames inside the GUI.

50 SORT + BACK Press to sort the tracks by Beats Per Minute.

5] L.PREP Press to load the currently selected track to the Preview Deck.

5] SHIFT + L.PREP Press to start and stop playing the track in Preview Deck.

5] SORT + L.PREP Press to sort the tracks by their Key.

52 FILES Press to maximize the library. Press this button again to exit maximized library.
While the library is maximized you can use the jog wheel to navigate quickly
through lists.

52 SORT + FILES Press to sort the tracks by Artist.

53 PANEL Press to open and close the FX panel inside the GUI.

53 SORT + PANEL Press to sort the tracks by Title.

Deck Section

oControl

Function

NZ

3 DECK

Selects which deck in the software is controlled by that hardware deck. The left
deck can control Deck 1 or 3; the right deck can control Deck 1 or 4.

23 SHIFT + DECK Press to switch Platter Ring LED Mode. Refer to the LEDs section for details.

24 SHIFT Press and hold this button to access secondary functions of other controls.

25 SYNC Press to automatically match the corresponding deck’s fempo with the tempo and
phase of the opposite deck. Press again to deactivate Sync. Hold this button down
for one sec to permanently match the tempo.

26 CUE If a cue point is not set then press this button to set it at the current track position.

During playback, press this button to return the track to the cue point.

If the deck is paused, press and hold this button to play the track from the cue
point. Release the button to return the track to the cue point and pause it. To
continue playback without returning to the cue point, press and hold this button and
then press the PLAY button, afterwards release cue button.

26 SHIFT + CUE

Press to return to the start of the track.

[\

7 PLAY / PAUSE

Press to pause or resume playback.

[\

7 SHIFT + PLAY / PAUSE

Press to stutter play the track from the last set cue point.

continues on next page
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oControl

Function

DIz

8 Jog Wheel

Controls the audio playhead when the wheel is touched and moved.

When the VINYL button is lit, move the platter to “scratch” the track as you would
with a vinyl record.

When the VINYL button is unlit (or if you are touching only the side of the platter),
move the platter to temporarily adjust the track’s speed.

If the library is maximized (use FILES button) turning the jog wheel will scroll the
current table view (currently playing track is not affected). Be careful though: after
exiting the maximized library view the jog wheel will immediately return to jog or
scratch mode.

28 SHIFT + Jog Wheel

Navigates quickly through the track. This only applies if touching the side of the
platter or with VINYL deactivated.

29 STOP TIME Controls the rate at which the track slows to a complete stop (“brake time”) dur-
ing backspin. This also affects how quickly the track starts after a backspin (“Soft
Start”).

30 VINYL Press to activate/deactivate a “vinyl mode” for the platter. When activated, you can
use the platter to “scratch” the track as you would with a vinyl record.

3] Pitch Fader Move to adjust the speed (pitch) of the track.

32 PITCH BEND —/+ Press to momentarily reduce or increase the speed of the track.

32 SHIFT + PITCH BEND - | Press to set the Pitch Fader range. You may adjust the steps in JavaScript file

I+
33 KEY LOCK Press to activate/deactivate Key Lock. When Key Lock is activated, the track’s key

will remain the same even if you adjust its speed.

33 SHIFT + KEY LOCK

Press to automatically match the corresponding deck’s key with the key of the op-
posite deck.

34 KEY SELECT/RESET

Turn to raise or lower the key of the track. Press to reset the track’s key to its original
key.

34 SHIFT +

KEY SE-
LECT/RESET

Turn to zoom in and out the waveform or push the knob to reset the Waveform
zoom to the level set in preferences.

3% Performance Pads

refer to the Performance Pads section for details.

40 AUTO LOOP Press to create an auto-loop with the length set with loop length. You may change
the length of beats by using the X1/2 or X2 buttons.

40 SHIFT + AUTO LOOP Press to toggle the current loop on or off. If the loop is ahead of the current play
position, the track will keep playing normally until it reaches the loop.

4] X172 Press to halve the length of the current loop.

4] SHIFT + X1/2 Press to create a loop in point at the current Location.

42 X2 Press to double the length of the current loop.

42 SHIFT + X2 Press to create a loop out point at the current Location.

43 </>PARAM 12 Press to add/remove rating stars to the loaded track.

43 SHIFT + </> PARAM 1 2 | Press to change the track color in the library.

+ SLIP

Press to enable or disable Slip Mode. In Slip Mode, you can jump to cue points,
trigger loops or use the platters, while the track’s timeline continues. In other words,
when you deactivate Slip Mode, the track will resume normal playback from where
it would have been if you had never done anything (i.e., as if the track had been
playing forward the whole time).

After scratch, hot cue play, reverse play and backspin the slip mode releases itself
so the timeline of the track jumps back to original position after the action is done.
Slip mode reactivates itself after 50ms so you can continue with more actions in slip
mode almost immediately after.

continues on next page
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oControl Function
45 CENSOR Press and hold this button to play the track in REVERSE. When releasing the button,
the track immediately starts playing from it’s momentary position.
If SLIP was active then after releasing the CENSOR button the track continues as
it had been playing forward the whole time (CENSOR). Slip mode stays enabled so
you can continue with more actions in slip mode.
4% SHIFT + CENSOR Press to activate a backspin with the length set by the STOP TIME knob.
If SLIP was active then after releasing the CENSOR button the track continues as
it had been playing forward the whole time. Slip mode stays enabled so you can
continue with more actions in slip mode.

Z

46 BEAT GRID ADJUST Press to adjust the Beat Grid to the current play position.
46 SHIFT + BEAT GRID AD- | Press to activate Quantize mode.
JUST
47 BEAT GRID SLIDE Press to adjust the Beat Grid to another playing track.
54 NEEDLE DROP Place your finger on a point along this sensor to jump to that point in the track (strip

represents entire track).
54 SHIFT + NEEDLE DROP | Press to jump to a position while a track is currently playing.

Suggeréncia: The jog sensitivity and scratch parameters (28), the default vinyl mode (30), the pitch fader ranges (32)
as well as the needle drop activity (54) can be set by modifying the variables inside the JavaScript file accordingly.

Nota: Use SHIFT + CENSOR for a backspin while SLIP is active. Backspin using the platter is only possible while
SLIP is disabled.

Performance Pads

Mode Selection

NoControl Function

35 Performance Pads Press to perform action with one of those buttons.

36 CUE Press to switch to “Hot Cue” mode.

37 ROLL Press to switch to “Roll” mode.

37 SAVED LOOP Press ROLL one more time to get into “Fixed Loop” mode.
38 SLICER Press to switch to “Beatjump’ mode.

39 SAMPLER Press to switch to ““‘Sampler”” mode.

Hot Cue Mode (blue LED)

8 Hot Cue positions can be defined in this mode.

Press one of the pad buttons to set or play a Hot Cue.

Use SHIFT + pad button to delete an existing Hot Cue.

If SLIP is active then press and hold a pad button to play from the Hot Cue position. After releasing the Hot Cue button
the track continues as it had been playing forward the whole time. Slip mode stays enabled so you can continue with
more actions in slip mode.
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Hot Cue 1

Hot Cue 2

Hot Cue 3

Hot Cue 4

Hot Cue 5

Hot Cue 6

Hot Cue 7

Hot Cue 8

Roll Mode (turquoise LED)

This mode lets you repeat a number of beats while keep pushing a pad button down.
The SLIP function remains active so that the track continues at the position where it had been playing forward the whole

time.

Fixed Loop Mode (yellow LED)

This mode lets you set a dedicated loop from current position.

Another push on the pad button will turn the loop off.
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1/16 beat 1/8 beat
Loop Roll Loop Roll
1 beat 2 beat
Loop Roll Loop Roll

1/4 beat
Loop Roll

1/2 beat
Loop Roll

4 beat
Loop Roll

8 beat
Loop Roll
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SAVED LOOP

4 heat
Loop

8 beat
Loop

1 beat 2 beat
Loop Loop
16 beat 32 bheat
Loop Loop

64 beat
Loop

128 beat
Loop
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Beatjump Mode (red LED)

This mode lets you jump a number of beats while pushing a pad button once.

Jump fwd
1 beat

Jump fwd
2 beats

Jump back
1 beat

Jump back
2 beats

=3

Jump fwd
4 beats

Jump back
4 beats

Jump fwd
8 beats

Jump back
8 beats

Press and hold «SHIFT» and then push a pad button to jump even more beats.
16, 32, 64 and 128 forward on the upper row and backwards on the lower row.

Suggerencia: If experimental features were set to frue in the JavaScript file then the pad LEDs counting the beat after
the main CUE point.

Sampler Mode (pink LED)

8 samplers can be triggered from either Deck.

Add samplers to the sampler bank pushing a pad button.
If a sampler is loaded, then another push on the pad button will play the sampler from its Cue point.
Push the pad button again while playing will replay the sampler from Cue point.
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When a sampler is started while another one is still playing, then the initial sampler stops and only the newly triggered
sampler plays (single play).

Use SHIFT + pad button to stop a sampler while playing or eject a sampler when stopped.

Sample 1 Sample 2 Sample 3 Sample 4

Sample 5 Sample 6 Sample 7 Sample 8

Suggeréncia: To use default Mixxx behaviour and allow playing multiple samplers at the same time you can set the user
variable MC7000 . prevSamplerStop inside the JavaScript file to false.

LEDs

The Channel Volume Meters matches to the ones shown in Mixxx GUI Only when clipping the red LED illuminates.
The Master Volume Meter is not correlated to Mixxx GUI as the controller handles that in Hardware.

Button LEDs are fully mapped for the first function. As you press and hold SHIFT then the secondary functions have
only got some flashing LEDs mapped, e.g. TAP and KEY SYNC, when activated.

Press SHIFT + Deck to switch Platter Ring LED Mode.
* Mode 0 - Single “oft” LED chase (all other LEDs are “on”)
* Mode 1 - Single “on” LED chase (all other LEDs are “off”)
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Suggeréncia: The default mode can be set to 0 or 1 inside the JavaScript file.

Platter Ring LEDs are correlated with the VINYL button.
* If vinyl mode is enabled, the LED imitates a turntable platter spinning at 33.3 rpm.

* If vinyl mode is disabled, the current track position is indicated by the Platter LEDs starting at the top.

Nota: The Platter Ring LEDs are not moving while the track position is “negative”. That means if the position is before
the track starts then the position LED keeps staying at most up position.

Known Issues

¢ Some Performance Pad modes are not available (Cue Loop, Flip, Slicer Loop, Velocity Sampler, Pitch).

¢ The Effect Units don’t use Mixxx” Standard Effects Mapping

17.1.20 DJ Tech CDJ 101

DJ Tech is not to be confused with DJ TechTools, the makers of the MIDI Fighter series, Chroma Cables, and Chroma
Caps. There is no (longer) a product page for this discontinued device.

¢ Forum thread

Novetat de la versié 1.11.

Mapping description

Needs the CDJ 101 to be on midi channel 1 for deck 1 and on channel 2 for deck 2.
* Pitch slider works as you’d expect
* Holding down the push button works as a “shift” to activate secondary functions
¢ Rotate push button: navigate tracks
« Shift + rotate push button: switch between playlists
 Cue button: default cue behaviour
* Play: toggle play
* Shift + play: sync
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While track is playing

* Surface of jog wheel: scratch
» Edge of jog wheel: tempo bend
« Shift + edge of jog wheel: fine tempo bend

While deck is paused

* Press push button: load a track

* Surface of jog wheel: scratch thru track

« Shift + surface of jog wheel: scan through track quickly
» Edge of jog wheel: jog though track slowly

* Shift + Cue: move beatgrid

17.1.21 DJ Tech DJM 101

DJ Tech is not to be confused with DJ TechTools, the makers of the MIDI Fighter series, Chroma Cables, and Chroma
Caps. There is no (longer) a product page for this discontinued device.

¢ Forum thread

Novetat de la versio 1.11.

Nota: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller, please
consider contributing one.

17.1.22 DJ Tech iMix Reload

DJ Tech is not to be confused with DJ TechTools, the makers of the MIDI Fighter series, Chroma Cables, and Chroma
Caps. There is no (longer) a product page for this discontinued device.

¢ Forum thread

Novetat de la versio 1.10.

Nota: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller, please
consider contributing one.
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17.1.23 DJ Tech Kontrol One

DIJ Tech is not to be confused with DJ TechTools, the makers of the MIDI Fighter series, Chroma Cables, and Chroma
Caps. There is no (longer) a product page for this discontinued device.

¢ Forum thread

Novetat de la versio 1.11.

Nota: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller, please
consider contributing one.

17.1.24 DJ-Tech MIX-101

Novetat de la versi6 2.0.

Nota: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller, please
consider contributing one.

17.1.25 DJ Tech Mixer One

DJ Tech is not to be confused with DJ TechTools, the makers of the MIDI Fighter series, Chroma Cables, and Chroma
Caps.

e Manufacturer’s product page

Novetat de la versi6 1.10.1.

Nota: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller, please
consider contributing one.

17.1.26 DJ TechTools MIDI Fighter Classic

A simple 16 button controller that has been discontinued.
The default Mixxx mapping has the buttons mapped to hotcues 1-8 for decks 1 & 2.

Novetat de la versi6 1.8.

Nota: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller, please
consider contributing one.
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17.1.27 DJ TechTools MIDI Fighter Twister

e Manufacturer’s product page

Novetat de la versi 2.1.5.

Nota: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller, please
consider contributing one.

17.1.28 EKS Otus

This controller has been discontinued as EKS is went out of business.

Novetat de la versio 1.11.

Nota: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller, please
consider contributing one.

17.1.29 Electrix Tweaker

The Electrix Tweaker is an unconventional MIDI controller that can control most aspects of Mixxx. Instead of jog wheels,
it fits an 8x4 grid of multicolor backlit buttons, 8 velocity-sensitive buttons, and 6 push encoders with LED rings into a
relatively small package. It does not have a built in sound card, so it requires a separate sound card or splitter cable
(although it does include 5-pin MIDI in and out ports).

¢ Manufacturer’s website
* Forum topic
¢ Manufacturer’s manual

Novetat de la versi6 2.0.

Compatibility and setup

The Tweaker is a USB MIDI class compliant device, so it does not require any special drivers on any operating system.
Just plug it in and load the Mixxx mapping on any OS that Mixxx runs on.

Use it with the Tweaker MIDI 1 port (Tweaker MIDI 2 is the 5-pin MIDI I/O on the Tweaker).
Mapping description
Global controls

1. Scroll through library. Press to toggle big library view

Scroll up left panel of library
Scroll down left panel of library

Ll

Samplers

¢ Off when empty, red when loaded
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* Press a button to load the selected sample into a sampler and play it
* Press a button to play a sample. When the button is released, the sample will stop playing.
* Press [[#top-shift-layerltop shift]] and a sampler button to eject a sample from a sampler

¢ Samples will play with their volume proportional to how much force was used to strike the button. You can adjust
the sensitivity or disable the velocity sensitivity (and make them work as on/off switches) by adjusting options at
the top of the JavaScript file in a text editor.

5. Crossfader

Top shift layer

Figure14: Electrix Tweaker (top shift layer controls)

This layer is active while the top shift button (#1 in the diagram) is held down.

With the exception of the headphone mix encoder (#8 in the diagram), pressing the encoders 7-12 resets them to center.
1. Top shift button
2. Eject left deck
3. Eject right deck
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10.
11.
12.
13.
14.
15.

16.

® N s

Expand/collapse selected item in left library pane

Expand/collapse selected item in left library pane

Scroll through library quickly. Push to load selected track into first stopped deck.
Headphone gain

Headphone cue/master mix in headphones. Press to toggle split cue mode. The blue LED below encoder is lit when
split cue mode is enabled.

Channel gain for active deck on left side
Master output gain

Master output balance

Channel gain for active deck on right side
Eject sampler

Delete hotcue

Deck shift button. Press to enable [[#vinyl timecode mode]] on the deck that is active on the left side (press top
shift button first, then this button while holding down top shift)

Deck shift button. Press to enable [[#vinyl timecode mode]] on the deck that is active on the right side (press top
shift button first, then this button while holding down top shift)

Deck controls

The deck controls are the same on each half of the controller. Which deck each side controls can be switched with the
deck toggle button, labeled #11 in the diagram. When controlling deck 1 or 2, the switches on that side (9, 11, 13, 14,
and 15 in the diagram) are blue when enabled, as shown on the left side of the diagram. When controlling deck 3 or 4,
the switches on that side are magenta when enabled, as shown on the right side of the diagram.

1.

10.
11.
12.

NS R » N

Filter (low pass filter left of center; high pass filter right of center)

Load track selected in library into deck

Toggle encoders between EQ and loop mode (see [[#channel-encoder-layersibelow]])
Headphone cueing

Volume

Play/pause

Hotcues. Press an unlit button to set a hotcue. When slip mode is disabled (see #9 below), pressing a hotcue simply
jumps to that hotcue. When slip mode is on, hotcues can be previewed on a stopped deck. While previewing a
hotcue, press the play button to let the track keep playing after the hotcue is released. Pressing a hotcue while a
deck is playing and slip mode is on will jump to the hotcue then jump back to where the track would have been
once the last hotcue button is released.

Jump 4 beats forward (with quantize enabled)

Slip mode. When active, loops and hotcues will only play as long as they are held down. When they are released,
the track will jump to where it would have been if the loop or hotcue was not pressed.

[[#deck-shift-layer/Deck shift]]
Deck toggle between decks 1 & 3 on the left and decks 2 & 4 on the right.

Jump 4 beats backward (with quantize enabled)
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13. Quantize. In addition to snapping cues, loops, and play button presses to the nearest beat, this changes the behavior
of the controller’s navigation buttons. When enabled, the navigation buttons are white as shown by 8 & 11 in the
diagram. With quantize enabled, the navigation buttons jump by 4 beats or 1 beat with [[#deck-shift-layerldeck
shift (#10)]] pressed. When disabled, the navigation buttons are green as shown by 15 & 16 in the diagram. With
quantize disabled, the navigation buttons fast forward and rewind the track. When quantize is disabled and deck
shift is pressed, the navigation buttons are temporary pitch bend buttons.

14. Key lock

15. Sync lock

16. Fast forward (with quantize disabled)
17. Rewind (with quantize disabled)

Deck Shift layer

1,1 aees
17 T aees
5 s@UEEE B
LEXED B8

—

g

Figure16: Electrix Tweaker (deck shift layer)

This layer is active while the yellow deck shift button on that side of the controller is held down.
1. Pitch (only adjusts tempo with keylock on)

2. Jump 32 beats forward or backward
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3. Scroll through hotcue pages. The pages are color coded, in order, cyan, green, red, and white. The LED around
the encoder indicates the hotcue page number. The active page on a deck is remembered when toggling between
decks (see [[#deck-controlsldeck controls (#11)]] above).

4. Exit loop
5. Volume

6. Cue. When previewing from the cue point on a stopped deck, release this cue button to stop playing and jump back
to the cue point. Release deck shift to continue playing.

7. Move hotcue to current position
8. Jump forward 1 beat (with quantize enabled, see [[#deck-controlsldeck controls #13]])
9. Manually place loop start point
10. Deck shift button
11. Manually place loop end point
12. Jump back 1 beat (with quantize enabled, see [[#deck-controlsldeck controls #13]])
13. Align beatgrid with current position
14. Sync key. If key has been changed from track’s original key, reset the key.
15. Reset tempo
16. Temporarily raise pitch while pressed (with quantize disabled, see [[#deck-controlsldeck controls #13]])

17. Temporarily lower pitch while pressed (with quantize disabled, see [[#deck-controlsldeck controls #13]])

Channel encoder layers

The encoder layer buttons (#4 and #8 in the diagram) toggle the encoders between EQ and loop layers.

The left side of the diagram shows EQ mode. In EQ mode, pressing encoders toggles that EQ’s kill switch. The blue
LED below the encoder is lit while the kill switch is on. Pressing the encoder while holding deck shift (see deck controls
#10) resets the EQ to center.

Tip: You can go to Options > Preferences > Equalizers and check “Reset equalizers on track load”. On most controllers,
this would be an issue because the physical knobs would be misaligned with the values in software when the EQs were
reset, but because the Tweaker has LED rings around encoders instead of knobs, this is not an issue.

The right side of the diagram shows loop mode. The LEDs on the loop move length and loop length encoders represent
numbers of beats. Center means 1 beat. Each step to the right doubles the beats and each step to the left halves the beats.
For example, the default loop length is 4 beats, so the center LED and 2 LEDs to the right are lit (2 x 2 = 4).

1. High EQ

Mid EQ

Low EQ

Encoder mode button. Press to switch to loop mode.
Loop move length

Move loop

NS R »N

Loop length. Press to toggle loop. When in slip mode (see [[#deck-controlsldeck control button #9]]), the loop is
only active while this is held down. The blue LED below the encoder is lit while

8. aloop is active.
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9. Encoder mode button. Press to switch to EQ mode.

Vinyl Timecode Mode

Seeaaann
Seeaaann
3U@0UUUUU
_Beeaaeann

—

U
U

Figure18: Electrix Tweaker (vinyl timecode mode)

1. Top Shift

2. Toggle vinyl timecode mode by pressing deck shift (#2 in the diagram) while holding top shift (#1 in the the
diagram). This replaces the navigation buttons for that deck with buttons that toggle options for timecode control.

3. Cycle through vinyl control modes: absolute (LED off), relative (LED indicates cue mode), and constant (LED red).
If the deck is in relative mode and playing, pressing the button cycles through cue modes: off (white), cue (yellow),
hotcue (green). When the deck is playing in relative mode, pressing the button with deck shift (#2) switches to
constant mode.

4. toggle vinyl control. Turns green when vinyl control is enabled. With deck shift (#2) pressed, it toggles passthrough
mode and turns white. Pressing the button while passthrough mode is enabled turns passthrough mode off (without
toggling whether vinyl control is enabled).
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17.1.30 Evolution X-Session

This product has been discontinued.

Novetat de la versi6 1.6.

Nota: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller, please
consider contributing one.

17.1.31 FaderFox DJ2

Manufacturer’s product page

Novetat de la versi6 1.6.

Setting up the controller

In order for this mapping to work, you will need to use these settings. First, enter System Mode by pressing the two black
buttons in the top right encoder section. There is a vertical System label next to these two buttons. The orange Sys/Mon
LED in the center bottom should be on and not blinking.

You can now modify various settings by pressing each of the 4 black buttons of the encoder section. There are two
possible settings for each function, On or Off, depending which of the corresponding LED is lit. There is also a brief
explanation of these settings on a gray sticker in the back of the controller.

The top left button controls the Auto Switch function. If the Seek/Scratch green LED, is on, the function is off.
If the List/load red LED is on, the function is on. If the Aufo Switch function is on, the encoder will switch to
Seek/Scratch after pressing the encoder to load a track. This function is up to the user’s preference and will not
affect the mapping.

The bottom left button must be set to the Gain green LED for this mapping to work. If set to the red Pitch
LED, the transport buttons will have different CC numbers. This is useful if you own a second controller which
already has transport functions.

The top right button must be set to the Seek/Scratch green LED. If set to the List/Load red LED, the Auto
Play function will be on, meaning that loading a track from the List/load encoder will trigger playback. You don’t

want this function on since it will conflict with the play button of the transport section which would have the same
CC number.

The bottom right button must be set to the Gain green LED. If set to the red LED, the joystick will have
different CC numbers, and its mapping won’t work properly.

If the green FX1 LED is on, the controller’s will use MIDI channel 1, and channel 16 if the FX2 LED is on. This is
useful if you want to control four decks using two FaderFox DJ2 controllers. If you use only one controller, leave
this setting to FXI. To change the setting, press the Shift button and the lower left black button of the encoder
section for channel 1, or the lower right black button of the encoder section for channel 16.

Important : changes to your settings won’t be saved if you just turn off the controller on System Mode. To save the settings,
exit System Mode by pressing again the two black buttons of the left encoder section.
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Encoders Section

The two encoders on top of the controller control various parameters. They can of course be turned but also act as push
buttons. You can select which function is used for each of the encoders by pushing the black buttons of the encoders
section. LEDs indicate which function is currently selected.

e List/Load (top red LED is on) lets you browse your playlist. Push the left encoder to load the highlighted track into
Deck A or the right encoder for Deck B.

 Seek/Scratch (top green LED is on) acts as a jogwheel. Turn the left encoder for Deck A or the right encoder for
Deck B. Pushing the encoder on that setting will activate Sync on that deck.

¢ Gain (bottom green LED is on) controls the gain of the channel. Pushing the encoder on that setting will mute the
track.

* Pitch (bottom red LED is on) controls the tempo of the deck. Unfortunately there is no MIDI CC number emitted
when pushing the encoder on that position.

Joystick

The joystick can be set to control either the first or the second unit of the effect rack. To control the first effect unit, press
Shift + the lower black button of the left encoder section (FX/ green LED is on). To control the second effect unit, press
Shift + the lower black button of the right encoder section (FX2 green LED is on).

The horizontal axis of the joystick controls the Mix knob of the effect unit. The vertical axis control the Super Knob of
the unit.

Mixer Section

» Using the knobs and faders should be straightforward as the controls follow the labels printed on the controller.
* The Cue Mix knob controls the headphone mix. The Cue A and Cue B are used to pre-listen the selected deck.
e The green FX ctrl buttons are used to activate a desired effect unit on the selected deck.

* the left green button enables effect unit 1 on that deck

* the right green button enables effect unit 2 on that deck

* Shift + left green button enables effect unit 3 on that deck

* Shift + right green button enables fx unit 4 on that deck

 The Kill button controls Low Kill and Shift + Kill controls High Kill. To use Mid Kill, press Shift + Cue A (Deck
A) or Shift + Cue B (Deck B)

Transport Section

The left transport section controls Deck A transport functions, and the right transport section those of Deck B.

» The top left gray button (labeled with a pause symbol) of each section controls the Align beatgrid to current play-
position function. Shift + this button controls the Quantize function.

* The top right gray button (without any label) controls the Keylock. Shift + this button controls the Reverse function.

¢ The bottom left gray button (Play/pause label) controls Play. Shift + this button will make the playback jump one
beat backward on this deck.

* The bottom right gray button (play label) controls Cue (depending on the settings in Mixxx’s preferences). Shift +
this button will make the playback jump one beat forward on this deck.
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* The top blue button holds down the speed (temporary pitch bend) and the bottom blue button holds the speed up
according to the labels on the controller. Pressing Shift + these blue buttons will act similarly but with a smaller
pitch bending.

17.1.32 Gemini CDMP-7000

¢ Manufacturer’s product page

Novetat de la versi6 2.0.

Nota: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller, please
consider contributing one.

17.1.33 Gemini FirstMix

e Manufacturer’s product page (archived)
e Forum thread

Novetat de la versio 1.11.

Nota: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller, please
consider contributing one.

17.1.34 Hercules DJ Console 4-Mx

The Hercules DJ Console 4-Mx is a USB controller with a built in sound card. It is very similar to the [[Hercules DJ
Console RMX]], but with switches for 4 decks.

¢ Manufacturer’s product page

Novetat de la versid 1.11.

Audio

The DJ Console 4-Mx is not a USB class compliant MIDI device, although it is a USB Audio device. Drivers for Mac
OS X and Windows can be found on the Hercules support page.

Avis: The controller will not work on Linux out of the box. You will need to use the Linux usermode driver. The
device will only produce audio if the device hasn’t been configured for ASIO under windows previously. Also, check
the volumes in alsamixer.

The sound card has 4 inputs and 4 outputs (2 stereo in/out). The inputs are switchable between line-in and phono, and
also is possible to select different line levels (consumer -10dBV, Pro +4dBu and boost +8dBu ), so you can connect both
CD players and turntables on the inputs. * Inputs are RCA. * Outputs are RCA or 1/4» TRS balanced. * Microphone
input is 1/4» TS * Headphone jack is 1/4» (6.35 mm) TRS stereo
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Hercules Tray Icon configuration

The drivers for Windows and OS X install an application that can be used to configure the audio and controller settings.
Most of the settings work well on the default setting.

Volume/Pan/Mute: Sets the volume output for channels 1-2 and channels 3-4. Note that the volume of the
channels 3-4 refers to the line output from behind. In other words. It does not affect the volume of the headphones.

Line in mode: Sets the line level of the inputs. In case of line 1-2, it also allows to redirect the microphone to the
line 1-2. Else, it is mixed in hardware to the master out.

Talkover attenuation: Sets how much to attenuate the master output when activating the hardware mixed micro-
phone.

Enable/Disable jog wheels: Allows to disable the jog wheels, in case the user desires not to use them.

Sensitivity: Alters the sensitivity of the jog wheels. If you change this, change also the sensitivity option in the
script, as described below.

Audio Mode: Enables the WDM drivers (non-asio) or the specific ASIO-only driver.

MIDI pitch resolution: Sets the resolution of the pitch sliders. Mixxx will work with any of the two settings, but
it is recommended to set it to 14bit (8bit used) which doubles the precision versus 7bit.

ASIO: You can configure the samplerate, bit depth and latency for the ASIO driver.
MIDI channel for controls: Keep these at 1-2 (Default) when you use it with Mixxx.

Crossfader settings: Allows to configure how does the crossfader react. Mixxx also offers an alternate invert
option in the crossfader settings.

Headphone channels: Allows to setup which input channels are sent to the headphone output.

Channels 1-2 hardware mix: Allows mixing the line in or the microphone directly in hardware to the speaker
output.

Deck mode: Leave this at 4 Decks (Default) if you want to use four decks with Mixxx. Else, you will only be able to
use two decks.

Options

There are several options that can be configured for this mapping. You can edit these by opening the JavaScript file in a
text editor like Notepad, TextEdit, or gEdit and editing the values at the top of the file.

autoHeadMix: Indicates if the Headphone/Master mix should automatically be set to master when none of the
headphone cue buttons are activated.

autoHeadcueOnLoad: Automatically enable the headphone cue select (PFL) of the deck when a song is loaded.
(Like in virtual-dj)

beatFlashLed: set which LED, if any, blinks with the beat

useVuMeters: Simulate vuMeters using the kill and source buttons’ LEDs. If enabled, shows master VUs, or deck
VU depending if prefader listen button is enabled or not.

naviScrollSpeed: KeyRepeat speed for navigating up/down, in milliseconds. 100 is a good value. Lower values
make it scroll faster.

crossfaderScratchCurve: The controller has two modes to report the crossfader position. The default/beatmix
curve, and the scratch curve. The default curve reports the real position of the control. The scratch curve just
crossfades on the edges. Setting this setting to true, the curve will change to scratch curve when the scratch mode
is on (scratch button). Setting it to false will not change it, so it will use the setting configured in the DJHercules
Tray-icon configuration.
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* vinylSpeed: Playback speed of the virtual vinyl that is being scratched. 45.00 and 33.33 are the common speeds.
(Lower number equals faster scratch)

* sensitivity: Jog wheel sensitivity. You should configure this setting to the same value than in the DJHercules tray
icon configuration. (Normal means 1/1). If crossfaderScratchCurve is true, or the setting is changed while Mixxx
is active, this value will be detected automatically.

« alpha: alpha value for the scratch filter (start with 1/8 (0.125) and tune from there)

* beta: beta value for the scratch filter (start with alpha/32 and tune from there)

* FXbuttonsSetup: This indicates which mapping for the FX buttons should Mixxx use. The possible values are:
mixxx21, mixxx20, and original (Hercules Manual and the default setup in Virtual DJ 7 LE)

Master / Global controls

Con- | Mode Function
trol
Cross- Fades between left and right decks
Fader
Vol. Controls the Master volume knob of Mixxx.
Main
Scratch Toggles scratch mode. When scratch mode is enabled, pressing a jog wheel controls scratching
Auto Enable AutoD]J. Stop decks 1 and 2 to disable it using the controller.
Auto | Au- | Fade to next song.
toDJ
on
Fold- Switches between browsing the sidebar in the library, or the list. If Folders is pressed twice,
ers / opens/closes the tree branch
Files
Files | Au- | The next song in the Auto DJ cue is skipped
toDJ
on
Up / Moves up and down in the library track list. If held down and any of the jog wheels is moved, then
Down the jog wheel takes over the cursor movement until the up/down button is released
Cue/Mix Control mix of master and PFL (cue) output in headphones
Mic Enables or disables the microphone. The microphone is always mixed in hardware. The trayicon
On/Off driver configuration allows to choose between direct mixing, or mix it only when enabled with the
button. It no longer tries to activate Mixxx microphone talkover.

Note: The Microphone volume and the Headphone volume controls are hardware controls (i.e. they don’t control Mixxx’s

interface)

Deck / Channel specific controls

Control Mode Function

Shift key When this button is pressed and released, it toggles between keypad functic
Shift key When this button is pressed and released, it toggles between keypad functic
P lay/Pause Play track if it is not playing; pause it if track is playing

P lay/Pause Shift Play backwards. If slip mode is enabled (triangle image in Deere skin), it v
Stop Moves the cursor to the beginning, or to the cue point if it is set, and stops
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Control Mode Function

Stop Shift Brake (Slow it down progressively). Releasing it will continue playing, exce

Cue Depends on the cue mode set in Mixxx preferences

Jog wheel Seeks forwards and backwards in a stopped track Temporarily changes the

Jog wheel Scratch on and jog pressed | If Scratch is on and the jog is pressed, moving it will do a scratch effect

Jog wheel Up/Down presssed Moves up / down in the tracklist if either Up or Down are held down

Jog wheel LED If the beatflash led has been set to jogwheel in the JavaScript file, the light

Forward / Backward Seeks at high speed.

Forward / Backward Seeks forward or backward in the track in steps of 4 beats (when the beatg

Forward / Backward Pressed for 500ms seeks at high speed.

Forward / Backward Shift Seeks forward or backward in the track in steps of 1 beats

Sync Automatically sets the pitch fader speed to match the BPM of the other de

Sync LED If the beatflash led has been set to Sync in the JavaScript file, the light of t}

Sync Pressed for 500ms Activates master sync for this deck.

Sync Shift Activates the beatgrid edit mode

Sync Beatgrid edit mode When the track is stopped, aligns the beatgrid with the current playback po

Pitch fader Adjusts playback speed (range and direction can be adjusted in Mixxx prefi

Pitch bend +/- Adjusts playback speed temporarily (range can be adjusted in Mixxx prefer

Pitch bend +/- Beatgrid edit mode Increases or decreases the BPM of the track (the detected one).

Pitch bend +/- Shift Adjust playback speed permanently (range can be adjusted in Mixxx prefer

Pitch Scale +/- These controls have a different meaning in Mixxx: They have been mappec

Pitch Scale +/- Beatgrid edit mode Move the beatgrid to the left or to the right

Pitch Scale - Shift Activates or deactivates the (musical) keylock mode

Pitch Scale + Shift Activates or deactivates the quantize (to beat) mode

Pitch Reset This is triggered when both pitch scale buttons are pressed at the same tim

Pitch Reset LED This led has a different meaning in Mixxx: If the beatflash led has been set

Deck A/C, B/D Switches the deck to control between Deck A/C or between Deck B/D. Lig

Vol. Deck Controls a deck’s output volume

Cue Select Deck Toggles on and off this deck’s output to the monitor/prefader listen (headpl

Cue Select Deck Shift Set this deck to control the “Preview Deck”. Press it again to leave this mo

Cue Select Deck LED The led is active when the monitoring with headphones is active. The butto
Load On Left/Right Deck

Bass knob EQ low frequencies

Medium knob EQ mid frequencies

Treble knob EQ high frequencies

Gain Controls a deck’s gain before the volume fader

Kill (Bass/ Medium/ Treble) Toggles that frequency band completely off

Kill (Bass/ Medium/ Treble) | LED If the useVuMeters option is activated in the JavaScript file, these LEDs wi

Source 1/2 Toggles the deck to use the input channel 1/2 as its audio source instead of

Source 1/2 LED If the vumeter is activated in the JavaScript file, they will show a vumeter c

Keypad 1 to 4 Set/Unset a beatloop of 0.5, 1, 2 or 4 beats. They act like the correspondin,

Keypad 1 to 4 Shift Set/Unset a beatloop. buttons 1 and 2 use a beatloop size of 0.125 and 0.2

Keypad 5 to 6 Reveses playback direction when held down. keypad 6 does it with audio 1«

Keypad 7 to 10 Set/Unset the hotcues 1 to 4

Keypad 7 to 10 Shift The corresponding hotcue is cleared

Keypad 11 to 12 Enables the effect rack 1 and 2 for this specific deck

Keypad 1 Sets the loop begin and Activates the loop edit mode

Keypad 1 Shift Same as click, but it will be a rolling loop (slip mode)

Keypad 1 Loop edit mode Exits the loop edit mode

Keypad 1 Loop active Disable the loop
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Control Mode Function

Keypad 1 LED The led is on if the loop is active

Keypad 2 Reloop (Enable or disable the previously existing loop)
Keypad 2 Loop edit mode Sets the loopend and exits the loop edit mode

Keypad 2 LED The led is on if a loop exists

Keypad 3 to 4 Sets a loop of 4 or 16 beats.

Keypad 3 to 4 Shift Same as click, but it will be a rolling loop (slip mode)
Keypad 3 to 4 LED If a beatloop of 1 or 4 beats is enabled.

Keypad 5 to 6

starts or stops a sampler 1 or 2 (buttons on the left deck), or the sampler 3

Keypad 3 to 6

Loop edit mode

Sets a beatloop of 2, 8, 16 or 32 beats

Keypad 7 to 10

Set/Unset the hotcues 1 to 4

Keypad 7 to 10 Shift The corresponding hotcue is cleared

Keypad 11 to 12 Enables the effect rack 1 or 2 for this specific deck

Fx knob Filter knob (the Quick Effect set in the equalizer preferences)

Fx knob Shift Move the filter knob slowly (the Quick Effect set in the equalizer preferenc
Fx knob Beatgrid edit mode Move the beatgrid position

Fx knob Loop edit mode Increase or decrease the loop size

Fx knob audio effect pressed If a keypad number is mapped to an audio effect, holding such button and 1
Fx knob pitch Scale +/- pressed Increases or decreases the musical key (it doesn’t matter which of the pitch
Fx knob Loop edit mode Move the loop forward or backward in steps of one beat

Fx knob keypad 1 held down Increase or decrease the loop size

Note: The actions of the Keypad buttons can be changed from the JavaScript. There are three preconfigured presets
corresponding to Manual/Virtual DJ LE, Mixxx 2.0 and Mixxx 2.1.

17.1.35 Hercules DJ Console (Mac Edition)

Novetat de la versi6 1.7.

Nota: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller, please

consider contributing one.

17.1.36 Hercules DJ Console MK1

Novetat de la versi6 1.11.

Nota: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller, please

consider contributing one.
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17.1.37 Hercules DJ Console MK2

Novetat de la versid 1.11.

Nota: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller, please
consider contributing one.

17.1.38 Hercules DJ Console MK4

Novetat de la versi6 1.8.

Nota: Unfortunately a detailed description of this controller mapping is still missing. If you own this controller, please
consider contributing one.

17.1.39 Hercules DJ Console RMX

e Manufacturer’s product page

The Hercules DJ Console RMX is a USB controller with a built in sound card. It is a class compliant USB Audio and
HID device. Older versions of Mixxx that did not support HID required using Hercules’ MIDI driver, but it is now
recommend to not use the Hercules driver on GNU/Linux. If you have it installed, it is recommended to uninstall the
driver and upgrade to the latest version of Mixxx if you have not already. On Windows (and Mac OS X?) the driver is
still recommended.

Novetat de la versi6 1.11.

Audio

The sound card has 4 inputs and 4 outputs (2 stereo in/out). The inputs are switchable between line-in and phono, so you
can connect both CD players and turntables on the inputs. The inputs require a high input signal (~10mV+) for turntables

if you want to record audio or mix it to the output. Time-coded vinyls, for Vinyl Control, should work okay with lower
input signal.

MIDI Mappings

Regular mapping
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Global controls

Con- | Function
trol
Cross- | Fades between left and right deck
Fader
Vol. Controls output volume of your mix
Main
Bal- Controls balance between left and right audio channel of your mix
ance
Scratch | Toggles scratch on and off which changes the function of the deck jog wheels Effect Shift when held down
shifts function of each decks Bass, Medium, Treble to control effect parameters

Up / | Moves up and down in the library track list When held down changes the jog wheels behaviour to scroll the
Down | library list

Left / | Moves up and down between the library sections

Right
Moni- | Fades monitor output (headphones) between cue selected tracks output and the main mix
tor
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Deck / Channel specific controls

Control Function

Play/Pause Starts playing a loaded track if stopped. If track is currently playing it stops the track

Stop Stops a currently playing track and moves to the beginning.

Cue Sets the cue point if a track is stopped and not at the curren cue point Stops track and returns to the
current cue point if a track is playing. Plays preview if a track is stopped at the cue point for as long
as it’s held down

Jog wheel Seeks forwards and backwards in a stopped track Temporarily changes the playback speed for playing
tracks Scratches both stopped and playing tracks when scratch mode is on Moves up / down in the
tracklist if either Up or Down is held down

Forward / | Seeks at high speed in a track

Backward

Load Deck | Loads the currently selected track in the track list to the related deck

A/B

Cue Select Toggles this decks output to the monitor (headphones) on and off

Pitch Adjusts playback speed +/-10% (can be adjusted in the preferences)

Sync Automatically sets pitch so the BPM of the other deck is matched

Pitch Reset | Resets the pitch to the tracks normal playback speed

Bass Adjusts the volume of a channels low frequency content (ex. bass drum) Adjusts flanger period when
Effect Shift is held down

Medium Adjusts the volume of a channels mid frequency content (ex. vocals) Adjusts flanger delay when Effect
Shift is held down

Treble Adjusts the volume of a channels high frequency content (ex. hi-hats) Adjusts flanger depth when

Effect Shift is held down

Kill (Bass /

Toggles output of a frequency band on and off

Medium /

Treble)

Gain Controls a decks input volume

Vol. Deck | Controls a decks output volume

A/B

Keypad 1 Toggles a channels flanger effect on and off
Keypad 4 Reveses playback direction when held down

Advanced mapping

The advanced mapping works similar to the normal RMX mapping, but also supports loops and hot cues. This mapping
was added to not brake the previous (Mixxx -1.7.2) behaviour. Controls that differ between the normal and advanced
mappings are described here.

Global controls

Con-
trol

Function

Scratchloggles scratch on and off which changes the function of the deck jog wheels Effect Shift when held down:
- Shifts function of each decks Bass, Medium, Treble to control effect parameters - Shifts the Keypad (1-6)
functions to effects. Currently flanger and reverse
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Deck / Channel specific controls

Control Function

Stop Deck shift changes behaviour of other controls related to this deck when held down

Forward Adjusts position of loop in/out and hot cues when a loop / hot cue button is held down

/ Back-

ward

Bass Adjusts the volume of a channels low frequency content (ex. bass drum) Soft takeover when Deck Shift
is held down, lets you move knob in position before adjusting Adjusts flanger period when Scratch is held
down

Medium | Adjusts the volume of a channels mid frequency content (ex. vocals) Soft takeover when Deck Shift is
held down, lets you move knob in position before adjusting Adjusts flanger delay when Scratch is held
down

Treble Adjusts the volume of a channels high frequency content (ex. hi-hats) Soft takeover when Deck Shift is
held down, lets you move knob in position before adjusting Adjusts flanger depth when Scratch is held
down

Keypad 1 | Go to hotcue 1 Set hotcue 1 when Deck Shift is held down Toggles a channels flanger effect on and off
when Effect Shift is held down

Keypad 2 | Go to hotcue 2 Set hotcue 2 when Deck Shift is held down

Keypad 3 | Go to hotcue 3 Set hotcue 3 when Deck Shift is held down

Keypad 4 | Hold down to adjust loop in position with Forward / Backward Set loop in when Deck Shift is held down
Reveses playback direction when held down if Effect Shift is held down

Keypad 5 | Hold down to adjust loop out position with Forward / Backward Set loop out when Deck Shift is held
down

Keypad 6 | Re-loop / exit turns looping on and off Half loop when Deck Shift is held down

17.1.40 Hercules DJ Console RMX2

e Manufacturer’s product page

¢ Forum thread

¢ Previous forum thread

This all-in-one DJ controller features a built in 4 channel sound card with balanced XLLR master outputs and a balanced
microphone input. It is a USB class compliant MIDI and audio device (unlike older Hercules controllers).

Novetat de la versio 1.11.

User Options

To change the mapping’s user options, you have to open the script file (.js). At the top of the file under **USER OPTIONS*
the following settings can be made:

* DJCRMX2.jogwheelSensivity: Sets the jogwheel sensitivity. 1 = default, 2 is twice as sensitive, 0.5 is half as
sensitive.

* DJCRMX2.jogwheelShiftMultiplier: Sets how much more sensitive the jogwheels get when holding [SHIFT].
Set it to 1 to disable jogwheel sensitivity increase when holding [SHIFT].

¢ DJCRMX2.twinkleVumeterAutodjOn: If true, level-meter twinkles if AutoDJ is enabled.
* DJCRMX2.autoPFL: If true, PFL / Cue (headphone) is being activated by loading a track into certain deck.
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* DJCRMX2.vuMeterOutputMaster: If true, deck vu meters show master output (L = Deck A, R = Deck B). If
false, deck vu meter shows deck output (mono).

* DJCRMX2.showHideSamplersEffectsOnPadMode: If true, Samplers and EffectRack get shown or hidden de-
pending on the Pad-Mode.

General Functions

Managed by Mixxx

Figure [SHIFT]?| Long- Control Name Description
press?
11 X X [MAIN VOL- | Controls Master volume
UME]
13 b ¢ X [VINYL] Split headcue
13 v b 4 [VINYL] Maximize library
20 X X [CROSS Controls crossfader
FADER]
21 X X [CUE TO MIX] Controls mix in headphones between PFL and master
signal
7 b 4 X [MIC ON/OFF] Toggle microphone on/off and talkover on/off
15 b ¢ X [FILES] Go To Item in Library
(Right)
15 v b 4 [FILES] Add to bottom of Auto DJ playlist
(Right)
15 (Left) | X X [FOLDERS] Move focus backward in Library
15 (Left) | v X [FOLDERS] Toggle Auto DJ
15 (Up) b 4 X [UP] Move vertically up in Library
15 (Up) b 4 v [UP] Scroll vertically up in Library
15 X b 4 [DOWN] Move vertically down in Library
(Down)
15 b 4 v [DOWN] Scroll vertically down in Library
(Down)

Managed by the controller

The following functions directly affect the controller’s sound card, so adjusting these will not change anything on screen

in Mixxx:
Figure | [SHIFT]? | Long-press? | Control Name Description
22 b 4 b 4 [HEADPHONES VOLUME] | Controls the headphones output volume
6 b 4 b 4 [MIC VOLUME] Controls the microphone volume (gain)
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Deck Functions

Figure [SHIFT]? | Long-press? | Control Name Description

3() b 4 X [PITCH BEND MINUS] Pitch bend down

3(-) v X [PITCH BEND MINUS] Decrement (halve) pitch range

3(+) b 4 X [PITCH BEND PLUS] Pitch bend up

3(+) v X [PITCH BEND PLUS] Increment (double) pitch range

2 (Left) X X [REWIND] Fast backward in loaded track

2 (Lefty | v b 4 [REWIND] Spinback effect

2 (Right) | X X [REWIND] Fast forward in loaded track

2 (Right) | v X [REWIND] Brake effect

9 X b 4 [SOURCE] Toggle pass thru

17 b 4 X [PREVIEW] Toggle pfl

17 v b 4 [PREVIEW] Toggle keylock

30 b 4 X [PLAY] Play Button

30 v b 4 [PLAY] Play Button

29 b 4 X [CUE] Cue Button

29 v X [CUE] Cue Button

28 b 4 X [SYNC] Sync Button

28 v X [SYNC] Sync Button

16 b 4 X [LOAD] Load selected track

16 v X [LOAD] Eject track

8 b 4 X [LOOP MODE] encoder Adjust beatloop size

8 v X [LOOP MODE] encoder Move loop forward/backward

8 X X [FX MODE] encoder EffectUnit’s mix knob, in EffectFocusMode in combination w
8 v X [FX MODE] encoder EffectUnit’s super knob

8 b 4 X [SAMPLE MODE] encoder | Switch between 4 sampler banks (each of 4 samplers)

8 b 4 b 4 [CUE MODE] encoder Adjust key of loaded track

24-1 b 4 X [LOOP PAD 1] Toggles beatloop over beatloop size

24-2 X X [LOOP PAD 2] Toggles beatloop over 2 beats

24-3 X b 4 [LOOP PAD 3] Toggles beatloop over 4 beats

24-4 b 4 X [LOOP PAD 4] Toggles beatloop over 8 beats

24-1 v b 4 [LOOP PAD 1] Toggles beatlooproll over 1/16 beats

24-2 v b 4 [LOOP PAD 2] Toggles beatlooproll over 1/8 beats

24-3 v X [LOOP PAD 3] Toggles beatlooproll over 1/4 beats

24-4 v X [LOOP PAD 4] Toggles beatlooproll over 1/2 beats

24-1 X X [FX PAD 1] Enables effect 1, in EffectFocusMode toggles effect button pa
24-2 b 4 X [FX PAD 2] Enables effect 2, in EffectFocusMode toggles effect button pax
24-3 b 4 X [FX PAD 3] Enables effect 3, in EffectFocusMode toggles effect button pa
24-4 X X [FX PAD 4] Shows/hides focus of EffectUnit

24-1 X v [FX PAD 1] In EffectFocusMode enables ParameterEditMode and gives en
24-2 b 4 v [FX PAD 2] In EffectFocusMode enables ParameterEditMode and gives en
24-3 X v [FX PAD 3] In EffectFocusMode enables ParameterEditMode and gives en
24-4 b 4 v [FX PAD 4] Enables EffectFocusMode (+ press [FX PAD 1..3] to focus a
24-1 v X [FX PAD 1] Enables effect 1 of EffectUnit and controls meta its meta knc
24-2 v X [FX PAD 2] Enables effect 2 of EffectUnit and controls meta its meta knc
24-3 v X [FX PAD 3] Enables effect 3 of EffectUnit and controls meta its meta kno
24-4 v X [FX PAD 4] Cycle through effectUnit numbers array

24-1 X X [SAMPLE PAD 1] Load selected track into Sampler (Index 1) if empty, else go
24-2 X b 4 [SAMPLE PAD 2] Load selected track into Sampler (Index 2) if empty, else go
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Table 5 - ve de la pagina anterior

Figure [SHIFT]? | Long-press? | Control Name Description

24-3 b 4 X [SAMPLE PAD 3] Load selected track into Sampler (Index 3) if empty, else go
24-4 b 4 X [SAMPLE PAD 4] Load selected track into Sampler (Index 4) if empty, else go
24-1 v X [SAMPLE PAD 1] Stop Sampler (Index 1) if playing, else eject loaded track
24-2 v X [SAMPLE PAD 2] Stop Sampler (Index 2) if playing, else eject loaded track
24-3 v X [SAMPLE PAD 3] Stop Sampler (Index 3) if playing, else eject loaded track
24-4 v X [SAMPLE PAD 4] Stop Sampler (Index 4) if playing, else eject loaded track
24-1 b 4 X [CUE PAD 1] Hotcue 1 Button

24-2 X X [CUE PAD 2] Hotcue 2 Button

24-3 X X [CUE PAD 3] Hotcue 3 Button

24-4 X X [CUE PAD 4] Hotcue 4 Button

24-1 v X [CUE PAD 1] Hotcue 1 Button

24-2 v X [CUE PAD 2] Hotcue 2 Button

24-3 v X [CUE PAD 3] Hotcue 3 Button

24-4 v X [CUE PAD 4] Hotcue 4 Button

1 b 4 X [JOG WHEEL] Jog/Scratch loaded track

1 v X [JOG WHEEL] Jog/Scratch loaded track using DJCRMX2. jogwheelShiftMult
10 b 4 X [GAIN] Controls pregain

18/19 b 4 X [VOLUME FADER] Controls volume

4 b 4 X [PITCH FADER] Controls rate (speed control)

12 X X [KILL TREBLE] High frequencies kill

12 X X [KILL MEDIUM] Middle frequencies kill

12 X X [KILL BASS] Low frequencies kill

14 b 4 X [TREBLE] High frequencies control

14 X X [MEDIUM] Middle frequencies control

14 b 4 X [BASS] Low frequencies control

14 v X [BASS] Filter (QuickEffectRack) control

17.1.41 Hercules DJControl AIR

This is one of the cheapest Hercules DJ controller from Hercules leisure DJ controllers brand. There are actually many
versions of it:

e DJControl AIR (The one shown in picture above)
¢ DJControl AIR Street Edition (Limited Edition)
¢ DJControl AIR S Series
¢ DJControl AIR for iPad
This controller have built-in soundcard with mixer output (3.5mm jack) and headphones output (6.35mm jack).

The main fun and uncommon feature of this controller is its proximity sensor (IR) located above EQ potentiometers and
between top horizontal vu-meter.

e Manufacturer’s product page
* Forum Thread

Novetat de la versié 1.11.
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Sound Hardware settings

e Sample rate: 44100 Hz
* Master Output: Channels 1 - 2
¢ Headphones Output: Channels 3 - 4

Mapping Description

Figure19: Hercules DJControl AIR (schematic view). This picture is taken from the Getting Started Tutorial (courtesy
of Guillemot Corporation S.A.).

We assume from the annotated picture above that each decks have same controls.

Jogs / Jogs Wheels (1)

Pressing Jogs enable the scratch mode.
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PADs (2)
Loops Effects Samples
1 | Loop In Flanger (Mixxx 1.10) Sample 1
2 | Loop Out Align Beat Grid to current position | Sample 2
3 | Loop Double | Toggle Quantitize Sample 3
4 | Reloop/Exit | Toggle KeyLock Sample 4

Proximity Sensor (4)

Currently not mapped

Library Navigation (8)

* Folder : Switch to previous view (library, playlist...)
* Files : Switch to next view (library, playlist...)
» Up : Scroll to previous track in library/playlist

¢ Down : Scroll to next track in library/playlist

Load track to Deck (9)

This button load track to the selected deck (A => Deck 1, B => Deck 2)

Headphone listen (PFL) (10)

This toggle the Pre Fader Listen for the selected Deck(s)

Rec (11)

Currently not mapped

Load selected track to sample (12)

This is done by pressing and holding the Magic button while pressing on the desired sample PAD.
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SpinBack(13)

Currently not mapped

Sync (16)

Synchronize the tempo to the other deck one (One-time beat sync, tempo/phase).

Speed Adjustment (17)

Adjust speed slower [ - ] or faster [ + ] in Coarse mode.

17.1.42 Hercules DJControl Compact

¢ Manufacturer’s product page
e MIDI mapping manual

The Hercules DJControl Compact is a simple controller for basic two-channel mixing. This device does not have a built
in sound card, so it would require a splitter cable or separate audio interface to be able to preview tracks in headphones.
It also does not have buttons for routing decks to headphones.

Thanks to Hercules for supporting the development of this mapping by providing a controller.

Novetat de la versi6 2.1.

Mapping description

Much of the Compact’s behavior is hard-coded into its firmware, including shift button messages and button mode selec-
tions.

Shift + Play jumps to the beginning of the track and stops playback.

The cue button behaves differently depending on the cie mode set in Mixxx’s Preferences.

The sync button synchronizes the tempo to the other deck. Press and hold sync to engage Sync Lock.

There is only one each of the Mode, Shift, and Scratch buttons, so they affect both decks.

Shift + Scratch (Automix) toggles AutoDJ on/off.

Jog Wheels

When Scratch is off, turning a jog wheel bends the pitch of the track. When Scratch is on, turning a jog wheel scratches
that deck. Holding Shift and turning a jog wheel adjusts the playback rate (tempo). Enable keylock on a deck by clicking
the music note button on screen if you do not want the pitch to change when adjusting the tempo.
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Pad Grid

Press the MODE button to cycle through each pad mode.

Loop mode

In loop mode, the buttons are mapped in a way that’s more artistically expressive:
* Button 1 enables and disables the loop
* Button 2 enables an 8 beat loop
* Button 3 divides the current loop in half
* Button 4 doubles the length of the current loop
* Shift + Button 1 performs an 1/8th beat roll
« Shift + Button 2 performs an 1/4th beat roll
« Shift + Button 3 performs an 1/2th beat roll

* Shift + Button 4 performs an 1 beat roll

FX mode

¢ Button 1 enables and disables the first FX chain for Channel 1
 Button 2 enables and disables the second FX chain for Channel 1
 Button 1 enables and disables the first FX chain for Channel 2
 Button 2 enables and disables the second FX chain for Channel 2

Shift-FX buttons are not mapped.

Sampler mode

 Left side buttons play Sample Decks 1 through 4
* Right side buttons play Sample Decks 5 through 8
« Shift + Buttons stops Sample Deck and puts the playhead at the cue point

Cue mode

¢ Each button activates the hotcue with that number

¢ Shift + button clears the hotcue with that number
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17.1.43 Hercules DJControl Inpulse 200

e Manufacturer’s product page
* Manufacturer’s support and downloads page
* Forum thread

Novetat de la versi6 2.3.0.

Compatibility

This controller is a class compliant USB MIDI and audio device, so it can be used without any special drivers on
GNU/Linux, Mac OS X, and Windows. However, if you wish to use the ASIO sound API under Windows, please
install the latest driver package available from the Support page.

Sound Card Setup
This controller has built-in 4 channel output sound card, with MASTER output (RCA) and HEADPHONE output (3.5mm
jack).
1. Open Preferences > Sound Hardware
2. Select the Output tab
3. From the Main drop-down menu, select the audio interface, then Channels I - 2
4. From the Headphones drop-down menu, select the audio interface, then Channels 3 - 4
5. Click Apply to save the changes.
Vegeu també:

The example setups section provides more details about the audio configuration in Mixxx.

Nota: The MASTER and HEADPHONE knobs, as well as the MASTER button are hardware controls and interact
directly with the integrated sound card’s output. Although they also send MIDI messages, they have NOT been mapped
in Mixxx, so do not expect an on-screen reaction when using them. This was done to prevent the knobs to adjust both the
gain on the controller’s sound card and in Mixxx.

Mapping description

All controls not mentioned behave as labeled.
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Decks
Control Function
SYNC button Toggle Sync Lock.
SHIFT + SYNC button Set deck as Sync leader.
CUE button Specifies, plays or recalls temporary cue point.
SHIFT + CUE button Return to the beginning of the track.
Play button Play/Pause the current track.
SHIFT + Play button Cue Stutter.
VINYL button Toggle scratch mode (default: on)
Loop IN button Enable Beatloop.
SHIFT + Loop IN button Halve the current loop size.
Loop OUT button Disable Beatloop.
SHIFT + Loop OUT button | Double the current loop size.
Beat Align LED Track end warning (make sure BEATMATCH GUIDE is on for this to work)
Browser
Control Function
BROWSER encoder (turn) | Move up/down list.
BROWSER encoder | Switch focus between list and file view.
(press)
SHIFT + Encoder (press) Maximize/Minimize library view.
ASSISTANT button Toggle AutoDJ (be sure a playlist was created for AutoDJ before activating this func-
tion).
Performance Pads
Hot Cue Mode
Control Function
Pad1-4 Set and trigger hotcue 1 - 4
SHIFT + Pad 1 - 4 | Delete hotcue 1 - 4.

Roll Mode

Control | Function

Pad 1 Set Beatloop of 1 beat size.
Pad 2 Set Beatloop of 2 beat size.
Pad 3 Set Beatloop of 4 beat size.
Pad 4 Set Beatloop of 8 beat size.
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FX Mode

When using Firmware v1.68 and earlier, each FX pad will send multiple and different Note and CC messages. As these
could not all be used properly with Mixxx current effect framework, a simplified configuration was assigned using the pad

in SHIFT mode for convenience.

Control Function
SHIFT + Pad 1 - 3 Toggle Effect 1 - 3.
SHIFT + Pad 4 (deck A) | Toggle Effect Rack 1.

SHIFT + Pad 4 (deck B)

Toggle Effect Rack 2.

However, after applying Firmware v1.72, each FX pad now sends a simple Note On/Note Off (as is the case in every
other Pad mode). This makes it easier to use the pads to control effect and the latest mapping take advantage of this
possibility by removing the use of the SHIFT button.

Control Function

Pad1-3 Toggle Effect 1 - 3.
Pad 4 (deck A) | Toggle Effect Rack 1.
Pad 4 (deck B) | Toggle Effect Rack 2.

Vegeu també:

Read the update guide for more details about updating the firmware.

Sampler Mode

Control Function
Pad 1 -4 (deck A) | Trigger Sampler 1 - 4.
Pad 1 - 4 (deck B) | Trigger Sampler 5 - 8.

Unmapped Controls

The following controls are not mapped because they are controlled by the hardware.
* MASTER knob
« HEADPHONE knob
* MASTER buttons
* BEATMATCH guide
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17.1.44 Hercules DJControl Inpulse 300

e Manufacturer’s product page
* Manufacturer’s support and downloads page
* Forum thread

Novetat de la versi6 2.2.4.
Compatibility
This controller is a class compliant USB MIDI and audio device, so it can be used without any special drivers on

GNU/Linux, Mac OS X, and Windows. However, if you wish to use the ASIO sound API under Windows, please install
the latest driver package available from the Support page.

Nota: Firmware upgrade (v1.72) is required for pads to work correctly in FX Mode.
When using Firmware v1.68 and earlier, pads in FX Mode will not work as expected.

For more details about upgrading the Firmware.

Sound card setup
This controller has built-in 4 channel output sound card, with MASTER output (RCA) and HEADPHONE output (3.5mm
jack).
* Open Preferences > Sound Hardware
* Select the Output tab
¢ From the Master drop-down menu, select the audio interface, then Channels 1-2
¢ From the Headphones drop-down menu, select the audio interface, then Channels 3-4
 Click Apply to save the changes.
Vegeu també:

The example setups section provides more details about the audio configuration in Mixxx.

Nota: The Master and Headphone knobs, as well as the Master button are hardware controls and interact directly with
the integrated sound card’s output. Although they also send MIDI messages, they have NOT been mapped in MixxX, so
do not expect an on-screen reaction when using them. This was done to prevent the knobs to adjust both the gain on the
controller’s sound card and in Mixxx.
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Mapping description

Decks
Control Function
SYNC button Toggle Sync Lock.
SHIFT + SYNC button Set deck as Sync leader.
CUE button Specifies, plays or recalls temporary cue point.
SHIFT + CUE button Return to the beginning of the track.
Play button Play/Pause the current track.
SHIFT + Play button Cue Stutter.
VINYL button Toggle scratch mode (default: on)
Loop IN button Enable Beatloop 4 beats.
SHIFT + Loop IN button Halve the current loop size.
Loop OUT button Disable Beatloop.
SHIFT + Loop OUT button | Double the current loop size.
Beat Align LED Track end warning (make sure BEATMATCH GUIDE is on for this to work).
SLIP Toggles splip mode.
Q Toggles quantize.
SHIFT + Q Adjusts beatgrid so closest beat is aligned with the current playposition.
Browser
Control Function
BROWSER encoder (turn) Move up/down list.
SHIFT + BROWSER encoder | Move left/right (fold/unfold) list.
(turn)
BROWSER encoder (press) Switch focus between list and file view.
SHIFT + Encoder (press) Maximize/Minimize library view.
ASSISTANT button Toggle AutoDJ (be sure a playlist was created for AutoDJ before activating this
function).
FX
Control Function
ON pad Toggle FX 3 on/off.

SHIFT + ON pad (select) | Cycle to the next effect after the currently loaded effect.
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Performance Pads

Hot Cue Mode

Control Function
Pad1-8 Set and trigger hotcue 1 - 8
SHIFT + Pad 1 - 8 | Delete hotcue 1 - 8.

Roll Mode
Control | Function
Pad 1 Activate Beatloop of 1/8 beat size.
Pad 2 Activate Beatloop of 1/4 beat size.
Pad 3 Activate Beatloop of 1/2 beat size.
Pad 4 Activate Beatloop of 1 beat size.
Pad 5 Activate Beatloop of 2 beat size.
Pad 6 Activate Beatloop of 4 beat size.
Pad 7 Activate Beatloop of 8 beat size.
Pad 8 Activate Beatloop of 16 beat size.
FX Mode
Control Function
Pad1-3 Toggle Effect 1 - 3.
Pad5-7 Cycle to the next effect for Effect 1 - 3.
Pad 4 Toggle Effect Unit 1.
Pad 8 Toggle Effect Unit 2.

Shift + Pad I - 3

Toggle Effect 1 - 3. (Effect Unit 3 / 4 for deck A / B)

Shift + Pad 5 - 7

Cycle to the next effect for Effect 1 - 3 (Effect Unit 3 / 4 for deck A / B).

Shift + Pad 4 Toggle Effect Unit 3.
Shift + Pad 8 Toggle Effect Unit 4.
Sampler Mode
Control Function

Pad 1 - 8 (deck A) | Trigger Sampler 1 - 8.
Pad 1 - 8 (deck B) | Trigger Sampler 9 - 16.
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Beatjump Mode

Control | Function

Pad 1 -2 | Jump backward/forward by 1 beat.
Pad 3 - 4 | Jump backward/forward by 2 beats.
Pad 5 - 6 | Jump backward/forward by 4 beats.
Pad 7 - 8 | Jump backward/forward by 8 beats.

Known issues

Controls not included in this mapping

¢ Master knob (Hardware control)
» Headphone knob (Hardware control)
¢ Master buttons (Hardware control)

¢ Beatmatch guide (Hardware control)

PADS: Slicer/Slicer Loop
* PADS: Toneplay

17.1.45 Hercules DJControl Instinct (S)
This is the cheapest all-in-one controller with an integrated sound card. The DJControl Instinct S is functionally identical
to the DJ Control Instinct, but has a brushed stainless finish.

e Manufacturer’s product page

e Forum thread

Novetat de la versié 1.10.1.

Setup
The controller is a class compliant MIDI controller, so you should be able to just plug it in and it should be recognized in
Mixxx. No need for drivers.

Make sure to select the correct mapping for the controller and enable it.

Audio Channels

There are two outputs on the controller itself: the headphones output with builtin volume control on the side facing you
and the speakers output.

In Mixxx the headphones output is on channels 3 and 4, so select the “Channels 3-4” item to get stereo output. The
speakers output is on channels 1 and 2, so to get stereo output you want to select the “Channels 1-2” item.
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Controls
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Figure20: Hercules DJControl Instinct (schematic view). This picture is taken from product poster (courtesy of Guillemot
Corporation S.A.).

1. Jog Wheel for the deck on the side of the wheel
2. Action buttons for the deck on the side of the controls, depending on the mode they do the following:
* Hot Cue:
— 1: Set and play (by holding it) from Hot Cue 1
— 2: Set and play (by holding it) from Hot Cue 2
— 3: Reset Hot Cue 1
— 4: Reset Hot Cue 2
* Loop
— 1: Set Loop start
— 2: Set loop end
— 3: Shrink loop (halves it)
— 4: Exit loop
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* Effect
— 1: Toggle Effect 1
— 2: Toggle Effect 2
— 3: Toggle Effect 3
— 4: Toggle Effect 4
e Sample
— 1: Play Sample 1
— 2: Play Sample 2
— 3: Play Sample 3
— 4: Play Sample 4
Mode status display. The current mode is glowing or if none is on, Hot Cues are enabled.
Headphone volume controls
No direct use, used as a button to add a second layer of controls
Switch the current mode for both decks

Knobs to adjust the EQ of the deck they are on. Top knob adjusts highs, middle knob the mids and bottom know
the lows.

Buttons to browse your library. The up and down button go up and down in the current playlist, The folder/left
button goes up in the playlist list and the Files/right button goes down in the playlist list.

Load the currently selected track to the respective deck (A is the left deck, B is the right deck)
Listen to this deck unmixed on the headphones

Deck volume adjusts the output volume of the respective deck

Crossfader

Temporary pitch shift. Pressing the Vinyl button increases the shift.

Adjust tempo. Pressing both buttons together resets to the original tempo. Pressing the Vinyl button takes the steps
bigger.

Fast forward and backward buttons for the respective decks
Sync tempo of this deck to the tempo of the other deck

If pressed while paused sets the cue and when held plays from the cue, when pressed during playback jumps to the
cue.

Play and pause playback of the respective decks
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17.1.46 Hercules DJControl Jogvision

e Manufacturer’s product page
* Manufacturer’s support and downloads page
* Forum thread

Whether you're just getting started DJing or you’ve already refined your skills, you can let your creativity run wild. Enjoy
excellent precision and comfort to create your mixes using the circular displays on the jog wheels to guide your movements
and perfect your scratches, and have fun with the amazing contactless AIR Control sensor. Your adventure starts right
here and now. It’s your turn!

Compatibility
This controller is a class compliant USB MIDI and audio device, so it can be used without any special drivers on

GNU/Linux, Mac OS X, and Windows. For Windows, please install the latest driver package available from the manu-
facturer’s product page.

Sound card setup

This controller has built-in 4 channel output sound card, with:

Channel Port
Master Output RCA and 3.5mm jack
Booth Output RCA and 3.5mm jack

Headphone Output | 6.35mm and 3.5mm jack
Microphone Input | 6.35mm jack
Auxiliary Input 3.5mm jack

* Open Preferences » Sound Hardware

* Select the Output tab

* From the Master drop-down menu, select the audio interface, then Channels 1-2

e From the Headphones drop-down menu, select the audio interface, then Channels 3-4
* Click Apply to save the changes.

Please refer to the user manual for more details about the audio configuration in Mixxx.

Nota: The MASTER and HEADPHONE knobs, as well as the MASTER button are hardware controls and interact
directly with the integrated sound card’s output.
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Mapping configuration

Edit the Hercules_DJControl_Jogvision—-scripts. js, and change the CFG. (user | fine) variables to

fit your needs:

Suggeréncia:

This controller mapping can be customized by editing the corresponding Javascript file and editing the

configuration options at the top of the file.

All controls act as labeled, but there are some additional functionalities that have been added:

Control Description

MODE + LOOP ON Set a loop_in mark (with currently defined loop_size), activate it, and enable slip
mode

MODE + LOOP X% /LOOP X2 | Do a beatjump backward/forward

MODE + LOOP SIZE knob

Decrease/Increase pitch (only key, not tempo!)

MODE + Jog Wheel plate (play-
ing)

Scratch with “Slip” on (d